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CHAPTER 1

Desktop Basics

For information on the 
System Folder and 
other Macintosh¨ fea-
tures, such as the desk-
top and icons, see your 
Macintosh documenta-
tion.

The Avid driveÑthe computerÕs internal hard driveÑcontains a num-
ber of Þles and utilities you can use to organize and optimize your 
work. The desktop elements directly related to the Media Composer 
system (also referred to at times as the Avid Composer system) are 
stored in the Composer Projects, Avid Users, Utilities, and Media 
Composer folders. The System Folder also contains essential exten-
sions and control panels.

This chapter describes basic procedures involving the Composer 
Projects, Avid Users, and Media Composer folders in the following 
sections:

¥ Managing Composer Project and User Folders

¥ Using the Media Conversion Tool

¥ About the Media Composer Folder

¥ Mounting and Ejecting Disk Drives

Managing Composer Project and User Folders

Managing projects and user proÞles involves moving, copying, or 
deleting Þles and folders, and changing project or user names.
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About Composer Projects and Avid Users Folders

Composer Projects and Avid Users folders allow you to move whole 
projects or selected project and user settings between systems by copy-
ing and moving Þles on your desktop.

When you create a new project or user proÞle, the system creates the 
following Þles and folders:

¥ When you create a new user, the system creates three items: a user 
proÞle Þle, a user settings Þle, and a user folder containing the 
two. Each item is given the user name you provide. This new 
folder is stored in the Avid Users folder on the Avid drive.

¥ When you create a new project, the system creates three items: a 
project Þle, a project settings Þle, and a folder containing the two, 
each of which is given the project name you provide. This new 
folder is stored in the Composer Projects folder on the Avid drive.

Your settings are initially set to the default values. As you work, the 
Þles maintain current settings, while the project folder Þlls with bin 
Þles.

Changing Project and User Names

You cannot change project or user names from within the 
Media Composer application. You must change the name from your 
desktop before starting the application.

To change a project or user name:

1. Double-click the Avid drive to open it.

2. Double-click the Avid Users or the Composer Projects folder to 
open it.

3. Click the name of the folder you want to change.

The name is highlighted for text entry, and the arrow changes to 
an I-beam. Change or retype the name.
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4. Close the windows and restart the Media Composer application.

The new project or user name appears in the Project Selection dia-
log box. The system automatically changes the names of corre-
sponding Þles in the folder.

Deleting Projects and User Profiles

Digitized media related 
to a deleted project is 
not eliminated with the 
project folder. For more 
information on delet-
ing media Þles, see 
ÒDeleting Clips and 
SequencesÓ on 
page 235 andÒDeleting 
Tracks with the Media 
ToolÓ on page 273.

You cannot delete projects and user proÞles from within the Media 
Composer application. You must make the change from your desktop 
before starting the application.

To delete a project or user proÞle:

1. Double-click the Avid drive to open it.

2. Double-click the Avid Users or the Composer Projects folder to 
open it.

3. Drag the project or user folder you want to delete to the Trash. 
Empty the Trash to remove the Þles from the system.

c Deleting a project also deletes any bins that are in that project.

4. Close the windows and restart the Media Composer application.

The deleted project or user no longer appears in the Project Selec-
tion dialog box.
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Moving Projects and User Profiles from Another System

Adding a project folder 
from another system 
does not transfer 
accompanying media 
Þles. For more informa-
tion on moving media 
Þles between systems, 
see ÒTransferring a 
Project to Another 
Media Composer Prod-
uctÓ on page 664.

To open projects and user proÞles created on another system, you 
must move the Þles or folders from a diskette or available drive 
directly into your Composer Projects or Avid Users folders on the 
desktop before starting the application. In addition, if you are using 
earlier releases of Media Composer, you need to convert the Þles 
before you can open them on your system. See ÒUsing the Media Con-
version ToolÓ on page 29.

To add a project or user proÞle from another system:

1. Locate the new folders on the desktop:

¥ If the folders were copied onto a diskette, insert the diskette 
into the diskette drive and open it.

¥ If the folders were placed on a network to which you have 
access, locate them online.

2. Double-click the Avid drive to open it.

3. Double-click the Avid Users or the Composer Projects folder to 
open it.

4. Drag the project or user folder you want to add to the system to 
the appropriate folder.

c Do not open a project directly from a diskette. You must copy it to a 
folder on the Avid drive Þrst.

5. Close the windows and restart the Media Composer application.

The added project or user appears in the Project Selection dialog 
box.
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Using the Media Conversion Tool

You might need to convert projects and media to make them compati-
ble between different releases of your Avid Composer system. 

You can convert your 6.x media Þles from Media File Manager (MFM) 
to Media Stream Manager (MSM) by using the Media Conversion 
Tool, which is a standalone utility. Release 7.0 Avid Composer prod-
ucts only accept MSM format.

The video format is Joint Photographic Expert Group (JPEG), the 
audio formats include: Audio Interface File Format Ñ Compressed 
(AIFC) or Sound Designer IIª (SD2).

To convert media Þles:

1. Locate the 6.x MediaFiles folder or the OMFI MediaFiles folder 
you want to convert on your media drive. This will be your Source 
Folder.

n All the Þles must be in either MSM or MFM format. Do not mix Þles of dif-
ferent types in the Source Folder.

2. Choose the media drive where you want the converted Þles to be 
saved. The Media Conversion Tool will automatically create a Des-
tination Folder.

n The media drive where you choose the Destination Folder to be created must 
have at least as much available storage space as the size of your Source Folder.

3. Double-click the Media Conversion Tool icon located in the Utili-
ties folder on the Avid disk.

The utility launches.
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4. Click the Source Folder Find button to navigate to the folder you 
want to convert.

5. Click the Destination Folder Find button to navigate to the media 
drive where you want the Þles to go.

n If you select only the media drive, an OMFI MediaFiles folder will be created 
for you.

6. Choose a Source Format and a Destination Format.

When you choose MFM Media as your Source Format, MSM 
Media becomes your default Destination Format.

7. Choose the Audio and Video format. When the Destination For-
mat is MSM Media, the defaults are already selected.

8. Click Convert to convert the media Þles.
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A progress box appears. When the conversion is completed, select 
another folder to convert or click Quit to exit the tool.

The Media Conversion Tool creates a log of the converted Þles that can 
be read by using any word processing or text editing package. 
Vantageª, a text editor program, is included with the Avid Composer 
system and is located in the Apple menu items in the Utilities folder.

n After the media Þles have been converted to MSM format, your bins and 
projects will have lost their links to the original media Þles. When a clip 
becomes unlinked, it displays the message ÒMedia Ofßine.Ó For information 
on relinking media Þles, see ÒRelinking Media FilesÓ on page 282.

About the Media Composer Folder

The Media Composer folder contains essential operational Þles and 
supporting Þles. You should not touch any of these Þles, except where 
noted in the following descriptions.

¥ Attic Folder: The system automatically places copies of all bins 
into the Attic folder at regular intervals for backup. The procedure 
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for recovering bin Þles from the Attic is described in ÒRetrieving 
Bin Files from the Attic FolderÓ on page 60.

¥ Media Composer application: The program application icon 
resides here. Procedures for launching the program are described 
in ÒLaunching the Media Composer ApplicationÓ on page 32.

¥ Settings: In addition to Project and User settings, the system 
maintains two settings Þles in this folder that apply to all users 
and all projects on the system. You can copy or move the Site set-
tings Þle to other systems on the desktop, using the same proce-
dure described in ÒMoving Projects and User ProÞles from 
Another SystemÓ on page 28.

¥ Supporting Files: These are a series of Þles that add functionality 
to the application. The system accesses most of these Þles from 
within the application. You can add third-party effects to the Third 
Party Plug-Ins folder from programs such as Adobe Photoshopª 
for use in effects editing, as described in the Avid Media Composer 
and Film Composer Effects Guide.

Launching the Media Composer Application

The Media Composer application icon is located in the 
Media Composer folder on the Avid drive. For most users, the desktop 
or the Apple menu is a more convenient location for launching the 
application. 

c The application will not launch properly if the icon is moved out of 
the Media Composer folder. To launch the application from a conve-
nient location, Avid recommends that you create an alias and place it 
in a convenient location.

For more information 
on making an alias and 
using the Apple menu, 
see your Macintosh 
documentation.

To launch the application, double-click the application icon or alias, or 
choose it from the Apple menu.

When you launch the Release 7.0 software, a dialog box appears.
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Choose the appropriate conÞguration.

After the application starts, the Project Selection dialog box appears, as 
described in ÒOpening a ProjectÓ on page 35.

Mounting and Ejecting Disk Drives

You can eject one or several drive volumes mounted on the desktop at 
any time from within the Media Composer application. You can also 
remount all the drives and return them to the desktop. 

This is useful in several circumstances:

¥ If you work with optical drives for backup and retrieval of low-
resolution material, you can eject these drives and mount them as 
needed to avoid cluttering the desktop during normal use.

¥ If you work with an extensive array of Þxed-storage drives, which 
can involve many partitions divided among several projects, you 
can selectively mount and eject drives according to use.

¥ If you work with the MediaShare Þle-sharing program, you might 
have to eject and remount icons on the desktop. See the 
MediaShare documentation for more information.

Ejecting Disk Drives

To eject one or several drive icons from the desktop:
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1. With the Media Composer application active, choose Eject from 
the File menu.

A dialog box appears.

The scroll list displays all drives and partitions currently mounted.

2. Select a drive to eject. Shift-select additional drives.

3. Click Eject. The system removes the drives from the desktop and 
can no longer access them.

Mounting All Drives

Because the system cannot interface with ejected drives individually, 
you cannot mount selected drives. But you can mount all drives con-
nected to the system, including those previously ejected. 

To mount all drives, choose Mount All from the File menu.

The system mounts all partitions and drives that are turned on and 
connected to the system.
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CHAPTER 2

Starting a Project

For information on the 
Macintosh interface and 
terminology, see your 
Macintosh documenta-
tion. For information on 
turning on your system, 
see the Avid Media Com-
poser Getting Started 
Guide.

Your work in Media Composer begins when you turn on the system, 
launch the application, and open an existing project or create a new 
project. This chapter describes these and other procedures for starting 
a project. There are also several techniques you can use to safeguard 
and restore your work if necessary. These topics are covered in the fol-
lowing sections:

¥ Opening a Project

¥ Backing Up Your Work

¥ Ending the Edit Session

¥ Session Checklist

Opening a Project

Each time you start the Media Composer application, the Project Selec-
tion dialog box appears. 
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Use the options described in the following sections to establish your 
identity as a user with the system, and to select or create a project to 
open. You can also create additional folders within which to store 
projects, or you can quit the application from the Project Selection dia-
log box.

Identifying a User

To identify a user for the project, you can either create and identify a 
new user or select one from a list of existing users.

Setting Up a New User

To create a new user proÞle:

1. Click the New User button.

The New User dialog box appears.
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2. Type your name and press Return or click OK.

The Project Selection dialog box reappears with your user name 
highlighted in the list of users.

3. Click OK in the Project Selection dialog box to continue.

Selecting an Existing User

To select from the list of existing users, click the user name to highlight 
it in the Avid Users list on the left side of the Project Selection dialog 
box. This user proÞle is used when you open a project.

Parent folders containing collections of users appear with a dot. If the 
needed User folder is stored inside a parent folder within the Avid 
Users folder:

1. Double-click the folder to open it and display the user names.

2. Click a user name to select it. 

User name

Parent folder

Directory pop-up menu
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If the user proÞle you want is stored on your system outside the Avid 
Users folder (in another folder or on a network, for example), you can 
locate it by using the Directory pop-up menu.

To search for another user proÞle folder:

1. Click the Directory pop-up menu to display a list of other loca-
tions on the system.

2. Select the Avid drive or an external drive from the Desktop sub-
menu if necessary, and locate the folder.

3. Double-click the selected folder to open it. Continue to open any 
additional folders until the scroll list displays the appropriate user 
Þle name.

4. Click the user name to select it.

You are ready to open a project.

Selecting a Project

To open a project, you can either create and open a new project, or 
open an existing project.

Creating a New Project

To create a new project:

1. Click New Project in the Project Selection dialog box.

The New Project dialog box appears.
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2. Type the name of your new project in the highlighted text entry 
Þeld.

3. Select either NTSC or PAL from the Format pop-up menu.

4. Click OK.

The system creates the new project Þles and folder and returns you to 
the Project Selection dialog box where the project name is highlighted 
in the Composer Projects scroll list.

Nesting Projects in Folders

You can create folders in the Project Selection dialog box for storing 
related projects. To nest a folder, you must Þrst create a folder.

To create a folder:

1. Click the New Folder button in the Project Selection dialog box.

The New Folder dialog box appears.
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2. Type a name for the folder, and press Return or click OK.

The folder appears with a dot next to it in the Composer Projects 
scroll list.

3. Double-click the folder name to open the folder. 

Any new projects you create now are displayed and stored in this 
folder. Any existing projects you move into this folder from your 
desktop are displayed in this folder.

Selecting an Existing Project

Existing projects appear in the Composer Projects scroll list in the 
Project Selection dialog box.

To select an existing project, do one of the following:

¥ Click an existing project name to highlight it.

¥ Press the Þrst letter of the project name on the keyboard to high-
light it. (If there are multiple projects that begin with the same let-
ter, the Þrst project appearing with that letter in the list will be 
highlighted.)

If the project is nested in a folder:

1. Double-click the folder name to open it and display the contents in 
the scroll list.

2. Click the project name to select it.
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If the project is stored outside of the Composer Projects folder (in 
another folder or on a network, for example) you can locate it by using 
the Directory pop-up menu.

To locate a project in another folder:

1. Click the Directory pop-up menu and choose the Avid drive or an 
external drive from the Desktop submenu.

The Project Selection box displays all the stored folders.

2. Double-click a folder name to open it. Continue opening folders 
until the scroll list displays the project folder you want. 

3. Click the project name to highlight it.

Opening the Project

After you select the appropriate user and project names in the scroll 
lists, you can open the project with the selected user settings in one of 
the following ways:

¥ Click OK.

¥ Double-click the highlighted project name in the project scroll list.

¥ Double-click the highlighted user name in the user scroll list.

Read more about the 
Project window in 
Chapter 3.

The Composer window opens on the Edit monitor, and the Project 
window opens on the Bin monitor with the selected user settings 
loaded.
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Closing a Project

To close the Project window and return to the Project Selection dialog 
box, do one of the following:

¥ Click the close box in the Project window.

¥ With the Project window active, choose Close from the File menu, 
or press z Ð W.

The Project window and all open bins close, and the Project Selection 
dialog box appears.

Backing Up Your Work

To back up the larger 
media Þles that are cre-
ated when you digitize 
footage, you must use a 
mass-storage device 
such as an Avid digital 
linear tape (DLT) 
device. For more infor-
mation, see the Avid 
DLT 35/35R for Avid Sys-
tems Setup and UserÕs 
Guide.

Although the Avid Composer system automatically saves your bins, 
projects, and settings, you should back up these items frequently to 
avoid losing any of your work in case of a hard drive crash or corrup-
tion of the Þles. Because the storage requirements are minimal, you 
can back up these Þles easily to a variety of storage devices, such as:

¥ Diskette

¥ Network storage device, such as a Þle server

¥ Mass storage device
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Saving Your Work on a Diskette or Drive

To save your work on a diskette or drive:

1. Mount or insert the drive or diskette as appropriate.

2. Double-click the icon for the targeted storage drive or diskette to 
open it. Double-click any additional folders to target the appropri-
ate storage location.

3. Double-click the Avid drive to open it.

4. Drag a project folder, user folder, or settings Þle to the targeted 
storage location.

5. When the system Þnishes copying the Þles, eject the diskette or 
drive and store it when appropriate.

Restoring from a Backup

To restore a project, user proÞle, or settings from a backup storage 
device: 

1. Mount or insert the drive or diskette as appropriate.

2. Open the drive or diskette, and the Avid drive.

If you are restoring an 
individual bin or bins, 
you must relink them to 
the project from within 
the Project window. For 
more information, see 
Chapter 3.

3. Drag the copies from the storage device to the appropriate folder 
on the Avid drive:

¥ Project folders and settings Þles go in the Composer Projects 
folder.

¥ User folders and settings Þles go in the Avid Users folder.

¥ Site settings Þles go in the Media Composer folder.

4. Launch the Media Composer application. The restored project/
user proÞle appears in the Project Selection dialog box.
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Ending the Edit Session

To end the session you must Þrst quit the application, then turn off 
your equipment in the order described in this section.

Quitting the Media Composer Application

There are two ways to quit the Media Composer application, depend-
ing upon whether you have a project open, or you are between 
projects:

¥ If you are working on an open project and want to exit Media 
Composer quickly, choose Quit from the File menu.

The project closes and the application quits.

¥ If you are between projects, at the Project Selection dialog box:

a.  Click the Quit button. The system asks if you want to leave 
the application.

b. Click Leave to quit Media Composer. Click Cancel to return to 
the Project Selection dialog box and select another project.
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Turning Off Your Equipment

When you are through using your system and want to turn it off com-
pletely, follow these steps to avoid damaging your Macintosh or 
media storage disks.

1. Choose Shut Down from the Special menu. This turns off your 
Macintosh. The screens on the Bin and Edit monitors go dark.

2. Turn off your speakers and monitors.

3. Turn off each drive in the chassis, then turn off the chassis itself.

Move your disks only when the Macintosh is completely off.

4. Turn off all other hardware.

c Never remove disks from your Avid Composer system when it is 
turned on.
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Session Checklist

Turn on your equipment in the proper order: storage Þrst, peripherals 
second, Macintosh last. For more information, see the Avid Media Com-
poser Getting Started Guide.

On your desktop, move any settings Þles, Project folders, or User fold-
ers from another system into the Avid folders on the Avid drive if nec-
essary before launching the application.

Launch the application.

Create new projects or user proÞles or select existing ones in the 
Project Selection dialog box.

After Þnishing your work for the session, quit the application.

Back up your work before shutting down the equipment.

Turn off your equipment in the opposite order: Macintosh, peripher-
als, and Þnally storage.
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CHAPTER 3

Working with the Project 
Window

The Project window provides controls in three different display modes 
for structuring and viewing important information about your current 
project. These include a display of bins and folders associated with the 
project, a list of all settings, and basic information about the format of 
the project and use of system memory. These topics are described in 
the following sections:

¥ Opening and Closing the Project Window

¥ Using the Bins Display

¥ Using the Settings Display

¥ Using the Info Display

Opening and Closing the Project Window

The Project window opens automatically when you select a project in 
the Project Selection dialog box.
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To close the Project window and return to the Project Selection dialog 
box, do one of the following:

¥ Click the close box in the Project window.

¥ With the Project window active, choose Close from the File menu, 
or press z Ð W.

Because the Project window remains open the entire time you are 
working within a project, it might be hidden from view by several 
open bins or tools on the Bin monitor.

To locate and redisplay the Project window, do one of the following:

¥ Choose Project from the Tools menu.

¥ Click any unobstructed piece of the Project window to bring it for-
ward.

Using the Bins Display

Bins contain the master clips that are created when you digitize source 
material. (The master clips are linked to the media Þles.) Bins also con-
tain the sequences, subclips, group clips, and effect clips that you cre-
ate during a project. From the Project window, you can view a list of 
bins associated with the project, and open, close, and create bins. You 
can also open bins created for another project.

Close box
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To view a list of bins associated with the project, click the Bins button 
in the Project window.

From the Bins list you can examine the number, names, size, and loca-
tion of bins: 

¥ Click the triangle next to a bin icon to display the binÕs contents in 
the Project window. Click the triangle again to close up the dis-
play.

¥ Double-click a bin icon to open the bin in its own window. A col-
ored icon next to the bin indicates that the bin is closed. A dimmed 
icon next to the bin indicates that the bin is open. 

¥ To view a list of only the folder contents and not the folders, as in 
earlier versions of Media Composer, select Flat View from the Fast 
menu.

To open a bin from another project:

1. Select Open Bin from the File menu.

The Select a Bin window opens.

2. Find and select the bin you want.

3. Click the Open button.

The bin appears in the Project window in a folder called Other Bins. 
The name Other Bins is in italics. You can rename this folder.

Bins button
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Displaying Bins

You can add folders to the Project window to help organize your 
project. You can drag and drop bins into folders, or folders into fold-
ers. See ÒManaging Folders and BinsÓ on page 52.

Creating a Folder in a Project

To create a folder in a project:

New folders

Trash icon

Bin Fast menu
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1. Click Bins in the Project window.

2. Choose New Folder from the Bin Fast menu.

A new untitled folder appears.

3. Click the untitled folder and rename it.

Deleting a Bin or Folder

To delete a bin or folder:

1. Select the bin or the folder you want to delete.

2. Press the Delete key.

A Trash icon appears in the bin folder. It contains the deleted item.

n Clips, subclips, and effects that are in a bin appear in the Trash after you 
delete the bin. However, if you select a clip, subclip or effect directly and press 
the Delete key, the item does not appear in the Trash.

Emptying Trash

To empty the Trash:

1. Choose Empty Trash from the Bin Fast menu.

An alert box appears.
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2. Click Empty Trash to delete the bins or folders from the Trash.

Viewing Contents in the Trash

If you need to view the contents in the Trash or decide you do not 
want to delete those items in the Trash, you must Þrst move the bins 
and folders out of the Trash. 

To view items in the Trash:

1. Double-click the Trash icon to open it.

2. Click the bins or folders you want to remove (or view) and drag 
them from the Trash to the Project window.

3. Double-click the bin or folder to view it.

Managing Folders and Bins

You can use the Project window to create hierarchies of folders and 
bins that reßect the speciÞc workßow of the current project. This struc-
ture should provide both simplicity and backup security. Although the 
speciÞcs can vary depending upon your production needs and habits, 
the following are a few basic principles that can help you get started:

¥ Limit the number of sequences you create in each project. For 
instance, consider creating one new project for each show, episode, 
spot, or scene.
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¥ Limit the number and complexity of clips in each bin by creating 
and organizing bins in three groups, as follows:

- Create a set of bins for the digitizing stage. 

For example, you can create one bin for each source tape to be 
digitized to avoid slowing the system with large bins and 
causing confusion between tapes.

- Create a second set of bins for organizing your project.

For example, you can create separate bins for each segment of 
a video project, depending upon the preferences of the editor.

- Create a third set of bins for the editing stage, including:

A current cut bin for storing each work in progress (sequence)

An archive bin for keeping the original version of each cut 
(sequence)

A selects or storyboard bin for screening selected clips or cuts 
gathered from the source bins

A format cuts bin for storing the Þnal cuts with added format 
elements such as segment breaks, bars and tone, slate, or 
countdown

n For information on creating script windows using scripts for your projects, 
see Chapter 11.

¥ (Option) Create additional folders at the desktop level for better 
organization. 

For example, you can create one folder for each digitizing bin and 
show cut bin, or a folder to contain all shot logs to be imported.

¥ Save these Þles as a template for future productions of a similar 
nature.

A sample template of bins for a project might be as follows:
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This hierarchy allows you to have one set of bins available in the 
Project window during the digitizing and organizing phase, and 
another set of bins available during editing to reduce clutter.

Creating a New Bin

To create a new bin from the Project window, do one of the following:

¥ Choose New Bin from the File menu.

¥ Click the New Bin button in the Project window.

¥ Use the Open Bin dialog box, as follows:

a. Choose Open Bin from the File menu.

The Select a Bin dialog box appears.

Bin icons

Project file

Specific structure and termi-
nology of the template can 
vary, depending upon conven-
tions at your facility. 
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b. Click New.

A directory dialog box appears.

c. Type a bin name in the New Bin Name text entry Þeld.

d. Save the bin as follows:

¥ To have the system save the new bin in the Project folder, click 
Save.

¥ To store the new bin in another location, click the Directory 
pop-up menu to select another drive or folder, then click Save.

Directory name

Click and hold here 
to display the pop-
up menu.
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Performing either of these procedures displays a new (empty) 
bin that is given the name of the project as displayed in the 
title bar of the Project window (unless you name it in the Open 
Bin dialog box). A corresponding Þle is placed in the Project 
folder, and a backup copy is placed in the Attic folder.

The default name of the bin appears at the top. You can keep 
the name, or rename the bin immediately. 

Renaming a Bin

Each new bin that you create takes the name of the project that appears 
in the Project window, numbered incrementally.

To change the name of a bin, click the Bins list in the Project window 
and type a new name.
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Opening and Closing a Bin

To open a bin with the Project window active:

1. Do one of the following:

¥ Double-click the bin handle (the icon) next to a bin.

¥ Choose Open Bin from the File menu.

The Select a Bin dialog box appears.

2. Using the Directory pop-up menu to Þnd the correct folder if nec-
essary, select a bin.

Bins list
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3. Click Open.

The bin opens and the bin name is added to the current Bins list in 
the Project window for future access. This option is especially use-
ful when you want to open a bin not currently displayed in the 
Project window.

c Never open a bin thatÕs stored on a diskette; otherwise the system 
wonÕt be able to save your work. Always copy the bin to your Avid 
drive before you open it.

Opening Selected Bins

To open several bins at once:

1. Click the name of one of the bins in the Bins list.

2. Shift-click each additional bin you want to open.

3. Choose Open Selected Bins from the File menu.

Closing a Bin

To close a bin, do one of the following:

¥ Click the close box in the upper left corner of the bin.

¥ Choose Close Bin from the File menu to close the active bin.

Deleting Bin Names

To delete Bin names from the Project window:

1. Select a bin name for deletion. Shift-select additional bins.

2. Press the Delete key. The bin names are deleted from the Bins list.

n Bin names deleted from the scroll list remain as Þles in the Projects folder and 
in the Attic folder. To delete bins completely, you must open the project folder 
on your desktop and drag the bin Þle to the Trash.
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Saving Bins Automatically

The Avid Composer system automatically saves changes to your work 
on a regular basis during each session. Two things happen when auto-
save occurs:

¥ Any open bins are updated with changes made since the last auto-
save.

¥ Copies of these bins are placed in the Attic folder as backup.

The system automatically places copies of all bins into the Attic folder 
at regular intervals for backup. The procedure for recovering bin Þles 
from the Attic folder is described in ÒRetrieving Bin Files from the 
Attic FolderÓ on page 60.

You can manually save bins for added securityÑfor instance, immedi-
ately after an important edit. When your work is lost, or when you 
want to recover an earlier version of a bin or sequence, you can 
retrieve Þles from the Attic folder.

n The Save Bin command is dimmed if there have been no changes since the last 
time the active bin was saved.

Saving Bins Manually

There are three ways to save bins manually:

¥ To save a speciÞc bin:

a. Click the bin to activate it.

b. Choose Save Bin from the File menu.

¥ To save selected bins:

a. Activate the Project window by choosing Project from the 
Tools menu or clicking anywhere on the window.

b. Click a bin handle to select it. Shift-click any additional bins.
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c. Choose Save Selected Bins from the File menu.

The system saves all the selected bins.

¥ To save all the active bins:

a. Click an open bin to activate it, or click the Project window to 
activate it but donÕt select any individual bins listed in the 
window.

b. Choose Save All from the File menu.

The system saves all the open bins for the project.

Retrieving Bin Files from the Attic Folder

You retrieve Þles from the Attic folder in the following circumstances:

¥ When you want to replace current changes to a sequence or clip 
with a previous version

¥ When the current bin Þle becomes corrupt

When a copy of a bin Þle is stored in the Attic folder, the system adds 
the extension Ò.bakÓ plus a version number to the bin name. When 
you view the Attic folder in the Name view, you can identify the most 
recent backup Þle based on the name and timestamp of creation dis-
played in the Last ModiÞed column.

To retrieve a Þle from the Attic folder:

1. If you do not plan to overwrite existing Þles, create a new bin.

2. Open the Attic folder in the Project window.

Click the triangle next to the Attic folder icon or double-click the 
Attic icon. (If you open the Attic window, select by Name from the 
View menu if the Folder window is not already in the Name view.)

3. Open the bin that you want to retrieve in the Attic folder.

4. Lasso or Shift-select the desired Þles.
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5. Drag the Þles to the desired destination.

If you want to maintain the Attic Þles in the Attic folder, duplicate 
the selected Þles and drag the duplicates as desired.

There is no conßict with 
sequences, so there is no 
need to modify the cre-
ation date of a 
sequence. 

Once you have moved the objects, modify their creation dates so they 
are considered newest by the system. 

To modify the creation date: 

1. Click the F button at the lower left of the bin window to put the 
bin in Frame display mode.

2. Select the object (for an entire bin, choose Select All from the File 
menu).

3. Advance the frame displays by one frame by pressing the Step 
Forward button or key. Move back again by pressing the Step 
Backward button or key. 

The date stamp is updated to the present time and date.

Using the Settings Display

From the Settings display you can view, select, open, and alter various 
User, Project, and Site settings, as described in this section.

To view the Settings display, click the Settings button in the Project 
window.
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About Settings

Three types of settings are displayed in the Settings scroll list, as indi-
cated in the third column of information: User, Project, and Site set-
tings.

¥ User settings are speciÞc to a particular editor. In general, User 
settings reßect individual preferences for adjusting the user inter-
face in Media Composer. Individual User settings are stored in 
each user folder within the Avid Users folder on the Avid hard 
drive.

¥ Project settings are directly related to individual projects. When a 
Project setting is changed, it affects all editors working on the 
project. SpeciÞc Project settings are stored in each project folder 
within the Composer Projects folder on the Avid hard drive. 

¥ Site settings establish default parameters for all new users and 
projects on a particular system. These can apply to particular con-
Þgurations of equipment installed at the site (for example spec 
and node settings for an external switcher). They can also include 
other user or project settings that you copy into the Site Settings 

Settings button

Setting type
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window. Site settings are stored in a separate Settings folder in the 
Media Composer folder on the Avid hard drive.

Defining Settings

You can use the Settings display to establish a hierarchy of settings 
that address the speciÞc needs of each production phase. For example, 
you can establish:

¥ User settings for the assistant editor: Facilitate logging, digitizing, 
and organizing projects.

¥ User settings for the editor: Include editing interface preferences.

¥ Project settings: Reßect the speciÞc needs of the project.

¥ Bin View settings: Display useful columns of information for each 
of the bins described in ÒManaging Folders and BinsÓ on page 52.

By establishing these settings once, and selecting the appropriate set-
ting or bin view in context, you can save time and effort that would be 
spent searching for information or adjusting bin headings on-the-ßy. 
You can also save these settings along with your template (as 
described in ÒManaging Folders and BinsÓ on page 52) for use on 
similar projects.

Reviewing Basic Settings

For a complete descrip-
tion of all settings and 
their options, see the 
Avid Media Composer 
Products Reference.

The following list describes basic system settings to review at the start 
of your project:

¥ Bin settings

¥ General settings

¥ Interface settings

Double-click each setting in the Settings scroll list of the Project win-
dow to view the following dialog boxes:
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¥ Bin settings deÞne general system functions related to bins, 
including:

- Parameters of the Auto-save function

- Maximum number of bin backup Þles stored in the Attic 
folder 

- Whether double-clicking objects in the bin loads them into 
Source/Record monitors or pop-up monitors

¥ General settings deÞne fundamental system defaults, including:

- Starting timecode for sequences edited in Media Composer

- Setup default for either American NTSC or NTSC/EIAJ video 
input (affects calibration)

- Whether the system uses the drive-Þltering function to auto-
matically target only the fastest drives when digitizing high-
resolution media

¥ Interface settings determine the level of basic information dis-
played in the interface, including:

- Whether the system displays long (complete) menus or short 
(simpliÞed) menus

- Whether written labels are displayed beneath icons in the var-
ious command palettes

Displaying Project Settings

You can display the Project Settings window in different ways, 
depending on what you need to view. Table 3-1 describes the Project 
Settings options.
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To change a project setting display:

1. Click the Settings buttons in the Project window.

The Project Settings window opens.

2. Choose a settings display from the Fast menu or from the Settings 
menu.

Table 3-1 Project Settings Options

Option Description

All Settings Displays all settings available in the Avid Com-
poser system.

Base Settings Displays project settings only; no views are dis-
played.

Bin Views Displays all the bin view settings you created.

Timeline Views Displays all the Timeline view settings you cre-
ated.

Title Styles Displays all the templates you created for the Title 
Tool.

Video Tool Settings Displays all the Video Tool settings.

Workspaces Displays all the workspace settings you created.



66

Working with Settings

You can view and modify most of your current settings by double-
clicking them in the Project window and selecting new options. You 
can duplicate, rename, copy, and move settings among Þles or sys-
tems.

Selecting Another User

Because User settings are not project or site speciÞc, you can display 
another set of user settings within the Project window.

To select another user, choose another name from the User pop-up 
menu.

Settings menu

Fast Menu button
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The previous userÕs settings are saved, and the new userÕs settings are 
loaded into the Avid Composer system and the Project window.

Modifying Settings

You can alter the default options for various settings to reßect the spe-
ciÞc needs of a project or to customize the system based on personal 
preferences.

There are three types of settings you cannot modify. These are:

¥ Settings that require the presence of standalone peripherals, such 
as the Avid Media Reader

¥ Settings that can be modiÞed only from within the tools in which 
they are used, such as Bin and Timeline views

¥ Film settings when working in nonÞlm projects

To modify available settings:

1. Double-click the name of a chosen setting in the Settings scroll list.

User pop-up menu
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A dialog box or window opens. 

2. Enter new values or select new options for the settings.

3. Click OK, Save, Cancel, or the close box when done.

The system saves changes in the appropriate User, Project, or Site 
settings Þle.

Working with Multiple Settings

You can have multiple versions of settings in your Project window that 
apply to several users at various stages of production. For example, 
you can have:

¥ Two bin settings: one that automatically saves more often when 
you are editing intensively, and one that automatically saves less 
often when you are doing organizational work in the bins

¥ Multiple Digitize settings for digitizing various types of source 
material

Double-click in these columns to open a 
settings dialog box.
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¥ Multiple Keyboard and Composer settings to use for various 
activities such as digitizing, ofßine editing, Þlm editing, or online 
effects editing

¥ Multiple Deck settings for various types of digitizing or for output

Duplicating Settings

To create a new version of a setting:

1. Click the Settings button in the Project window to display a list of 
your current settings.

2. Click the setting you want to copy. Shift-click any additional set-
tings you want to copy.

3. Choose Duplicate from the Edit menu. 

A copy of each setting appears in the window, with each setting 
name followed by a period and a version number. Rename your 
settings to indicate their functions.

Renaming Settings

You can rename settings to differentiate among more than two copies 
or to indicate a speciÞc use.

To rename settings:

1. Click the settingÕs name in the Settings scroll list. 

2. Type a new name and press Return. 

The new name appears in the list and is saved in the settings Þle.

Setting name
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Selecting Among Multiple Settings 

With multiple settings, only one setting at a time is active. Settings that 
are currently active have a checkmark to the left of the setting name. 

To change the active setting, click in the space to the left of the setting 
you want to select as the active setting.

A checkmark indicates that it is now active.

Deleting Settings

You can delete settings from the Settings list in the Project window at 
any time. For example, you might choose to delete one or more among 
multiple versions of a particular setting. Or you might want to delete 
all but a few settings to transfer into another settings window. 

To delete a setting:

1. Click a setting to highlight it. Shift-click each additional setting 
you want to delete.

2. Press the Delete key or choose Delete from the Edit menu.

The selected settings are immediately removed.

c You cannot undo the deletion. You can, however, restore the default 
settings, or you can transfer settings from other Þles, as described in 
the following sections.

Restoring Default Settings

You can restore your settings to the default values at any time by 
doing the following:

1. Click a setting to highlight it. Shift-click each additional setting 
you want to select.

2. Choose Restore to Default from the Special menu.

An alert box asks whether you want to save the settings.
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3. Click Copy & Restore to copy the current settings before restoring 
the default settings, or click Cancel to discard the current settings.

The system restores the default values for the selected settings.

Copying Settings Between Settings Files

You can copy selected settings between existing settings Þles or into a 
new settings Þle for use in other projects, for transfer to other Avid 
Composer systems, to change one type of setting to another, or into the 
Site Settings folder to establish standard system settings for all new 
projects and users.

To copy settings between Þles:

1. With Settings display active, open the target settings Þle in one of 
the following ways:

¥ Create and open a new settings Þle by choosing New Setting 
File from the File menu.

An untitled settings window appears.

¥ Open an existing settings Þle by choosing Open Setting File 
from the File menu.
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A dialog box appears.

Locate and select a settings Þle in the Composer Projects or 
Avid Users folder and click Open. The settings Þle window 
opens.

¥ Choose Site Settings from the Special menu. 

The Site Settings window opens.

2. Click the setting you want to copy in the settings window scroll 
list of the current project. Shift-click any additional settings that 
you want to copy.

3. Drag the highlighted settings to the new settings window.
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When you copy settings back into the settings window scroll list, a 
dialog box appears.

4. Click Add to add the new settings to the project without affecting 
the projectÕs current settings. Or click Replace to replace the cur-
rent version of each setting with the new settings. Additional ver-
sions of each setting are not affected. 

The copied settings are saved when you close or save the Þle or 
project.

To copy, drag settings 
between windows.

Settings Scroll List New Settings Window
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Moving Settings Between Systems

You can automatically transfer settings to another Avid Composer sys-
tem without having to re-create them. You do this by copying your 
User folder, Project settings Þle, or Site settings Þle and moving it to 
the new location.

To move settings between systems:

1. Insert a diskette into the computerÕs diskette drive.

2. From your desktop, open the appropriate folder (Avid Users 
folder, a speciÞc project folder, or the Settings folder) on your Avid 
hard drive.

3. Drag the settings Þle or User folder to the diskette icon.

The Macintosh copies the Þle or folder to diskette.

4. Eject the diskette and bring it to another Avid Composer system.

5. Insert the diskette into the new Avid Composer system.

6. Double-click the diskette icon to open it.

7. Double-click the Avid hard disk icon and open the appropriate 
folder (Avid Users, a chosen project folder, or the Settings folder).

8. Drag your settings Þle or User folder to the folder on the Avid 
drive.

The next time you open a project at the new location, your settings will 
be available as follows:

¥ User settings folder. Your name appears in the list of editors.

¥ Project settings Þle. Your project settings are active in the chosen 
project.

¥ Site settings Þle. Your site settings are active for all projects at the 
new location.

When you choose your name and a project, your customized settings 
are loaded into the new system.
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Using Site Settings

When the system opens a new project, it Þrst searches the Site settings 
Þle (located in the Media Composer folder) and loads any settings 
placed here. The system then proceeds to load any Project and User 
settings not included in the Site settings.

This feature is useful if you need to establish global settings for all new 
users and projects, such as switcher settings, a speciÞc start timecode 
for all sequences, or various customized features of the interface.

To load settings into the site settings folder:

1. Open a project with the settings you would like to establish as site 
settings. If a project does not already exist with the desired set-
tings, create one and make adjustments to the default settings as 
needed.

2. Choose Site Settings from the Special menu.

The Site Settings window opens.

3. Click a setting in the Project window or Shift-select multiple set-
tings and drag them into the Site Settings window.

Copies appear in the Site Settings scroll list.

4. Close the Site Settings window. 

All new users and projects opened from the Project Selection dialog 
box use these settings as the default settings.
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Using the Info Display

The Info display in the Project window allows you to view basic 
project information, such as the video format (NTSC, for example) or 
frame rate (24 fps for Þlm projects).

To activate Info display, click the Info button in the Project window.

The items listed in this view are for information only and cannot be 
changed from the Info list.

The Fast Menu button at the bottom of the Info window displays four 
menu items: ProÞle, Memory, Usage, and Hardware.

Displaying a Project Profile

ProÞle displays basic project information, such as the video format 
(NTSC or PAL) or frame rate (24 fps for Þlm projects).

To display the ProÞle information:

1. Click the Info button in the Project window.

Info button

Fast Menu button
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2. Choose ProÞle from the Fast menu.

Basic project information is displayed.

Displaying Usage Information

The Avid Composer system includes a statistics feature that gathers 
and reports information on system usage. You can use this information 
to support business functions such as resource management. 

All statistics are gathered and reported by project. The Þle that con-
tains this information is formatted so that you can use it as input to 
software programs such as analysis applications, spreadsheets, or 
report generators. 

c Do not rely on the statistics feature for billing or other Þnancial pur-
poses. 

To view statistics for an open project:

1. Click Info in the Project window. 

2. Choose Usage from the Fast menu.

You see a display similar to the following:
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3. Click the Info button again to update the Usage window to reßect 
any changes you made to the project.

To print this Þle, choose Print from the File menu.

A new Þle is created each time you open the project. The Þles are 
stored in a Statistics folder inside each project folder. 

The Þle name has the following format:

Statistics. yymmdd.HHMMSS

where:

yy indicates the last two digits of the year
mm indicates the month
dd indicates the date
HHindicates the hour
MMindicates the minute
SSindicates the seconds

Fast Menu
button
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File Structure and Layout

The statistics Þle is formatted as comma-separated ASCII text, so it can 
be accepted by a variety of software programs. Each line in the Þle is 
tagged with indicators for identifying content and data type to assist 
in programming custom applications. Figure 3-1 shows a sample data 
Þle.
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Figure 3-1 Sample Data File

Description of Data File Values

The values in the Þrst column indicate the content of the line. Values 
are:

01,01,Project Name: april5,,,Statistics as of: 
Fri Apr 05 11:39:37 1997

02,01,Project created: Fri Apr 05 07:44:40 
1997,,,Last Session Started: Fri Apr 05 11:36:22 
1997

117,04, 

03,04, 

03,04,Elapsed Time:,---,Total,---,---,Last 
Session,---

03,04, 
,Hours,Minutes,Seconds,Hours,Minutes,Seconds

101,02,Time Project Open ,1,10,04,0,00,00

03,04, 

102,02,Digitize Tool open ,0,45,08,0,00,00

104,02,Digitize Tool active ,0,14,16,0,00,00

116,02,Digitize Tool logging ,0,00,00,0,00,00

115,02,Digitize Tool digitizing ,0,25,04,0,00,00

03,04, 

111,02,Title Tool open ,0,00,00,0,00,00

113,02,Title Tool active ,0,00,00,0,00,00

114,02,Title Tool rendering ,0,00,00,0,00,00

03,04, 

110,02,Effects rendering ,0,00,00,0,00,00

03,04, 
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01title1
02title2
03heading
100project info
101Time Project open
102Digitize Tool open
104Digitize Tool active
105Digitized Media bytes used
106Rendered Effects bytes used
110Effects rendering time 
111Title Tool open
113Title Tool active
114Title Tool rendering
115Digitize Tool digitizing
116Digitize Tool logging
117user comments

The value in the second column indicates the type of data in the line. 
Values are:

01project info
02time used
03bytes used
04text string

Importing the Statistics File into a Spreadsheet

You can import the statistics Þle into spreadsheet or other programs as 
an ASCII Þle and use the application to set up the proper format. For 
example, to create a statistics Þle in Microsoft¨ Excelª on a Macin-
tosh:

1. From the Finder, locate the statistics Þle you want to copy.

2. Start Excel.
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3. Open the Þle by choosing Open from the File menu and navigat-
ing to the directory the Þle is in.

After you open the Þle, the Text Import Wizard starts.

To complete the steps for the Text Import Wizard:

1. Choose Delimited for the Original Data Type and click Next.

2. Choose Comma for Delimiters and click Next.

3. Choose General for Column Data Format.

4. Click Finish.

The statistics Þle appears in spreadsheet format.

Spreadsheet Form of Statistics Data File

Figure 3-2 is the same sample Þle as it appears when you import into a 
spreadsheet.
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Figure 3-2 Sample Spreadsheet Form

About Projects and Memory

The way in which a project uses memory has a direct effect on perfor-
mance. As a project develops, the number of media Þles in use (clips, 
effects, and other bin items) increases. Because the system keeps track 
of them in RAM, they can be played back faster, but the memory 
requirements can slow down the system in other ways.

The Avid Media Composer and Film Composer Release Notes provide 
information about system requirements for RAM. Occasionally you 
might need to adjust the way your Macintosh uses its RAM in order to 
work efÞciently. There are two factors that can affect the performance 
of your system:
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¥ If you opened and quit several applications during a session, or if 
you opened and closed various Avid Composer tools repeatedly, 
your computerÕs memory might become fragmented. As a result, 
your system might be sluggish. To solve this problem, close all 
applications and restart your Macintosh.

¥ If you need to open more or larger Þles within the Avid Composer 
system, you might want to increase the amount of memory allo-
cated to the application from the desktop.

n To check and adjust the allocation of system memory (RAM), see your 
Macintosh documentation.

Viewing Memory

To display system memory information:

1. Click the Info button in the Project window.

2. Choose Memory from the Fast menu.

The Memory window opens.

The window displays the total number of objects (all clips, sequences, 
and other objects associated with a bin) in use for a particular project, 
the total free memory, and the total memory available.

If the memory in use is already near the limit of the total memory, you 
might want to consolidate Þnished elements and eliminate old mate-
rial from the project, or break the project up into separate, segmented 
projects. For more information on consolidating, see ÒConsolidating 
MediaÓ on page 276.
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Accessing the Hardware Tool from the Info Window

You can display the Hardware Tool by choosing Hardware from the 
Tools menu. You can also choose it from the Fast menu in the Info win-
dow.

To activate the Hardware Tool:

1. Click the Info button in the Project window.

2. Choose Hardware from the Fast menu.

The Hardware Tool appears.

Customizing Your Workspace

A workspace is the arrangement and size of windows displayed on 
your Avid Composer system. If you are accustomed to working with a 
particular group of windows arranged and sized in a particular setup, 
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you can assign a workspace setting to remember that arrangement. 
For example, during digitizing you might want to have the Digitize 
Tool and Video Input Tool open. During editing, you want to have the 
Effect Palette, Effect Editor and the Keyboard window open and 
arranged in a particular order and size. You can have as many work-
space settings as you want.

Eight buttons allow you to switch between user-customized work-
spaces. The buttons are assigned to the workspaces in the Settings 
window in the order that they appear. For example, W1 button is 
assigned to the Þrst workspace that appears in the Settings window. 
W2 is assigned to the second workspace that appears in the Settings 
window.

Assigning a Workspace

To assign a workspace:

1. Click Settings in the Project window.

The Settings window opens.

2. Scroll to the bottom of the Settings list and select Workspace.

Workspace is highlighted.

3. Press kÐD to duplicate the workspace.

Workspace appears twice.

4. Click a workspace you want to use. (Click to the left of the word 
ÒWorkspace.Ó)

A checkmark appears next to the workspace.

5. In the second column (to the right of ÒWorkspaceÓ), move the cur-
sor until the pointing hand becomes a text cursor.

6. Type a new workspace name; for example, digitizing.
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7. Open the windows that you want to associate with the workspace. 
Resize and position the windows the way you want them in the 
workspace.

The windows and placements are assigned to the new workspace. 

Deleting a Workspace

To delete a workspace:

1. Select the workspace you want to delete from the Project Settings 
list.

The selection is highlighted.

2. Press the Delete key.

The selection is removed from the Settings list.

n You cannot delete the active workspace.
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Assigning a Workspace Button

To assign a workspace button:

1. Choose Command Palette from the Tools menu.

2. Click the More tab.

3. Select the Button to Button Reassignment box.

4. Click and drag the W1 (or W2ÐW8) button to a location on another 
palette (for example, under the Source/Record monitors or a user 
tear-off palette).

The W1 button appears in the new location.

5. Press the W1 button to display the Þrst assigned workspace.

Button-to-Button Reassignment

W1 button More tab
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CHAPTER 4

Using Basic Tools

The Tools menu on the Media Composer menu bar provides quick 
access to a collection of essential tools for use in your projects. This 
chapter provides information about several basic tools that you can 
use at any time during your project.

¥ Using the Tools Menu

¥ Using the Deck Controller

¥ Using the Command Palette

¥ Using the Avid Calculator

¥ Using the Console

¥ Using the Hardware Tool

¥ Using the Serial Ports Tool

Using the Tools Menu

You can open any of the most frequently used system tools from the 
Tools menu located on the Bin monitor menu bar.

To open a tool, choose its name from the Tools menu.
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The Tools menu also allows you to activate or open windows that have 
been closed or are covered by other windows. These include any open 
tools, plus the Composer, Timeline, and Project windows.

The following sections describe several basic tools that you can use at 
any time during a project. For a brief description of all the tools listed 
in the Tools menu, see the Avid Media Composer and Film Composer 
Quick Reference.

Using the Deck Controller

The Deck Controller provides direct serial or VLXi¨ (V-LAN¨) control 
of an Avid-compatible tape deck at any time during editing. This 
allows you to cue and screen footage from source tapes in various edit 
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modes or when recording a digital cut, without entering Capture 
mode.

To open a Deck Controller, choose New Deck Controller from the Tools 
menu.

The Avid Deck Manager program is initialized, and a new Deck Con-
troller window opens.

For information on 
compatible decks and 
cabling, see the Avid 
Media Composer Products 
Connecting Audio and 
Video Equipment man-
ual.

Each Deck Controller includes the following elements:

¥ The Status indicator provides information about the control status 
of the tape deck, as follows:

- If the deck is properly connected and power is on, the Deck 
Controller displays timecode when a tape is mounted.

- If a deck is not properly connected to the system or power is 
off when you open the Controller, the indicator displays the 
message ÒNo Driver.Ó

- If you turn the deck power off with the Deck Controller 
already open, the indicator displays the message ÒPower Off.Ó

- If you switch the deck control to Local on the VTR, the indica-
tor displays the message ÒLocal.Ó

¥ The Timecode indicator ßashes green during playback or digitiz-
ing to indicate that the system is receiving valid timecode from the 
source tape. If the indicator remains unlit, the system is not receiv-
ing timecode.

Timecode indicator

Status indicator

Controls

Deck Selection pop-up menu

New Tape button
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¥ The deck controls provide a standard range of playback capabili-
ties, including fast forward and rewind, stop and play, step back 
and step forward, pause, and eject.

¥ The Deck Selection pop-up menu allows you to specify a deck 
with deck control parameters that you can customize in the Deck 
ConÞguration dialog box. For more information, see ÒDeck Con-
Þguration SettingsÓ on page 135.

¥ The Deck Controller allows you to associate a tape name with the 
controller by clicking the New Tape button and selecting a tape in 
the Tape Selection dialog box. For more information, see ÒLogging 
with an Avid-Controlled DeckÓ on page 121.

You can also click the size box in the Deck Controller window to open 
a window of controls for logging IN and OUT marks while cueing 
your tape.

For more information 
on logging with the 
Digitize Tool, see ÒDigi-
tizing and Logging at 
the Same TimeÓ on 
page 190.

Marks you set with the Deck Controller are temporary, and allow you 
to return to timecode locations entered in the window while screening 
and cueing a tape. If the Digitize Tool is open, however, timecodes 
logged here also appear in the Digitize Tool, and can be entered into an 
open bin.

Zoom box

Timecode display

Mark IN button

Mark OUT button

Go To Mark
button 

Erase Mark
button
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Using the Command Palette

The Command Palette provides a central location for all user-selectable 
buttons (USBs) that you can map to various locations for ease of use. 
User-selectable buttons allow you to perform a wide range of com-
mands with a single click of the mouse. You can map buttons to any 
command palette in a pop-up, Source, or Record monitor and to recon-
Þgure the keyboard, AvidDroid buttons, or the Manual User Interface 
(MUI) keys. You can also map menu commands to various buttons 
and keys.

The Command Palette groups buttons by editing function. Tabs are 
displayed for each function and the buttons that perform those func-
tions are displayed within each tab. The functions are: Move, Play, 
Edit, Trim, FX, 3D, MCam, Other, and More.

n Functions can also be performed directly from the Command Palette by dese-
lecting the reassignment boxes at the bottom of the palette.

Figure 4-1 and Figure 4-2 show the Command Palette tabs.
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Figure 4-1 Command Palette Tabs 1-5

Move buttons

Play buttons

Edit buttons

Trim buttons

Effect buttons
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Figure 4-2 Command Palette Tabs 6-8

Using the Blank Button

The Blank button allows you to replace a deÞned button with an unde-
Þned button. If you donÕt need or use a speciÞc button within the 
Source/Record monitor, a pop-up monitor, or a user command palette, 
you can replace these buttons with a blank button.

3D Effects buttons

Multicamera buttons

Miscellaneous buttons

Workspace buttons
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To map the blank button to a new location, see ÒMapping User-Select-
able ButtonsÓ on page 97. For information on button mapping, see 
ÒAbout Button MappingÓ on page 96.

About Button Mapping

You can also map USBs 
and menu commands to 
the Manual User Inter-
face (MUI). For more 
information, see Chap-
ter 6.

Mapping of user-selectable buttons allows you to reconÞgure com-
mand palettes or the keyboard in various combinations to suit various 
editing needs. The following are a few examples:

¥ Subcataloguing clips: You can map the Make Subclip button and 
other clip-management-oriented buttons.

¥ Complex layering and effects editing: You can map buttons such 
as Motion Effect, Remove Effect, Render Effect, Transition Corner 
Display, Fade Effect, Add Dissolve, Grid (which displays Safe Title 
overlays), and Cycle/Picture Sound.

¥ Film projects: You can map buttons and commands such as the 
Slip Left One Perf and Slip Right One Perf buttons, and the Auto-
Sync and Cut List menu commands.
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¥ Multicamera editing: You can map the MultiCamera Mode menu 
command, the Quad Split and Gang buttons.

For more information 
on multiple settings, see 
ÒWorking with Multi-
ple SettingsÓ on 
page 68.

When you remap buttons or commands, the system immediately 
saves your new conÞguration in one of the default settings that you 
can open from the Project window. You can also save, rename and 
recall multiple versions of any of these settings to serve various pur-
poses. Media Composer saves button conÞgurations as follows:

¥ Changes to the keyboard, the Steenbeck controller, or the MUI 
controller are saved with their respective settings.

¥ Changes to the pop-up monitor command palettes, monitor com-
mand palettes, and user tear-off palettes in the Composer window 
are saved with the Composer settings.

¥ Changes to command palettes in Trim mode are saved with Trim 
settings.

Mapping User-Selectable Buttons

To remap buttons or keys on the keyboard, using the Command Pal-
ette:

1. Open a window that has a user-selectable button palette by doing 
one of the following:

¥ Activate the Source or Record monitor in the Composer win-
dow.

¥ Click and drag one of the user command palettes to tear off a 
menu.

¥ Open a clip in a pop-up monitor.

¥ Enter Trim mode in the Composer window.
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¥ Open the Keyboard or MUI or Steenbeck palette from the 
Project Settings scroll list.

2. Choose Command Palette from the Tools menu.

The Command Palette appears.

3. Select the Button to Button Reassignment box.

4. Select the tab from which you want to choose a user-selectable 
button.

5. Click and drag the button from the Command Palette to a location 
on the other palette.

n If you want to perform a command function from the Command Palette, for 
example, click the Play button in the Command Palette to play the material in 
the Source window. You must have both the Button to Button and Menu to 
Button Reassignment boxes deselected. Then activate the Source window and 
click Play in the Command Palette.

Mapping Menu Commands

You can map menu commands displayed in the pull-down menus on 
the Bin monitor directly onto buttons in any of the command palettes 
or onto the keyboard. This is especially useful if you make much use of 

Click a tab.

Click the Button to Button Reassignment box.
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the keyboard or command palettes during editing. In some phases, 
you can avoid using the menus altogether.

To map menu commands:

1. Open a window that has user-selectable buttons by doing one of 
the following:

¥ Activate the Source or Record monitor in the Composer win-
dow.

¥ Tear off the user command menu that contains the item you 
want by clicking and dragging it.

¥ Open a clip in a pop-up monitor.

¥ Enter Trim mode in the Composer window.

¥ Open the Keyboard or MUI or Steenbeck palette from the 
Project Settings scroll list.

2. Choose Command Palette from the Tools menu.

The Command Palette appears.

3. Select the Menu to Button Reassignment box.

Click the Menu to Button Reassignment box.
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4. Press a target button on the keyboard or palette (for example, the 
palette under the Source or Record monitor).

The pointer changes to a small white menu.

5. Choose the menu command you want to map to the target button.

The initials for the menu command appear on the target button.

Using the Avid Calculator

The Avid Calculator helps you calculate video and Þlm durations and 
convert timecode and Þlm key numbers to different formats. For 
example, you can: 

¥ Convert drop-frame to non-drop-frame timecode values

¥ Convert timecode durations between 30-fps and 25-fps projects

¥ Convert a duration in video to the corresponding length in footage 
and frames for measuring 35mm Þlm

To use the Avid Calculator:

1. Choose Calculator from the Tools menu to open the Avid Calcula-
tor window.

Menu command mapped
to button
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2. Choose a format from the format pop-up menu.

3. Make calculations in the selected format. Click numbers and func-
tions in the Avid Calculator, or enter numbers and functions with 
the numeric keypad or the top row of numbers on the keyboard.

You donÕt need to enter leading zeroes, colons, or semicolons for 
timecode.

4. To convert your totals at any time to another format, choose a dif-
ferent frame code or key number format from the pop-up menu.

Using the Console

The Console window provides a number of features, including:

¥ Current system information, including your system ID number

¥ A log of error messages

¥ Detailed information about sequence segments in the Timeline or 
about objects in a bin

¥ Information after you digitize or import

Format pop-up menu



102

c Do not use the programming features of the Console without guid-
ance from Avid professionals. Contact Avid Customer Support with 
speciÞc questions.

Displaying System Information

To display current system information:

1. Choose Console from the Tools menu to open the Console win-
dow.

2. Scroll to the top of the Console window to view your system infor-
mation and ID. 

This feature is especially useful for Þnding the system ID when 
contacting Avid Customer Support.

Reviewing a Log of Errors

To review errors logged to the console:

1. When an error occurs, exit the alert box and choose Console from 
the Tools menu.

2. Scroll through the Console window to Þnd a log of the error to use 
when contacting Avid Customer Support.
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Getting Information with the Console

This function provides quick access to bin information such as total 
duration of selected clips, or total items in a bin including hidden 
items. You can also use this procedure to display information about a 
shot, segment, or sequence in the Timeline.

To get information with the Console window:

1. Choose Console from the Tools menu, or press kÐ6.

2. Select the item about which you want information:

¥ In the Timeline, place the position indicator in the chosen shot 
or segment. 

¥ In the bin, select an object or Shift-select multiple objects.

3. Choose Get Bin Info from the File menu, or press kÐI.

Information about the shot appears in the Console window.

Using the Hardware Tool

The Hardware Tool provides information about the systemÕs hardware 
conÞguration.
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To check the conÞguration of your system, choose Hardware from the 
Tools menu to display the Hardware Tool.

¥ Each online disk is listed on the right side of the tool. The shaded 
portion of the bar graph next to each disk shows the amount of 
storage space currently Þlled.

¥ At the center of the window is a display box for each board slot in 
the computer. The names of the currently installed boards appear 
in the display boxes. 

¥ To the left of the display boxes, two speakers identify audio boards 
and two monitors identify video boards.

¥ The name of the central processing unit (CPU) appears in a gray 
area beneath the list of boards. Any internal card, such as an inter-
nal 8-bit video board, is also listed in the same location.

Board slots

Monitors indicate 
video cards

Speakers indicate
audio cards

Online disks
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Using the Serial Ports Tool

The Serial Ports Tool allows you to view the current conÞguration of 
the Macintosh serial interface at any time during editing. You can also 
use it to reconÞgure the ports without closing the Media Composer 
application or shutting down the computer.

n Although you can use the Serial Ports Tool to reassign ports, you still need to 
reconnect the appropriate cables to the newly assigned ports.

 To access the Serial Ports tool:

1. Choose Serial Ports from the Tools menu.

The Serial Ports Tool appears.

2. Assign ports for deck control, the Avid Controller, the Steenbeck, 
the Manual User Interface (MUI), VTR emulation, or the 
Media Reader as necessary by choosing Modem port, Printer port, 
or no port from any of the pop-up menus.

n The Deck Control pop-up menu appears only if you have already selected a 
deck from the Deck ConÞguration window. The Audio Faders pop-up menu 
appears only if you choose the Automation Gain Tool from the Tools menu.
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Specifying the AvidDroid Controller

To specify the AvidDroid controller and its port:

1. Choose Serial Ports from the Tools menu.

The Serial Ports Tool appears.

2. Choose Avid Controller from the Controller type pop-up menu.

3. From the Avid Controller pop-up menu, choose the port to which 
you connected the AvidDroid cable. See the AvidDroid Setup and 
UserÕs Guide for more information about connecting cables.

4. Close the Serial Ports Tool.

5. Continue setting up the AvidDroid as described in the AvidDroid 
Setup and UserÕs Guide.

Specifying the Steenbeck Controller

To specify the Steenbeck controller and its port:

1. Choose Serial Ports from the Tools menu.

The Serial Ports Tool appears.

Choose Avid Controller
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2. Choose Steenbeck from the Controller type pop-up menu.

3. Check the back of your Avid system to see which port the Steen-
beck cable is plugged into.

4. From the Steenbeck pop-up menu, choose the port to which you 
connected the Steenbeck cable.

5. Close the Serial Ports Tool.

Specifying the MUI Controller

To specify the MUI controller:

1. Choose Serial Ports from the Tools menu.

The Serial Ports Tool appears.

Choose Steenbeck
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2. Choose MUI from the Controller type pop-up menu.

3. You donÕt need to specify a port for the MUI.

4. Close the Serial Ports Tool.

Choose MUI
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CHAPTER 5

Logging

When you log with a deck or import shot log Þles, you provide the 
Avid Composer system with frame-accurate clip information used to 
digitize the source footage. The logs you create form the foundation 
for organizing, tracking, storing, retrieving, and generating lists of edit 
information throughout your project. Techniques for preparing log 
information prior to digitizing are covered in the following sections:

¥ Logging Tips

¥ Preparing Logs for Import

¥ Importing Shot Log Files

¥ Logging Directly into a Bin

¥ Modifying Clip Information

¥ Exporting Shot Log Files

Logging Tips

Observe the following important guidelines for preroll, timecode for-
mats, and naming of tapes when logging prior to digitizing.
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Logging Preroll

Be sure to leave adequate preroll with continuous timecode prior to IN 
points when logging your tapes. The recommended minimum preroll 
is 1 second for Betacam playback, and 5 seconds for 3/4-inch U-matic 
playback.

n You set the default preroll for tape playback by using Deck Settings. For more 
information, see the Avid Media Composer Products Reference.

Logging Timecode

Within an NTSC project, check the timecode format of each tape (drop-
frame versus non-drop-frame timecode) when you are logging with-
out a tape in the deck. Log drop-frame timecode by using semicolons 
(;) between the hours, minutes, seconds, and frames. Log non-drop-
frame timecode with colons (:). 

n To change the logged timecode format, use the Modify command from the clip 
menu.   For information, see ÒModifying Clip InformationÓ on page 126.

Naming Tapes

When entering tape names in the Digitize Tool, consider the following:

¥ Tape names must be alphanumeric characters (A to Z, 0 to 9), with 
no spaces before the name. They can include uppercase and lower-
case characters. The maximum length of a name is 32 characters. 

¥ It is possible to have a single tape listed as several different tapes if 
you alter the case of the letters. For example, if you type a single 
name as TAPE, Tape, and tape on three different occasions, all three 
names will appear. This can cause signiÞcant problems in keeping 
track of clips when batch digitizing, redigitizing, and generating 
an EDL. Choose a case convention and maintain it throughout a 
project.
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n If you want your Avid Composer system to consider master clips as coming 
from the exact same tape, you should try to choose that tape name from the 
Select Tape dialog box. If you do not see the tape you are looking for, but know 
you have online media from that tape, you should click the Scan for Tapes but-
ton. For more information, see ÒLogging with an Avid-Controlled DeckÓ 
on page 121.

¥ It is important that you devise a naming scheme for your tapes. 
For example, tapes with similar names can be easily sorted and 
viewed together in a bin. However, it can be difÞcult to distin-
guish among numerous tapes with similar names when trying to 
locate a speciÞc tape quickly. Name tapes based upon the amount 
and complexity of your source material.

¥ If you are planning to generate an EDL for import into an edit con-
troller for online editing, double-check the controllerÕs speciÞca-
tions beforehand. Some edit controllers will truncate source tape 
names to as few as six characters, while others will eliminate char-
acters and truncate to three numbers. Alterations like these at the 
EDL stage might cause the system to identify different source 
tapes with similar names in the same way, causing you to lose 
track of source material.

Double-Checking the Logs

When importing shot logs for video, the Avid Composer system com-
pares the video duration to the video out minus the video in. When 
importing Þlm shot logs, the system compares the key number out 
minus the key number in.

If the system detects a discrepancy, it reports the error to the console 
and does not bring the clip into the bin. For more information on using 
the console, see ÒUsing the ConsoleÓ on page 101. The best way to 
ensure that clips are not discarded on import is to double-check the 
logs for discrepancies in duration and marks.
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Preparing Logs for Import

Your Avid Composer system provides many useful tools to help you 
prepare frame-accurate log information for import into the bin from 
any number of sources. This process can involve one or more of the 
following methods, which are described in this section:

¥ To log the material on any Macintosh or PC, use the MediaLog 
application, and transfer the bins directly into the Avid Composer 
system with minimum effort, as described in ÒUsing MediaLogÓ 
on page 112.

¥ To quickly convert logs (created by other sources), use the Avid 
Log Exchange program, as described in ÒConverting Logs with 
Avid Log ExchangeÓ on page 114.

¥ Use a word processor or standard text editor to create and import 
logs, as described in ÒCreating Avid LogsÓ on page 117.

Using MediaLog 

For information on spe-
ciÞc MediaLog proce-
dures, see the Avid 
MediaLog for Macintosh 
UserÕs Guide or the Avid 
MediaLog for PC UserÕs 
Guide.

MediaLog is a standalone application that speeds the process of creat-
ing and importing log information from any Macintosh or IBM¨-com-
patible computer. MediaLog mirrors the Avid Composer interface for 
creating projects, bins, and clip information in the bin, and includes 
serial deck control for logging directly from tape.

n If you purchased Film Composer or Media Composer 1000, 4000, or 8000, the 
MediaLog application is included with your application disks. If you have the 
Media Composer 900 or Ofßine models and would like to purchase MediaLog, 
contact your Avid sales representative for more information.
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Transferring Bins from MediaLog for Macintosh

If you log your source footage by using MediaLog for Macintosh, you 
can transfer the bins directly to the Avid Composer system for batch 
digitizing by moving the bin Þles in the Finder.

To transfer bins from MediaLog for Macintosh:

1. Save the MediaLog bins to a 3.5-inch diskette.

2. Quit the Media Composer application.

3. In the Finder, open the project folder where you want to store the 
MediaLog bins. This folder is usually located inside the Composer 
Projects folder on the Avid drive.

4. Insert the disk from MediaLog into the diskette drive.

5. Double-click the diskette icon.

If your MediaLog folders are available through a server or other 
networked source mounted on your desktop, then locate the 
MediaLog folder there instead.

6. Shift-select the bins in the Disk Directory window and drag them 
into the project folder.

7. Restart the application and open your project.

8. Associate the imported bins with your project by doing the follow-
ing:

a. Choose Open Bin from the File menu.

b. Locate the new bin by using the Directory pop-up menu.

c. Double-click the bin to open it within your project. 

d. The new bin appears in the Bins scroll list in the Project win-
dow.

The bins you have imported contain master clips only with no associ-
ated media Þles. Before you can view or manipulate these clips, you 
must create the associated media Þles by batch digitizing the source 
material.
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Transferring Bins from MediaLog on the PC

If you log your source footage by using MediaLog on the PC, you can 
import the logs by using the same procedure as you would for other 
Avid-compatible log formats, as described in ÒImporting Shot Log 
FilesÓ on page 118.

c To work with PC Þles such as MediaLog on the PC, you must have 
the Macintosh 7.5 or later operating system or the DOS Mounter 
application on your system.

Converting Logs with Avid Log Exchange

You can use the Avid Log Exchange program included with your sys-
tem to quickly convert shot logs that are created by other sources. You 
can then import the Þles directly into bins, as described in ÒImporting 
Shot Log FilesÓ on page 118. 

To convert a Þle:

1. In the Finder, open the Utilities folder on the Avid drive and locate 
the Avid Log Exchange application inside the folder labeled ALE f.

2. Double-click the Avid Log Exchange icon to start the application.

The Avid Log Exchange window opens.
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For speciÞc informa-
tion on the various Þle 
types shown here, see 
the Avid Media Composer 
Products Reference. 

3. Make a selection for Input and Output. 

The default output selection is the Avid Log Exchange (.ALE) for-
mat. This is the required format for import into an Avid Composer 
bin.

4. Select the tracks to include in the Tracks column of the log. After 
you import the log into an Avid Composer bin, the system digi-
tizes all tracks shown in this column when batch digitizing.

5. Select the Clean option if you want Avid Log Exchange to clean 
the input Þle to eliminate overlapping timecodes for clips.

When you select the Clean option, the utility removes the end 
timecode from any clip that overlaps the start of the next clip.

6. Click the Convert button to open the Þle selection dialog box.

7. Open the disk and folder that contain the Þles you want to con-
vert.

Files you 
can gener-
ate 

Files you 
can convert

Clean 

Convert button Quit button

option

Track
selection
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8. Double-click the input Þle name. Only one Þle is converted at a 
time.

Avid Log Exchange stores the converted Þle in the same folder as 
the original input Þle.

The original Þle name extension is replaced by the extension for the 
new format. The .ALE Þles can be imported only into Avid products.

Drag and Drop Conversion

Use this shortcut to convert any type of Þle into an .ALE Þle:

1. Insert the disk in the Macintosh disk drive if the Þles you want to 
convert are stored on a 3.5-inch diskette.

2. Open the folder that contains the Avid Log Exchange utility icon.

3. Open the folder that contains the Þles you want to convert, posi-
tioning the folder so the Avid Log Exchange icon is visible.

4. Select Þles for conversion.

Location of the 
files

File to be 
converted

Input file Converted file
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5. Drag the selected Þles to the Avid Log Exchange icon and release.

The system converts the Þles to Avid format, adding the .ALE 
extension to the new Þle names.

Creating Avid Logs

You can prepare an Avid log on any type of Macintosh or IBM-compat-
ible computer by using a word processing application or a text editor. 
In either case, to ensure accuracy, you must follow closely the speciÞ-
cations described in the Avid Media Composer Products Reference.

When logging manually, you should document the following informa-
tion:

¥ Identify the source tape for each shot.

¥ Document each clipÕs name, start timecode, and end timecode.

This is the minimum information required to digitize successfully. You 
can also add other information such as comments, auxiliary time-
codes, or key numbers for Þlm projects. You can make a separate log 
Þle for each videotape, or log clips from several different videotapes in 
one log.

Using a Word Processor

If you use a rich-text formatted program like Microsoft Word or 
WordPerfect¨, you must do the following:

Select files, drag to the 
icon, and release.
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1. Enter shot log information according to the speciÞcations 
described in the Avid Media Composer Products Reference.

2. Save your Þle as an ASCII text Þle in the Save As dialog box.

c The Avid Composer system only accepts text Þles (ASCII format).

Using Vantage

Another alternative is to use a text editor, such as the Vantageª pro-
gram provided with your system. Text editors like Vantage always 
maintain the log information in text Þle (ASCII) format. Vantage also 
provides useful tools for arranging and conforming text to various 
shot log, cut list, and EDL (edit decision list) speciÞcations. The Van-
tage program is located in the Utilities folder. 

Importing Shot Log Files

You can also import an 
EDL to a bin for use in 
digitizing. For more 
information, see 
ÒUsing EDL ManagerÓ 
on page 624.

You can import any log created or converted to meet Avid log speciÞ-
cations. You can also combine or merge events while importing a log 
so that fewer master tapes require digitizing, as described in this sec-
tion.

To import shot log Þles into a bin:

1. Open a bin, click anywhere in an open bin to select it, or create a 
new bin for the shot log import.

2. Choose Import from the File menu. The Select Files to Import dia-
log box appears.
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3. Choose Shot Log from the File Type pop-up menu. 

4. (Option) Select the option Show All Files in the lower left corner of 
the dialog box to display all Þles in a chosen folder, regardless of 
Þle type. Use this option if you want to batch-import from multi-
ple Þle types.

n When you batch-import multiple Þles and Þle types, you should establish 
global import settings in advance. See ÒUsing Global Import SettingsÓ on 
page 215.

5. Click the Options button to open a dialog box if you want to select 
options for combining events on import from the import settings.

Directory pop-up menu Source file scroll list Import file scroll list

File Type pop-up menu
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6. After selecting the appropriate options, click OK to close the 
Import Settings dialog box and return to the Select Files to Import 
dialog box.

7. Use the Directory pop-up menu to locate the folder containing the 
source Þle.

8. Select the Þle name in the source Þle list and click the Add button, 
or double-click the Þle name to add it to the import Þle list on the 
right.

9. Click Done.

When the system Þnishes importing the Þle, the clips appear in the 
selected bin.

Logging Directly into a Bin

You can log clip information in advance, allowing you to batch digitize 
the clips in one step. To log the clips in advance, do one of the follow-
ing:

¥ Prepare shot logs using MediaLog, a word processor, or a standard 
text editor, and then import the logs directly into Avid Composer 
bins. For more information see ÒPreparing Logs for ImportÓ on 
page 112.

¥ Log the clip information directly into the bin, as described in this 
section.

You can log clips directly into a bin by using the Digitize Tool in one of 
two ways described in this section:

For complete informa-
tion on working with 
bin columns and clip 
information, see 
ÒUsing Text ModeÓ on 
page 242.

¥ Log directly into a bin with an Avid-controlled deck for semiauto-
mated data entry.

¥ Log manually during or after viewing of footage ofßine with a 
deck or other source that is not Avid-controlled.
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Logging with an Avid-Controlled Deck

For information about 
connecting a compati-
ble deck to your system, 
See the Avid Media Com-
poser Products Connect-
ing Audio and Video 
Equipment.

When you log with a compatible tape deck controlled from within 
your Avid Composer system, you can automate part of the logging 
process by using buttons to enter frame-accurate timecode informa-
tion from the deck. This method is more accurate than manual entry 
because timecodes are transferred directly from tape to the bin.

To log clips to a bin by using the Digitize Tool:

1. Turn on power to the tape deck and make sure the deck is prop-
erly connected.

2. Open the bin where you want to store the clips.

3. Choose Digitize from the Tools menu. The Digitize Tool opens and 
the third, full-screen monitor displays playback from the deck.

n If you forgot to connect and/or turn on the power to the deck before opening 
the Digitize Tool, you can reinitialize deck control after turning it on by using 
the Check Decks command in the Deck Selection pop-up menu.

Deck controls

Mark IN

Log buttonTrack Selection

Erase Mark

Message bar

Deck Selection pop-up

Mark OUT

menu

Timecode display

Memo field
(constant)
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4. If the Digitize Tool is not currently in Log mode, click the Digi-
tize/Log Mode button to display the Log icon.

5. Load your tape into the deck. The system prompts you for a name. 

You can select the option ÒShow other projectÕs tapesÓ to display 
the tape names and associated project names for all bins that have 
been opened in the current session.

n Because the media Þle database no longer opens when you bring up your Avid 
Composer system, tape names of all online media Þles no longer appear auto-
matically.

If the tape name you are searching for does not appear in the Select Tape dia-
log box, click the Scan for Tapes button. Tape and project names are listed.

For guidelines in nam-
ing tapes, see ÒLogging 
TipsÓ on page 109.

6. Select a tape name from the scroll list. Tape names and associated 
projects are listed in two columns. Or, click the New button and 
enter a new tape name in the name entry Þeld that appears at the 
bottom of the dialog box. You can cancel the process any time by 
clicking the Cancel button.

New tape name

Show Tapes option

List of tapes
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7. Press Return. The tape name is displayed in the Digitize Tool.

8. Click the Log Mode button in the Digitize Tool.

The Capture Message bar displays a message that the system is 
waiting for you to mark an IN point. The Log button displays an 
IN mark.

9. Set either an IN mark or an OUT mark for the clip you want to log, 
using one of the following methods:

¥ Use the deck controls in the Digitize Tool to cue your source 
tape to the start or end point, and click the Mark IN or Mark 
OUT button.

¥ Click the large Log button in the upper right corner of the Dig-
itize Tool to enter the mark.

¥ If the footage starts at a known IN or ends at a known OUT, 
type the timecode in the display area next to the mark, press 
the Go To IN or Go To OUT button to scan the tape forward to 
the mark, or press Return to enter it.

After you set the mark, the icon in the Log button changes to the 
corresponding OUT or IN mark, and a pencil appears on the but-
ton.

10. To Þnish logging the clip, do one of the following:

¥ Set the remaining IN or OUT mark on-the-ßy by using the 
buttons.

New tape name
text entry field

Mark IN

Mark OUT

Go To IN 

Go To OUT
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¥ Type a timecode for the clipÕs IN, OUT, or duration in the 
timecode entry Þeld next to the corresponding icon and press 
Return. 

The system automatically calculates the appropriate timecode for 
the remaining mark IN, mark OUT, or duration, and enters the 
clip into the bin. The clip name, which is chosen and automatically 
numbered by the system, is highlighted and ready to be changed.

c You must enter at least two of the three timecode marks (IN mark, 
OUT mark, or duration) in order to complete the log entry.

11. Name the clip by typing a new name before clicking any of the 
buttons in the Digitize Tool. 

n You should change the clip name immediately because it is very easy to forget 
the contents of each clip among the dozens that you log. You can, if necessary, 
accept the clip name and proceed with the logging process and change the clip 
names in the bin at a later time.

12. Repeat these steps until you have logged all your clips.

While viewing the footage, you can continuously update your marks 
on-the-ßy by clicking the Mark IN or Mark OUT button repeatedly 
before entering the second mark.

Logging with Non-Avid-Controlled Decks

You can use the Digitize Tool to log clips directly into a bin from a 
source that is not Avid-controlled. For example, you can log clips from 
a deck that is not connected to the system, or from handwritten or 
printed log information for a tape that was previously logged but is 
not currently available.

1. If there is a deck connected to the system, eject the tape from the 
deck.
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n For NTSC projects, when you are logging within the Digitize Tool, you 
should leave the deck empty. If a tape remains in the deck, the system will 
determine drop-frame or non-drop-frame from that tape whether or not it 
matches your tapeÕs timecode format.

2. Double-click Deck Preferences in the Settings scroll list of the 
Project window to open the Deck Preferences dialog box.

3. For NTSC projects, choose Non-Drop-Frame or Drop-Frame from 
the When No Tape in Deck Log pop-up menu.

4. Click OK to close the dialog box.

5. Open the bin where you want to store the clips.

6. Choose Digitize from the Tools menu. The tool opens.

Deck 

Track

Message

Deck Selection 
pop-up menu

 Selection

 bar

controls

Log 
button

Timecode 
display

Memo field (constant)

Erase
Mark

Mark OUT button

Mark IN button

button

Tape Name
button
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7. Click the Digitize/Log Mode button in the Digitize Tool to activate 
Log mode.

8. Click the Tape Name button. A dialog box appears.

9. Click Yes to open the Tape Selection dialog box.

10. Double-click the name of the tape in the dialog box, or click New 
and enter the name of the tape.   Click OK.

11. Select the tracks you want to log in the Digitize Tool.

12. Type the start and end timecodes in the mark IN and mark OUT 
displays.

13. Click the Log button, or press the B key.

The clip is logged into the bin.

Modifying Clip Information

For complete informa-
tion on working with 
bin columns and clip 
information, see 
ÒUsing Text ModeÓ on 
page 242.

You can change or modify the information logged in the bin. This is 
especially useful if you Þnd that some of the data is incorrect, or if you 
need to update the information based on technical needs, such as 
varying timecode formats.
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For additional bin 
shortcuts, see the 
ÒShortcutsÓ section of 
the Avid Media Composer 
and Film Composer 
Quick Reference.

There are two ways to modify clip information prior to digitizing: 

¥ You can modify the information directly by clicking in a column 
and entering the new information one Þeld at a time.

¥ You can use the Modify command to change selected groups of 
clips all at once.

Using the Modify Command

The Modify command gives you specialized control over groups of 
clip information. For example, you can use the Modify command to 
change the name of source tapes for some or all of your clips, to 
change the timecode format from drop- to non-drop-frame, or to incre-
ment or decrement the start and end timecodes by a speciÞed length of 
time for one or several clips at once.

To modify selected clips:

1. Open the bin.

2. Click a clip icon to select it. Shift-click each additional clip you 
want to modify.

3. Choose Modify from the Clip menu.

The Modify dialog box appears.

Selected clips are 
highlighted.
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4. Choose an option, such as Set Timecode By Field, from the pop-up 
menu.

Depending on the modiÞcation you select, different options 
appear in the dialog box that allow you to establish the speciÞc 
modiÞcation as shown in Table 5-1.

Click here to display 
pop-up menu.
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5. After choosing the type of modiÞcation, select an option or enter 
information into the entry Þelds (timecode values, for example) 
when they appear.

6. Click OK. The modiÞcation takes effect.

Table 5-1 Modify Dialog Box Options

Type of ModiÞcation Options Description

Set Timecode Drop/
Nondrop

Drop, Nondrop radio buttons Changes the timecode format between 
drop- and non-drop-frame.

Set Timecode By Field Start or End radio buttons Changes either the start or end timecode.

Fields for Hour, Minutes, Sec-
ond, Frame

Allow you to enter custom timecode.

Increment Timecode Start or End radio buttons Changes either the start or end timecode.

Timecode entry Þeld Allows you to enter custom incremental 
timecode.

Decrement Timecode Start or End radio buttons Changes either the start or end timecode.

Field for timecode Allows you to enter new incremental time-
code.

Set Key Number 
Generic (PreÞx)

Field for Key Number Allows you to enter a custom generic key 
number.

Set Pullin Punch frame timecode entry 
Þeld

Sets the timecode location of the punch 
frame for pullin.

A, B, C, or D radio buttons Selects the pulldown frame to match to the 
timecode entry.

Set Tracks V, A1, A2, A3, A4 track selector 
buttons

Changes the clips conÞguration of tracks.

Set Source Opens the Tape Name dialog 
box

Selects another source tape name for the 
clips.
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Exporting Shot Log Files

You can export a shot log Þle from the Avid Composer system in one 
of two formats for making adjustments in a text processor or for 
importing into another system.

To export a shot log based on clip information in a bin:

1. Open the bin containing the clips you want to export and change 
to Text mode.

2. Choose Export from the File menu. The Export File Type dialog 
box appears.
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3. Select either Avid Log Exchange or Tab Delimited as the Þle type.

4. Click OK. 

A destination dialog box opens with a default Þle name in the 
Export As text box, based on the Þle type.

5. Change the Þle name, if you want (keep the Þle extension), and 
select the destination folder for the Þle and click Save.

The Þle is exported and appears at the chosen destination.
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CHAPTER 6

Preparing to Digitize

Digitizing is the process of converting source material from analog vid-
eotape to digital form. Before you begin this processÑdescribed in 
Chapter 7Ñyou need to complete the following preparations:

¥ Preparing the Hardware

¥ Selecting Settings

¥ Entering Capture Mode

¥ Setting Up the Compression Tool

¥ Setting Up the Digitize Tool

¥ Preparing for Audio Input and Output

¥ Preparing for Video Input

¥ Digitize Preparations Checklist

Preparing the Hardware

Your source material can originate from a videotape, a digital audio-
tape (DAT), a compact disc (CD), an in-house router, a tuner, or 
straight off-the-air, with the proper hardware conÞguration.
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n For information on connecting your equipment, see the Avid 
Media Composer Products Connecting Audio and Video Equipment manual.

The following are a few last-minute items to double-check prior to dig-
itizing.

¥ Video Slave Driverª settings. If your system is equipped with 
the Digidesign¨ hardware, make sure the pulldown switch on the 
front of the Video Slave Driver is set to the X 1.00 setting for nor-
mal use. For information on settings to use for Þlm projects, see 
the Avid Media Composer Products Reference.

¥ Third, full-screen monitor. Before you begin digitizing and edit-
ing, set up your NTSC or PAL full-screen monitor by using a color 
bar generator (or house pattern) and lock in those settings, if you 
havenÕt done so already.

For more information 
on the 16 x 9 format 
option, see ÒUsing the 
16 x 9 Display FormatÓ 
on page 329.

¥ 16 x 9 format. You can edit with video in the 16 x 9 wide-screen 
format. To digitize footage shot in the 16 x 9 format, you must 
have a compatible playback deck.   To view the footage on a full 
screen, you must have a 16 x 9 compatible full-screen NTSC or 
PAL monitor.

¥ Remote switch. The deck control switch on the front of the source 
deck must be set to remote rather than local to control the deck 
with the Digitize Tool.

¥ Striped drives. If your footage contains complex images that you 
digitize at high resolution, you must use striped drives as 
described in the AVIDdrive Utility UserÕs Guide. In addition, vari-
ous models and AVRs have different striping requirements. For 
more information, see the Avid Media Composer Products Reference.

¥ DAT (digital audiotape). To digitize music or audio from a DAT 
machine, check the Avid Media Composer Products Connecting Audio 
and Video Equipment manual to determine whether your model 
requires VLXi for deck control. Also, when digitizing from DAT 
you must choose Digital from the Sync Source pop-up menu in the 
Audio Tool Setup display. For more information, see ÒPreparing 
for Audio Input and OutputÓ on page 157.



134

n The Avid Composer system does not support input and output of S-Video. 
Use the composite input/output to and from your S-Video equipment or a 
transcoder to digitize from S-Video format.

Selecting Settings

For more information 
on all settings options, 
see the Avid Media Com-
poser Products Reference. 
For a complete descrip-
tion of procedures for 
locating and changing 
settings, see ÒUsing the 
Settings DisplayÓ on 
page 61.

Several settings have a direct bearing on the digitizing process. Before 
digitizing, review the following options:

¥ General Settings include options for NTSC tape formats and 
drive Þltering:

-  Drive Filtering Based on Resolution causes the system to dim all 
drives for which speed capabilities are unknown or untested 
in a particular Avid Video Resolution (AVR). This is the 
default setting in the General Settings dialog box.

n The Avid Composer system will not prevent you from using non-Avid drives, 
but their reliability cannot be assured.

-  NTSC Has Setup applies to standard NTSC format. This is the 
default setting in the General Settings dialog box. If the source 
footage is in the NTSC/EIAJ format standard (used primarily 
in Japan), deselect NTSC Has Setup. 

- The Audio File Format pop-up menu allows you to choose 
either AIFF or SDII as the default audio media for the project. 
For more information, see ÒChoosing the Audio File FormatÓ 
on page 158.

¥ Digitize Settings include essential options for digitizing, batch 
digitizing, autodigitizing, and digitizing to multiple media Þles.

-  Digitize Video to Multiple Files   allows you to create longer 
clips whose media Þles would otherwise exceed the 
Macintosh operating system Þle size limitation of 2 GB. For 
more information, see ÒDigitizing to Multiple Media FilesÓ 
on page 152.
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-  Digitize across timecode breaks causes the system to begin digi-
tizing a new master clip at each timecode break. Select this 
option when you are performing unattended batch digitizing 
or autodigitizing. Deselect this option if you plan to digitize 
the entire tape as a single clip by digitizing to multiple media 
Þles. For more information, see ÒDigitizing Across Timecode 
BreaksÓ on page 156.

- The with outpoint set option allows you to mark an OUT point 
to stop digitizing when you are performing unattended batch 
digitizing or autodigitizing.

Deck Configuration Settings

Deck ConÞguration settings and global deck control preferences 
appear as separate items in the Settings scroll list of the Project win-
dow.

Deck conÞguration settings allow you to establish deck control param-
eters for a single deck or for multiple decks. As with all settings, you 
can create multiple versions, allowing you to select among them for 
frequent changes in hardware conÞgurations.

Deck control settings
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c You must manually conÞgure the appropriate hardware connections 
before deck conÞguration settings can take effect. For more informa-
tion, see the Avid Media Composer Products Setup Guide or the Avid 
Media Composer Products Connecting Audio and Video Equipment 
manual.

To conÞgure a deck or multiple decks:

1. Double-click Deck ConÞguration in the Settings scroll list.

The Deck ConÞguration dialog box appears.

2. If you are conÞguring your system for the Þrst time, click the Add 
Channel button to add a new channel box on the left side of the 
Deck ConÞguration dialog box and automatically open a Channel 
dialog box.



137

n Channel refers to the signal path for deck control, whether through a serial 
port or a V-LAN VLXi system. Direct serial port connection provides two 
channels (modem port and printer port), while a V-LAN VLXi system pro-
vides multiple channels.

3. Choose either Direct (serial port) or V-LAN VLXi from the Chan-
nel Type pop-up menu, depending upon your system conÞgura-
tion.

4. If you chose Direct for the channel type, choose either Printer Port 
or Modem Port from the Port pop-up menu.

n If you are not sure which port to choose, check the serial cable connection on 
the back of the Macintosh. 

5. Click OK to close the Channel dialog box.

A new channel appears in the display area of the Deck ConÞgura-
tion dialog box.
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n You can reopen the channel settings to change the options at any time by 
double-clicking the channel box.

6. Click the channel box to select it.

7. Click Add Deck to add a new deck box on the right side of the 
Deck ConÞguration dialog box and automatically open a Deck 
Settings dialog box.

n With a deck already connected to the system, you can also click the Autocon-
Þgure button to bypass the Deck Settings dialog box and automatically con-
Þgure a deck with the default settings.

Channel boxes appear on the left side
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8. ConÞgure deck settings.

n For information on deck settings, see the Avid Media Composer Products Ref-
erence.

9. Click OK to close the Deck Settings dialog box and return to the 
Deck ConÞguration dialog box.
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n You can reopen the Deck Settings dialog box to change the options at any time 
by double-clicking the deck box.

10. Repeat steps 2 to 9 for each additional channel or deck you want to 
conÞgure.

11. Click Apply to complete the conÞgurations and close the Deck 
ConÞguration dialog box.

12. If necessary, double-click Deck Preferences in the Settings scroll 
list of the Project window to adjust global deck control options for 
default timecode format, insert or assemble editing, and stop key 
and shuttle operation.

Deleting Configurations

You can delete deck conÞguration elements to remove or replace them.

Decks appear on the right side
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To delete deck conÞguration elements in the Avid Composer system:

1. Double-click Deck ConÞguration in the Settings scroll list of the 
Project window. 

The Deck ConÞguration dialog box appears.

2. Click a channel box, a deck box, or the entire conÞguration to 
select it.

3. Click the Delete button in the dialog box, or press the Delete key to 
delete the element.

Deck Preferences

Deck preferences are global settings for basic deck control. These set-
tings apply to all decks connected to your system, regardless of your 
deck conÞguration. You can open the Deck Preferences dialog box 
from the Settings scroll list of the Project window (see ÒDeck ConÞgu-
ration SettingsÓ on page 135). For information on deck preferences, 
see the Avid Media Composer Products Reference.

Entering Capture Mode

Capture mode provides all the tools and controls you need to capture 
your footage in digital form. When you enter Capture mode, the sys-
tem initializes these tools and establishes an interface with the analog 
playback equipment attached to the system.

To enter Capture mode:

1. Make sure the playback deck is turned on and properly connected 
to the system.

2. Open your project and the bin in which you want to store your 
master clips.
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3. With the bin active, choose Go To Capture Mode from the Bin 
menu. The Bin monitor displays the Digitize Tool, Compression 
Tool, and the active bin.

n In Capture mode, the Client monitor displays the playback footage on a full 
screen at all times when the video track is selected in the Digitize Tool.
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Setting Up the Compression Tool

You can choose various compression parameters in the Compression 
Tool. To choose compression settings: 

1. Choose Compression from the Tools menu.

2. Make sure the proper audio sample rate is indicated under Audio 
Rate. The audio sample rate shown cannot be adjusted within the 
tool, but reßects hardware settings, as follows:

¥ Systems using a two-channel audio board support 44100 Hz 
(44 kHz) only. This is the default setting in the Compression 
Tool.

¥ If your system uses the Digidesign audio interface and a four- 
to eight-channel audio card, you can set the audio sample rate 
at either 44100 Hz or 48000 Hz by adjusting the sample rate 
switch on the front of the Video Slave Driver.

n Settings in both the Compression Tool and the audio interface do not affect the 
sample rate of digital audio signals.

3. Choose an AVR and color rate from the pop-up menus. 

Audio settings

Video compression
settings
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About the Color Rate Option

In addition to the AVR, the Color pop-up menu allows you to choose 
to Þlter out color from each frame of video with the monochrome 
option.

If you are digitizing black-and-white images, storage space will not be 
affected by these settings. 

c If you choose one of these settings and you intend to record profes-
sional-quality digital cuts, you will need to redigitize at Full 
Chroma before recording.

Setting Up the Digitize Tool

The Digitize Tool provides controls for cueing, marking, and logging   
footage, and speciÞes digitizing parameters such as source and target 
locations. Deck control in the Digitize Tool operates in the same way as 
in the Deck Controller. Click anywhere in the Digitize Tool to activate 
it.

Deck control

Track Selection Record button

Trash/Abort
Digitize/Log mode

Subclip status

Digitize indicator

Tape Name display

Message bar

Deck Selection
pop-up menu
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Using the Deck Selection Pop-Up Menu

The Deck Selection pop-up menu in the Digitize Tool contains a list of 
all decks that were connected to the system, powered up, and initial-
ized when you entered Capture mode. Deck 1 is selected by default. 

You must have V-LAN 
VLXi hardware to con-
trol more than one deck 
at a time. For more 
information on V-LAN 
equipment, contact 
your Avid sales repre-
sentative.

To activate playback from another available deck, choose the deck 
from the Deck Selection pop-up menu.

The menu also contains the command Check Decks below the list of 
decks. The Check Decks command helps you reestablish deck control 
if the power on your decks was turned off or the decks were discon-
nected when you Þrst entered Capture mode.

n Once deck control has been properly initialized, it will remain active for all 
deck controllers throughout the session until you quit the application.

Selecting a Tape

To select a source tape:

1. Insert a tape into your deck. The Select Tape dialog box appears.

Check Decks appears at the bottom of the 
Deck Selection pop-up menu.
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2. In an NTSC project, play the tape brießy so that the system can 
detect the timecode format of the tape (drop-frame or non-drop-
frame). Otherwise, the system maintains the timecode format set 
in Deck Settings, regardless of the format on the tape, and you 
might receive a Wrong Tape message.

n Drop-frame timecode appears in the Timecode indicator with semicolons 
between hours, minutes, and seconds, and frames. Non-drop-frame timecode 
appears with colons.

For information on 
tape naming conven-
tions, see ÒNaming 
TapesÓ on page 110.

3. Provide the system with a tape name in one of the following ways:

¥ Select the name of the tape from the list in the Select Tape dia-
log box and click OK.

¥ Click New if the tape is not in the list. A new tape name line 
appears at the bottom of the dialog box. Type the new name 
and click OK.
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Selecting Source Tracks

You can choose the tracks to digitize from the source tape. Click the 
video and audio track buttons in the Digitize Tool to select only those 
tracks that you want to digitize. 

n When using an Avid-controlled deck, the TC (timecode) track will be selected 
by default, and the system will digitize the timecode from the source tape. If 
you deselect the TC button, the system will digitize with timecode-of-day. For 
more information, see ÒDigitizing with Timecode-of-Day TimecodeÓ on 
page 198.

If you are not seeing the source video or hearing source audio in Cap-
ture mode, toggle these buttons to make sure they are not the cause.

n You can select or deselect all tracks at once by pressing the Option key and 
clicking any track selector.

c When batch digitizing, if the tracks are already logged into the bin, 
this selection will be made automatically, unless you deselect the 
option ÒDigitize the tracks logged for each clipÓ in the Digitize Set-
tings. For more information on Digitize Settings, see the Avid 
Media Composer Products Reference.
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Choosing a Resolution in the Digitize Tool

If you did not already choose a resolution in the Compression Tool, or 
the Compression Tool is closed, you can use the AVR pop-up menu in 
the Digitize Tool.

To choose a resolution, click the pop-up menu above the deck controls 
in the Digitize Tool and make a selection.

Release 7.0 of the Media Composer products addresses AVR 70 and 
AVR 75 as follows:

¥ AVR 70 and AVR 75 in Release 7.0 of the Media Composer prod-
ucts correspond to AVR 70B and AVR 75B used to record media in 
the Þeld with the Ikegami¨ Editcamª. As a result, users can now 
transfer media directly from the Ikegami Editcam to a 
Media Composer product for editing. For information on transfer-
ring media directly from the Ikegami Editcam, see ÒUsing Edit-
cam MediaÓ on page 210.

¥ When you choose AVR 70 or AVR 75 during digitizing, the video 
column in the bin will display AVR 70B or AVR 75B for the new 
clips.

¥ If you transfer AVR 70 or AVR 75 media from an earlier release of 
the Media Composer products, the Video column in the bin dis-
plays AVR 70 and AVR 75 for the older media.

¥ You can play older AVR 70 and AVR 75 media within Release 7.0, 
but you cannot digitize in the older format.

n For more information on AVRs, see the Avid Media Composer Products Ref-
erence.
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Choosing the Target Bin

You select a target bin as the destination for the master clips created 
when you digitize on-the-ßy. Or, you select a target bin containing the 
logged clips you will use to batch digitize your media.

To choose a target bin, do one of the following:

¥ Choose an existing bin from the pop-up menu.

¥ Activate a previously created bin by choosing Open Bin from 
the File menu, and then by locating and opening the bin in the 
Open Bin dialog box.

¥ Create a new bin by choosing New Bin from the File menu, 
and then naming and opening the new bin in the New Bin dia-
log box.

Targeting Drives

Targeting drives for the digitized media is a three-step process:

1. Make sure you are in Digitize mode. If the tool is in Log mode, 
click the Digitize/Log button to return to Digitize mode.

For tips on targeting 
media drives for effec-
tive storage and play-
back, see the Avid Media 
Composer Products Refer-
ence Guide.

2. Decide whether to digitize audio and video to a single drive, or 
separate drives, as described in the following sections.

3. Choose the speciÞc target drives from the pop-up menus, as 
described in the following sections.
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Targeting a Single Drive

By default, the Digitize Tool targets a single media drive volume for 
digitizing the audio and video for each clip.   Use this option when 
you are digitizing in a single-Þeld resolution, for instance, and play-
back performance is generally not an issue.

To target a single drive:

1. Click the One/Two Disk Mode button to display a single drive 
icon.

2. Choose a drive volume from the Target Drive pop-up menu. 

The name shown in bold in the menu has the most storage avail-
able. Time remaining on the selected drive, displayed above the 
menu, is calculated based on your AVR selection.

Targeting Separate Drives for Audio and Video

To achieve optimal per-
formance, stripe two or 
more drives. AVRs 71 
and 75 require drive 
striping. For more infor-
mation, see the AVID-
drive Utility UserÕs 
Guide.

 Optionally, you can target separate drives for video and audio tracks. 
This option improves performance because the system is not required 
to address all the information in separate locations on a single disk. 
You can also digitize for the longest continuous amount of time 
because the system is storing material on two disks rather than one.

To target separate drives for audio and video:

1. Click the One/Two Disk Mode button to display a two-drive icon.
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2. Choose separate drive volumes for audio and video from each 
Target Drive pop-up menu. 

Names shown in bold in the menus have the most storage avail-
able. Time remaining on each selected drive, displayed above each 
menu, is calculated based on your AVR selection.

Interpreting the Time Remaining Display

By default, the Digitize Tool displays a time remaining for each clip 
after you select an AVR and target drive or drives for the digitized 
media.

 You can interpret this display based on the following factors:

¥ Each digitized clip is limited by the Macintosh operating system to 
a maximum Þle size of 2 GB (gigabytes). 

¥ When adequate space exists on the chosen drive, the time remain-
ing displayed in the Digitize Tool is based on 2 GB per clip at the 
chosen AVR.   This number will reappear for each clip digitized, as 
long as there is adequate disk space.

¥ When you choose another AVR, the time remaining display 
adjusts accordingly.

¥ When the storage space on the chosen drive is less than 2 GB, the 
time remaining will begin to decrease for each clip digitized, until 
the drive is full.

Time remaining

One/Two
DIsk Mode
button
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You can also press the Option key and click the One/Two Disk Mode 
button to show the total time remaining on the chosen drive at the 
selected AVR.

Digitizing to Multiple Media Files

You can digitize video to multiple media Þles across multiple drive 
volumes, with the following advantages: 

¥ You can create longer clips whose media Þles would otherwise 
exceed the Macintosh operating system Þle size limitation of 2 GB.

¥ You can group all drive volumes with the multiple Þles options, 
enabling the system to record continuously during digitizing of 
long video clips Ñ such as satellite feeds or program airchecks.

¥ The system makes more efÞcient use of drive space, particularly 
when digitizing long clips.

n This feature applies to video Þles only because audio media Þles rarely exceed 
2 GB in size.

To digitize video to multiple media Þles:

1. Double-click Digitize in the Settings scroll list of the Project win-
dow.

The Digitize Settings dialog box appears.
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2. Select the option ÒDigitize Video to Multiple Files.Ó

3. Select the option ÒPrepare multiple Þles for (minutes).Ó You can 
accept the default or enter a different time limit in the text Þeld, 
based on the following explanation:

Prior to digitizing, the system goes through a process of preparing 
the drive volumes. This process is called preallocation. With the 
ÒDigitize Video to Multiple FilesÓ option selected, the allocation 
process can take a long period of time in preparation for poten-
tially unlimited video clip lengths. This option instructs the sys-
tem to preallocate according to an estimated maximum video clip 
length. The default is 30 minutes.

Multiple file 
options
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c If you think that any of your digitized video clips might exceed 
30 minutes, make sure you enter a higher estimate in this Þeld; oth-
erwise, the system will stop digitizing at 30 minutes.

4. Click OK to close the dialog box and apply the options.

5. Enter Capture mode or open the Digitize Tool.

6. To digitize to multiple Þles across drive volumes, choose Change 
Group from the Target Drive pop-up menu in the Digitize Tool.

Target Drive 
pop-up menu
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The Volumes dialog box appears.

7. Shift-select multiple volumes to include in the digitizing session, 
or click the All button to select all volumes.

8. Click OK to close the dialog box and apply the changes.

When you digitize, any clip that exceeds the capacity of a volume 
(whether that volume is empty or already contains media Þles) 
will continue digitizing onto another volume in the group.

c For media Þle management purposes, any video clip whose media 
exceeds the 2-GB limit will have more than one media Þle associated 
with it. When you view the source Timeline for the clip loaded in 
the Source monitor, you will also notice edit breaks based on the 
separate media Þles (the breaks do not appear in the record-side 
Timeline).

n For more information on managing media Þles, see Chapter 10.
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Digitizing Across Timecode Breaks

You can use control track instead of timecode for VTR preroll when 
digitizing across timecode breaks.

For more information 
on all settings options, 
see the Avid Media Com-
poser Products Reference. 
For a complete descrip-
tion of procedures for 
locating and changing 
settings, see ÒUsing the 
Settings DisplayÓ on 
page 61.

Control track preroll allows you to capture all the footage following a 
timecode break. Otherwise the system uses approximately 1 to 
6 seconds of unbroken timecode following the break to perform the 
preroll before digitizing begins.

This is especially useful when you are batch digitizing across timecode 
breaks, but you can also select this option when you are manually dig-
itizing one clip at a time.

Preroll option
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Preparing for Audio Input and Output

The Media Composer products support direct input and output of up 
to eight channels of audio, depending upon your model. Systems sup-
porting eight-channel input and output provide the following fea-
tures:

¥ For eight-channel audio input, source track assignments are 
mapped directly to audio tracks in the digitized clips. For exam-
ple, when you digitize source footage with audio channels 1 to 5, 
the resulting master clip has matching audio tracks 1 to 5.

¥ For eight-channel audio output, you can reassign output channels 
from tracks in a sequence or clip to any of the eight optional out-
put channels. For more information, see ÒAdjusting Output on 
Four-Channel or Eight-Channel Audio Board SystemsÓ on 
page 610.

c Eight-channel audio input and output require the appropriate hard-
ware conÞguration. For more information, see the Avid 
Media Composer Products Connecting Audio and Video Equipment 
manual.

You can switch the hardware conÞguration to use either four-channel 
or eight-channel audio. If you change the conÞguration after launch-
ing the software, you can choose a new conÞguration in the Audio Set-
tings dialog box without restarting the software.

To change the audio interface conÞguration after launching the soft-
ware:

1. ReconÞgure the hardware. For more information, see the Avid 
Media Composer Products Connecting Audio and Video Equipment 
manual. 

2. Double-click Audio in the Settings scroll list of the Project window. 
The Audio Settings dialog box appears.

3. Choose the new audio interface conÞguration from the Peripheral 
pop-up menu.
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Using Digital Sync with the Eight-Channel Audio Converter

The eight-channel audio converter is limited to acquiring digital sync 
signal from channels 1 and 2.

c Channels 1 and 2 are often the Þrst choice for input of a signal that 
provides digital sync. If you want to input audio from channels 3 
through 8, however, you must have a valid digital signal coming in 
on either channel 1 or 2.

Check for a valid digital sync signal as follows:

¥ If the green indicator light labeled DIGITAL on the audio con-
verter shines steadily during input, the system is receiving a valid 
digital sync signal.

¥ If the green light blinks during input, the system is not receiving 
valid sync signal. Make sure you have a digital sync signal source 
properly connected to channel 1 or channel 2.

The effects of capturing audio without a valid digital sync source can 
include random noise, silence, or a jittering effect in the audio when 
played back.

Choosing the Audio File Format

The Media Composer products support the creation of audio media in 
the industry-standard Audio Interchange File Format (AIFF). The 
Media Composer products continue to support the Sound Designer II 
(SDII) format.

AIFF and Sound Designer II audio media Þles can be mixed within a 
project. The system default is 16-bit OMF (AIFF) audio. 
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n Choose the SDII format for all audio media when you need to transfer audio 
media Þles directly to a Pro Tools¨ or AudioVision¨ system for audio sweet-
ening.

To toggle between AIFF and SDII:

1. Double-click General Settings scroll list of the Project window.

The General Settings dialog box appears.

2. Choose either AIFF or SDII from the Audio File Format pop-up 
menu.

Audio is written in the chosen Þle format when you:

¥ Digitize audio tracks in Capture mode

¥ Create new clips by using the Audio Punch-In Tool

¥ Create tone media by using the Audio Tool

¥ Mix down audio tracks by using Audio Mixdown

¥ Import Þles by using the Import dialog box

Audio File
Format pop-
up menu
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¥ Apply a Digidesign audio plug-in that creates new source audio

If you switch the audio format in the middle of a project, all new audio 
media Þles will be written in the new format with the following excep-
tions:

¥ Media Þles written when rendering audio effects: The system 
uses the Þle type of the A-side (outgoing audio) media for a transi-
tion. For example, if the A-side of an audio dissolve is in OMF 
(AIFF) format and the B-side (incoming) is SDII, the rendered Þle 
will be OMF (AIFF).

¥ Audio media Þles written when using the Consolidate feature: 
Media Þles that are copied or created during a consolidate proce-
dure retain their original Þle types.

Adjusting Audio Settings

You can use the Audio Settings dialog box to check the current conÞg-
uration of audio hardware, and to choose various input options. 

To open the Audio Settings dialog box, double-click Audio in the Set-
tings scroll list of the Project window.

The dialog box appears.
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Two-channel audio boards now support both 44100-Hz (44.1 kHz) and 
48000-Hz (48 kHz) audio rate settings. The broadcast standard of most 
high-end video postproduction houses is 48 kHz. The sound quality of 
the two rates is very similar; you should select the rate based on the 
requirements of your facility. For more information on settings, see the 
Avid Media Composer Products Reference.

On a two-channel board, select the rate by choosing a value from the 
Sample Rate menu in the Audio Settings dialog box. You access the 
dialog box from the Settings scroll list in the Project window. For four- 
to eight-channel systems, adjust the sample rate on the audio interface 
or audio converter.

The setup display for two-channel board systems includes the same 
setup information as the display for four- to eight-channel systems, 
with these exceptions:

¥ There is no peripheral display because there are no audio periph-
erals connected.

¥ The sample rate option is Þxed at 44 kHz with two-channel board 
systems.

Display for four-
channel board 
systems
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¥ There is no Digital Format display option because two-channel 
systems can only input S/PDIF (Sony/Phillips Digital Interface 
Format) digital audio.

The Þrst four items in the display are informational, and cannot be 
changed from within the Audio Tool. These include: 

¥ The type of audio card installed

¥ The slot number where the card is located

¥ The sample rate for audio input, determined by the position of the 
Sample Rate switch on the Digidesign audio interface (four- to 
eight-channel systems only)

¥ The type of peripheral audio device attached to the system (audio 
interface)

You can make adjustments to any of the Þnal three options from 
within the Audio Tool by clicking the option and making a new selec-
tion from the pop-up menu. These selections include:

¥ The Sync Mode pop-up menu, which includes two optional 
sources for audio sync:

- InternalÑThis sets the clock and timing for the sample rate 
internally. If your system is equipped with the Digidesign 
audio interface and black burst generator, set the Sync Mode 
to Internal.

- DigitalÑIf you are using a digital source that provides a digi-
tal word-clock signal, set the Sync Mode to Digital. Choose 
digital if you are digitizing from DAT (digital audiotape).

c You must plug a digital source device to the digital input port on the 
two-channel audio board directly or through the Digidesign audio 
interface if you have system with a four- to eight-channel audio 
board.

¥ The Input Source pop-up menu, which includes two options for 
the type of input: analog or digital.



163

¥ The Digital Format pop-up menu (systems with four- to eight-
channel audio boards only), which provides two options for the 
digital input format if you chose Digital as the input source:

- AES/EBU (Audio Engineering Society/European Broadcast 
Union)Ñthe industry format

- S/PDIF (Sony/Phillips Digital Interface Format)Ñthe con-
sumer format

Using the Audio Tool

The Audio Tool, along with your hardwareÕs audio parameters, allows 
you to do the following in preparation for input:

¥ Check and manage your audio hardware setup.

¥ Calibrate system input levels.

¥ Set audio levels before digitizing.

In addition, controls in the Audio Tool allow you to calibrate, set lev-
els, and generate customized calibration tone for output to the speak-
ers or a record device. For more information on output procedures 
involving the Audio Tool, see ÒPreparing for OutputÓ on page 601.

To open the Audio Tool, choose Audio Tool from the Tools menu, or 
click the Audio Tool button in the Digitize Tool.

Audio Tool
button

Audio Tool command
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The Audio Tool appears. The tool displays meters for two to eight 
channels, depending on your Media Composer model.

The Audio Tool has the following characteristics:

¥ The Output Level button displays a panel that contains a single 
slider control for raising or lowering global audio output.

¥ The Output Options button displays a panel that contains options 
for channel assignments, mixing tracks, and ignoring pan and vol-
ume settings.

¥ The Reset Peak button resets the current maximum peak measure-
ments. It also stops the playback of the internal calibration tone.

¥ The In/Out buttons toggle the meter displays for each channel 
between input levels from a source device and output levels to the 
speakers and record devices. I indicates Input, and O indicates 
Output.

¥ The Peak Hold button displays a pop-up menu that allows you to 
choose options for customizing the meter displays, and setting 
and playing back the internal calibration tone.

Reset Peak 
button

Input button (2-
channel boards 
only)

Output button

Four-Channel Audio Board Output options 
button

In/Out toggle

Peak Hold 
button

Meter display

Analog VU scale 
(adjustable)

Digital scale 
(fixed)

Two-Channel Audio Board
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¥ The digital scale to the left of the meters displays a Þxed range of 
values from 0 to Ð90 dB (decibels), according to common digital 
peak meter standards.

¥ The analog VU (volume unit) scale to the right of the meters dis-
plays a range of values that you can conform to the headroom 
parameters of your source audio.

¥ The meters dynamically track audio levels for each channel as fol-
lows:

- Meters show green below the target reference level (default 
reference level is Ð14 dB on the digital scale).

- Meters show yellow for the normal headroom range, above 
the reference level to approximately Ð3 dB.

- Meters show red for peaks approaching overload, between Ð
3 dB and 0 (zero) dB.

- Thin green lines at the bottom indicate signals below the dis-
play range.

Resizing the Audio Tool

You can resize the Audio Tool for greater visibility during input and 
output. For example, when batch digitizing in a busy facility, you can 
make the tool larger to watch levels from across a room.

To adjust the size of the Audio Tool, click the size box in the lower cor-
ner and drag to the preferred size.
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Adjusting the Reference Level

The VU (Volume Unit) scale to the right of the meters is a sliding scale 
relative to the Þxed digital scale displayed on the left. You can adjust 
the VU scale up or down based upon the headroom parameters of your 
playback devices.

To customize the VU scale:

1. Choose Set Reference Level from the Peak Hold pop-up menu.

A dialog box appears.

Size box
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2. Enter the new value for the reference level (-12, for example), and 
click OK.

The VU meter scale slides to match the new reference level, which 
is displayed on the digital scale.

Choosing a Peak Hold Option

The Peak Hold pop-up menu provides two options for displaying 
peak levels in the meters, as follows:

¥ When you choose Peak Hold, the meters display a normal rising 
and falling volume trail in the meters. This is the default option.

VU scale slides up to display 
less headroom.

Digital scale displays corre-
sponding reference value.
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¥ When you choose the InÞnite Hold option, each meter perma-
nently retains a single bar at the peak volume level measured dur-
ing playback. The effect is cumulative: the bar continues to rise 
and hold with each new peak, and serves as a record of the highest 
peak for each channel. 

To delete the peaks and start over at any time, click the Reset Peak 
button.

To enable either Peak Hold or InÞnite Hold, click the pop-up menu 
and choose an option.

Infinite hold peaks 
remain during and after 
playback.
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Adjusting Input Levels

This section describes procedures for calibrating and adjusting audio 
input levels with the Audio Tool. The types of adjustments you can 
makeÑand the procedures you useÑvary depending upon whether 
your system is equipped with a two-channel audio board or a four-to 
eight-channel audio board, as follows:

¥ You can use the calibration controls in the Audio Tool to calibrate 
the Digidesign audio interface input levels on systems equipped 
with four- to eight-channel audio boards.

¥ You can use input level controls in the Audio Tool on systems 
equipped with two-channel audio boards to calibrate and set lev-
els during digitizing.

¥ You can use additional procedures described in this section to 
avoid digitizing over- or under-modulated audio due to variations 
in levels among the source material, playback devices, and the 
Media Composer system.

To adjust input levels:

1. Click the In/Out toggle buttons for the appropriate channels to 
display the I for Input.

2. Play back the source audio (from a videotape or DAT, for exam-
ple). If the recording includes reference tone, cue to the tone and 
play it back. 

n Voice recording serves as a good backup reference. Upper peaks of inßection 
should reach the normal target range (around -14 dB on the digital scale or 
0 dB on the VU scale with playback from videotape, for example).

3. Adjust the output on the playback device so that the deviceÕs vol-
ume meter shows the appropriate level for the reference signal 
(0 dB for videotape playback, for example).

4. Adjust the input levels using the following procedures for either 
two-channel or four- to eight-channel systems.
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Adjustments for Four- to Eight-Channel Audio Board Systems

You can use the calibration features of the Audio Tool to Þne-tune the 
Trim level settings of the Digidesign audio interface. These adjust-
ments should be made when you Þrst install the system, and repeated 
occasionally thereafter (once a month, for example).

To calibrate the audio interface:

1. Choose Calibrate from the Peak Hold pop-up menu. 

The Audio Tool changes to Calibrate mode: the scales display a 
range of approximately 2 dB, and the meters indicate levels within 
this range.

2. Use a jewelerÕs screwdriver to Þne-tune the Input Level Trim pots 
on the Digidesign audio interface until the peaks rest at the appro-
priate value.

VU scale varies, displaying 
custom reference level setting, 
+1 dB above and -1 dB below.
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3. To return to the default display, choose Calibrate from the Peak 
Hold menu.

To set the input level during digitizing, adjust the level externally until 
the signals fall within the appropriate range on the meters:

¥ Adjust the output level on the playback device.

¥ Put an audio mixer in line, and use it to adjust track separately.

¥ Put an audio compressor in line. This allows other adjustments of 
the audio levels as well as overall volume.

c You cannot adjust the levels for four- to eight-channel audio board 
systems from within the Audio Tool.

Adjustments for Two-Channel Audio Board Systems

To set the input level during digitizing for two-channel audio board 
systems:

1. Click the Input button (microphone icon) to display the input level 
slider. 

2. View the meters and adjust the slider to the appropriate level.

Input slider
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Creating Tone Media

Early releases of the Avid Composer products allowed you to set up 
your own custom calibration tone for output to tape. You can now cre-
ate your own tone media and master clips for editing directly into 
sequences.

To create tone media:

1. Open a bin.

2. Choose Create Tone Media from the Peak Hold pop-up menu in 
the Audio Tool.

A dialog box appears.

3. Set the appropriate calibration tone parameters for the project. You 
can also use the default output tone of Ð14 dB (digital scale) with a 
1000-Hz signal. 

n If you set the tone media frequency to 0, the system generates random noise.
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4. Choose a target bin for the tone master clip and a target disk for 
the tone media from the pop-up menus.

5. Click OK.

After a few seconds, the media Þle is created and a master clip 
appears in the target bin. The default name reßects the options 
you selected. You can rename the clip by typing a new name.

Using the Console to Check Audio Levels

Once you have played back audio through the Audio Tool, you can 
use the Console to view a list of precise information about the peak 
levels.

To check peak levels in the Console:

1. Click the Reset Peak button to clear the systemÕs record of the 
most recent maximum peaks.

2. Open the Audio Tool and play a sequence or portion of the 
sequence.

3. After playing back the audio, open the Console by choosing Con-
sole from the Tools menu.

4. In the Console command line, type:

DumpMaxPeaks

5. Press Enter. 
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A list of peak values appears in the Console.

Preparing for Video Input

The Avid Composer system provides both a Video Output Tool and a 
Video Input Tool for calibrating either composite or component video. 

If your system is equipped with the serial digital video I/O board 
(used in place of the Betacam card) you can digitize material directly 
from a D1 or digital Betacam VTR without the need of calibration Ñ 
much like direct input of digital audio from DAT or CD.

To open either the Video Input or the Video Output Tool, choose one 
from the Tools menu.
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You can also open the Video Tools in Capture mode by clicking the 
Video Tools button at the lower right corner of the Digitize Tool.

For more information 
on calibrating for video 
output, see ÒCalibrat-
ing for Video OutputÓ 
on page 602.

Release 6.0 and later of Media Composer allow you to input and out-
put NTSC or PAL video in both composite and Betacam component 
formats without additional hardware, such as a transcoder. Direct 
input and output of Betacam component video allows you to maintain 
better image quality for online editing with Media Composer.

n Media Composer supports the SMPTE/EBU component standard, but does 
not support the MII component video standard.

This section provides essential information for input calibration. You 
should proceed as follows:

¥ Make sure your monitor is properly calibrated for displaying foot-
age accurately. See your monitorÕs hardware documentation for 
more information.

Video Input Tool Video Output Tool
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¥ If your systemÕs output settings have not already been calibrated 
according to house standards, use the procedures described in 
ÒCalibrating for Video OutputÓ on page 602. If you are in a facil-
ity where this is not necessary, leave the output settings at their 
preset values.

¥ If you are using footage in the NTSC/EIAJ format standard, dese-
lect the option NTSC Has Setup in the General Settings dialog box. 
This will enable the appropriate display for the setup portion of 
the signal in the Waveform monitor.

¥ Proceed to calibrate the input levels for each videotape when you 
digitize in order to ensure continuity of picture quality between 
tapes, as described in ÒCalibrating for Video InputÓ on page 177.

n If your system is equipped with the serial digital video I/O board for input 
from a D1 or digital Betacam VTR, you do not need to calibrate input signals. 
Proceed to Chapter 7.

Using the Factory Presets

The preset buttons on both the Video Input Tool and the Video Output 
Tool show the status of each calibration setting as follows:

¥ When you Þrst open the tools, all preset buttons are lit (green), 
with the factory presets loaded for each slider.
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¥ When you click a lit preset button, the button becomes unlit 
(gray), and the slider returns to the most recent manual level set-
ting.

¥ When you click an unlit preset button, it becomes lit (green), and 
the slider moves to the factory preset level for that parameter.

As you adjust levels in the tools, you can toggle the preset buttons 
between the levels you set manually and the factory preset levels.

Calibrating for Video Input

To calibrate for videotape input:

1. Choose Video Input Tool from the Tools menu. The Video Input 
Tool opens.

Video Input Tool Video Output Tool

Preset buttons

Preset buttons
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2. Choose the appropriate input channel from the Input menu: Com-
posite or Component.

3. Cue the tape to the section containing bars and tone (usually the 
beginning) and play the tape.

n Always play the tape when calibrating. Signal display is unstable when the 
tape is paused.

Choose either 
Composite or 
Component to dis-
play the correct 
controls and select 
the proper input 
channel.
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The third, full-screen monitor displays either of the following 
types of bars:

4. Open the internal Waveform monitor by clicking the icon located 
at the lower right of the tool.

SMPTE standard split bars

Full-field color bars

Full-field bars can 
be either 75% (max-
imum signal ampli-
tude as percentage 
of peak white) or 
100%.

Full-field bars 
(NTSC or PAL)

100% white 

7.5 black level 

Color bars

SMPTE bars 
(NTSC only)

(lines 16 to 182)

(lines 183 to 202)

(lines 203 to 263) 
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5. Adjust the Line Selector slider located below the Waveform moni-
tor to display the appropriate line of the test pattern, then adjust 
the luminance values based on Table 6-1.

NTSC waveform value s

PAL waveform values
(volts)

(IRE)

Black level at 7.5 IRE

White level at 100 IRE
(100% bars)

White level at 1 volt
(100% bars)

Black level at 0.3 volt

Line Selector

(White level at 77 IRE
(75% bars)

(Setup level falls at 0 IRE
for NTSC/EIAJ)
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6. Close the Waveform monitor, and open the Vectorscope monitor 
by clicking the Vectorscope button.

Table 6-1 Luminance Settings 

Parameter SMPTE bars Full-Þeld bars at 
75% signal level

Full-Þeld bars at 
100% level

NTSC/EIAJ

Black level (setup) Adjust Line Selector 
to approximately 
183

Adjust Line Selector 
to approximately 
150

Any line Any line

Adjust Black slider 
to 
7.5 IRE (NTSC)

Adjust Black slider 
to
7.5 IRE (NTSC), 
0.3 volt (PAL)

Adjust Black slider 
to
7.5 IRE (NTSC), 
0.3 volt (PAL)

Adjust Black 
slider to 
0.0 IRE

White level (gain) Adjust Line Selector 
to 203

Adjust Line Selector 
to 150

Adjust Line Selector 
to 150

Adjust Line Selec-
tor to 203

Adjust Gain/Y 
Gain slider to 
100 IRE (NTSC)

Adjust Gain/Y 
Gain slider to 
77 IRE (NTSC), 
0.825 volt (PAL)

Adjust Gain/Y 
Gain slider to 
100 IRE (NTSC), 
1.0 volt (PAL)

Adjust Gain/Y 
Gain slider to 
92.5 IRE (NuVista 
card systems) or 
100 IRE (ABVB 
card systems)



182

7. Adjust the Line Selector to display the signal for color bars at 
around line 150 (this applies to all formats and all types of bars). 

8. Adjust the Sat and Hue sliders (composite) or the RY Gain and BY 
Gain sliders (component) until the angle and amplitude of the six 
color vectors fall within the target boxes on the vectorscope.

n There is no hue adjustment for PAL video.

Saving Settings

You can also color cor-
rect shots by applying 
the Color effect to seg-
ments in the Timeline 
and making adjust-
ments in Effect mode. 
For more information, 
see the Avid Media Com-
poser and Film Composer 
Effects Guide.

You can save the settings for an individual tape each time you cali-
brate bars.   For example, you can have one or a series of shots that 
require color correction (the shots are dark, too bright, or were not shot 
with the proper color balance or Þltering). You can make corrections 
by using the Video Input Tool now, or at any time during or after edit-
ing in order to match shots in the sequence.

Vectorscope button
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To save the calibration settings for an entire tape:

1. After calibrating as described in ÒCalibrating for Video InputÓ on 
page 177, choose Save As from the Settings pop-up menu. The 
Save As dialog box appears.

2. Type a name for the settings.

3. Click OK.

n If you give the settings the same name as the tape name, Media Composer will 
apply the settings automatically when that tape is loaded into the deck in the 
future (for example, when redigitizing).

Whenever you batch digitize or redigitize, the system recalls the saved 
settings as follows:

¥ The system looks for a tape setting.   If the setting exists, the sys-
tem recalls it.

¥ If no tape setting exists, the system uses the default Video Input 
Tool settings.

Saving a Default Video Input Setting

Each time you insert a new tape into the VTR, the Video Input Tool 
reverts to its default settings for composite input, and the Settings 
pop-up menu displays the name ÒUntitled.Ó

Use the following procedure to save your own custom default setting 
for the current project Ñ for example, if you want the Video Input Tool 
to display a set of calibrations for component video each time you put 
in a new tape.

n The default setting for the Video Input Tool is a project setting. You must cre-
ate a new default setting for each project.

To save a new Video Input setting default:

1. (Option) Insert a tape into the VTR and cue up the bars.
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2. Choose Video Input Tool from the Tools menu.

The Video Input Tool opens.

3. Calibrate the default settings that you want to save.

4. Choose Save As from the Settings pop-up menu.

5. Type the name ÒDefault,Ó and click OK. 

n You must use the name ÒDefaultÓ for the setting, otherwise it will not func-
tion as the default. Capitalization does not affect it.

The system uses the default setting in the current project whenever 
you load a new tape that does not have its own setting.

Adjusting Video Levels by Eye

Color bars are the best way to set the video levels consistently. How-
ever, if you have a tape or series of tapes with no color bars, you might 
need to adjust levels by eye. To do this, use the following criteria:

¥ Blacks should not seem ßat and lacking detail. Find the blackest 
region of an image (shadows work better than black objects) and 
adjust the setup.

¥ Whites should not be washed out or lacking detail. Find the whit-
est region of an image (bright, well-lit regions work better than 
white objects) and adjust the gain.

¥ Skin colors should be realistic. Find a skin color and adjust both 
hue and saturation as necessary.

¥ Pure yellows should be a rich gold and not reddish or greenish in 
tone. Find a pure yellow and adjust both hue and saturation as 
necessary.
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Digitize Preparations Checklist

Make sure you have the options selected in the General Settings, Deck 
Settings, and Digitize Settings dialog boxes.

Check your hardware conÞgurations: power on switches, cable con-
nections, pulldown switch on the Video Slave Driver, and remote 
switch on the source deck for deck control.

Consider striping your drives in advance according to the AVIDdrive 
Utility UserÕs Guide if you are working on a complex project with mul-
tiple streams of video and high-resolution images.

Insert a tape into the deck and set up the Digitize Tool for track selec-
tion, target bin, target drives, source tape, and source deck.

Set up the Compression Tool for audio sample rate, AVR, detail and 
color compression, and frame rate.

Use the Audio Tool to set the audio input levels.

Use the Video Tool to set the video input levels for setup, gain, satura-
tion, and hue; save your video settings for future use.
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CHAPTER 7

Digitizing

When you digitize, you convert source material from videotape into 
master clips that contain reference information. You also create associ-
ated media Þles that contain the digital audio and video. Once you 
prepare the capture tools, as described in Chapter 6, you can digitize 
the source material in one of several ways, as described in the follow-
ing sections:

¥ Before You Begin

¥ Special Digitizing Procedures

¥ Digitizing and Logging at the Same Time

¥ Digitizing to the Timeline

¥ Batch Digitizing

¥ Redigitizing Your Material

¥ Using Editcam Media

Before You Begin

Depending upon your immediate needs, use the following guidelines 
for working through this chapter based on a chosen digitizing method:
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¥ If you want to use the Avid Media Reader, add locators, create 
subclips, or log errors to the console during digitizing, read ÒSpe-
cial Digitizing ProceduresÓ on page 187.

¥ If you have no logs and would like to begin digitizing right away, 
see ÒDigitizing and Logging at the Same TimeÓ on page 190.

¥ If you want to digitize video to multiple media Þles across multi-
ple drives, see ÒDigitizing to the TimelineÓ on page 199.

¥ If you have logs already entered in a bin and would like to auto-
mate the digitizing process with playback from an Avid-controlled 
deck, see ÒBatch DigitizingÓ on page 200.

¥ If you are redigitizing deleted media or have imported a sequence 
that lacks the associated media Þles, see ÒRedigitizing Your Mate-
rialÓ on page 205.

Preparing Digitize Bins

If you have not already prepared a structure of bins for your project, as 
described in ÒManaging Folders and BinsÓ on page 52, consider the 
following tips before digitizing:

¥ You can create one bin for each source tape. This helps to avoid 
slowing the system with large bins, associates each bin with a 
source tape for better organization, and simpliÞes redigitizing.

¥ You can name the bin after the tape, so that when you autodigitize 
or digitize on-the-ßy without noting a tape name, the system will 
automatically name each clip or take after the bin (tape) and num-
ber them sequentially for easy reference.

Special Digitizing Procedures

This section describes several optional procedures that you can use 
during the digitizing process.
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Using the Avid Media Reader

If your system has the 
Media Reader, see your 
Avid Media Reader Setup 
and UserÕs Guide before 
digitizing. If you are 
interested in learning 
more about the 
Media Reader, contact 
Avid for details.

The Avid Media Reader is a powerful and ßexible external standalone 
LTC/VITC timecode reader and encoder. It enables the Avid Com-
poser system to decode up to three lines of VITC (vertical interval 
timecode) or one line of VITC and one line of LTC (longitudinal time-
code) while digitizing. It automatically adds the information to the bin 
while creating subclips based on timecode breaks in any or all of the 
VITC lines.

Logging Errors to the Console

The Console is useful during the digitizing process for logging digitize 
errors, as described in ÒUsing the ConsoleÓ on page 101. 

To open the Console, choose Console from the Tools menu:

For more information 
on Digitize Settings, see 
the Avid Media Composer 
Products Reference.

¥ If the option ÒLog errors to the console and continue digitizingÓ is 
selected in the Digitize Settings dialog box, when you batch digi-
tize and the system encounters an error, it will abort the clip, enter 
error comments into the console, and continue digitizing the next 
clip.

¥ If the option ÒLog errors to the console and continue digitizingÓ is 
not selected in the Digitize Settings dialog box, an alert message 
will appear and the system will pause if an error occurs while dig-
itizing. If this happens, do the following:

a. Click Try Again to retry the operation. The clip might digitize 
successfully. 

b. If the clip does not digitize the second time you try, the error 
message appears again. Click Next Clip to skip the clip that 
caused the error, and continue batch digitizing any remaining 
clips, or click Abort to cancel the entire batch digitize process.
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c. Make note of all errors, messages, and steps that youÕve taken 
and decide whether to troubleshoot the problem on your own 
or contact Avid Customer Support.

Creating Subclips On-the-Fly

For information about 
creating subclips after 
digitizing, see ÒCreat-
ing SubclipsÓ on 
page 353.

Subclips are marked sections of a longer master clip that you can view 
and edit like any other object in a bin. This section describes a shortcut 
method for creating subclips on-the-ßy during digitizing. The maxi-
mum number of subclips you can generate while digitizing a clip is 50.   

To create a subclip on-the-ßy:

1. Start digitizing as usual.

2. At the point where you want to begin the subclip, press the F1 key.

This highlights the subclip IN mark in the Digitize Tool.

3. While the system is digitizing, you can enter a name for the sub-
clip by typing the name. Press the Tab key to enter comments 
about the clip.

4. When you want the subclip to end, press the F2 key. This high-
lights the subclip OUT mark in the Digitize Tool. 

n You can press the F2 key repeatedly as you search for the end point of the sub-
clip. The system accepts the last occurrence as the end point. You can also 
press the F1 key at anytime before pressing F2 again to remove the previ-
ous subclip marks and start a new subclip IN point.

The subclip appears in the target bin when you press the F1 key 
again to mark another subclip, or when you stop digitizing.

As you continue to mark subclips while digitizing, a number 
appears between the subclip indicators to show the number of 
subclips created so far.

Subclip
status
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Adding Locators On-the-Fly

For more information 
on speciÞc uses for loca-
tors, see ÒUsing Loca-
torsÓ on page 355. 

Locators mark a single frame within a clip or sequence so that you can 
attach a note or Þnd the frame at a later time.   This section describes a 
shortcut method of adding locators on-the-ßy while digitizing.

To add a locator to a frame while digitizing, watch the playback of the 
footage in the Edit monitor and press the F3 key when you see the 
appropriate shot or frame.

Adding Comments On-the-Fly

The Avid Composer systemÕs annotate feature allows you to type com-
ments during the digitizing of a clip. These comments are saved in the 
clip Comments column in the bin.   You can add comments about such 
things as color correction or directions for editing.

n To carry your comments over to the sequence so that they will appear in the 
Timeline, in EDLs, or in cut lists, you must add the comments again when 
creating the sequence by using the Add Comments command in the Monitor 
menu.

To add comments on-the-ßy, start typing at any time during the digi-
tizing of a clip. The annotate window opens on screen, allowing you to 
see the text as you type. You cannot edit the text until after the digitiz-
ing is complete, but you can backspace and retype the information.

Digitizing and Logging at the Same Time

When you digitize without entering log information in a bin ahead of 
time, the system creates clips and associated media Þles while you dig-
itize. Digitizing in this manner involves manually cueing source foot-
age with an Avid-controlled deck, using the deck controls in the 
Digitize Tool.
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There are several ways to digitize and log at the same time:

¥ Digitizing from a mark IN to a mark OUT. This method lets you 
specify the exact timecode location to begin and end digitizing. 
You can also specify only a mark IN or mark OUT, and enter the 
other mark on-the-ßy. These procedures are described in ÒDigitiz-
ing from a Mark IN to a Mark OUTÓ on page 191.

¥ Digitizing on-the-ßy. This method is easier than setting marks, 
but it is more imprecise. It involves using the deck controls in the 
lower left corner of the Digitize Tool to cue, play, and stop the 
source footage manually while digitizing. These procedures are 
described in ÒDigitizing On-the-FlyÓ on page 193.

¥ Autodigitizing. This method requires the least amount of supervi-
sion and effort, but usually calls for more digitizing time and disk 
storage space. It involves playing each source tape from a cue 
point near the beginning and letting the system digitize the entire 
tape, automatically naming and entering each cut into the bin. 
These procedures are described in   ÒAutodigitizingÓ on page 196.

Two additional techniques you can use when digitizing and logging at 
the same time are described in ÒDigitizing from a Non-Avid-Con-
trolled DeckÓ on page 197 and ÒDigitizing with Timecode-of-Day 
TimecodeÓ on page 198.

Digitizing from a Mark IN to a Mark OUT

Digitizing from a mark IN to a mark OUT lets you specify exactly 
where to begin and end digitizing. You can specify only a mark IN or 
mark OUT, and the system enters the other mark on-the-ßy. Use this 
method in the following circumstances:

¥ If logs exist in written or printout form but not in the proper for-
mat for quick import into the system

¥ If the IN and OUT marks are rough and need to be 
double-checked for accuracy 
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¥ If you are familiar enough with the source material to estimate the 
timecode for the mark IN, the mark OUT, or both, quickly and 
accurately

Setting Both Marks

To digitize by specifying a mark IN and a mark OUT:

1. Set either an IN mark or an OUT mark for the clip you want to 
digitize, using either of the following methods:

¥ Use the deck controls in the Digitize Tool (or on the MUI or 
Steenbeck controller).   Cue your source tape to where you 
want to start or end the clip, and click the Mark IN or Mark 
OUT button.

¥ If the material starts at a known IN or ends at a known OUT, 
you can type the timecode in the display area next to the 
mark. Press Return to enter the mark.

To double-check the accuracy of the IN or OUT mark, click the Go 
to IN button. The system cues the tape and pauses the deck at the 
mark. You can play the tape and reset the mark, if necessary.

2. To Þnish logging the clip, use either of the following methods:

¥ Set the corresponding IN or OUT mark.

¥ Type a timecode for the clipÕs duration in the display area next 
to the Duration mark (below the OUT mark).

The system automatically calculates the appropriate timecode for 
the corresponding mark IN, mark OUT, or duration. 

3. Click the Record button in the Digitize Tool, or press the B key on 
the keyboard.

The Digitize Tool automatically rewinds the tape to the preroll 
point before the IN point of the clip, and the tape begins to play. 
The Record button becomes bright red, and the message bar dis-
plays the message that the Avid Composer system is digitizing.

Mark IN

Mark OUT
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4. While the system is digitizing, you can type a clip name. To enter 
comments about the clip, press the Tab key after typing a clip 
name. The information that you type does not appear on the 
screen until you have completed digitizing. (After you log clips, 
you can modify information to correct input errors or to add infor-
mation.)

When the tape reaches the clipÕs OUT point, digitizing stops and 
the system creates a new clip in the bin.

Setting Only One Mark

To set only one mark and enter the other mark on-the-ßy:

¥ Set an IN point and click the Record button to begin digitizing. 
Then, click the Record button again to stop digitizing on-the-ßy 
and set a mark OUT.

This method is useful if you donÕt need a precise mark OUT. You 
save time because you donÕt have to shuttle to locate the mark 
OUT before digitizing.

¥ Set a mark OUT only, then move to the position on the tape where 
you want to start digitizing. Click the Record button to begin digi-
tizing on-the-ßy. When the tape reaches the clipÕs OUT point, digi-
tizing stops.

This method is useful if you donÕt need a precise mark IN, but do 
need to stop at a precise OUT point, for example, just before a 
timecode break.

Digitizing On-the-Fly

If you are digitizing 
from a source that can-
not be controlled by the 
system, see ÒDigitizing 
from a Non-Avid-Con-
trolled DeckÓ on 
page 197 for additional 
steps.

Use the digitizing on-the-ßy method in any of the following circum-
stances:

¥ If you are eager to begin editing immediately and no adequate 
logs exist for importing into the system or setting marks 
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¥ If you are digitizing from a source deck that cannot be controlled 
by the Digitize Tool or a V-LAN VLXi unit

¥ If your source tape does not have timecode

¥ If you are digitizing from a digital source such as a CD or DAT 
player

¥ If you are digitizing from a live source, such as a studio feed, or an 
in-house router

n There is a slight delay of several frames after you manually select a spot both 
to start and to stop digitizing. Therefore, use this method when you do not 
need precise beginning and end points in your clip.

To digitize on-the-ßy:

1. Make sure you have selected the proper Digitize Settings and set 
up the capture tools, as described in Chapter 6.

2. Click the Digitize/Log Mode button on the left side of the Digitize 
Tool until the DIG icon appears.

3. Use the deck controls in the bottom left corner of the Digitize Tool 
to locate the position on the tape where you want to start digitiz-
ing.

4. To begin digitizing, play the deck and when it gets up to speed, 
click the red Record button. 

Fast forward/Rewind

Stop

 Pause

Play Shuttle Single-frame step

Eject
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n Make sure you have cleared any previous marks so that the deck does not 
begin cueing to the previous location.

Digitizing begins within a few frames, and the timecode for the 
clipÕs IN point appears. The horizontal LED above the Record but-
ton ßashes on and off. The title bar displays a message that your 
Avid Composer system is digitizing.

5. While the system is digitizing, you can type a clip name. The 
Annotate window appears with the new clip name typed into the 
Name Þeld. 

If you want comments 
to appear in EDLs or cut 
lists, add them during 
editing by using the 
Add Comments com-
mand from the Monitor 
menu. For more infor-
mation, see ÒAdding 
Comments to Sequence 
ClipsÓ on page 392.

6. Press the Tab key after typing a clip name to enter comments 
about the clip. You cannot edit the text during digitizing, but you 
can backspace to retype the comments.

7. Click the Pause button at any time to pause play. You can also 
abort the digitize procedure by clicking the Trash button. The clip 
will be discarded.

8. To stop digitizing and enter the OUT point of the clip, click the 
Record button, or press the Escape key on the keyboard.

The system creates a new clip in the bin. It also enters basic log 
information for each clip, consisting of the mark IN, the mark 
OUT, the duration, and any other information typed in during the 
digitize procedure.

9. If you did not enter a clip name while digitizing, type it now while 
the clip name is highlighted in the bin. If you return to the Digitize 
Tool and begin another clip, the default clip name remains in the 
bin until you change it.

In some circumstances, the digitized material might exceed the logical 
Þle size of the Avid Composer application. For example, the maximum 
size of a media Þle cannot exceed the size of a 2-GB partition. A 2-GB 
Þle at a high resolution, such as AVR 71, consists of approximately 10 
to 18 minutes of footage. In such a case, consider digitizing the shot in 
shorter overlapping pieces, breaking it at points that are likely to be 
cut out during editing.
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Autodigitizing

Autodigitizing can save you time by allowing you to bypass both the 
logging process and the time it takes to cue each shot. However, this 
process requires the most storage space, and more time is spent while 
the system is actually digitizing entire reels.

n This process is for tapes shot with starting and stopping timecode and no 
control track breaks (where snow appears between shots).

When you autodigitize, you mount and cue your tape to a starting 
point and launch the digitizing process through the Digitize Tool. If 
you follow the tips and techniques described in this section, you can 
allow the system to complete the digitizing process unattended.

The following tips apply to autodigitizing entire reels:

¥ Select the ÒDigitize across timecode breaksÓ option in the Digitize 
Settings dialog box prior to digitizing. For more information, see 
the Avid Media Composer Products Reference.

¥ Select the ÒLog errors to the console and continue digitizingÓ 
option in the Digitize Settings dialog box. For more information, 
see the Avid Media Composer Products Reference.

¥ Under Deck Settings, turn off the Fast Cue option and set the pre-
roll to approximately 4 seconds. For more information, see the 
Avid Media Composer Products Reference.

¥ You should have accurate notes on the number and content of takes 
on each reel to identify the content of each clip when necessary.

To autodigitize:

1. Create one bin for each reel. This keeps bins to a manageable size 
and automatically names all clips from each reel after the name of 
their respective bins.

2. Name each bin after the source reel number: by default all clips are 
named after the reel and numbered incrementally beginning with 
the sufÞx .01.
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3. Enter Capture mode from the Bin menu and open the bin for the 
Þrst reel.

4. Load the source tape and cue past any false starts.

5. Play the tape, and wait 4 seconds before clicking the Record but-
ton.

When you have long continuous shots (for example, footage from a 
live event), the digitized material for a single clip might exceed the 
logical Þle size of the Avid Composer application. For example, the 
maximum size of a media Þle cannot exceed the size of a 2-GB parti-
tion. In such cases, consider digitizing the shot in shorter overlapping 
pieces, broken at points that are likely to be cut out during editing. For 
more information, see ÒDigitizing to Multiple Media FilesÓ on 
page 152.

c The Avid Composer system can digitize across timecode breaks and 
control track breaks, but it cannot digitize across breaks in the 
recording (that is, if the recorded footage breaks up into noise 
between shots). If such breaks in recording exist on your tape, con-
sider using the methods described in ÒDigitizing On-the-FlyÓ on 
page 193.

Digitizing from a Non-Avid-Controlled Deck

If you have a deck that cannot be controlled directly by the system, 
you can digitize with manual deck control as follows:

1. Enter Capture mode and set up the tools.

2. Click the Deck Ofßine button in the Digitize Tool to disable the 
deck controls and leave only the Source Tape Name display.

n The TC button also disappears. The footage will be digitized with timecode-of-
day generated by the system.
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3. Click the Source Tape Name display to open the Tape Name dialog 
box and identify the source tape.

4. Play the tape manually and click the Record button to stop and 
start the digitizing of each clip.

Digitizing with Timecode-of-Day Timecode

When you digitize with an Avid-controlled deck, you can digitize your 
footage with timecode-of-day rather than source timecode.

To digitize with timecode-of-day timecode:

1. Enter Capture mode and set up the tools.

2. When selecting tracks, deselect the TC button.
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3. Digitize by using any of the techniques described in ÒDigitizing 
On-the-FlyÓ on page 193.

Digitizing to the Timeline

You can digitize footage directly from tape into a sequence loaded in 
the Timeline in one step, bypassing several steps such as organizing 
and reviewing clips, marking edit points, and performing edits. 

To digitize to the Timeline:

1. Prepare for digitizing by using standard procedures. For more 
information, see Chapter 6.

2. Load a sequence into the Record monitor.

3. Mark an IN point in the sequence or place the blue position indica-
tor where you want the edit to take place.

4. Mark the source material that you want to digitize by using the 
Digitize Tool logging controls. For information on setting marks in 
the Digitize Tool, see ÒDigitizing and Logging at the Same TimeÓ 
on page 190.

5. (Option) You can mark an OUT point based on the following:

¥ If you are digitizing to the middle of a sequence in the Time-
line, mark both IN and OUT points for frame accuracy.

¥ If you are digitizing onto the end of a sequence, you can mark 
just an IN point and then mark the OUT point later on-the-ßy.

6. Click the Splice-in button or the Overwrite button in the Digitize 
Tool to choose the type of edit.
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7. Click the red Record button to begin digitizing.

8. If you did not mark the OUT point in advance, click the Record 
button again when the footage reaches the appropriate frame. 

n If you already marked an OUT point, digitizing will stop automatically.

When digitizing ends, the clip appears in place in the sequence, 
and a master clip appears in the bin.

Batch Digitizing

You can also use the 
batch digitize process to 
redigitize existing clips. 
The redigitizing pro-
cess is described in 
ÒRedigitizing Your 
MaterialÓ on page 205.

Once you have imported a log or manually logged a group of clips 
into a bin, you can automate the digitize process by using the Avid 
Composer systemÕs batch digitizing capabilities. To batch digitize, 
source tapes must have timecode.

Preparing to Batch Digitize

Preparing for batch digitizing involves optional procedures for resiz-
ing the Digitize Tool, and establishing settings that allow you to batch 
digitize with a minimum of supervision.

Logging controls

Click the Splice-in 
button or the Over-
write button.
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Resizing the Digitize Tool

Because your clips are already logged in the bin, you can simplify the 
interface during batch digitizing by hiding the deck controller and log-
ging window in the Digitize Tool.

To resize the Digitize Tool during batch digitizing, click the zoom box 
in the upper right corner of the tool.

Preparing Settings for Unattended Batch Digitizing

Unattended batch digitizing allows you to digitize a large number of 
clips with a minimum of supervision by selecting Digitize Settings that 
avoid a pause in the digitize process. 

For more information 
on all Digitize Settings, 
see the Avid Media Com-
poser Products Reference.

To prepare for unattended batch digitizing, select the following 
options in the Digitize Settings dialog box:

¥ Log errors to the console and continue digitizing

¥ Switch to the emptiest drive if current drive is full

¥ Digitize across timecode breaks
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c You cannot batch digitize clips that contain timecode breaks 
between the logged IN and OUT marks.   Also, you cannot digitize 
across breaks in the recording (that is, if the recorded footage breaks 
up into noise between shots). If such breaks in recording exist on 
your tape, consider using the methods described in ÒDigitizing On-
the-FlyÓ on page 193.

Starting the Batch Digitize Process

To batch digitize clips:

1. Make sure you have selected the proper Digitize Settings and set 
up the capture tools, as described in Chapter 6.

2. Open the bin that stores the logged clips.

3. Select the clips to batch digitize:

¥ Choose Select All from the Edit menu, or press kÐA to select 
all the clips.

¥ Shift-click to select speciÞc clips.

4. Choose Batch Digitize from the Clip menu. A dialog box appears.
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n If the logged clips that you want to batch digitize are not highlighted in the 
active bin, Batch Digitize is dimmed in the Clip menu.

5. Select options in the dialog box:

¥ If the bin contains some clips that are already digitized and 
you do not want to redigitize those clips, select the option 
ÒDigitize only those items for which media is currently 
unavailable.Ó If this option isnÕt selected and some of the 
selected clips have media Þles, the system deletes the media 
Þles and redigitizes new media Þles.

For more information 
on handle lengths when 
redigitizing, see 
ÒRedigitizing 
SequencesÓ on 
page 206.

¥ If your selections include a sequence for batch digitizing, the 
dialog box prompts you for handle length information, 
because the system will create new master clips based on the 
length of edited clips in the sequence.

n If you are batch digitizing the original source master clips used in the 
sequence, the sequence will automatically be updated. Therefore, you might 
want to deselect the sequence during this procedure.

Handle length options 
appear only when a 
sequence is selected.
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6. Click OK.

If you havenÕt loaded a tape, the system prompts you to insert the 
Þrst tape.

7. Insert the tape into the tape deck and click Mounted.

A conÞrmation dialog box appears.

8. Click OK to conÞrm the tape and deck entries and begin the digi-
tizing process. The system digitizes each clip from the tape, in start 
timecode order. 

9. If the system needs another source tape, the system prompts you 
for the tape. At this point you have several options:

¥ Insert the new tape and click Mounted to continue the digitiz-
ing process.

¥ Click Skip this clip to skip just the Þrst clip from the tape and 
continue digitizing the remaining clips.

¥ Click Skip this tape to skip all the clips from the mounted 
tape. The system then prompts you for the next tape.

¥ Click Abort to end the batch-digitizing process. You can also 
stop digitizing at any time by clicking the Trash button in the 
Digitize Tool.

n To skip speciÞc clips in the process of batch digitizing a particular tape, you 
must abort each clip manually by clicking the Trash button, then click next 
clip in the Abort window to continue.
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10. When the system has Þnished batch digitizing, a dialog box noti-
Þes you that the process is complete.

Redigitizing Your Material 

Redigitizing is the process of capturing previously digitized source 
footage based on existing clips and sequences. Redigitizing uses the 
batch digitize process and does not require extra logging time because 
the clip information for such things as source tracks, timecodes, and 
compression settings already exists in the bin.

There are several situations in which you might want to redigitize:

¥ You can quickly redigitize selected clips if you make an error 
while digitizing the Þrst time (for example, if you forget to check 
audio levels or set the correct AVR).

¥ You can redigitize clips if you accidentally delete media Þles.

¥ You can redigitize a sequence after you transfer it to another sys-
tem.

¥ You can redigitize low-AVR clips at a higher AVR setting after they 
have been edited into a sequence.

c Redigitizing requires your original source footage. Do not delete the 
media Þles if the source footage is no longer available, unless you 
will not need the material again.

For information on loading the media database to relink clips, see 
ÒLoading the Media DatabaseÓ on page 279.

Redigitizing Master Clips and Subclips

The procedure for redigitizing master clips and subclips is identical to 
the process for batch digitizing logged clips. See ÒBatch DigitizingÓ 
on page 200.
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Although the procedure is the same, the result is slightly different, as 
follows:

¥ Master clips are linked to entire media Þles and serve as sources 
for subclips and sequences. Therefore, when you redigitize a mas-
ter clip, changes in compression settings and levels affect all sub-
clips and sequences created from the master clip.

¥ Subclips are smaller sections of master clips. When you redigitize 
a subclip, the system creates a new, smaller master clip that is 
linked to new media Þles and reßects the shortened length of 
material. Therefore, redigitizing subclips streamlines the digitize 
process.

Also, redigitizing breaks the link from the subclip to the original 
master clip.   But if you edit the subclip into a sequence, the 
sequence will reßect any changes in the newly digitized subclip.

Redigitizing Sequences

Redigitizing a sequence creates new master clips and associated media 
Þles based on the length of each shot edited into the sequence. It 
breaks any links to the original source clips, and only the sequence and 
its new master clips are linked to the newly digitized media Þles. 
Redigitizing a sequence can involve any of the procedures described 
in the following sections.

Saving Two Versions of a Sequence When Redigitizing

To save the original version of your sequence before redigitizing, you 
can create a duplicate. For example, use this method if you create a 
sequence at a low AVR to save storage space and want to redigitize the 
sequence at a higher AVR while retaining the Þrst version.   This is rec-
ommended if you intend to use the Decompose feature.

To make a duplicate of the sequence:

1. Select the sequence in the bin and choose Duplicate from the Edit 
menu.
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2. Create a new bin by choosing New Bin from the File menu and 
move the duplicate sequence into the bin. This step is optional, but 
saves you the confusion of mingling new sequences and master 
clips with existing ones, especially when using Decompose.

Using Decompose When Redigitizing

Decompose creates new master clips in the bin for each shot in the 
sequence prior to redigitizing. Decompose allows you to create new, 
shorter master clips based only on the material you have edited and 
included in your sequence, which saves system memory. Using 
Decompose gives you greater control during the redigitizing process. 
You can use this procedure to sort clips in the bin, modify them, and 
then redigitize selected clips in the sequence.

To use Decompose:

1. Activate the bin that stores the sequence.

2. Choose Decompose from the Clip menu. 

The Decompose dialog box appears.
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3. If you want to preserve clips that already have existing media 
Þles, select the option ÒDecompose only those items for which 
media is currently unavailable.Ó Deselect this option if you plan to 
decompose and redigitize the entire sequence.

4. Click the Handle Length box and type the number of additional 
frames you want to digitize at the heads and tails of the new mas-
ter clips. This provides enough overlap for trimming and adding 
transition effects.

c If you attempt to trim or add effects with no handles, you will get an 
error message notifying you that there is ÒinsufÞcient media.Ó

5. Click OK. The new master clips appear in the bin. You can now 
sort and select these clips like all other objects in the bin.

6. Proceed with the redigitizing procedures described in ÒRedigitiz-
ing the Sequence.Ó

Redigitizing the Sequence

When you redigitize the sequence without using Decompose, the digi-
tize process creates media Þles for each shot in the sequence during 
the digitizing process. Skipping the Decompose procedure saves only 
a small amount of time, and you cannot make changes after the media 
Þles are created without repeating the entire procedure. Therefore, 
review ÒUsing Decompose When RedigitizingÓ on page 207 before 
proceeding.

To redigitize a sequence:

1. Choose Go To Capture Mode from the Bin menu.

2. Open or activate the bin that stores the sequence or decomposed 
clips.

3. Select one or more sequences, or the decomposed clips you want:

¥ Choose Select All from the Edit menu to select all the clips in 
the bin.
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¥ Shift-select speciÞc clips.

4. Choose Batch Digitize from the Clip menu. The Batch Digitize dia-
log box appears.

5. To preserve clips that already have existing media, select the 
option ÒDigitize only those items for which media is currently 
unavailable.Ó Deselect this option if you plan to redigitize the 
entire sequence.

6. Click the Handle Length box and type the number of additional 
frames you want to digitize at the heads and tails of the new mas-
ter clips. This provides enough overlap to allow for trimming and 
transition effects.

c If you attempt to trim or add effects with no handles, you will get an 
error message notifying you that there is ÒinsufÞcient media.Ó

7. Click OK. The system prompts you to insert the Þrst tape.

8. Insert the tape into the tape deck if you have not already done so.

9. Click Mounted to indicate to the system that the correct tape is 
loaded and ready for digitizing.
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A conÞrmation dialog box appears.

10. Click OK to conÞrm the tape and deck entries. The system digi-
tizes each clip from the tape, in start timecode order. If another 
source tape is needed, the system prompts for the tape.

11. You can stop the Batch Digitize process at any time by clicking the 
Trash icon in the Digitize Tool. 

When batch digitizing is Þnished, an alert box notiÞes you that the 
process is complete. The new master clips appear in the bin, and 
associated media Þles exist on the targeted drive or drives.

Using Editcam Media

For more information 
about setting up and 
using the Avid Desktop 
FieldPak Adapter, see 
the Avid Desktop Field-
Pak Adapter Setup and 
UserÕs Guide.

The Media Composer products support media captured in AVR 70 
and AVR 75 with an Ikegami Editcam. The Editcam is a Digital News 
Gathering (DNG) camera. You access Editcam media from an Avid 
FieldPak¨ loaded into an Avid Desktop FieldPak Adapter connected 
to the Avid Composer system.

Acquiring Editcam Clips

There are two ways to acquire Editcam clips from an Avid FieldPak 
that is loaded into an Avid Desktop FieldPak Adapter:

¥ Use the import procedure to import master clips or sequence play-
lists into a bin, as described in Chapter 8.

n To read about import speciÞcations for Editcam media, see the Avid Media 
Composer Products Reference.

¥ Use the Media Tool to copy Editcam master clips from the 
FieldPak into a bin, as described in ÒUsing the Media Tool to 
Copy Editcam Master ClipsÓ on page 211.
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n You cannot rename, delete, or overwrite the clips on the FieldPak with the 
Avid Composer system and adapter.

Using the Media Tool to Copy Editcam Master Clips

You can use the Media Tool to copy Editcam master clips from the 
FieldPak to the Avid Composer system. 

To copy Editcam master clips from a FieldPak by using the Media 
Tool:

1. Insert the FieldPak into the Desktop FieldPak Adapter.

2. Launch the system and open your project.

3. Open the bin in which you want to store the Editcam clips.

4. Choose Media Tool from the Tools menu. 

The Display Media Selector dialog box appears.

5. Select Other Projects and Digitized Master Clips.

6. Click OK. The Media Tool window opens.

7. Choose Custom Sift from the Media Tool Fast menu. 

The sift dialog box appears.

8. Enter a search criteria to list just the clips on the FieldPak:

a. Type the name of the FieldPak in the box next to Òcontain.Ó

n The FieldPak icon on the desktop is named AV with a 6-digit number 
(AVnnnnnn).

b. Choose Disk from the adjacent pop-up menu.

c. Click OK.

Only the clips on the FieldPak are displayed in the Media Tool 
window.
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9. Select clips in the Media Tool window and drag them into the 
open bin.

The bin now contains master clips from the FieldPak media Þles that 
you can edit with the Avid Composer system.
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CHAPTER 8

Importing Files

The Media Composer products support numerous Þle types. For a 
complete list, see the Avid Media Composer Products Reference. The fol-
lowing sections describe how to import Þles:

¥ Preparing to Import Files

¥ Importing Mixed-Resolution Projects

¥ Using Global Import Settings

¥ Importing Files

Preparing to Import Files

Before you begin the import process, make sure the system and the 
Þles are ready for import as follows: 

¥ To read about issues and tips for mixed-resolution projects, see 
ÒImporting Mixed-Resolution ProjectsÓ on page 214.

¥ Before importing complex graphics and animation, check Render 
settings to determine the correct softening parameters that can 
affect import of large Þles. For more information, see the Avid 
Media Composer and Film Composer Effects Guide.
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¥ For graphics Þle import, prepare the Þles in advance according to 
speciÞcations described in the Avid Media Composer Products Refer-
ence.

¥ For QuickTime¨ import, prepare the Þles in advance according to 
speciÞcations described in the Avid Media Composer Products Refer-
ence.

¥ For OMF¨ Þle import, prepare the Þles in advance according to 
speciÞcations described in the Avid Media Composer Products Refer-
ence.

¥ For a complete description of all options in the Import Settings 
dialog box, see the ÒFile Format SpeciÞcationsÓ chapter of the Avid 
Media Composer Products Reference.

Importing Mixed-Resolution Projects

For more information 
on resolutions, see the 
Avid Media Composer 
Products Reference.

Beginning with Release 6.0 of the Media Composer products, you can 
work with mixed resolutions in the same sequence. This feature allows 
you to import graphics that will accompany video at the highest reso-
lution you will be using.

For example, assume that you want to use a low resolution such as 
AVR 12 for your initial work and then redigitize your media at AVR 77 
for the Þnal version. In this case, you should import the graphics at 
AVR 77. Then when you redigitize your material, you will not have to 
reimport the graphics.

If you plan to redigitize your media at a higher AVR, the lower AVR 
must be from the same family (single-Þeld or two-Þeld). For example, 
if you plan to Þnish at AVR 77, you could start the project at AVR 12, 
but not 6s.
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Using Global Import Settings

You can establish a set of global import parameters in the Import Set-
tings dialog box prior to beginning the import process. These parame-
ters remain the default settings for all imported Þles, unless you 
change them during import. This is especially useful when you batch 
import a number of Þles in one procedure.

To adjust options in the Import Settings dialog box, double-click 
Import in the Settings scroll list of the Project window.

Importing Files

When you import source shot logs, graphics, animation, audio, 
QuickTime, or OMFI (Open Media Framework¨ Interchange) Þles, the 
system converts them into objects in a bin. You can manipulate and 
edit these objects as you would any other clip or sequence. Any corre-
sponding media Þles are stored on a target drive that you specify.
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You can access Þles for import from any folder or drive source 
mounted on the desktop, such as a 3.5-inch diskette, Þxed drive, 
removable magnetic (RMAG) drive, or network server. You can import 
more than one Þle at a time, including Þles of multiple types.

To import Þles:

1. Open the bin in which you want to store the imported Þles. Click 
anywhere in the bin to select it.

2. Choose Import from the File menu.

The Select Files to Import dialog box appears.

Source file list

Media Disk pop-up menu

Import file list

File Type pop-up menu

Directory pop-up menu

Resolution pop-up menuOptions button
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3. Choose an import Þle type from the File Type pop-up menu:

¥ Choose Shot Log to import ASCII text or Avid Log Exchange 
(ALE) Þles containing clip information into a bin. For more 
information about Avid Log Exchange speciÞcations, see the 
Avid Media Composer Products Reference.

¥ Choose Graphic/Audio to import one of more than 30 sup-
ported graphics and audio Þle types. For more information on 
the various Þle types and their import speciÞcations, see the 
Avid Media Composer Products Reference.

¥ Choose OMFI to import Þles that have been saved in the 
OMFI Þle format, such as sequences transferred from an 
effects or digital audio workstation.

¥ Choose Editcam to import master clips captured with an Ikeg-
ami Editcam. You can also import a sequence playlist. For 
more information, see ÒDigitize Preparations ChecklistÓ on 
page 185.

By default, the system displays Þle types that belong to the chosen 
category only in the source Þle list on the left side of the dialog 
box.

4. (Option) Select the option Show All Files in the lower left corner of 
the Select Files to Import dialog box to display all Þles in a chosen 
folder, regardless of Þle type. Use this option if you want to batch 
import from multiple Þle types.

n When you batch import multiple Þles and Þle types, you should establish 
global import settings in advance. See ÒUsing Global Import SettingsÓ on 
page 215.
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5. Click the Options button to open a dialog box for adjusting the 
import settings.

n The Import Settings dialog box contents depend on the Þle type selected.

6. Select the appropriate options. Click OK to close the Import Set-
tings dialog box and return to the Select Files to Import dialog box.

7. Choose a destination disk for the imported Þle from the Media 
Disk pop-up menu.

8. For graphics and video Þles, choose a resolution for the imported 
media from the Resolution pop-up menu.

n For optimum speed when importing an OMF Þle, set the resolution to match 
the resolution of the OMF File you are importing. If you are using mixed res-
olutions, choose the highest AVR that you will be using for the Þnal version of 
the sequence. See ÒImporting Mixed-Resolution ProjectsÓ on page 214.

9. Use the Directory pop-up menu to locate the folder containing the 
source Þles.

10. Add Þles to or remove Þles from the import Þle list on the right, 
using the following methods:
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¥ To add a single Þle, select a Þle name in the source Þle list and 
click the Add button, or double-click the Þle name.

¥ To add all the Þles in the source Þle list, click the Add All but-
ton.

¥ To remove a single Þle from the import Þle list, select a Þle 
name and click the Remove button.

¥ To remove all the Þles from the import Þle list, click the 
Remove All button.

n If you are importing a sequential series of image Þles, you need to add only the 
Þrst Þle in the series to the import Þle list.

11. Click Done.

If you are batch importing OMF Þles at multiple resolutions with 
the OMFI Resolution: Ask Me option selected in the Import Set-
tings dialog box, a warning appears whenever the AVR of the 
source Þle does not match the current AVR setting in the Select 
Files to Import dialog box.

Choose either the AVR of the source Þle or the current AVR setting 
to continue.

When the system Þnishes importing the Þles, the clips appear in 
the selected bin.
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n If you import an OMF Þle with a stereo sound track, the Avid Composer sys-
tem creates a new master clip that contains the right channel of the sound 
track. The original master clip contains the left channel. Both clips appear in 
the bin you select.
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CHAPTER 9

Organizing with Bins

The Avid Composer system provides powerful database tools for 
organizing and managing your digitized material. You can view bins 
in three different display modes. You can rename, sort, sift, duplicate, 
and delete clips and sequences. You can also print out single clip 
frames or whole bins. A worksheet at the end of this chapter provides 
guidelines for using these techniques to create and print storyboards 
for your project. These topics are covered in the following sections:

¥ Before You Begin

¥ About Bin Display Modes

¥ Basic Bin Procedures

¥ Using Text Mode

¥ Using Frame Mode

¥ Using Script Mode

¥ Printing Bins

¥ Gathering Format Elements

¥ Storyboard Worksheet
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Before You Begin

There are several procedures you might want to perform before you 
begin organizing your project, because they affect the display of infor-
mation in bins or the way the clips play back during screening:

¥ If you digitized clips by using LTC (longitudinal timecode) 
recorded on an audio track, and would like to instruct the system 
to address this timecode during editing, see ÒUsing Audio Time-
codeÓ on page 222.

¥ If you would like to center the pan between left and right speakers 
for some or all of the clips in a bin, see ÒUsing the Center Pan 
CommandÓ on page 225.

¥ If you would like to customize the types of objects (clips, subclips, 
and so on) displayed in a bin, see ÒSetting the Bin DisplayÓ on 
page 226.

¥ If you digitized some of your video and audio clips separately, 
and need to synchronize them for editing, see ÒAutosyncing 
ClipsÓ on page 555.

¥ If you need to group or multigroup material, see ÒGrouping and 
MultigroupingÓ on page 582.

Using Audio Timecode

The Avid Composer system can read audio timecode (LTC or longitu-
dinal timecode recorded on an audio track). If you captured the LTC as 
an audio track during the digitizing process, use the Read Audio 
Timecode command. This instructs the system to address this track for 
timecode information to be displayed in the bins and used in editing.

To use timecode on an audio track:

1. In the bin, select the appropriate clips, then choose Read Audio 
Timecode from the Special menu. 

The Read Audio Timecode dialog box appears.
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2. To read timecode stored in the User Bits of the LTC, select User Bit 
Timecode. If this option is not selected, the system reads the LTC 
timecode.

c Information contained in the user bits of the LTC must be timecode 
only. Other data stored in the user bits will not appear in 
Media Composer unless you use the Avid Media Reader. For more 
information about the Avid Media Reader, contact your Avid sales 
representative.

3. Choose the audio track containing the timecode from the Audio 
Timecode Source pop-up menu. A1 is the default.

4. Choose the target auxiliary timecode bin column for recording the 
audio timecode from the Destination Track pop-up menu. Aux 1 is 
the default selection.

5. Select Fill Undecodeable Frames to instruct the system to Þll in 
any timecode breaks with continuing timecode. This is the default.

For example, in a 3-minute master clip, the audio timecode starts 
at 1:00:20:20. At 1:00:22:10, the timecode ends. With the Fill Unde-
codable Frames option selected, the system assigns 1:00:22:11 to 
the next frame and continues assigning timecode.
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Deselect this option if you do not want to Þll timecode breaks.

6. Click OK to complete the procedure. The timecode appears in the 
bin in the auxiliary timecode column that you chose.

Adjusting Pan Defaults

For information on 
using the Audio Mix 
Tool to adjust pan for 
individual clips in a 
sequence, see ÒUsing 
the Audio Mix ToolÓ 
on page 490.

The way your footage was recorded in the Þeld, and digitized in 
Media Composer, will affect the way sound pans between the speak-
ers. By default, the system pans audio tracks 1 and 3 to the left speaker 
output and pans tracks 2 and 4 to the right speaker output. 

You can set global pan settings before or during editing by using the 
Audio Settings dialog box and the Center Pan command, as described 
in this section. 

Adjusting Default Pan Settings

The Audio Settings dialog box provides options for adjusting the 
default audio pan when editing with new clips, and digital audio 
scrub parameters for monitoring and analyzing audio tracks and tran-
sitions.
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By default, the audio tracks for clips alternate with track 1 on the left 
and track 2 on the right speaker for monitoring and output. The All 
Tracks Centered option instructs the system to center the pan of all 
tracks between the two speakers for monitoring and output.

Using the Center Pan Command

You can use the Center Pan command on source material in bins. Use 
it prior to editing or at any time during the editing process.

As opposed to adjusting pan on individual clips by using the Audio 
Mix Tool, Center Pan allows you to create a standard distribution of 
audio between left and right speakers. You can adjust the pan on 
selected clips or all clips with a single command. This is especially use-
ful when you have clips with Þeld audio recorded (and subsequently 
digitized) variably between A1 and A2. Panning all of the audio to 
center eliminates the distraction of having to listen to left and right 
speakers in turn. It also smooths the playback of the edited sequence, 
with all shots panned to center.

To adjust the pan on clips:

1. In a bin, select the clips you want to pan to the center.

2. Choose Center Pan from the Clip menu. 

A dialog box appears and asks you to conÞrm the pan.

3. Click OK. The system pans all of the selected clips to the center.
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Setting the Bin Display

By default, your bins display all existing media objects except source 
clips and rendered effects. To reduce crowding in the bin and to dis-
play only those objects that you need to organize your project, you can 
display selected media objects.

To set the bin display:

1. Choose Set Bin Display from the Bin menu.

The Display Bin Selector dialog box appears.

Table 9-1 brießy describes the icons listed in the Display Bin Selec-
tor dialog box.
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2. Select the object types that you want to see: master clips, subclips, 
sequences, and so on.

3. The option ÒShow clips created by userÓ is selected by default. 
Deselect this option only if you want to hide all objects except 
those created by the system.

4. Select the option ÒShow reference clipsÓ to automatically display 
objects that are referenced by sequences in the bin, whether those 
clips were previously in the bin or not.

5. Click OK. The bin displays objects according to your speciÞca-
tions.

Table 9-1 Object Icon Descriptions

Object Icon Object Description

Master Clip
A clip that references audio and video media Þles 
formed from digitized footage or imported Þles.

Subclip
A clip that references a selected portion of a master 
clip.

Sequence
A clip that represents an edited program, partial or 
complete, that you create from other clips.

Source Clip
A clip that references the original videotape source 
footage for master clips.

Effect
A clip that references an unrendered effect that you 
create.

Motion effect
A Þle in the bin that references effect media Þles 
generated when you create motion effects.

Rendered effect
A clip that references an effect media Þle generated 
when you render an effect.

Multigroup clip
(For multicamera editing) A clip containing two or 
more grouped clips, strung together sequentially 
according to common timecodes.
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About Bin Display Modes

There are three display modes for viewing and working with clips in a 
bin: Text mode, Frame mode, and Script mode, as follows.

¥ In Text mode, clips are displayed in a database text format, using 
columns and rows, with icons representing the various objects. 
You can save various arrangements of columns, text, and objects 
as customized views. 

For information on spe-
ciÞc Text mode features, 
see ÒUsing Text ModeÓ 
on page 242.

To enter Text mode, click the Text Mode button (labeled T) in the 
lower left portion of the bin.

¥ In Frame mode, each clip is represented by a single picture frame, 
with the name of the clip. You can play back the footage in each 
frame, and change the size of frames. You can also rearrange the 
frames in any order within the bin.

Bin Fast menu

Text Mode button

Object icons

Bin View menu

Column headings
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For information on spe-
ciÞc Frame mode fea-
tures, see ÒUsing Frame 
ModeÓ on page 257.

To enter Frame mode, click the Frame Mode button (labeled F) in 
the lower left portion of the bin.

¥ In Script mode, the system combines the features of Text mode with 
Frame mode, and adds space for typing notes or script. The frames 
are displayed vertically on the left side of your screen with a text 
box to the right of each clip. Clip data is displayed above the text 
box. 

Clip frame

Clip name
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For information on spe-
ciÞc Script mode fea-
tures, see ÒUsing 
Script ModeÓ on 
page 261.

To enter Script mode, click the Script Mode button (labeled S) in 
the lower left portion of the bin.

Bin Fast Menu

All Bin menu commands are also available in the Bin Fast menu 
located in the lower left corner of every bin.

To open the Bin Fast menu, click the Fast Menu button in any of the 
three display modes.

Clip informationScript text box
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The Bin Fast menu is especially convenient when you are working 
with several open bins and need to access Bin menu commands 
quickly.

Basic Bin Procedures

There are some basic procedures that you can use in any of the three 
bin display modes for manipulating clips in the bin. These include 
selecting, deleting, duplicating, moving, copying, and sifting clips and 
sequences.

Setting the Bin Font

To change the bin font:

1. Choose Set Font from the Edit menu.

A dialog box appears.

2. Choose a font from the Font pop-up menu. 

Fast Menu button
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n Any font loaded in the Fonts folder in the Macintosh System Folder appears 
in the list.

3. Enter another point size for the font in the Size entry Þeld.

4. Click OK. The new font appears in all bin display modes.

Using the Clip Information Window

The Clip Information window displays statistical information about a 
clip. You can open the Clip Information window from a bin, Source 
and Record monitors, a pop-up monitor, or a script window. This win-
dow updates information automatically.

To open the Clip Information window from a bin, press the Command 
(k) key and click the clip for which you want to display information.

For information on displaying clip information from the Script win-
dow, see ÒDisplaying Clip Information in a Script WindowÓ on 
page 295. For information on displaying clip information from the 
Source, Record, or pop-up monitors, see ÒChanging the Sequence 
Clip InfoÓ on page 375.
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Moving the Clip Information Window

To leave the Clip Information window open:

1. While holding the mouse button down to display the Clip Infor-
mation window, move the cursor over the window.

2. Drag the window to a new location or another monitor.

An outline of the window appears. When you release the mouse 
button, the Clip Information window opens.

Copying Text from the Clip Information Window

You can cut, copy, and paste information from the Clip Information 
window anytime, but you cannot edit or change any information 
within the window.

To copy text from the Clip Information window:

1. Click and drag your cursor over the information you want to copy. 

2. Press kÐC to copy the information.

3. To paste the information, place and click your cursor at the loca-
tion you want to paste it and press kÐV.

Selecting Clips and Sequences

Use one of the following procedures to select clips in a bin:

¥ Click the clip or sequence icon (Text mode), or click the picture 
area of the clip or sequence (Frame mode).

¥ Select multiple clips or sequences by Shift-clicking additional 
items, or lassoing several clips.

To reverse your selection, choose Reverse Selection from the Bin menu. 
The clips that you previously selected are deselected and those clips 
that were previously deselected are selected.
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Duplicating Clips and Sequences

When you duplicate a clip or sequence, the system creates a separate 
clip linked to the same media Þles. You can move, rename, and manip-
ulate this clip without affecting the original clip.

To duplicate a clip or sequence:

1. Select the clip or sequence that you want to duplicate, or Shift-
select multiple clips.

2. Choose Duplicate from the Edit menu.

A copy of the clip or sequence appears in the bin, with the original 
clip or sequence name followed by the extension .Copyn, where n 
is the number of duplicates created from the original clip or 
sequence.

Moving Clips and Sequences

You can move clips and sequences to other bins in order to group and 
organize various types of material based on project needs.

To move clips or sequences from one bin into another:

1. Create or open another bin. Give the bin a name that represents its 
purpose or contents.

2. Position the bins so that you can see both of them at the same time. 
You might need to resize the bins to do this.

3. Select the clip or sequence that you want to move, or Shift-select 
multiple clips.

4. Drag the clips to the new bin.

n If the destination binÕs display has been set to show reference clips, the refer-
enced object types do not appear until you save the bin. For more information 
on setting the bin display, see ÒSetting the Bin DisplayÓ on page 226.



235

Copying Clips and Sequences

When you copy clips or sequences, you are essentially cloning the 
same clip or sequence in another bin. Any change you make to the 
copy will affect the original as well. The system does not add the 
.Copy extension to the clip or sequence as it does when duplicating. 
You cannot copy clips to the same bin, and you cannot return a clip 
copy to the same bin where the original resides.

To copy clips or sequences from one bin into another bin:

1. Position the bins so that you can see both of them at the same time. 
You might need to resize the bins to do this.

2. In the original bin, click the clip or sequence that you want to copy, 
or Shift-select multiple clips or sequences.

3. Press the Option key and drag the clips to the destination bin and 
release.

The clips appear in the new bin, displayed in the destination binÕs cur-
rent display mode (Script, Frame, or Text), and the originals remain in 
the Þrst bin. If the destination binÕs display has been set to show refer-
ence clips, the referenced object types do not appear until you have 
saved the bin.

When you copy clips from one bin to another, the custom columns that 
you created in the Þrst bin are also copied to the second bin. The cus-
tom columns appear in the order in which you created them.

Deleting Clips and Sequences

To delete clips or sequences from a bin:

1. Select the clips and sequences that you want to delete.

2. Choose Clear from the Edit menu or press the Delete key on the 
keyboard.

A dialog box displays information about the selected items.
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In this example, two subclips and two master clips (along with 
their media Þles) are highlighted for deletion. 

3.  Select the items highlighted for deletion. Do not select items you 
do not want to delete.

4. (Option) Delete the associated media Þles for master clips and 
effect clips. You can select clips and media Þles for deletion, or you 
can select only the media Þles if you want to retain the clips for 
later redigitizing.

5. Click OK.

A dialog box asks you to conÞrm the deletion.

6. Click Delete.

Sifting Clips and Sequences

When you sift clips, the bin displays only those clips that meet a spe-
ciÞc set of criteria. For example, you can do a custom sift to display 
only those clips containing the word Òclose-upÓ in the heading col-
umn. The custom sift dialog box provides you with six different levels 
of criteria.
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To sift clips and sequences:

1. Choose Custom Sift from the Bin menu.

The custom sift dialog box appears.

2. Move the cursor to the box containing the word Òcontain.Ó This is 
called the Operator menu box. Click and hold to display a pop-up 
menu.

3. Select one of the sifting options.

4. Click the Þrst Sift criteria Þeld and enter the text that you want to 
use as a sift criterion.

Operator menu Sift criteria field Column specification box

Pop-up menu
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5. Click the column pop-up menu and select a column heading to 
which you want to apply the criterion.

6. Enter additional sift criteria, and make additional column selec-
tions, as necessary.

Only the clips that meet your criteria remain in the bin, with the 
word ÒpartialÓ added to the bin name.

After you have sifted the clips in a bin, you can display the bin in a 
sifted or an unsifted state.

¥ To view the entire bin, choose Show Unsifted from the Bin menu.

¥ To view the sifted bin, choose Show Sifted from the Bin menu.

The word ÒpartialÓ after the bin name appears or disappears to indi-
cate the current state of the bin you are viewing.

Locking Items in the Bin

You can lock any item in the binÑincluding source clips, master clips, 
subclips, and sequencesÑto prevent deletion. When you lock clips in 
the bin, you lock their associated media Þles on your desktop as well.

To lock items:

1. Click a clip, subclip, or sequence to select it. Shift-select additional 
clips if necessary.

2. Choose Lock Bin Selection from the bottom of the Clip menu.
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For more information 
on displaying columns, 
see ÒAbout Bin ViewsÓ 
on page 243.

A lock icon appears for each locked clip in the Lock column of the 
default Statistics Bin view.

To unlock previously locked items:

1. Select the items in the bin.

2. Choose Unlock Bin Selection from the Clip menu.

n You can use the clip-locking feature along with archiving software such as 
Cheyenne to automatically archive all locked media Þles. For more informa-
tion on archiving locked Þles, see your archiving softwareÕs documentation.

Selecting Offline Items in a Bin

Ofßine items are clips, subclips, or sequences that are missing some or 
all of their original media Þles. 

To identify ofßine items, choose Select Ofßine Items from the Bin 
menu.

The bin highlights all items that are missing media Þles.

Lock icon
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Selecting Media Relatives for an Object

When you identify the media relatives of a selected clip or sequence, the 
system highlights all other clips linked to the selected clip, such as 
subclips or other sequences.

To identify media relatives:

1. Open the bin that contains the chosen clip or sequence.

2. Open any other bins that might contain the media relatives that 
you want to Þnd.

3. Resize and position the bins so that you can see their contents. 
Text mode is best for viewing as many objects as possible.

4. Select the chosen clip or sequence, and choose Select Media Rela-
tives from the Bin menu.

The system highlights all related objects in all open bins.

Selecting Sources Used by an Object

Use the Select Sources command to identify all of the sources used by 
a particular object. For example, if you select a sequence as the object, 
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you use the Select Sources command to identify every master clip, 
subclip, tape, and media Þle that is a source for that sequence.

To identify sources for a clip or sequence:

1. Select one or more objects in a bin.

2. Choose Select Sources from the Bin menu.

All sources for the selected objects in all open bins are highlighted.

Selecting Unreferenced Clips

When you select Unreferenced Clips, the system highlights all clips 
that are not currently referenced by clips or sequences that are present 
in the open bins. Any master clips, subclips, or effect clips you have 
edited into a sequence in the bin are not highlighted. This command is 
effectively the reverse of the Select Media Relatives command.

n The Unreferenced Clips command is useful for Þnding unused footage or 
media.

Identify unreferenced clips as follows:

1. Open the bin containing the sequence or clip that is referenced.

2. Open all other bins containing clips that were used during editing.

3. Choose Select Unreferenced Clips from the Bin menu.

An alert box warns you that unreferenced clips will be highlighted 
in open bins only (items in closed bins will not be shown).

4. Click OK.

All unreferenced clips are highlighted in the open bins.
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Using Text Mode

Text mode provides the most complete view of clip information. It 
uses database columns that you can rearrange and customize to suit 
your needs. 

To enter Text mode, click the Text Mode button (labeled T) in the lower 
left corner of the bin.
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About Bin Views

For complete informa-
tion on all Film and Sta-
tistical column 
headings, see the Avid 
Media Composer Products 
Reference.

To the right of the Display Mode buttons is a pop-up menu of titles for 
different bin views. This option is available only in Text mode. Bins 
have three default views that are automatically loaded:

¥ Statistics view: Uses the standard statistical column headings 
derived from information established during capture, such as start 
and end timecodes, duration, resolution, and so on.

¥ Film view: Has Þlm-related column headings, including key num-
ber, ink number, pullin, and so on. If you are working on a non-
Þlm-related project, and select the Film view, a dialog box informs 
you that only the non-Þlm-related columns will be displayed.

¥ Custom view: Allows you to create and save customized views. 
The only required heading is the clip name, displayed by default. 
You can customize the view by adding, hiding, or rearranging col-
umn headings.

Customizing Bin Views

There are several ways to customize views of the bin:
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¥ Alter the arrangement of existing columns in the standard Statis-
tics view or Film view to suit your needs, without adding or hid-
ing columns. These arrangements will be recalled each time you 
choose Statistics view or Film view.

For more information 
on working with set-
tings, see the Avid Media 
Composer Products Refer-
ence. 

¥ Add or hide columns of information to create customized Statis-
tics or Film views. These will be saved as additional view settings 
in numerical order, for example Statistics.1, Statistics.2, unless you 
choose another name.

¥ Add, hide, copy, or rearrange standard or customized columns in 
any combination to create your own custom views. You can name 
and save these to suit your needs.

When you create a new bin view, the system saves the settings for this 
view so that you can later access and alter, copy, or delete these set-
tings.

Moving and Rearranging Columns

To move a text column in a bin:

1. Click the heading of the column that you want to move.

The entire column is highlighted.

2. Drag the column to the desired position and release the mouse 
button.

The column appears in the new position, and columns to the right 
are moved over to make room.

Tidying Up Bin Columns

When you tidy up bin columns, the system maintains the same order 
of columns from left to right, but spaces them according to the length 
of contents. This is especially useful for removing spaces left after 
moving or rearranging columns.
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To tidy up bin columns, choose Tidy Up Columns from the Bin menu, 
or press kÐT.

Showing and Hiding Columns

You can select individual or multiple headings to display or hide in 
the bin. 

To choose column headings by using the headings dialog box:

1. With a bin in Text mode, choose Headings from the Bin menu. You 
can also double-click a bin view setting in the Settings list of the 
Project window.

A dialog box appears.

You can also display a 
frame for each clip 
along with statistical 
information in Text dis-
play mode by display-
ing the Frame column. 
For information, see 
ÒAdding Customized 
Columns to a BinÓ on 
page 247.

2. Select the headings you want to add to the bin:

¥ Click the name of a heading to select it. 

¥ Click a highlighted heading to deselect it.

¥ Click Select All to highlight all the headings in the bin.

¥ Click Deselect All to deselect all the headings.
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3. Click OK. Only the headings highlighted in the headings dialog 
box appear in the bin or bin view.

Deleting a Column

Deleting a statistical column is the same as hiding the column; you can 
restore the column at any time by using the headings dialog box, as 
described in ÒShowing and Hiding ColumnsÓ on page 245. When 
you delete a Custom column, however, you must re-create the col-
umn.

To delete a column:

1. Click the column heading.

2. Choose Clear from the Edit menu or press the Delete key.

The column disappears from the view and surrounding columns 
close to Þll the space.

Duplicating a Column

You can duplicate existing columns containing timecode information 
in other compatible columns that you target in a dialog box.

To duplicate a timecode column:

1. Select the column you want to duplicate by clicking its header. 

2. Choose Duplicate from the Edit menu. 

A dialog box appears.
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In the example, the user has selected the Duration column to dupli-
cate; thus ÒCopy Duration to:Ó appears at the top of the dialog box. 
Select a column name from the list. The column must be of the same 
type of data for the copy to occur. For example, you can copy start 
timecodes to the Aux TC column, but you cannot copy timecodes to 
the Pullin column. 

The column of information appears in the column you designated.

Adding Customized Columns to a Bin

In addition to the standard statistical or Þlm headings, you can add 
your own column headings to describe information about clips and 
sequences. For example, you might want to add a column heading to 
describe what kind of shot (close-up, wide shot, master shot, extreme 
close-up, and so on) is used in a clip.

To add a new column:

1. Click an empty area to the right of the current headings in the 
headings box.

2. Move any existing column to the right or left in order to create an 
empty area.

3. Type the column heading you want and press Return. Column 
headings must contain fewer than 30 characters, including spaces.
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This puts the cursor in the data box, beside the Þrst clip in the bin.

4. Use the Tidy Up Columns command after you have entered the 
new column heading.

5. Type the information and press Return to move to the next line.

Changing a Custom Column Heading

You can change the heading name of custom columns. You cannot 
change any of the standard statistical or Þlm column headings.

To change the name of a custom column:

1. Hold down the Option key and click the heading to highlight it. 

2. Type the new text for the heading and press Return.

Saving a Custom View

Any time you add, hide, or delete a column, the bin view name 
changes to an italicized name to indicate that it no longer matches the 
original view. If you try to select a new bin view setting while the cur-
rent setting is untitled or italicized, a dialog box asks if you want to 
discard the current setting.

n If you donÕt save the view after adding or deleting headings, it is discarded.

To save a bin view:

1. Add or hide columns according to preference. The bin view name 
becomes italicized.

2. Choose Save As from the Bin View pop-up menu.
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The view name dialog box appears.

3. Name the custom view:

¥ To keep the default view name, click OK or press Return.

¥ To create a new name for the custom view, type the name and 
click OK or press Return.

Managing Clip Information in Text Mode

For additional bin 
shortcuts, see the 
ÒShortcutsÓ section of 
the Avid Media Composer 
and Film Composer 
Quick Reference.

There are several ways to manage clip information in Text mode col-
umns. These methods include copying information between cells, 
moving information between whole columns, sorting clip information, 
and modifying clip data, as described in this section.

Moving Within Column Cells

Use the keyboard shortcuts to move from cell to cell in bin columns:
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¥ Tab: Moves the cursor to the parallel cell in the next column. You 
can continue to press the Tab key to scroll through the cells to the 
right until the cell in the last column is highlighted. The next time 
you press the Tab key, the cell in the Þrst column is highlighted.

¥ Shift-Tab: Moves the cursor to the left to the cell in the previous 
column. You can continue to press the Shift-Tab keys to scroll 
through cells to the left until the cell in the Þrst column is high-
lighted. The next time you press Shift-Tab, the cell in the last col-
umn is highlighted.

¥ Return: Enters any new information typed into the cell and moves 
the cursor down to the cell in the next row. You can continue to 
press the Return key to scroll down the column until the last cell in 
the column is highlighted. The next time you press the Return key, 
the Þrst cell in the column is highlighted.

¥ Shift-Return: Moves the cursor up to the cell in the previous row. 
You can continue to press the Shift-Return keys until the cell in the 
top row is highlighted. The next time you press the Shift-Return 
keys, the cell in the last row is highlighted.

Modifying Clip Information

You can change or modify the information in certain columns for your 
master clips, subclips, tapes, and other objects stored in the bin. This is 
especially useful if some of the data is incorrect, or if you need to con-
form information for organizational purposes.

The following conditions apply to modifying clip information:

¥ When you modify a clipÕs information, related objects are auto-
matically updated to reßect the new data. For example, if you 
change the name of a clip, the updated name appears in the 
sequences that use the clip. 

¥ Some data cannot be modiÞed after digitizing because changes 
would prevent you from playing back and editing the material 
successfully.
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¥ Sequence data cannot be changed, even though it appears in your 
bin. The only way to modify sequence data is to edit the sequence 
itself. You can, however, change the name and start time for the 
master timecode track, as described in ÒChanging the Sequence 
Clip InfoÓ on page 375.

There are two ways to modify data: 

¥ You can modify some data directly for master clips, subclips, and 
other objects stored in a bin.

¥ You can use the Modify command to change speciÞc information 
for clips only.

Modifying Data Directly

When you modify information directly, you click a cell and type the 
new information. For example, you can type a new name for a clip, or 
correct the start and end timecodes.

You can directly modify any data in the bin prior to digitizing. After 
the footage is digitized, however, you can directly modify only 
selected headings, with restrictions as shown in Table 9-2.

Table 9-2 Direct Modification Headings 

Heading Restrictions

(Clip) Name No restrictions.

Mark IN Altering the mark IN also alters the IN to OUT duration. This replaces any 
previous mark.

Mark OUT Altering the mark OUT will also alter the IN to OUT duration. This replaces 
any previous mark.

Color Framing Must be according to tape speciÞcations. See ÒTracking Color Frame ShiftsÓ 
on page 451.

Auxiliary timecodes, 1Ð5 No restrictions.
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To modify the clip data directly:

1. Enter Text mode.

2. Click the cell that you want to modify. Select only one item at a 
time. In this example, the timecode data is highlighted.

3. Click the cell again to enter text.

If the cursor does not change to an I-beam, you might be attempt-
ing to modify a column that cannot be directly modiÞed.

4. Type the new information and press Return.

KN (key number) Start Only for Þlm projects; altering the starting key number will also alter the 
ending key number to maintain the duration. This can also cause discrepan-
cies with any auxiliary timecode information that you entered manually.

KN (Key Number) End Only for Þlm projects. Altering the KN end also alters the KN Start to main-
tain the duration. This can also cause discrepancies with any auxiliary time-
code information that you entered manually.

Pullin Pullin data imported from a telecine-generated list can only be altered by 
using the Modify command. See ÒUsing the Modify CommandÓ on 
page 253. (NTSC only.)

Pullout Pullout data imported from a telecine-generated list can only be altered by 
using the Modify command. See ÒUsing the Modify CommandÓ on 
page 253. (NTSC only.)

Table 9-2 Direct Modification Headings (Continued)

Heading Restrictions
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Using the Modify Command

The Modify command gives you specialized control over information 
in speciÞc headings. For example, you can use the Modify command 
to change the name of source tapes, or to increment or decrement the 
start and end timecodes by a speciÞed length of time for one or several 
master clips at once.

For a complete descrip-
tion of the Modify dia-
log box options, see 
ÒUsing the Modify 
CommandÓ on 
page 127.

You can apply changes with the Modify command to master clips 
only; subclips and sequences cannot be altered in this way. In addition, 
you can only perform modiÞcations that alter the end timecodes or the 
tracks before digitizing, as described in Table 9-3.

Table 9-3  Modify Command Options 

Option Restrictions

Set Timecode Drop/Non-
drop

Setting must match the timecode format of the 
tape

Set Timecode By Field Only start timecode can be altered after digitiz-
ing

Increment Timecode Only start timecode can be incremented after 
digitizing

Decrement Timecode Only start timecode can be decremented after 
digitizing

Set Key Number Generic 
(PreÞx)

Only for Þlm projects

Set Pullin Only for Þlm projects

Set Tracks Only for Þlm projects

Set Source Should match the original source tape name
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To modify selected data:

1. Open the bin.

2.  Click the small Þlm clip icon to the left of the clip, sequence, or 
other object you want to modify. Shift-click each additional object 
you want to modify.

3. Select objects in the bin: master clips, subclips, sequences, tapes, 
audiotapes, Þlm reels, effects, group clips, or rendered effects. 

4. Choose Modify from the Clip menu.

The Modify dialog box appears.

Pullin Only for adjusting Pullin information from an 
imported telecine list for a Þlm project

Pullout Only for adjusting Pullout information from an 
imported telecine list for a Þlm project

Table 9-3  Modify Command Options (Continued)

Option Restrictions

Modify Options pop-up menu
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5. Choose an option, such as Set Timecode By Field, from the Modify 
options pop-up menu.

6. Select an option or enter information into the entry Þelds (time-
code values, for example) when they appear.

7. Click OK. The modiÞcation takes effect.

Copying Information Between Columns

The following steps describe how to copy all the information in one 
column to another. To demonstrate these steps, you will copy time-
code information in one column to a new column. 

1. Select the timecode column that you want to copy.

2. Choose Duplicate from the Edit menu or press kÐD.

A dialog box prompts you to target a timecode column for the 
data.

3. Select the target column for the data and click OK.

Copying Information from Another Cell in a Custom Column

To copy information from another cell in a custom column:
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1. Hold down the Option key while you click in the destination cell 
to reveal a pop-up menu of all items entered in that column. 

2. Select the text from the menu. The text appears in the cell.

You can also use the following two shortcuts to move information 
between cells in a custom column:

¥ Press Option-Tab to load the text from the cell below into the cur-
rent cell, then select the cell to the right of the current cell.

¥ Press Option-Shift-Tab to load the text from the cell below into the 
current cell, then select the cell to the left of the current cell.

Sorting Clips

Sorting clips arranges them in either numerical or alphabetical order, 
based on the data in the column you select as the sorting criteria. You 
can sort clips in several different ways, using an ascending sort, a 
descending sort, and a multilevel sort.

n You can sort clips and sequences in Text mode only. If you need to view sorted 
clips in Script or Frame mode, sort them in Text mode Þrst and then return to 
Script or Frame mode.

Sorting Clips in Ascending Order

To sort clips in ascending order:

1. Click the heading of the column that you want to use as the crite-
rion.

The column is highlighted.

2. Choose Sort from the Bin menu or press kÐE.

The objects in the bin are sorted.

n If the Sort command is dimmed in the menu, you have not selected a column.
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To reapply the last sort, choose Sort Again from the Bin menu with no 
column selected. This step is especially useful after you have added 
new clips to a sorted bin.

Sorting Clips in Descending Order

To sort clips in descending order:

1. Click the heading of the column that you want to use as the crite-
rion.

The column is highlighted.

2. Hold down the Option key while you choose Sort Reversed from 
the Bin menu, or while you press kÐE.

Sort Reversed displays the column in descending order.

Multilevel Sorting with Columns

You can select multiple columns in a bin and perform a multilevel sort 
by using the information in the columns.

To do this, rearrange the columns in the bin to establish the primary 
column. The column that appears farthest to the left in Text mode 
becomes the primary criterion for the sorting operation. 

Using Frame Mode

In Frame mode, each clip is represented by a single frame, with the 
name of the clip displayed below the frame. The system uses the head 
frame as the default, but you can play back the footage within any clip 
and select any frame to represent the footage. You can make the pic-
tures larger to see more detail, or smaller to see more clips in the win-
dow. You can also rearrange the frames in any order.

To enter Frame mode, click the Frame Mode button (labeled F) in the 
lower left portion of your screen.
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Each frame appears on your screen with its assigned name directly 
below it.

Changing the Bin Background Color

You can customize the background color of the bin behind the frames. 
Changes affect one bin at a time. However, changes you make in 
Frame mode appear in Script mode as well.

To change the bin background color:

1. Activate the bin you want to change and make sure you are in 
Frame mode (or Script mode).

2. Choose Set Color from the Edit menu, and select a color from the 
pop-up palette.
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The bin color changes based on your selection.

Enlarging or Reducing Frame Size

You can enlarge and reduce the size of the frames appearing on the 
screen to Þve available sizes. You must enlarge or reduce all frames 
together. You cannot change the size of individual frames.

¥ To enlarge the frame size, choose Enlarge Frame from the Edit 
menu. The display size increases each time you choose this option, 
up to Þve times.

¥ To reduce the frame size, choose Reduce Frame from the Edit 
menu. The display size decreases each time you choose this 
option, up to Þve times.

Rearranging Frames

Frame mode allows you to rearrange the display of the frames in the 
bin by moving them. 

To rearrange frames:

1. Click and drag a single frame to its new position.

To rearrange more than one frame at a time, Shift-select or lasso 
multiple frames and drag them to a new position in the bin.

2. Click the background area of the bin to deselect the clips.
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Changing the Frame Identifying the Clip

If you have Group or 
MultiGroup clips in the 
bin and want to change 
the displayed frame, 
you must use controls 
in Source/Record 
mode. For more infor-
mation, see ÒMulti-
Camera Editing 
TechniquesÓ on 
page 591.

By default, Frame mode displays the Þrst frame of each clip in the bin. 
However, you can choose a different frame.

To change the frame identifying the clip:

1. Select the clip that you want to change.

Hold the K key on the keyboard (Pause) and press the L key (Play) 
to roll the footage within the frame forward at slow speed. To 
move backward through the footage, hold the K key and press the 
J key (Reverse Play).

2. When you see the frame that you want use, release the keys.

When you Þnd the frame you want to use, Media Composer saves 
your choice as part of the bin conÞguration.

Tidying Up Frames in a Bin

To realign or tidy up the frames in a bin after you have changed their 
display, use one of the following procedures:

¥ To align all frames to an invisible grid, choose Tidy Up Columns 
from the Bin menu.

¥ To align only selected frames, choose Align Selected to Grid from 
the Bin menu.

¥ To spread out the frames evenly to Þll available space in the bin 
window, choose Fill Window from the Bin menu.

¥ To arrange frames in the order in which they are sorted in Text 
mode, choose Fill Sorted from the Bin menu.
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Using Script Mode

Script mode combines the features of Text mode with Frame mode, 
with an added script box next to each frame. The frames are displayed 
vertically on the left side of your screen with the script box next to 
each. Clip data matching the column headings in Text mode appears 
above each text box.

To enter Script mode, click the Script Mode button (labeled S) in the 
lower left portion of the bin.



262

Adding Text in Script Mode

To type text into the script box, click the box and begin typing. This 
text does not appear in sequences edited from the clips, only in print-
outs of the bin in Script mode.

You can use basic word processing procedures to highlight, delete, cut, 
copy, and paste text between script boxes.

If the notes or script you type extend beyond the size of the text box, 
you can use the Page Up or Page Down keys on the keyboard to scroll 
through the text.

Rearranging Clips in Script Mode

You can rearrange the order of clips in Script mode in two ways:

¥ You can drag each clip up or down to a new location in the bin.

¥ You can sort and sift clips in Text mode, then return to Script mode 
to display selected clips in the desired sort order.

n When you return to Text mode, the order of the clips is changed there as well.

Printing Bins

Media Composer allows you to print entire bins or individual frames 
in hardcopy form.

To print entire bins in Text, Script, or Frame mode:

1. Install the correct printer driver in the System Folder on the Avid 
disk.
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Directions for installing the printer driver are included in the man-
ual for your printer and in the Macintosh system documentation.

2. Select the printer by using the Chooser.

Directions for selecting the printer are included in the Macintosh 
system documentation.

3. Click the T (Text mode), S (Script mode), or F (Frame mode) button 
in the lower left corner of the bin to select the view you want to 
print.

n To print a frame in Script or Frame mode, you must use a printer capable of 
rendering graphics or PICT Þles.

4. Choose Page Setup from the File menu. A Page Setup dialog box 
appears, reßecting speciÞc options for the type of printer you 
have.

5. Select the appropriate options from the Page Setup dialog box, 
then click OK.

6. Choose Print Bin from the File menu. The print dialog box 
appears, reßecting speciÞc options for your type of printer.

7. Set the print options in the print dialog box, then click Print.

The system prints the frame currently displayed in the active mon-
itor.

To print a single frame of a clip or sequence:

1. Load a clip or sequence into the Source or Record monitor.

2. Select the frame you want to print.

3. Choose Print Frame from the File menu, or press kÐP.

4. Make any needed adjustments to the print setup and click Print.

The system prints the frame currently displayed in the active mon-
itor.
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Gathering Format Elements

While organizing your project, you can gather various format ele-
ments into a single bin that you can open and use later during editing. 
Some useful format elements might be:

¥ Bars and tone

¥ Head and tail leader

¥ Repeated titles

¥ Countdowns

¥ Graphic elements (repeated animations, and so forth)

This section describes techniques for creating digital bars and tone, as 
well as leader clips for use in sequences. For information on creating 
or importing graphic elements and titles, see the Avid Media Composer 
and Film Composer Effects Guide.

Preparing Digital Bars and Tone

If you expect to output your Þnal sequence as a digital cut that 
requires calibration before playback (a digital cut that will be broad-
cast, for example), then in most cases you need a clip of color bars. You 
can add the clip to the front of the sequence in Media Composer, or 
you can output the clip separately as an assemble or insert edit onto 
tape during recording of a digital cut.

There are several ways to acquire a clip of bars, each with different 
advantages:

¥ Digitize bars and tone from a house generator. This method 
requires the least effort with good results, because you capture 
high-quality bars and tone simultaneously, with a minimum of 
calibration. Not all facilities, however, have a house generator.

¥ Digitize bars and tone from a videotape. This method allows you 
to capture bars and tone simultaneously, but you must calibrate 
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carefully to ensure accuracy. In addition, the Þnal clip reßects the 
quality of the source tape recording.

¥ Digitize bars from an external color bar generator. This method 
provides good results, but you must have a color bar generator 
available, and you must rearrange your system inputs to attach 
the generator. In addition, you must acquire tone separately and 
sync it with bars within Media Composer.

¥ Import a PICT Þle of bars. This method provides the highest qual-
ity results, because the source image is already digital. If the PICT 
Þle is accurate, the quality of the clip is ensured. You must, how-
ever, acquire tone separately, and sync it with bars within Media 
Composer.

Importing a PICT File of Bars

The following procedure describes the method for importing a PICT 
Þle. This method is available to all users because your Media Com-
poser system includes a SMPTE bars PICT Þle.

To import bars:

1. Open an existing bin, or create a new one for the test pattern.

2. Choose Import from the File menu to open the Select Files to 
Import dialog box.

3. Using the directory pop-up menu on the left side of the dialog box, 
locate the Color Bars for Import PICT Þle in the Avid Goodies 
folder. The Avid Goodies folder is located on the Avid (internal) 
drive.

4. Import the Þle by using options described in ÒPreparing to Import 
FilesÓ on page 213.

5. Create a clip of tone media by using the Audio Tool. For more 
information, see ÒCreating Tone MediaÓ on page 172.
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n Match the resolution of the tone to the audio resolution of the sequence.

6. Load the new color bars clip into the Source monitor, and create a 
subclip of appropriate length for use in sequences (1 minute is a 
common standard).

7. Select the new subclip and the audio clip containing the tone, and 
choose AutoSync from the Bin menu.

A new subclip containing bars and tone appears in the bin.

8. Rename the clip as necessary.

Creating Leader

Film editors traditionally use standard head and tail leaders for cueing 
and syncing material. You can use digital leader in Media Composer to 
mark the beginning and ending of tracks, and to help you maintain 
sync, as described in ÒManaging Sync with Multiple TracksÓ on 
page 562. You can create your own leader for video or Þlm, as 
described in this section. Whatever your choice for speciÞcation, be 
sure to make all your leader clips the same length, with common sync 
points.

Creating Video Leader

To create leader for picture tracks:

1. Create a black screen in the Title Tool for tail leader, or a white 
screen for head leader. See the Avid Media Composer and 
Film Composer Effects Guide for information on using the Title Tool.

Optionally, you can type a title onto the screen that says ÒTail 
LeaderÓ or ÒHead Leader.Ó

2. Name this clip Head Leader or Tail Leader when you save the title.

3. Subclip an appropriate length of the clip, according to your chosen 
speciÞcations.

4. (Option) Mark a sync frame in the subclip as follows:
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a. Load the clip into the Source monitor. 

b. Find an appropriate sync point and add a locator.

c. (Option) Double-click the locator in the Source monitor to add 
a sync point notation that appears on the monitor.

For information on 
placing add edits, see 
ÒAdding an Edit 
(Match Framing)Ó on 
page 445.

d. (Option) To make the sync point visible within the Timeline, 
step one frame backward and place an add edit before the 
sync frame, then step two frames forward and place an add 
edit after the sync frame.

Once the leader is prepared, you can splice the leader during editing 
onto the tracks that you want to keep in sync. You can use the sync 
points for visually aligning tracks.

Creating Audio Leader

To create tail leader for audio tracks:

1. Load a clip that includes a section of digitized tone into the Source 
monitor.

2. Subclip an appropriate section of the clip, according to your cho-
sen speciÞcations.

3. Name this new subclip Head Leader or Tail Leader.

4. Load this subclip into the Source monitor.

5. Prepare the sound levels by using one of the following options:

¥ For leader without a sync point (no audio pop), open the 
Audio Mix Tool and bring the audio level all the way down 
for the entire clip.

¥ For leader that includes a sync point (audio pop), do the fol-
lowing:

a. Find the appropriate sync point.
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For information on 
placing add edits, see 
ÒAdding an Edit 
(Match Framing)Ó on 
page 445.

b. Step one frame backward and place an add edit before the 
sync frame, then step two frames forward and place an add 
edit after the sync frame.

c. Place the position indicator before the Þrst add edit, and 
open the Audio Mix Tool.

d. Bring the audio level all the way down.

e. Place the position indicator after the second add edit, and 
use the Audio Mix Tool to bring the level all the way down.

Once the leader is prepared, you can splice the leader during editing 
onto the audio tracks that you want to keep in sync. You can use the 
sync points for visually aligning tracks.

Storyboard Worksheet

Make preliminary preparations such as synchronizing picture and 
sound, converting audio timecode, and modifying clip data.

Set the bin display to show only the media objects you will use for 
your storyboard.

Narrow down the clip selection by deleting, moving, copying, sorting 
and sifting clips.

Select either Script mode or Frame mode to display your storyboard in 
the bin with or without a text box. Enter information into the script 
box if necessary.

Rename clips to include additional information such as numbered 
ordering, or enter this information into the Script box in Script mode.

Use the keyboard to jog through each clip and display the reference 
frame you want to use for each clip.
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Rearrange the clips in sequential order by selecting and dragging one 
or several clips at a time to a new location.

Enlarge or reduce the size of the frames as necessary.

Tidy up the rearranged frames along invisible grid lines when using 
Frame mode.

(Option) Change the font and background color for the storyboard.

Choose Save Bin from the File menu when the storyboard is complete.

Choose Print from the File menu to print the storyboard in its Þnal 
form.
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CHAPTER 10

Managing Media Files

When you digitize footage, the system creates digital media Þles for 
the video and audio tracks on the media drives attached to your sys-
tem. In addition to the bin tools that allow you to organize the clips 
that reference these media Þles, your Avid Composer system provides 
useful tools and features for directly managing media Þles for storage 
and playback efÞciency, for backup, and for transfer between systems. 
These procedures are described in the following sections:

¥ Using the Media Tool

¥ Freeing Storage Space

¥ Consolidating Media

¥ Backing Up Media Files

¥ Finding a Related Media File

¥ Relinking Media Files

¥ Unlinking Media Files

Using the Media Tool

The Media Tool is your window onto the digitized video and audio 
data Þles stored on your media drives. As an important counterpart to 
the bins, the Media Tool provides similar database tools for manipulat-
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ing digital media Þles in tandem with your organization of clips and 
sequences. Unlike bins, however, the Media Tool gives you access to 
separate video and audio portions of each clip.

Basic Media Tool Features

The Media Tool provides many of the same controls for viewing and 
managing information that you use with bins, including the following:

¥ Three display modes in the Media Tool function like those in bins: 
Text mode, Script mode, and Frame mode.

¥ The Media Tool Fast menu gives you quick access to all the same 
commands available in the Bin Fast menu.

¥ You can highlight, move, copy, duplicate, delete, and sift clips. You 
can also select media relatives, sources, and unreferenced clips, as 
described in ÒBasic Bin ProceduresÓ on page 231.

¥ You can use Text mode headings and display options for columns 
of clip and media Þle data. You can also use procedures such as 
customizing the display of columns, moving within columns, and 
sorting information, as described in ÒUsing Text ModeÓ on 
page 242.

¥ You can use the same Frame mode display options described in 
ÒUsing Frame ModeÓ on page 257.

¥ You can use the same Script mode display options described in 
ÒUsing Script ModeÓ on page 261.

¥ You can print Media Tool data by using the same procedures for 
printing bins, described in ÒPrinting BinsÓ on page 262.

In addition to the procedures described, the Media Tool has a number 
of unique functions, described in this section. These include the fol-
lowing:

¥ Unlike bins, the Media Tool displays all the tracks digitized for 
each clip as separate media Þles. Therefore, when you view, delete, 
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and manipulate Þles, you have the added option of specifying 
individual video and audio tracks.

¥ The Media Tool does not display sequences and subclips. Only 
master clips, precompute (rendered effect) master clips, and asso-
ciated media Þles are displayed.

¥ The following Bin and Clip menu commands do not apply to the 
Media Tool: Modify, Select Ofßine Items, Reveal File and Relink. 
You must perform these functions from the bin.

¥ The Media Tool database and display options are not saved as 
they are with bins. Instead they must be re-created each time you 
open the tool. Likewise, when you close the Media Tool, any cus-
tomization of columns or other views elements is deleted.

Opening the Media Tool

To open the Media Tool:

1. Choose Media Tool from the Tools menu. The Display Media 
Selector dialog box appears.

2. Select display options:
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¥ You can display Þles for just the current project, or all other 
projects.

¥ You can display digitized master clips, precompute (rendered 
effect) master clips, individual media Þles, or all three.

3. Click OK. The Media Tool window opens.

Deleting Tracks with the Media Tool

You can use the Media Tool to delete selected media Þles without 
harming the related master clips, subclips, and sequences.

n  If you use the Media Tool to delete selected media Þles, you will no longer 
have access to visuals of the deleted material. If you load a clip for which a 
media Þle has been deleted, a black screen appears with the words ÒMedia 
Ofßine.Ó If you need to use those clips again, you must redigitize from tape.

Depending on your needs, you can do one of the following:
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¥ Delete selected audio or video tracks and retain other tracks from 
a clip.

¥ Delete entire sets of media Þles and related clips from within the 
Media Tool.

¥ Delete all unrelated media upon completion of a project, and 
retain only the media required for playback of a Þnished sequence 
as described in ÒConsolidating MediaÓ on page 276.

To delete selected media Þles:

1. Open the Media Tool. In the Display Media Selector dialog box, be 
sure to select the types of Þles you want to delete.

2. Select one or more media Þles (audio, video, or both) or master 
clips whose media Þles you want to delete. 

3. Choose Clear from the Edit menu, or press the Delete key to open 
the Delete Media Files dialog box.

4. Select the media objects that you want to delete:
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¥ Audio media Þle (A1, A2, A3, A4). The master clip linked to 
that Þle will be silent. Subclips and sequences created from the 
master clip are affected in the same way.

¥ Video media Þle (V1). The master clip linked to that Þle will 
be black, with the message ÒMedia OfßineÓ displayed. Related 
subclips and sequences are affected in the same way.

¥ Precompute media Þle (V, A). The section of the sequence 
with the effect becomes black with the message ÒMedia 
OfßineÓ displayed.

¥ Audio Mixdown File (A). The section of the sequence with 
the mixdown becomes silent.

5. Click OK.

A conÞrmation dialog box appears.

6. Click Delete.

Freeing Storage Space

To quickly view remain-
ing storage on your 
media drives at any 
time, open the Hard-
ware Tool as described 
in ÒUsing the Hard-
ware ToolÓ on 
page 103.

Unlike the bin Þles stored in project folders on the Avid drive, media 
Þles require considerable storage space. When you Þnish either a 
rough cut or a Þnal version of a sequence, you can quickly free storage 
space by deleting the media and clips that are not referenced by the 
sequence. This procedure is performed on clips selected in bins only.

To delete all unreferenced clips and media Þles:

1. Choose Select Sources from the Bin menu. All source clips for the 
sequence are highlighted in the bin.

2. Click the bin containing the highlighted clips to activate it.

3. Choose Reverse Selection from the Bin menu. All the clips in the 
bin that are not source clips for the sequence are now highlighted.

4. Press the Delete key, then click the check boxes in the Delete dialog 
box to delete the clips or the media Þles.



276

Consolidating Media

When you consolidate media Þles, the system Þnds the media Þles or 
portions of media Þles associated with selected clips, subclips, or 
sequences. It then makes copies of them, and saves the copies on a tar-
get disk that you specify. Because the Media Tool displays only master 
clips, you cannot consolidate subclips or sequences with the Media 
Tool. You can consolidate master clips, subclips, and sequences in the 
bin.

About the Consolidate Feature

For illustrations of the 
different types of con-
solidation, see the Avid 
Media Composer and Film 
Composer Quick Refer-
ence.

The Consolidate feature operates differently depending upon whether 
you are consolidating master clips, subclips, or sequences. There are 
also different advantages in each case, as follows:

¥ Master clips: When you consolidate a master clip, the system cre-
ates exact copies of the media Þles. If you link the original master 
clip to the new Þles, the system creates a master clip with the 
extension .old that remains linked to the old Þles. If you maintain 
the link between the original master clip and the old media Þles, 
the system creates a new master clip with the extension .new that is 
linked to the new Þles. The new clips are also numbered incremen-
tally beginning with .01. Consolidating master clips does not save 
storage space because the system copies the same amount of 
media for each clip.

¥ Subclips: When you consolidate a subclip or group of subclips, 
the system copies only the portion of the media Þles repre-
sented in the subclip, and creates a copy of the master clips and 
the subclips. The sufÞx .new is attached, along with incremental 
numbering beginning with .01.

¥ Sequences: When you consolidate a sequence, the system copies 
only the portions of media Þles edited into the sequence, and cre-
ates new master clips for each shot in the sequence. The sufÞx 
.new is attached to the master clips, along with incremental 
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numbering beginning with .01. The sequence is not renamed, 
but is automatically relinked to the new media Þles.

n Because a consolidated sequence is linked to the new Þles by default, consider 
duplicating the sequence each time you consolidate if you need to maintain 
links to the original Þles.

Using the Consolidate Command

To consolidate master clips, subclips, or sequences:

For more information 
on rendering effects, see 
the Avid Media Composer 
and Film Composer 
Effects Guide.

1. If you are consolidating a sequence, duplicate the sequence to 
maintain links to the original Þles, if necessary, and render any 
unrendered effects.

2. With the bin open, select the clips or sequence to consolidate.

3. Choose Consolidate from the Clip menu. The Consolidate dialog 
box appears.
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4. Select one of the following:

¥ ÒDelete original media Þles when doneÓ to delete original 
media Þles automatically.

¥ ÒSkip media Þles already on the target diskÓ if some related 
media Þles are already located on the target disk.

¥ ÒRelink selected clips to target disk before skippingÓ to ensure 
that all selected clips are linked to media on the target drive. 
This option appears when you select ÒSkip media Þles already 
on target disk.Ó

5. Select a target disk from the pop-up menu.

Make sure that you choose a target disk with enough storage 
space for all the consolidated media Þles.

6. Enter a handle length for the new clips in the entry Þeld, or leave it 
at 60 frames to accept the default.

For more information 
on group clips, see 
ÒGrouping and Multi-
groupingÓ on page 582.

7. If you are consolidating a group clip or a sequence that contains 
group clips, select the option ÒConsolidate all clips in a group 
editÓ to copy media for all the clips in the group. This option is 
dimmed if there are no group clips in your selection.

8. Click OK. If you did not choose to delete the original media Þles, a 
second dialog box appears and offers you a choice.
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9. Link the original master clips to the new or old media Þles, accord-
ing to preference.

10. Click OK.

Another way to back up media Þles is to copy them directly onto 
another hard drive in the Finder. You cannot, however, take advantage 
of the storage-saving features of the Consolidate command, and it is 
more difÞcult to identify particular media Þles when searching 
directly through folders.

c Do not make copies of media Þles in the Finder while the Avid Com-
poser system is running. Also, do not keep duplicate copies of 
media Þles online; either delete the originals, take the backups 
ofßine, or store the backups in a folder with a different name.

Loading the Media Database

The media database is a catalog of master clips and precomputes 
stored on the external media drives. One use of the media database by 
the Avid Composer system is to display master clips and precomputes 
in the Media Tool.

Bins also contain references to some of the media Þles based on the 
contents of the bin. The Avid Composer system does not maintain the 
entire database in memory at all times but instead builds up a partial 
database for the bins that have been opened in the current session in 
order to preserve as much memory as possible for editing.

If you store the master clips and the edited sequences for a project in 
separate bins, there are two cases in which you need to load the entire 
database in order to relink clips to their media Þles:

¥ Redigitizing: When you redigitize the master clips while the 
sequences bin is closed; quit the Avid Composer application; 
relaunch the application and open the sequences bin only Ñ the 
sequences might appear to be ofßine.
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¥ Consolidating: When you consolidate the master clips and relink 
them to the consolidated media while the sequences bin is closed; 
quit the Avid Composer application; relaunch the application and 
open the sequences bin only Ñ the sequences might appear to be 
ofßine.

To update the ofßine sequences with the new media Þles, choose Load 
Media Database from the File menu to load all online master clips and 
precomputes.

n You need not load the media database more than once during a single editing 
session because the database remains in memory until you quit the applica-
tion or restart the Avid Composer system.

c If a bin continues to display Media Ofßine after loading the media 
database, either the media Þles are missing or the links have been 
broken. For more information, see ÒRelinking Media FilesÓ on 
page 282.

Backing Up Media Files

The MediaFiles folders on your external media drives contain the indi-
vidual media Þles created when you digitize source material. Unlike 
the smaller Composer Project and Avid User folders, these folders are 
too large to back up onto diskettes.

The following are the options for backing up media Þles:

¥ You can use the Consolidate feature, described in the previous sec-
tion, to make copies of selected media Þles on a target hard drive 
connected to the system.
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For information on 
archiving procedures, 
see your AVIDdrive 
DLT documentation. 
For information on pur-
chasing AVIDdrive 
DLT, contact your Avid 
sales representative.

¥ You can back up smaller projects digitized at low AVRs (AVR 1sÐ
3s, for example) to optical drive cartridges.

¥ You can archive larger media Þles and folders to a dedicated mass-
storage system, such as AVIDdrive DLT (digital linear tape).

¥ You can consolidate or make copies of media Þles for transfer to 
another system. For more information, see ÒTransferring a Project 
to Another Media Composer ProductÓ on page 664.

Finding a Related Media File

The Reveal File command allows you to select a clip in a bin and auto-
matically open up its related media Þle. This is useful if you want to 
delete, move, or label the media Þle.

To Þnd a related media Þle:

1. Select the clip for which you want to Þnd the media Þle.

The clip is highlighted.

2. Choose Reveal File from the File menu.

The system searches on all available drives and opens the folder 
and highlights the related media Þles.
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Relinking Media Files

Sometimes after you consolidate or move material between systems, 
the clips or sequences lose their link to the original media Þles. When a 
clip becomes unlinked, it displays the message ÒMedia Ofßine.Ó If 
appropriate media exists online, you can use the Relink command to 
reestablish the link. 

Related
media files

Media Offline mes-
sage indicates a 
clip with no link to 
media files.
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When you select subclips or sequences and choose the Relink com-
mand, the system searches for master clips that contain the same mate-
rial included in the selection. 

You can also relink master clips to appropriate media Þles. The system 
compares information such as source tape name, timecode informa-
tion, and channels digitized. If the search is successful, the system 
establishes new links to the available media Þles. You can instruct the 
system to search speciÞc drives, or all available drives.

To relink clips, subclips, or sequences:

1. Select the unlinked object or objects.

2. Choose Relink from the Clip menu.

The Relink dialog box appears.

3. Choose an option from the Volume pop-up menu:

¥ Choose All Available Disks to search across all drives that are 
online.

¥ Choose a speciÞc drive volume if you know the location of the 
media, or want to relink to media on a speciÞc drive.

4. Select the option:
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¥  Select Relink To Selected to direct a relinking of related sub-
clips or sequences to the highlighted clip in the bin.

¥ Select the option Relink Master Clips to relink master clips to 
media Þles that share similar database information.

5. Click OK. The system searches the selected drives and relinks if 
possible.

The system disregards capture rate and audio resolution when match-
ing media Þles.

n If you want to be sure to maintain the original capture settings for a subclip 
or sequence, use the Batch Digitize command; do not use the Relink com-
mand.

Relinking to Selected Clips

You can also use the Option key to modify the Relink command for 
connecting subclips or sequences to selected master clips and subclips.

To relink to selected master clips and subclips:

1. Place the subclips or sequences that you want to relink into the bin 
containing the clips.

2. Select the clips targeted for relinking.

3. Press the Option key and choose Relink from the Clip menu.

4. The subclips or sequences are linked to the selected clips or sub-
clips.

Relinking Consolidated Clips

If the appropriate media exists online, you can reconnect consolidated 
clips, subclips, or sequences to the new or old media Þles by choice.
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For example, if you consolidated a sequence and forgot to create a 
duplicate, and later Þnd that you want to use the original media Þles 
instead of the consolidated media Þles, you can break the new link and 
reestablish the old link to the original Þles.

n Because subclips and sequences do not point directly to the media Þles, you 
can only perform this procedure by using the source master clips.

To relink consolidated subclips or sequences:

1. Select the new master clips for a consolidated subclip or sequence 
(the clips will have the sufÞx .new attached), and unlink them.

2. Choose Relink from the Clip menu.

3.  Target the volume containing the original media Þles in the Relink 
dialog box.

The clips are relinked to the original media.

Relinking Moved Projects

If you move projects between systems with similar media existing at 
each site, but digitized separately, your clips and sequences will dis-
play the message ÒMedia Ofßine.Ó You can use Unlink and Relink 
commands to reconnect the Þles at either site.

For example, if you have a project that requires sharing work repeat-
edly between two different sites, you can digitize the source material 
once at each site, and exchange only the project folder at each stage, 
rather than moving large media drives back and forth. The project 
folder can be exchanged on 3.5-inch diskette, or instantly across a net-
work. Because the media Þles maintain slightly different parameters at 
each site, you must relink the material each time.

To relink a moved project:

1. Select the sequences and unlink them.

2. Select existing clips in the bin.
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3. Press the Option key and choose Relink from the Clip menu.

The sequences are relinked to the local media.

Unlinking Media Files

You can use the Control and Shift keys to modify the Relink command 
for unlinking clips from their media Þles. 

To unlink master clips from their current links:

1. Select master clips to unlink.

2. Press Control-Shift and choose Unlink from the Clip menu.

The clips are unlinked and display the message ÒMedia Ofßine.Ó

n Because subclips and sequences do not point directly to the media Þles, you 
can only perform this procedure by using the source master clips.

If you have similar material from different sources, you can duplicate 
a set of clips, unlink the duplicates, and then modify the sources of the 
duplicates before digitizing the new source material.

For more information 
on working with multi-
camera material, see 
Chapter 18.

For example, if you are working with multicamera material, you can 
digitize one reel, unlink the clips, duplicate them several times, and 
rename their source tapes to batch digitize the remaining reels.
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CHAPTER 11

Using Script Integration

The lined script is traditionally used as a tool for managing scene and 
take information during postproduction on a dramatic feature Þlm or 
television production.   In Media Composer and Film Composer, script 
integration allows you to adapt the lined script to the digital realm for 
use in any type of production, from drama to documentary to spot 
advertising. The following sections describe these methods:

¥ Line Script Basics

¥ Script Window Basics

¥ Manipulating Script Text

¥ Searching Through Script

¥ Linking Clips to the Script

¥ Manipulating Slates

¥ Manipulating Takes

¥ Using Script Marks

¥ Finding Clips and Script

¥ Editing with the Script Window
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Line Script Basics

The conventional lined script Ñ which evolved during decades of trial 
and error in Hollywood Ñ provides assistant editors and chief editors 
with a road map that helps them Þnd the coverage they need to edit 
scenes in a Þlm or television show. 

Traditionally, the continuity person creates the lined script on the set at 
the time of shooting. All notes are handwritten. The following is an 
example of a scene from a lined script:

88/1

88A/1 88A/2

88B/188B/2 88B/3

88C/1 88C/2
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Explanation of Symbols

Each vertical line drawn through the scene represents a single take 
from the moment the director says ÒActionÓ to the moment the direc-
tor says ÒCut.Ó Each scene might require several camera angles and 
positions, with one or more takes, all of which are lined and identiÞed 
alphanumerically. 

The following is a brief summary of the lining techniques and num-
bering system shown in the previous example:

¥ Master shot: The long line drawn through the middle of the scene 
labeled 88/1 is the master shot that usually covers all the action in 
a wide shot. The Þrst number in the label indicates the scene num-
ber as written on the script (scene 88). The number following the 
slash indicates that this is the Þrst take captured on Þlm for the 
master shot. A second take of the master shot, for example, would 
be labeled 88/2.

¥ Additional setups: The lines for each subsequent camera setup 
within the scene are labeled with the scene number (88 in our 
example) followed by a letter for each setup (A, B, C, and so forth), 
followed by a slash and the number of the take within that setup. 
These lines can be any length, depending upon what portion of 
the script is covered by the particular shot.

¥ Off-screen dialog: The jagged lines in the script represent the 
parts of dialog where the actor is off screen. For example, the char-
acter Amanda is off camera during the action described in the sec-
ond paragraph (when the character Laurel enters), so a jagged line 
is drawn through the shots that cover Amanda (88A/1 and 2).

When the scene is recorded on videotape Ñ in a sitcom shoot, for 
example Ñ the line script can also include timecode notes written next 
to speciÞc lines of dialog that represent a sync point between the dia-
log on the page and the recorded dialog on tape. These sync points 
provide assistant editors or chief editors with a quick path to speciÞc 
points in the source material. 
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Lining in the Digital Realm

Script integration in Media Composer and Film Composer provides a 
number of enhancements to this traditional system. These enhance-
ments allow you to shorten dramatically the distance between the con-
cepts captured on the page and the source materials used to assemble 
a Þnished program.

Unlike the traditional lining of a script, digital script integration is 
usually performed after the shoot Ñ by the assistant editor, for exam-
ple Ñ using the notes of the continuity person. The following is an 
example of the script shown in the previous section, prepared and 
lined using script integration:

Slates

Takes

Script mark

Color
indicator

Off-screen
indicator

Tool bar
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In addition to the standard lining conventions, script integration 
includes the following enhancements:

¥ Slates: Takes are organized into slates that display a representative 
frame and clip name for the take that is currently selected.

¥ Takes: The nodes and lines extending from the bottom of each 
slate indicate the number of takes for that scene. Click on a node to 
select the take.

¥ Indicators: You can apply off-screen dialog indicators or colors to 
indicate such things as preferred takes, takes used in the current 
active sequence, or line changes in dialog.

¥ Script marks: The double arrows marking the takes at various 
points represent marked lines of dialog in the script that have been 
synchronized to matching dialog in the source clip.   Script marks 
are especially effective during editing, allowing the editor to 
quickly locate dialog and piece together parts of a scene.

The script window provides additional controls for matching back to 
clips in the source bins, loading and playing back takes, and searching 
for takes and script text.

Script Integration Workflow

The basic workßow for script integration is as follows:

1. The continuity person or an assistant creates the lined script in 
hardcopy form on the set during shooting.

2. Source footage from the shoot is prepared and digitized by using 
methods described in Chapter 6 and Chapter 7.

3. The assistant editor uses the lined script from the shoot, a text Þle 
of the script itself, and methods described throughout this chapter 
to import and line the script, link clips to the script, place script 
marks, and customize the display of takes prior to editing.

4. The editor uses the fully prepared script window to edit the pro-
gram.
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Using Script Integration in Video Projects

Script integration can be an effective tool for editing any type of pro-
duction, not just feature Þlms and television drama. For example:

¥ You can adapt many of the procedures described in this chapter 
for use in audio/visual scripts for documentaries, corporate spots, 
news magazine segments, and spot advertisements.

¥ You can turn script integration into a quick storyboarding tool by 
positioning selected slates in the script window and printing out 
storyboard bins that include your script.

The following is an example of an audio/visual script for a news mag-
azine piece, imported into the script window, with most of the basic 
features of script integration applied.
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Script Window Basics

This section describes basic procedures for creating and manipulating 
script windows, including importing script text; navigating through 
the script; displaying clip information; opening, closing and saving 
windows; and adjusting margins. 

n Before you begin creating script windows, make sure you have established the 
proper defaults in Script Settings for font, margin, and display of frames and 
takes, as described in the Avid Media Composer Products Reference. These 
parameters can also be changed manually, as described throughout this chap-
ter.

Narration track is 
synced to the script.

All possible B-roll 
shots are ready to be 
loaded and cued. 
Color indicates pre-
ferred shots.

Music cuts are linked 
to appropriate sec-
tions of the script.
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Importing a Script

The Þrst step in script integration is to import a script in the correct 
format.

c The imported script must be in ASCII text format. However, to 
maintain the original formatting, export the script from your word 
processor by using the Òtext with layoutÓ option. If you export the 
script as ÒtextÓ only, the formatting will be lost.

To import a new script:

1. Place the Þle in a directory that is available to your system in one 
of the following ways: 

¥ Transport the Þle on a diskette and copy it to your internal 
hard drive.

¥ Place the Þle in a network location that you can access from 
your system.

2. From within the Media Composer application, choose New Script 
from the File menu.

A directory dialog box appears.

3. Locate the Þle and double-click it, or select the Þle and click Open.
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The system creates a new bin named after the project by default. 
The script, with its original layout, appears in the bin.

4. Change the name of the script bin by clicking the title in the 
Project window and typing a new name.

Opening, Closing, and Saving the Script Window

The script window behaves in many respects like a bin:

¥ When you make changes in the script window, a small diamond 
icon appears in the title bar to indicate that the changes have not 
yet been saved.

¥ You perform a save by choosing Save Script from the File menu.

¥ Auto-save functionality also applies to the script window, based 
on parameters established in the Bin settings.

¥ Script window Þles are saved in the folder for the project along 
with bins, and backup copies are automatically stored in the Attic 
folder.

¥ You can use the Open and Close commands in the File menu to 
open additional script windows and add them to the Project win-
dow, or to close script windows.

Displaying Clip Information in a Script Window

To open the Clip Information window from a script window:

1. Press the Option key and click the take tab.

2. Drag the window to a new location to leave the window open.

For information on the Clip Information window, see ÒUsing the Clip 
Information WindowÓ on page 232.
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Navigating in the Script Window

After importing a script, you can navigate to any point in the text by 
using basic techniques available in most word processors:

¥ Use the scroll bar on the right to scroll up or down.

¥ Resize the window by dragging the size box in the lower right cor-
ner.

¥ Press the Page Down or Page Up key to move a screen at a time.

¥ Press the Home or End key to move to the beginning or end of the 
script.

¥ Press the Up Arrow or Down Arrow key to move your line selec-
tion up or down by one line.

n You can also use several search features, as described in ÒSearching Through 
ScriptÓ on page 302.

Adjusting the Script Margins

You can resize a script window at any time to show more script or to 
enlarge the right margin by dragging the size box in the lower right 
corner.

The default size of the left margin is established on import, based on 
the current Script settings. You can also override the margin setting 
and adjust the left margin after importing the script.

To adjust the left margin of an imported script:

1. Choose Left Margin from the Script menu.

The margin dialog box appears.

Scroll bar

Size box
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2. Type a new margin size, in pixels, into the text entry box and click 
OK.

The script window reßects the new setting.

Manipulating Script Text

After importing a script, you can customize its appearance by chang-
ing the font and font size. You can also cut, copy, paste, or remove lines 
of script to reßect changes that might occur in the course of a project.

Changing the Font of the Script

The default font and font size used in the script are established on 
import, based on the current Script settings. You can also override the 
settings and change the font and size after importing the script.

To change the font and size of imported script:

1. Choose Set Font from the Edit menu.

The font dialog box appears.
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2. Choose a new font from the pop-up menu. The menu includes all 
fonts currently installed in the Fonts folder of the Macintosh Sys-
tem Folder.

3. Type a new font size into the entry box and click OK.

The script window reßects the new settings.

n As you enlarge font size, the available sizes for the slate frames also increase. 
This can be useful for presentation or screening purposes, when you need to 
display extra-large text and slate frames for a large audience or across a room. 
For information on enlarging slate frames, see ÒResizing a SlateÓ on 
page 308.

Selecting Text

Selecting text in the script window is similar to making selections in a 
word processor, except that the smallest unit you can select is an entire 
line of text. 

To select a single line of script, click anywhere in the line to highlight 
it.
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To select several lines of script, use one of the following methods:

¥ Lasso the Þrst line of the selection and drag through the text. As 
you drag, a box appears to outline your selection.

Selected lines are 
highlighted.

Lasso a portion of 
script to select it.
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Release the mouse button when you Þnish lassoing the chosen 
lines. The text is highlighted.

¥ Click the Þrst line of the selection, then press the Shift key and 
click the last line. The entire block of text is highlighted.

n You can also extend a selection by pressing the Shift key and clicking a line of 
text preceding or following the current selection.

Cutting, Copying, and Pasting Script

You can cut, copy, and paste text in the script just as you would in a 
normal word processor. However, because you cannot select individ-
ual words or characters, you can only move lines or paragraphs. 

c You cannot undo cut, copy, or paste procedures in the script window.

To cut or copy and paste lines of script:

1. Select the lines.

2. Press kÐC to copy, or kÐX to cut.

3. Select the line below the location where you want to insert the text.

4. Press kÐV to paste the text.   

If only one line is selected at the insertion point, an alert message 
asks if you want to replace the selected line.
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5. Select one of the following:

¥ Click Yes if you selected lines at the insertion point that you 
want to overwrite.

¥ Click No if you want to insert the text above the selected line.

The text is pasted into the script.

n To rearrange or rewrite individual words or characters in the script, you 
should make the changes in a word processor before importing them into a 
separate script window. You can then use the procedures in this section to 
copy and paste the new lines into the existing script window, overwriting the 
incorrect lines.

Removing Script Text

You cannot delete lines of text from the script window by using the 
Delete key as you would in a normal word processor. Use the Cut 
command to remove the text instead.

To remove lines of script:

1. Select the lines of script you want to delete.

2. Press kÐX to cut the text from the script.

Unlike a normal deletion, the text remains in the Macintosh Clipboard 
until the next time you copy or cut a selection.
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Searching Through Script

You can use the Find 
Bin and Find Script but-
tons to match back and 
forth between script 
and clips. For more 
information, see ÒFind-
ing ScriptÓ on 
page 321.

Script integration provides a number of search tools you can use dur-
ing the preparation phase, during editing, or during screenings. You 
can apply and search for page or scene numbers, or you can conduct a 
full-text search.

Using Page and Scene Numbers

When you add page and scene numbers to the script window, you 
gain the ability to search for them during preparation of the script and 
during editing. You can customize page and scene numbering by add-
ing, changing, and moving the numbers as necessary.

Adding a Page or Scene Number

To add a page or scene number:

1. Select the line of the script at the beginning of the scene or page.

2. Click the Add Scene or the Add Page button in the script window 
tool bar, or choose Add Scene or Add Page from the Script menu.

The Add Scene or Add Page dialog box appears.

3. Type the number for the scene or page, and click OK.
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In the case of a scene, the number appears in the left margin next 
to the Þrst line of the selected region.

Scene and page numbers both appear in the status bar at the bot-
tom of the script window, and reßect your current position within 
the script. Each scene or page number will continue throughout 
the script until you mark another line as the beginning of a new 
scene or page.

Changing a Page or Scene Number

You can change a scene or page number both to correct any errors that 
occur when adding numbers, and to reposition scene and page num-
bering to match script changes during postproduction.

To change a page or scene number:

1. Select the beginning line of the previous scene or page.

2. Click the Add Scene or Add Page button in the script window tool 
bar, or choose Add Scene or Add Page from the Script menu.

The Change Scene or Change Page dialog box appears.

New scene number

Scene/page status bar
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3. Type a new number for the scene or page and click OK.

4. If the renumbering affects page or scene numbers that precede or 
follow the current change, then repeat these steps as necessary.

Deleting a Page or Scene Number

To delete a page or scene number:

1. Select the Þrst line of the scene or page.

n You can also delete all page or scene numbering throughout a range of the 
script by selecting the range of lines, or the entire script.

2. Press the Delete key.

The Delete dialog box appears.
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3. Select the options for Delete scene or Delete page break(s), as 
appropriate, then click OK.

The numbering is deleted from the script window.

Searching for a Page and Scene Number

Once you have added scene and page numbers, you can search for 
them quickly during editing.

To search for a page or scene number:

1. Choose Goto Page or Goto Scene from the Script menu. 

n You can also click on the page or scene display in the status bar at the bottom 
of the script window.

A dialog box appears.

2. Type the number of the scene or page and click OK.

The script window scrolls to the page or scene, and the Þrst line of 
script is highlighted.

Conducting a Text Search

To search for text in the script:

1. With the script window active, choose Find from the Edit menu.

The Find dialog box appears.

2. Type the text you are looking for.

3. Select one of the optional search parameters, when appropriate:

¥ Choose Ignore case if you do not want the search to be case 
sensitive.

¥ Choose Whole word if you do not want the search to highlight 
instances where your text is one part of another word.
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4. Click OK. 

The Þrst occurrence of the text is highlighted in the script window.

5. Choose Find Again from the Edit menu to search for the next 
occurrence of the text.

Linking Clips to the Script

To link clips to the script:

1. Open the script bin.

2. Open the source bin for the clips that you want to link to the script.

3. (Option) Sort the source clips to make the job easier:

¥ You can sort the Scene/Take column for an alphanumeric list 
of clips that matches their relative order in the script.

¥ If you are not working with scene and take information (for 
example, in a video documentary project), you can provide 
your own numbering for the clips in a custom column, or you 
can sort the clips manually in Frame mode according to their 
order in the script. For more information on adding a custom 
column, see ÒAdding Customized Columns to a BinÓ on 
page 247.

4. Select the portion of the script that is covered by the Þrst clip or 
clips.

5. Select the clip or clips in the source bin and drag them to the high-
lighted text.
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A slate frame appears above the text, with one or more of the takes 
covering the scene as lines.

6. Continue to apply clips to additional portions of the script until 
you have Þnished creating all your slates.

Alternatively, you can create slates one at a time, place script 
marks, and Þne-tune the lining of each scene before proceeding to 
the next portion of the script.

Drag a clip or several clips to 
the highlighted text.

The slate appears.
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Manipulating Slates

Once you create a slate by dragging a clip into the script window, you 
can manipulate the slateÕs appearance and position.

Selecting Slates

There are several ways to select slates:

¥ Click a slate to select it.

¥ Shift-click additional slates to select all the active takes.

¥ Drag a lasso through a region of the script containing slates. All 
slates and takes within the lasso are selected.

n Selecting multiple slates is especially useful when you are adding or deleting 
color or off-screen dialog indicators across takes, as described in ÒManipu-
lating TakesÓ on page 311.

Resizing a Slate

You can resize a slate the same way you resize frames in the bin in 
Frame mode:

¥ To enlarge a slate, select it and press kÐL or choose Enlarge Frame 
from the Edit menu.

¥ To reduce a slate, select it and press kÐK or choose Reduce Frame 
from the Edit menu.

n You can enlarge the font size of the script to increase the size of the slate 
frames. This can be useful for presentation or screening purposes, when you 
need a large display for an audience. For information on resizing the font, see 
ÒChanging the Font of the ScriptÓ on page 297.
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Hiding Slate Frames

By default, the system displays a representative frame for each take in 
the slates. You can hide this frame display and show only the clip 
name to simplify the interface or speed up scrolling and movement in 
a complex script window.

To hide the slate frames, choose Show Frames from the Script menu. 
The script window shows only the clip names for the takes.

To restore the frames, choose Show Frames again.

Showing One Take Per Slate

You can display only one representative take per slate to minimize 
clutter on the screen.

To show one take per slate, choose Show All Takes from the Script 
menu. The script window shows only the Þrst take in each slate.
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To display all the takes, choose Show All Takes again.

Moving a Slate

You can adjust the position of slates to make room for more slates, to 
avoid blocking words, or to display takes over speciÞc lines.

To move a slate, use one of the following methods:

¥ To move a slate horizontally, click the slate and drag it to the left or 
the right.   (If necessary, resize the script window by dragging the 
size box.)

¥ To move a slate vertically without moving the position of the take 
lines in the script, click the slate and drag it up or down. The take 
lines remain Þxed over the text to which they have been previ-
ously linked.

¥ To move the slate and all its take lines vertically to a new location 
in the script, press the Command key, then drag the slate to the 
new location.

A single take is shown.
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n As you move the slate, the takes continue to cover the same number of lines in 
the script. To lengthen or shorten the number of lines covered in the takes at 
the new location, see ÒAdjusting Take LinesÓ on page 314.

Deleting a Slate

Occasionally you might need to delete a slate Ñ for example, when 
you Þnd that the takes in the slate are no longer needed.

n When you delete slates and takes from the script window, the digitized source 
clips remain in the source bins.

To delete a slate:

1. Select all the takes in the slate by pressing the Shift key and click-
ing the tab for each take.

2. Press the Delete key.

The Delete dialog box appears, indicating the number of takes to 
be deleted.

3. Click OK to delete the takes.

The slate and all its takes are deleted from the script.

Manipulating Takes

Script integration provides a number of tools and techniques for 
manipulating the relationship between lined takes in the script win-
dow and their source clips, as described in this section.

Selecting Takes

To select takes, use one of the following methods:
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¥ Click any take tab to select it. The outline of the take becomes bold 
to indicate that the take is active.

¥ Shift-click additional takes in the same slate or across slates to 
select them.

¥ Drag a lasso through an entire region of the script. All takes within 
the lasso are selected.

n Selecting multiple takes is especially useful when adding or deleting color or 
off-screen dialog indicators, as described in ÒIndicating Off-Screen DialogÓ 
on page 315, and ÒUsing Color IndicatorsÓ on page 316.

Adding Takes

To add another take to an existing slate:

1. Select the region of the script that the take covers.

2. Open the bin where the clip for the take is located.

3. Drag the clip to the slate.

The new take appears in the slate and is applied to the selected 
region of the script. 

Deleting Takes

As you screen clips, you might Þnd that a take has been applied to the 
wrong scene and should be deleted from the slate.   Or, you might 
decide to delete a bad take to simplify the script interface for the edi-
tor.

To delete one or more takes:

1. Select the takes.

2. Press the Delete key. 

The Delete dialog box appears.
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3. Click the Delete Takes checkbox, then click OK.

The takes are deleted.

Displaying Take Numbers

To display take numbers within the tab of each take, enter the numbers 
in the Take column of the source bin for the clips.

Changing the Representative Frame for a Take

To change the representative frame that appears in the slate for a take:

1. Select the take.

2. Press the appropriate J-K-L (step) keys on the keyboard to advance 
the footage displayed in the slate forward or backward to the 
frame you want.

You can also select multiple takes and advance them all at once.

Numbers in the Take column 
appear in the tabs for each 
take.
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Loading Takes

You can load individual takes into the Source monitor one at a time, or 
you can load multiple takes, as follows:

¥ Double-click any take tab.

¥ Select multiple takes, then double-click any take in the selection. 

Playing Takes

There are two ways to play back a take:

¥ Double-click a take to load it into the Source monitor, then click 
the Play button or press the Play key. 

The clip plays back and stops when it reaches the end. 

¥ Select a take in the script, then click the Play button at the top of 
the script window. 

The clip loads and plays back in a continuous loop until you press 
the space bar. If you selected more than one take, each take will 
play in sequence.

Adjusting Take Lines

As you screen clips in the script, you might Þnd that a take or group of 
take lines should begin earlier or end later in the script. You can adjust 
the take lines by moving the beginning mark, the end mark, or both.

To change the length of a take line:

1. Press the Command key (k). 

Notice the movement icon that appears when you point the cursor 
at either end of the take.

2. Click the end mark or beginning mark of a take and drag it until 
you reach the correct line in the script.
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3. Press the Command key and drag the opposite end of the take to a 
new location if necessary.

4. Repeat the procedure for other takes in the slate as necessary. 

Indicating Off-Screen Dialog

In the traditional lined script, you indicate off-screen dialog by draw-
ing a jagged line next to the dialog. You can apply a similar effect to 
lines in the script window.

To indicate off-screen dialog:

1. Select the range of script containing the off-screen dialog.

2. Select one or more takes that you want to mark with the off-screen 
indicators.

3. Click the Off-Screen button in the script window tool bar.

The indicators appear, superimposed on the selected takes. You 
can toggle the indicators on or off by clicking the button repeat-
edly. 

To remove one or more off-screen indicators:

1. Select the range of script containing the off-screen indicators.

2. Select only those takes that display the indicators.

3. Click the Off-Screen button.
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Using Color Indicators

You can use color to indicate several pieces of information, including:

¥ Preferred takes or takes used in the current active sequence

¥ Picture versus audio track used in the current active sequence

¥ Line changes in dialog

¥ Use of multiple cameras

To apply color to takes:

1. Choose a color from the Color submenu of the Script menu.

2. Select the region of the script that covers the range within the take 
or takes that you want to highlight with color.

3. Select one or more takes.

4.  Click the Color button in the script window tool bar.

The color appears only in the highlighted script region of the 
selected takes. You can toggle the indicators on or off by clicking 
the button repeatedly.

To remove one or more color indicators:

1. Select the range of script containing the color indicators.

The Þrst take in the selected region determines the color indicator 
status displayed in the Color button.

2. Select only those takes that display the indicators.

3. Click the Color button.

Using Script Marks

Script marks allow you to synchronize individual lines of script with 
matching points in digitized clips. When you place a mark in the 
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script, an IN mark also appears in the clip when you load it into a 
monitor for editing. This provides line-by-line control over alternative 
takes that the editor can instantly load and edit into the sequence.

You can place script marks one take at a time, or you can automate the 
process of screening and marking selected takes in a playback loop.

Placing Script Marks Manually

To place script marks manually:

1. Map the Add Script Mark button from the Command Palette to a 
user-customizable palette or to the keyboard.

2. Double-click in the script window at the intersection of a take and 
the line of dialog that you want to mark. 

The take is selected in the slate, the chosen line of the dialog is 
highlighted, and the clip loads into the Source monitor.

3. Click or press Play. The take plays in the monitor.

Alternatively, you can step (jog) or shuttle through the footage, 
place the position indicator on the exact frame, or scrub the audio 

Intersection of take 
and line of dialog
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to Þnd the exact line of dialog. The clip does not have to be play-
ing.

4. When the playback reaches the chosen line of dialog, click the Add 
Script Mark button or key. 

The line is marked in the script window with a small horizontal 
bar, and play stops.

5. Repeat these steps to add additional script marks.

Automating Screening and Marking

The script window provides controls for automating the process of 
screening and placing script marks for a single take or across multiple 
takes.

To use automated screening and marking:

1. Select one or more takes.

2. Click the Record Marks button in the script window tool bar.

The Þrst selected take turns green in the script window, the system 
automatically loads the clip into the Source monitor, and the clip 
begins to play.

The script mark 
appears
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3. As you hear a line of dialog (or see a particular shot) that you want 
to mark, click the matching line in the script window.

A script mark appears at that location in the take, and the clip con-
tinues to play.

4. Continue to mark additional sync points by using one of the fol-
lowing methods:

You can scroll through 
the script window with-
out affecting playback.

¥ Click a line that already contains a mark to replace the previ-
ous mark and update the sync point in the clip.

¥ Click a line in the script before or after the range of the exist-
ing take line, and the mark will be added while the take line is 
extended to include the new line.

¥ Use variable-speed play controls (J-K-L keys on the keyboard) 
to shuttle, step, or pause during playback.

¥ Press the Tab or Shift-Tab keys on the keyboard to begin play-
back of the next or the previous take.

As each take reaches its end, the system automatically loads and 
plays the next take.

5. Continue to place marks until all takes have been screened.

6. To stop the playback loop, press the space bar.

Current playback is 
highlighted in green.

Several takes are 
selected for automated 
playback.
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Loading and Playing Marked Segments

Once you have placed marks syncing lines in your script to points in 
the source clips, you can quickly load and cue takes for selected lines 
of dialog. You can load a single take, or you can load all the coverage 
for any given range of lines.

To load the marked segment of a take, click the script mark at the line 
of dialog that you want to cue.

The take is loaded into the Source monitor and cued to the synced line 
of dialog. An IN mark is placed at the sync location.

To load all the coverage for a range of lines:

1. Select the lines in the script window, dragging through all inter-
secting takes.

The script lines and takes are highlighted.

2. Click the Play button in the script window if you want to screen 
the takes for those lines, or click the Record Marks button if you 
want to add script marks.

The takes load and play back one after another. You can use the 
Tab key or J-K-L keys to jump between takes and control playback.

Moving a Script Mark

When you move a script mark up or down, the mark in the source clip 
remains at the same frame, but is resynced to a new line in the script.

To move a script mark:

1. Press the Command key.

Notice the movement indicator that appears when you point the 
cursor at a mark in the script.

2. Click the mark and drag it to the new position.
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Deleting a Script Mark

When you remove a script mark, you do not delete the marked portion 
of the take, only the sync point between the script and the source clip.

To delete a script mark:

1. Click once on the mark. (If you double-click, you will load the clip 
and make the Source/Record window active.)

2. Press the Delete key. 

The Delete dialog box appears.

3. Click OK. The mark is deleted.

Finding Clips and Script

After you have placed script marks, synchronizing lines in the script 
window to frames in the source clips, you can use the Find Bin or Find 
Script buttons to search back and forth between the two.

Finding Script

The Find Script button allows you to quickly match back from cur-
rently loaded clips to portions of script in the script window to which 
the clip has been linked.

To Þnd the script linked to a loaded clip:

1. Place the position indicator in the clip at the line of dialog (or 
within a range of dialog) that you want to Þnd.

2. Click the Find Script button.

The script window instantly scrolls to and highlights the portion 
of script that most closely matches the clip location.
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Finding Clips and Bins from the Script

Script integration allows you to search instantly through bins and Þnd 
the source clips for takes that have been linked to the script. You can 
search on a single take, or on multiple takes across several slates.

To Þnd source clips and bins:

1. Select the takes that you want to Þnd.

2. Click the Find Bin button in the script window tool bar.

The system searches through bins linked to the project, opens the 
bin containing the linked clips, and highlights them in the bin.

Editing with the Script Window

Using the script window in combination with the Single Mark Editing 
feature, an editor can conduct a highly streamlined form of editing. To 
use the script window most effectively during a session, make sure:

¥ The script window is fully prepared, including preferred takes, 
alternative takes (indicated with colors), and script marks for 
matching lines of text to sync points in the clips.
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¥ The Single Mark Editing option is enabled in Composer settings. 
This option allows you to skip several steps by performing edits 
on-the-ßy while playing back clips (without marking OUT points). 
For more information, see ÒUsing Single Mark EditingÓ on 
page 386.

Script Editing Workflow

To quickly assemble a rough cut from the script window:

1. Open the script window for the current cut.

2. Double-click the Þrst preferred take and load it into the Source 
monitor. The IN point is already marked and cued.

3. Play the take until the appropriate OUT point is reached, and click 
the Splice-in or Overwrite button to make the Þrst edit.

4. Prepare the sequence for the next edit:

a. Create new tracks if necessary.

b. Enable the appropriate source and record tracks.

c. Patch the tracks if necessary. 

d. Mark an IN point in the sequence for the next edit.

5. Double-click the next preferred take to load it.

6. Play the clip until you reach the appropriate OUT point, and per-
form the edit on-the-ßy.

7. Repeat steps 4 through 6 until you have walked through the entire 
scene or segment.

8. Fine-tune the edits by using normal trimming and editing proce-
dures. Continue to use the script window to quickly load and cue 
alternative takes as necessary.
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Splicing a Script Range

During editing, you can use the Control key to instantly splice clips 
linked to ranges of script directly from the script window into the 
sequence. To use this feature with accuracy, you should carefully mark 
the ranges of script during the screening and marking phase.

To splice a range:

1. Mark an IN point or place the position indicator at the location in 
the sequence where you want to splice in the segment.

2. Press the Control key. Notice that the Splice-insert arrow appears 
when you point to a take.

3. Double-click the preferred take within the range of dialog that has 
been marked.

The marked section of the clip is spliced into the sequence.

Revising the Script

During or after each session, or when a scene or segment is completed, 
the editor or assistant editor can update the script window to reßect 
the Þnal edit decisions made during the day.   In this way you can 
maintain a complete record of the elements used to construct the scene 
or segment, as well as all existing alternatives. When further changes 
or repackaging are required, you can quickly retrieve all the source 
material in one window.

Interactive Screenings

The script window can be an invaluable tool during screenings of 
work in progress, allowing you to:

¥ Quickly search for scenes and pages with clips attached for instant 
retrieval.
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Sequences cannot be 
loaded into the script 
window. Alternatively, 
you can perform a 
video mixdown and 
load the resulting mas-
ter clips instead. For 
more information, see 
ÒUsing Video Mix-
downÓ on page 629.

¥ Match back and cue source material to compare alternative takes.

¥ Quickly Þnd and open bins for retrieval of additional material not 
included in the script window.

¥ Enlarge the script font and slate frames for better viewing by your 
audience.

The script window provides a visual, interactive look at the content of 
the original script versus the elements in the Þnal piece.

Matching colors indicate takes 
used in the preferred cut as 
well as alternative cuts.

You can mix down alternative 
cuts to form master clips and 
place them alongside the script.

All alternative takes are 
available for viewing and 
comparing.
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CHAPTER 12

Viewing and Marking 
Footage

Before making your Þrst edit, you can review your footage, add loca-
tors to clips, mark IN and OUT points, or create subclips. By viewing 
and marking your material in advance, you can concentrate on editing 
and reÞning your sequence at a later time without having to pause 
and set marks each time you load a new clip. Complete techniques for 
playback, viewing, and subcataloging clips are described in the fol-
lowing sections:

¥ Customizing the Composer Window

¥ Viewing Methods

¥ Using the Window Zoom Box

¥ Loading and Clearing Footage

¥ Controlling Playback

¥ Marking and Subcataloging Footage

¥ Finding Frames, Clips, and Bins

¥ Using the Manual User Interface (MUI)
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Customizing the Composer Window

The Composer window is central to the editing process, providing all 
the essential controls for viewing, tracking, marking, and editing 
source and record footage.

The Composer window consists of all the elements displayed by 
default in the Edit monitor. The upper region of the screen constitutes 
Source/Record mode. The lower region constitutes the Timeline win-
dow.

Use the Composer Settings dialog box and various pull-down menus 
within the Composer window to conÞgure displays and functions. 

You can learn about Composer settings as follows:

Source/Record
window

Timeline
window

Composer window



328

¥ For an overview of all Composer settings, see the Avid 
Media Composer Products Reference.

¥ For more information on the following settings, see the applicable 
sections in this guide:

- Digital audio scrub parameters (see ÒUsing Digital Audio 
ScrubÓ on page 484)

- Play Multicamera Singularly option (see Chapter 18)

- Sync Point Editing (see ÒUsing Sync Point EditingÓ on 
page 567)

- Phantom Marks option (see ÒUsing Phantom MarksÓ on 
page 386)

- Options for creating tracks in the Timeline (see ÒAdding a 
TrackÓ on page 443)

In addition, you can:

¥ Map various buttons onto command palettes or the keyboard, as 
described in ÒAbout Button MappingÓ on page 96.

¥ Display or hide labels on buttons by using Interface settings, as 
described in ÒReviewing Basic SettingsÓ on page 63.

¥ ConÞgure the appearance of the Timeline as described in ÒCus-
tomizing Timeline ViewsÓ on page 399.

Changing the Source/Record Window Background Color

To change the background color of the Source/Record window:

1. Click in the Source/Record window to make it active.

2. Choose Set Composer Background from the Edit menu.

3. Choose a shade of gray for the background from the pop-up pal-
ette.
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Using the 16 x 9 Display Format

Releases 6.0 and later of the Avid Composer system support the 16 x 9 
display format for standard NTSC and PAL signals. This option allows 
you to display the full aspect ratio of wide-screen video in the Source 
and Record monitors during editing.

n The 16 x 9 preference does not enable the use of 16 x 9 HDTV (High DeÞni-
tion Television) video with the Avid Composer system. You can, however, 
transfer HDTV to NTSC or PAL videotape formats that you can digitize for 
ofßine editing.

To enable the 16 x 9 display:

1. Click the Settings button in the Project window.

2. Double-click Composer in the Settings scroll list. The Composer 
Window Settings dialog box appears.

3. Select Big Source/Record Monitors.

4. Select the option for 16 x 9.

Displaying Tracking Information

Tracking information consists of any type of format used to identify 
clips, audio and video tracks, individual frames, or footage durations 

16 x 9 option
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while you work. The Media Composer interface displays this informa-
tion above the monitors in the Source/Record window. This informa-
tion is updated continuously to reßect your current position in the 
footage. You can choose various alternative tracking formats from 
pull-down menus.

By default, the tracking information area displays no information until 
you select a tracking format. In addition, there is no display of tracking 
data when there is no material loaded in the monitor. If you load a clip 
and no information is currently displayed, you can still open the pull-
down menu by clicking in the area above a monitor.

To choose a tracking information format:

1. Load a clip or sequence into the monitor.

2. Click in the information display area in either the Þrst or second 
row of information above the monitor and choose a format.

First row of infor-
mation (the bottom 
row)

Second row of 
information (the 
top row)

Pull-down menus 
for the selected 
source-side row

Click on display 
area to access 
Tracking Informa-
tion Display menu

Tracking Information Displays for the Source and Record monitors
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For more information 
on Composer settings, 
see the Avid Media 
Composer Products 
Reference.

If you select the option for two information rows above the monitors 
in the Composer settings, you can display two different types of track-
ing information for the footage in each monitor. For example, you can 
display both running timecode and IN to OUT durations for clips 
loaded in the Source monitor. You can display similar information for 
the sequence shown in the Record monitor.

Tracking Format Options

The Tracking Information Display menu contains a number of options 
for information to display above the monitors. The following is a sum-
mary of the contents of the menu.

¥ The upper portion of the menu lists options for summary informa-
tion, such as master timecode (Mas), duration of the entire clip 
(Dur), IN to OUT duration (I/O), absolute timecode (Abs), and 
time remaining (Rem).

¥ The second portion of the menu lists options for displaying the 
timecode for a speciÞc track (V1, A1, A2, and so forth). This list 
contains options only for the tracks existing in the currently 
loaded clip or sequence. For example, a clip with only one audio 
track does not show an option for A2.

Upper portion of 
the menu

Second portion of 
the menu
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¥ The menu for the Record monitor contains an added third portion 
for displaying Clip Name. Choose this option to display clip 
names in the sequence for a particular track that you choose from 
a submenu. The name displayed is continuously updated based 
on the location of the position indicator.

¥ The lower portion of the menu lists tracking formats, such as time-
code in hours, minutes, seconds, and frames (Timecode), feet and 
frames for Þlm projects (Footage), a sum total of frames for either 
Þlm or video (Frames), or none, to leave the display area blank.

Displaying the Clip Information Window

The Clip Information window displays statistical information about a 
clip. You can open the Clip Information window from the Source and 
Record monitors or a pop-up monitor. The window updates the infor-
mation automatically.

With the Timeline active, click in the gray area just above the Splice-in 
or Overwrite buttons.

¥ To display information about the clip or sequence in the Source 
monitor, click above the yellow Splice-in button. 

Third portion 
(Record monitor 
menu only)

Lower portion of 
the menu
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¥ To display information about the sequence in the Record monitor, 
click above the red Overwrite button.

Only Þelds with data will be displayed.

As you move the position indicator through the clip in the Source or 
Record monitor, the information in the window is updated.

n Around the Source and Record monitors, you can click almost anywhere 
within the gray area to open the Clip Information window.

If no clip is loaded in the Source or Record monitor, the Clip Information win-
dow does not open.

To open the Clip Information window from a pop-up monitor:

1. With a pop-up monitor open, click in the gray area at the top of the 
pop-up monitor.

2. Drag the window to a new location to leave the window open.

For more information, see ÒUsing the Clip Information WindowÓ on 
page 232.
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Setting Timecode Displays

Each pop-up monitor has two lines available to display timecode. The 
Timeline also displays two lines of timecode. The Timecode window 
allows you to display up to eight lines of timecode in a separate win-
dow. 

To set a timecode display:

1. Choose Timecode from the Tools menu.

The Timecode window opens.

If you resize the Timecode window, the text adjusts to Þt the win-
dow.

2. Click anywhere in the Timecode window. The Timecode pop-up 
menu appears.

3. Choose an option from the Timecode pop-up menu. See Table 12-1 
for a description of these options.

The window displays the timecode you have chosen.

Resize

Close box

Table 12-1 Timecode Display Options 

Option Description

Mas Displays master timecode at present location.

Dur Displays total duration of the sequence. 
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Setting Multiple Timecode Displays

To set multiple timecode displays:

1. Place the cursor anywhere in the Timecode window, and press the 
mouse button.

2. Select Add Display from the pop-up menu. The maximum num-
ber of lines to display is eight.

n You might need to resize the timecode display to see all the options. To do so, 
click and drag the lower right corner of the window. 

I/O Displays duration between IN and OUT marks.

Abs Displays absolute time duration at present posi-
tion.

Rem Displays time remaining at present position.

V1 Displays the source track of the video on track 1.

A1 Displays the source track of the audio on track 1.

A2 Displays the source track of the audio on track 2.

Timecode Displays tracking information as timecode.

Footage Displays tracking information as feet and 
frames.

Frames Displays tracking information as total frames.

None Hides the display of information.

Add Display Allows you to set multiple timecode displays.

Table 12-1 Timecode Display Options (Continued)

Option Description
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3. Click the close box to close the Timecode window.

Viewing Methods

You can work with clips and sequences in several different ways, 
depending upon your needs and preferences. Each method has its 
own uses and advantages, as follows:

¥ Viewing in bins: You see pictorial images of the clips in your bins 
by using Frame view. You can also list the clips by name by using 
Text view.

¥ Viewing in the Source monitor: You can load clips and sequences 
into the Source monitor to view and mark or subcatalog shots for 
use in a sequence that you build in the Record monitor.

¥ Viewing in the Record monitor: You can load a sequence into the 
Record monitor to view, mark, or modify an existing sequence. 
You cannot load clips directly into the Record monitor unless you 
option-drag a series of clips to create an Òinstant sequence (rough 
cut).Ó For more information, see ÒCreating an Instant Rough CutÓ 
on page 381.
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¥ Viewing in pop-up monitors: You can load clips into pop-up 
monitors to view and mark one or several clips simultaneously in 
smaller, movable windows.

Source monitor with clip loaded Record monitor with sequence loaded

Two pop-up moni-
tors with clips 
loaded
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¥ Viewing in the Timeline: Use the Timeline to view individual 
tracks for either a sequence or a source clip.

¥ Viewing in NTSC mode: You can use the third, full-screen moni-
tor to view your footage in a broadcast format.

Using the Window Zoom Box 

The zoom box allows you to shrink the Source and Record monitors 
and any pop-up monitor, displaying only the position bars for each 
window, the editing buttons, and the Timeline. No video is displayed 
(except on the third, full-screen monitor).

To shrink the monitors to display only the position bars, the editing 
buttons, and the Timeline:

1. With the Record monitor active, click the zoom box located in the 
upper right corner of the Record monitor.

The video disappears. Only the Source and Record monitors, posi-
tion bars, buttons, and Timeline are displayed.

2. With the Record monitor active, click the zoom box again to redis-
play the video.

Timeline in Source 
mode for viewing 
tracks

Zoom box
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Loading and Clearing Footage

You can load individual or multiple clips or sequences into the Source 
and Record monitors, into pop-up monitors, or into Full-Screen mode 
by using different methods. You can also use the Monitor menus to 
display or clear clips and sequences from the screen, as described in 
this section.

Loading into Source, Record, and Pop-Up Monitors

To load a single clip or sequence:

1. Open a bin and locate the clip or sequence.

2. Double-click the clip or sequence with one of the following results:

¥ If you have set the ÒLoads clip into source or record monitorÓ 
option in the Bin Settings dialog box (the default setting), a 
clip loads into the Source monitor or a sequence loads into the 
Record monitor.

¥ If you have set the ÒOpens new monitor for clipÓ option in the 
Bin Settings dialog box, the clips load into multiple pop-up 
monitors.

Press and hold the 
Option key, then dou-
ble-click to reverse the 
outcome.

You can also load a sequence into the Source monitor (for editing into 
another sequence, for instance) by clicking and dragging from the bin 
to the monitor.

Loading Multiple Clips or Sequences

You can quickly load several clips and sequences into the Source and 
Record monitors, or into multiple pop-up monitors.

To load multiple clips:

1. Open a bin and Shift-select clips, or lasso multiple clips.
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You can also drag mul-
tiple clips directly into 
the Record monitor to 
create a sequence. For 
more information, see 
ÒSelecting Clips and 
SequencesÓ on 
page 233.

2. Drag the selected clips to a monitor, or double-click one of the 
selected clips, with one of the following results:

¥ If you have set the ÒLoads clip into source or record monitorÓ 
option in the Bin Settings dialog box (the default), the clips 
load into the Source monitor.

Press and hold the 
Option key, then
double-click to reverse 
the outcome.

¥ If you have set the ÒOpens new monitor for clipÓ option in the 
Bin Settings dialog box, the clips load into multiple pop-up 
monitors.

Using the Monitor Menus

When you have clips loaded into a monitor, you use the Monitor pull-
down menu located above each monitor to switch between various 
loaded clips, or to clear clips from monitors.

Switching Between Loaded Clips

When you have loaded multiple clips into the Source or the Record 
monitor, you will see only one clip displayed at a time. You can view 
an alphabetical list of the loaded clips and choose an alternate clip for 
viewing.

To switch between clips:

1. Click the name of the current clip displayed above the monitor to 
reveal the Monitor menu. The list in the lower portion of the menu 
contains a list of all the clips or sequences currently loaded in the 
monitor.
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2. Choose a different clip name from the menu. The selected clip will 
replace the current clip in the monitor display.

n To see the list of clips or sequences sorted in the order in which they were 
loaded into the monitor, press the Option key while opening the pop-up menu.

Clearing Clips from Monitors

There are two options for clearing clips: 

¥ Remove the clip display and leave the monitor black but keep the 
clip loaded.

¥ Remove all the clip names from the Monitor menu and leave only 
the displayed clip loaded.

To clear the monitor or the clip names from the menu:

1. Click the Source monitor or the Record monitor to select.

2. Click the name of the clip currently displayed above the monitor 
to reveal the Monitor menu.

3. Choose one of the following commands:

The lower portion 
of the Monitor 
menu contains a 
list of loaded 
clips.
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¥ Clear Monitor removes the displayed clip from the screen, 
leaving black. The clips are still loaded.

¥ Clear Menu deletes the list of all loaded clip names and leaves 
only the clip currently displayed.

Loading Footage into Full-Screen Mode

Release 7.0 and later of the Avid Composer system supports the use of 
a full-screen monitor. The Full-Screen Monitor window appears on the 
Edit monitor (you do not need a special editor monitor) whether or not 
you have a third (client) monitor. This is helpful when you want to:

¥ Get a better feel for how your footage will play in a large format. 

¥ Examine details in the picture.

¥ Screen clips or sequences for production personnel or an audience 
seated some distance away from the monitors.

To load footage into a full-screen monitor:

1. Load the sequence into the Record monitor.

2. Choose Command Palette from the Tools menu.

3. Click the Toggle Full Screen icon.

The system creates a Full Screen mode workspace, reßected in the 
Settings scroll list. The full screen appears on the Edit monitor.

The Þrst time you use Full Screen mode, you must drag the 
Source/Record Monitors window and the Timeline window to the 
Bin monitor. Subsequently, these windows will appear in the Bin 
monitor whenever you go to Full Screen mode.

4. To return to regular mode, click the Toggle Full Screen icon.

The Full Screen Mode icon can be mapped the same way as other 
command icons.
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Controlling Playback

You can also use the 
MUI (Manual User 
Interface) if your sys-
tem is equipped with 
one. For more informa-
tion, see ÒUsing the 
Manual User Interface 
(MUI)Ó on page 366. 

There are several ways to play, view, and cue clips:

¥ Instantly access frames or move through footage by using the posi-
tion indicator within the position bar under the Source, Record, or 
pop-up monitors.

¥ Play, step (jog), or shuttle through footage by using user-selectable 
buttons.

¥ Play, step, or shuttle by using keyboard equivalents.

¥ Step or shuttle by using the mouse.

Using Position Bars and Position Indicators

You can quickly access frames within a clip thatÕs been loaded into a 
monitor or move through the footage by using the position indicators 
that appear in both the position bars under Source, Record, or pop-up 
monitors, and in the Timeline when you are viewing a sequence.

¥ You can move the position indicator within the position bar under 
the Source, Record, or pop-up monitors by clicking anywhere in 
the position bar, or by dragging the position indicator to the left or 
right. The speed with which you drag the position indicator deter-
mines the speed at which you move through the footage.

¥ In the Timeline, the position indicator shows your position within 
the sequence. It is always in the same position as the position indi-
cator in the Record monitorÕs position bar, and works in the same 
way: you can click anywhere in the Timeline to relocate the posi-

Position barPosition indicator
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tion indicator, or you can drag the position indicator through foot-
age at varying speeds.

¥ You can go directly to the beginning or end of a clip or sequence 
by clicking at the far left or far right of the position bar or the
Timeline.

Using Buttons

You can use the user-selectable buttons that appear below the Source 
and Record monitors and in the pop-up monitors to play and step 
through your footage. You can also use the keyboard to manipulate 
footage.

For more information 
about mapping user-
selectable buttons, see 
ÒAbout Button Map-
pingÓ on page 96.

Aside from the default conÞgurations, these buttons can be remapped 
from the Command Palette in any conÞguration onto any of the user 
palettes and the keyboard.

Play Reverse, Play Forward, Pause, Stop, Rewind, and Fast Forward Buttons

The Play Reverse, Play Forward, Pause, Stop, Rewind, and Fast For-
ward buttons work much like the buttons on any conventional VCR. 
With a clip loaded in a monitor, the Play Forward button plays your 
footage at a normal rate. The Play Reverse button plays backward at a 
normal rate. The Fast Forward and Rewind buttons instantly cue the 
footage to the next transition between clips.

The Play Forward, Fast Forward, and Rewind buttons appear by 
default in the Þrst row of buttons below the Source and Record moni-

Position indicator in Timeline
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tors and the pop-up monitors. Map the Play Reverse, Stop, and Pause 
buttons onto your button rows from the Command Palette.

n During playback, the Play Forward button also acts as a Stop button.

When viewing sequences in the Record monitor, you can play only 
video and audio tracks that are currently monitored in the Track Selec-
tor panel. For more information, see ÒUsing the Track Selector PanelÓ 
on page 435.

Play a clip by using the following procedure:

1. Load a clip or sequence into a monitor.

2. For sequences in the Record monitor, click the Video or Audio 
Monitor buttons in the Track Selector panel.

3. Go to the start of the clip or sequence by clicking the start of the 
position bar under the monitor, or pressing the Home key.

4. To play the clip or sequence, click the Play button under the cho-
sen monitor.

5. To stop playback, press the space bar or click the Play button 
again.

Step Buttons

You can also use the Step buttons under the monitors to play the clip 
backward or forward in 1- to 10-frame increments.

When you have a single row of buttons displayed under your moni-
tors, the Step Forward and Step Backward buttons appear. If you press 
and hold the Option key while clicking either button, you can advance 
10 frames forward and 10 frames backward.

n To display all four Step buttons, you must display two rows of buttons under 
the monitors when conÞguring the Source/Record window in the Composer 
Window Settings dialog box. For more information, see the Avid 
Media Composer Products Reference.
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To step through footage:

1. Load a clip or sequence into a monitor.

2. Press the appropriate key to step 1 or 10 frames forward or back-
ward.

Using the Keyboard

The default keyboard contains all of the buttons mentioned thus far.

n You can move and replace buttons on the keyboard by using the Command 
Palette, as described in ÒAbout Button MappingÓ on page 96.

J-K-L Keys (Three-Button Play)

The J-K-L keys on the keyboard allow you to play, step, and shuttle 
through footage at varying speeds. This feature, also referred to as 
three-button or variable-speed play, allows you to use three Þngers to 
manipulate the speed of playback for greater control.

To shuttle through the footage by using the J-K-L keys on the key-
board:

1. Do one of the following:

Play button

Stop

Step buttons Play/Step/Shuttle buttons Home key
End key
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¥ Load a clip or sequence into the Source or Record monitor.

¥ Open a pop-up monitor.

¥ Select a clip in a bin in Frame mode.

2. Use the following keys to shuttle at varying speeds:

¥ Press the L key to move forward through the footage at nor-
mal speed. Press once to increase the forward speed 2 times, 
twice to increase it 4 times, and 3 times to increase it 8 times 
normal speed.

¥ Press the J key to move backward at the same shuttle speed 
increments.

¥ Press the K and L keys together for slow forward.

¥ Press the K and J keys together for slow backward.

¥ Press the K key and tap the L key or the J key to step through 
footage one frame at a time.

3. To pause the shuttling, press the K key. 

4. To stop shuttling, press the space bar.

Home, End, and Arrow Keys

You can also use the Home, End, and arrow keys (located to the left of 
the numeric keypad) to move through footage when a clip is loaded in 
a monitor.

¥ The Home key takes you to the beginning of a clip or sequence.

¥ The End key takes you to the end of a sequence.

¥ The Left Arrow key moves the footage one frame forward.

¥ The Right Arrow key moves the footage one frame backward.
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Using Single-Field Step

Your Avid Composer system enables you to locate defects on individ-
ual Þelds of a frame with the single-Þeld step feature. By default, 
Media Composer displays the Þrst Þeld of every frame when you step 
through material frame by frame.

With single-Þeld step, you can view both Þelds of each frame sequen-
tially to locate a dropout from the source videotape, or dust and 
scratches from the original Þlm footage.

To use single-Þeld step:

1. Hold down the Control key and click the Step Forward button or 
the Step Backward button.

2. Continue to hold down the Control key while you click the Step 
Forward button (or the Step Backward button) to view each con-
secutive Þeld.

3. To return to viewing one Þeld from each frame, release the Control 
key and click the Step Forward button (or the Step Backward 
button).

Media Composer references the Þeld you were parked on (either 
Þeld 1 or Þeld 2) when you released the Control key. Subsequent 
single-frame steps will be based on this Þeld.

n Any edits you make using the paint tools affect both Þeld 1 and Þeld 2 of each 
frame. 

Using the Mouse

You can use the mouse for one-handed control of playback. You can 
either step or shuttle by using the mouse.
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Stepping with the Mouse

To step by using the mouse:

1. Do one of the following:

¥ Load a clip or sequence into the Source or Record monitor.

¥ Open a pop-up monitor.

¥ Select a clip in a bin in Frame mode.

2. Do one of the following:

¥ Press the N key to activate mouse control for stepping.

¥ Click the Mouse Jog button, which is available on the Com-
mand Palette and can be mapped to any button under the 
Record monitor.

3. Move the mouse to the right to step forward, or to the left to step 
backward.

4. To quit stepping with the mouse, press the space bar.

Shuttling with the Mouse

To shuttle by using the mouse:

1. Do one of the following:

¥ Load a clip or sequence into the Source or Record monitor.

¥ Open a pop-up monitor.

¥ Select a clip in a bin in Frame mode.

2. Do one of the following:

¥ Press the semicolon (;) key to activate mouse control for shut-
tling.

¥ Click the Mouse Shuttle button, which appears on the Com-
mand Palette and can be mapped to an editing button under 
the Record monitor.
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3. Move the mouse to the right to increase the shuttle speed, or to the 
left to decrease the shuttle speed.

4. To quit shuttling with the mouse, press the space bar or double-
click the mouse button.

You can also use the keyboard in conjunction with the mouse to con-
trol shuttling. For example, if youÕre shuttling with the mouse and you 
press the L key, the playback speeds up to the next normal play rate 
(30, 60, 120, or 240 fps for NTSC; 25, 50, 100, or 200 fps for PAL; 24, 48, 
96, or 192 fps for Þlm projects). You can continue to change the shuttle 
speed and direction with the mouse.

Marking and Subcataloging Footage

You can speed the editing process by marking clips with IN and OUT 
points, and/or by subcataloging by using locators and creating sub-
clips, explained in this section. When subcataloging, you might want 
to create or open additional bins for storing and isolating speciÞc sub-
clips, marked clips, or sequences, as described in ÒUsing the Bins Dis-
playÓ on page 48.

Marking IN and OUT Points

You can mark IN and OUT points for your clips in advance, which 
provides several advantages:

¥ You can quickly build a sequence by splicing the marked clips into 
place one after another.

¥ You can use the process of rough-cut or storyboard editing, which 
allows you to instantly splice several prepared clips into a 
sequence, as described in ÒCreating an Instant Rough CutÓ on 
page 381.

¥ You can play back and mark clips in the bin before loading a single 
clip, saving several steps.
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Even if your marks are not accurate now, Media Composer allows you 
to trim the edit points and Þne-tune the sequence later without reedit-
ing the material.

To mark INs and OUTs in advance:

1. Load a clip or sequence from a bin into a monitor, or select a clip in 
the bin.

2. Play, step, or shuttle through the material. Use the J-K-L keys 
when playing a clip in a bin.

3. Click the Mark IN button under the monitor to mark an IN point 
and stop playback. Use the Mark IN key on the keyboard when 
marking a clip in a bin (Mark IN on the keyboard does not stop 
playback).

The sawtooth icon appears on the left side of the monitor to indi-
cate the IN mark frame.

Marked IN point
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4. Continue playing, stepping, or shuttling through the material.

5. Click the Mark OUT button under the monitor to mark an OUT 
point and stop playback. Use the Mark OUT key on the key-
board when marking a clip in a bin.

The sawtooth icon appears on the right side of the monitor to indi-
cate the OUT mark frame.

6. To clear a mark and set a new one, do one of the following:

¥ To set a new IN point, click the Mark IN button or key when 
you reach a different frame. Or, click the Clear IN button or 
key to remove the IN point and then mark a new one.

¥ To set a new OUT point, click the Mark OUT button or key 
when you reach a different frame. Or, click the Clear OUT but-
ton to remove the OUT point and then mark a new one.

¥ To clear both the IN and OUT points, click the Clear Marks 
button or press the G key on the keyboard.

Marking an Entire Clip or Segment

Use the Mark Clip button to select an entire clip or an entire segment 
from a sequence. (A segment in a sequence consists of the material 
between any two edit points.)

1. Load a clip or sequence into a monitor.

2. In the case of a sequence, place the position indicator on the seg-
ment that you want to mark.

3. In the Source or Record monitors, select the tracks corresponding 
to the cuts you want to mark.
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4. Click the Mark Clip button under the monitor, or press the T key.

n To ignore the current track selection and mark the smallest clip at the current 
position in the sequence, press and hold the Option key while you click the 
Mark Clip button.

Creating Subclips

When you mark footage with IN and OUT points, you can either save 
the entire clip along with the new marks, or you can create subclips 
based on the marks you set to break up longer master clips into 
smaller segments of selected footage. 

This is similar to creating outtakes of all of your best footage before 
editing. Unlike outtakes, however, subclips do not directly reference 
the original media. Subclips remain linked to the master clips from 
which they are created, and the master clips in turn reference the digi-
tized media Þles located on your storage drives. As a result, none of 
the original footage is lost.

You can also create sub-
clips while digitizing as 
described in ÒCreating 
Subclips On-the-FlyÓ 
on page 189.

You can create subclips directly from the marked section of material in 
the monitors by using one of the following methods:

¥ Use the Option key: Press and hold the Option key, then drag the 
picture from the monitor to the bin in which you want to store the 
subclip.

¥ Use the Subclip handle: Click the subclip handle located above 
and to the side of the monitor; then drag the subclip handle to the 
bin in which you want to store the subclip.

Subclip handle
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The subclip handle changes to an icon of a frame during the drag, 
then becomes a subclip icon when you release the frame in the 
intended bin.

¥ Use the Subclip button: Click the Subclip button located in one of 
the command palettes to create the subclip and place it into the 
active bin by default. If you press the Option key while you click 
the Subclip button, a dialog box allows you to select the destina-
tion bin for the subclip.

The new subclip will be listed in the bin, preceded by a subclip icon 
and identiÞed with a numbered .Sub sufÞx, as shown in the following 
illustration.

For more information 
on trimming, see Chap-
ter 15.

Subclips do not limit your access to the original, digitized master clip 
material when trimming. Therefore, if you must trim beyond the 
marked IN to OUT boundaries of the subclip to make it longer or 
shorter, your system does accommodate the boundary adjustments 
during the trim.

A new sub-
clip as refer-
enced in 
Text Dis-
play mode
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Using Locators

Locators are a type of electronic bookmark.   They allow you to Þnd and 
identify speciÞc frames during editing. Key words you enter into the 
comments attached to a locator allow you to use standard Find proce-
dures to call up the clips quickly.

Ways to Use Locators

By default the Add 
Locator button appears 
only on the user tear-off 
palettes in the Com-
poser window. You can 
map the Locator button 
elsewhere, as described 
in ÒAbout Button Map-
pingÓ on page 96.

There are many possible uses for locators. A few basic examples are:

¥ Color correction notations: Use locators to mark clips or specify 
frames that require color correction, with notes on the speciÞc cor-
rection to perform if someone else does the job.

¥ Visual track alignments: Use locators at matching points in syn-
chronized audio and video tracks, so that if the tracks lose sync 
you can visually realign the locators in the Timeline to restore sync 
(for more information on sync, see Chapter 17).

¥ Music cues: Use locators to mark the IN and OUT points for 
music.

¥ Trim markers: Use locators in the Timeline to return directly to an 
edit youÕve designated for further trimming at a later time.

¥ Cutaway markers: Use locators to identify cutaway shots with 
comments, so that when you return to cover jump-frame edits 
with cutaway footage, you can quickly call up the shots using 
basic Find procedures.

When you insert a locator, it appears as an orange oval in the Timeline, 
the position bar, and at the bottom of the frame in the monitor.
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You can add locators to your source material while you are in an edit-
ing session, as described in the following section. You can also add 
locators while digitizing, as described in ÒAdding Locators On-the-
FlyÓ on page 190.

Adding Locators While Editing

To add locators while in an editing session:

1. Load a sequence or clip.

2. Cue to the frame and click the Add Locator button.

The locator oval appears in the Timeline, in the position bar, and at 
the bottom of the frame in the monitor.

3. Double-click the locator in the position bar under the monitor or 
click the large oval on the frame.

A dialog box appears.

Locator displayed in 
the monitor, the posi-
tion bar, and the 
Timeline
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4. Type the locator information and click OK. The amount of infor-
mation you can enter is limited to 255 characters.

The information is stored with the marked frame, and the Þrst line 
of the information appears at the bottom of the clip in the monitor.

5. To go quickly to a frame with a locator while editing, use the Find 
command in the Edit menu to search for a particular comment. 
This command works only when the sequence containing the loca-
tors is in the Record monitor.

Locators are copied from the Source monitor to the Record monitor 
when you edit group clips, motion effects, and sequences. They are not 
copied when you edit master clips and subclips, in which case you 
must reenter the information in the Record monitor.

Using the Locators Window

The Locators window allows you to quickly add, delete, go to, and 
print out a list of locators in the currently loaded clip or sequence.

The following illustration shows a Locators window with four
locators.
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To view locators in the window:

1. Load the sequence containing the locators.

2. Choose Locators from the Tools menu.

Features of the Locators Window

Many features of the Locators window are similar to those of the bin 
window:

¥ The window displays information in text columns.

¥ A Fast menu allows you to modify and sort the display.

¥ You can print out the Locators window. This is especially useful 
for identifying and listing speciÞc framesÑto be color corrected or 
used in an effect, for example. You can also make a list of marked 
IN and OUT points for adding music.

The Locators window also provides speciÞc controls for manipulating 
locators in the sequence:
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¥ You can double-click any locator to go to that locator in the 
sequence.

¥ You can select a single locator or Shift-select speciÞc locators and 
press the Delete key to delete them in one step.

Locators Window Fast Menu

The Fast menu allows you to do the following:

¥ Display a timecode or footage column.

¥ Sort or reverse-sort the display by timecode/footage, track, com-
ment, or locator color. Choose the text at the top of a column to 
specify which column to sort.

¥ Display the frame associated with each locator.

¥ Change the color of the locator icon. The Avid Composer system 
uses the same color in the Timeline, position bar, and Record mon-
itor display.
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Finding Frames, Clips, and Bins

Once you have digitized, viewed, marked, and subcataloged numer-
ous shots for a project, you might have difÞculty relocating speciÞc 
clips or frames among several bins. The Avid Composer system pro-
vides a number of features for quickly locating and cueing footage, 
including conventional timecode and frame-offset techniques, text 
searches, and Match Frame and Find Bin commands.

Using Timecode to Find a Frame

At any time during editing, you can type timecode values into the 
numeric keypad on the right side of the keyboard to cue a loaded clip 
or sequence to a speciÞc frame. In addition, you can cue backward or 
forward from the current location in the clip or sequence by a speciÞed 
number of minutes and seconds plus frames using positive or negative 
frame-offset values.

For more information 
on selecting the display 
of tracking informa-
tion, see ÒDisplaying 
Tracking InformationÓ 
on page 329 and the 
Avid Media Composer 
Products Reference.

The system interprets the numbers you type into the numeric keypad 
according to the type of tracking format you have chosen in the row of 
information displayed above the monitor. If you have two rows of 
information, the system looks to the top row.

To cue to a frame based on a known timecode, enter the timecode for 
the frame by using the numeric keypad on the right side of the key-
board, then press Enter.

In this example, the interface displays master timecode. Use one of the 
formats described in the next two paragraphs.
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¥ SMPTE timecode ÑUse two digits each for the hours, minutes, sec-
onds, and frames with no leading zeros. For example, type 
01230200 to enter 01:23:02:00. 

¥ Current timecodeÑIf you are Þnding a timecode that starts at the 
same time as the current timecode, just type the last digits. For 
example, if the current timecode is 1:05:12:13 and you type 4:25, 
the system Þnds the frame at 1:05:04:25.

To cue a frame by using frame offset:

1. Using the numeric keypad, type a plus (+) sign to move forward 
or a minus (Ð) sign to move backward from the current position. 

2. Enter a number for the frame offset and press Enter. Use the fol-
lowing formats:

¥ One or two digits Ñ Enter 1 through 99 to specify a number of 
frames forward or backward. For example, enter Ð42 to move 
backward 42 frames.

¥ Three digits ÑEnter 100 or a greater number to move forward 
or backward a speciÞed number of seconds and frames. For 
example, if you enter +100 and the master timecode is selected 

Type a master
timecode to find
a frame in the
sequence.

 Master track
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on the top line of the Timecode display, you move forward one 
second and zero frames.

Searching a Clip

You can use the Find feature to search a clip loaded in the Source mon-
itor or the sequence in the Record monitor for:

¥ Locator text

¥ Text displayed in the Timeline

¥ Clip names

To do a text search of a loaded clip or sequence by using the Find fea-
ture:

1. Load the clip or sequence into the monitor.

2. Choose Find from the Edit menu.

The Find dialog box appears.

3. Enter part or all of the text you are searching for. If the exact text is 
unknown, enter only a known word or portion of a word.

4. Select one or more options:

¥ Clip Names to search for matching text in Clip names only.

¥ Locators to search for matching text entered into locator com-
ments only.
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¥ Timeline Text to search for matching text in any clip text dis-
played in the Timeline.

5. Click OK. 

If the system Þnds matching text, it cues to the head of the clip in 
the case of Clip Name or Timeline text, or it cues to the Locator 
frame in the case of Locators.

6. If the cue point is not the one you want, choose Find Again from 
the Edit menu to search for another incidence of matching text.

Using Match Frame

The Match Frame function locates the source footage for the frame cur-
rently displayed in either the Source or Record monitor, loads it into 
the Source monitor, cues to the matching frame, and marks an IN 
point. It removes the source clipÕs original IN and OUT marks.

In addition to helping you relocate and reedit master clips during a 
session, the Match Frame command can be used to locate clips quickly 
based on media relatives when you have forgotten their location.

To use Match Frame:

1. Load a sequence into the Record monitor.

2. Move to the frame that you want to match.

3. Make sure you select the correct track for the frame that you want 
to match in the Track Selector panel. 

4. Click the Match Frame button in the Record monitor command 
palettes or the Command Palette.

This loads and marks the source clip in the Source monitor.

n If you do not want to mark the source clip and remove the original marks, 
hold the Option key when you click the Match Frame button.
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Finding a Bin

With a clip or sequence loaded into a monitor, you can quickly Þnd the 
original bin in which it is stored by using the Find Bin button. This 
command Þnds the bin, opens it, and highlights the clip within the 
bin. This works for sequences, subclips or clips within sequences, or 
clips in the Source monitor.

To locate a bin:

1. Click the Source or Record monitor to activate it. 

Be sure the clip or sequence is displayed.

2. Click the Find Bin button on one of the command palettes. The 
system opens the bin and highlights the clip or sequence.

To Þnd the bin in which a speciÞc clip is located:

1. Place the position indicator on the clip within the sequence.

2. Press and hold the Option key and click the Find Bin button. The 
system opens the bin and highlights the clip.

Locating a Master Clip from a Subclip in a Sequence

To Þnd the original clip in the bin for a subclip thatÕs been edited into a 
sequence, you can use the Match Frame and Find Bin buttons together. 

n For this operation, you must have the Match Frame button mapped below 
both the Source and Record monitors.

To locate a master clip from a subclip:

1. Cue to the subclip in the sequence.

2. Click the Match Frame button to load the subclip into the Source 
monitor.
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3. Click the Match Frame button in the Source monitor to load the 
original master clip into the Source monitor.

4. Click the Find Bin button in the Source monitor to open the bin 
and highlight the master clip.

Finding a Frame

The Find Frame button allows you to trace a digitized frame of footage 
displayed in a sequence or source clip back to its analog source on 
tape. This is useful for Þnding frames for color correction, or for redig-
itizing speciÞc clips to lengthen them or make alterations in digitize 
parameters. 

To Þnd a frame:

1. Make sure the source deck is properly connected to the system 
and load the clip or sequence.

2. In the Timeline or position bar, place the position indicator on the 
frame you want to Þnd.

3. Click the Find Frame button. If the tape is not in the deck (for 
example, if you do not know which tape the footage is on), a dia-
log box prompts you to insert the appropriate tape.

4. Insert the tape. The system cues to the requested frame and dis-
plays it. You can redigitize as necessary.
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Using the Manual User Interface (MUI)

Media Composer 8000 systems include the Manual User Interface (or 
MUI, pronounced ÒMoo-eeÓ), an alternative playback device you can 
use to mark, play, step, and shuttle through footage. If you have 
another model and are interested in using a MUI, contact Avid for 
details.

The Manual User Interface allows you to perform a collection of func-
tions normally controlled by the keyboard and mouse with one hand. 
Several movable parts allow you to arrange the controls in a variety of 
positions to suit your personal preference.

For information on how to install the MUI controller at your site, refer 
to the Avid Media Composer Products Setup Guide.

The MUI consists of two functional parts:

¥ The MUI shuttle consists of a weighted foot with a thumb-control 
for shuttling through a clip or sequence loaded into a Source, 
Record, or pop-up monitor, or the Timeline. The control knob 
glides easily from pause into the forward, fast-forward, reverse, or 

Reverse shuttle Pause Forward shuttle

MUI shuttle

MUI keyboard
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fast-reverse positions. You can also nudge the control knob right 
or left for one-frame advance or reverse.

¥ The MUI keyboard consists of an arc of keys that Þt onto the foot of 
the shuttle, and can be placed in the middle of the foot or slid to 
the left or right to accommodate the left or right hand, as shown in 
the illustration. An additional foot is provided to support the key-
board on either side.

Choosing the MUI

You must specify in the Deck settings which controller you want to 
use. 

n For information on using the Serial Ports Tool to specify the MUI controller, 
see ÒSpecifying the MUI ControllerÓ on page 107.

To choose the MUI controller:

1. In the bin window, click Settings.

2. In the Settings list, double-click Deck.

The Deck Setting dialog box appears.
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3. Choose MUI from the Editing Controller pop-up menu.

MUI Default Editing Buttons

Each MUI editing button matches a button or control within the Media 
Composer application, as shown.

Editing Controller
pop-up menu

Shuttle Forward

Shuttle Reverse

Splice-in
Pause

Play

Mark IN Mark OUT
Overwrite Go to Next Edit

Go to Previous Edit

Press one of
these buttons
to enter Trim mode.
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For access to the additional functions, press and hold the Shift key 
while pressing an editing button.

Customizing the MUI

Once you install a MUI, the system automatically adds a MUI settings 
option to the Settings scroll list in the Project window. You can custom-
ize the MUI keys and shuttle speed by using the MUI settings dialog 
box. 

To customize the shuttle speed:

1. Double-click MUI in the Settings scroll list of the Project window 
to display the Default MUI Settings dialog box.

Shift key

Play IN to OUT

Go to IN

Go to OUT

Lift

ExtractActivate Source or
Record Monitor

Step Backward

Step Forward

Step Backward 10 Frames

Step Forward 10 Frames

Shift Key
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2. Select a Speed Increment from Coarse to Fine.

Coarse moves quickly from 0 fps to the maximum play rate. Fine 
moves through 0 to 30 fps, and then to the maximum play rate. 
Move the shuttle to see what speed you want. Notice the Position 
Play Rate change.

3. Select 2x, 3x, 5x, or 10x (2, 3, 5, or 10 times the normal rate) for the 
Maximum Shuttle Speed for fast forward and reverse.

n The graphical representation of the shuttle moves on your interface as the 
MUI shuttle moves.

To customize MUI keys:

1. Open the Command Palette and position it in proximity to the 
MUI Settings dialog box.

2. Press and hold the Command key while you drag the command 
icon you want from the Command Palette to a key displayed in 
the MUI dialog box.

The system saves the new MUI key layout immediately after you 
remap a key.

To customize Shift-level commands:

1. Press the Shift and Command keys.

Shuttle speed

Position Counter
and Play Rate

Graphical 
representation
of the shuttle

Key settings
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2. Drag the appropriate command icon from the Command Palette 
to the MUI button.

Using the MUI

Follow this procedure each time you use the MUI:

1. Set the shuttle control knob to the center (pause) position.

2. Turn on the system and start the Media Composer application.

3. To calibrate the system, wait several seconds. Do not move the 
shuttle control knob.

The Media Composer system needs to know where the pause 
(zero detent) position is to calibrate the shuttle control.

If you forget to calibrate the shuttle when you start the system, 
you can always calibrate it later by setting the shuttle control knob 
to the center detent and waiting several seconds.

c If you donÕt calibrate the shuttle control, it will not operate.

4. Within Media Composer: 

a. Load clips and sequences into the Source, Record, or pop-up 
monitor. Click the monitor you want to use.

b. Open a bin and select Go To Capture Mode from the Bin menu 
to access the deck controls.

5. Use the MUI to control the activated deck or monitor.

c Activating the mouse to step and shuttle disables the MUI control. 
MUI control returns when you deactivate the mouse by pressing the 
space bar.
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CHAPTER 13

First Edits in Source/Record 
Mode

After you have viewed and marked your clips or created subclips, you 
are ready to create a sequence. This chapter introduces you to proce-
dures you use in Source/Record mode to build a basic sequence, as 
described in the following sections:

¥ Entering Source/Record Mode

¥ Setting Up a New Sequence

¥ Making the First Edit

¥ Undoing or Redoing Edits

¥ Editing Additional Shots into the Sequence

¥ Using Phantom Marks

¥ Lifting, Extracting, and Copying Material

¥ Adding Comments to Sequence Clips

¥ Playing the New Sequence

¥ How to Proceed

n Illustrations of the Avid Composer window show two button rows, two infor-
mation rows, and Center Duration. For information about changing the 
default display, see ÒUsing the Settings DisplayÓ on page 61.
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Entering Source/Record Mode

Source/Record mode is the default editing mode, and is composed of 
the screens and controls shown in the Source/Record window within 
the main Composer window on the Edit monitor. 

To enter Source/Record mode from within another mode, click the 
Source/Record Mode button displayed in both the Source/Record 
window and in the Timeline tool bar.

Setting Up a New Sequence

There are two ways to establish a new sequence:

¥ If you have speciÞc parameters in mind for the project that you 
would like to establish Þrst, you can create and name a sequence, 
set the start timecode, and determine the numbers and kinds of 
tracks to use before you make the Þrst edit, as described in this 
section.

Source/
Record 
Mode 
button
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¥ If you would like to begin editing right away and build the 
sequence as you go without setting parameters ahead of time, skip 
to ÒMaking the First EditÓ on page 379.

To set up a sequence with the New Sequence command:

1. Choose New Sequence from the Clip menu. One of the following 
occurs:

¥ If just one bin is open, or one of several bins is selected and 
you have clicked a speciÞc bin to activate it, the new sequence 
appears in that bin. It also appears in the Record monitor and 
in the Timeline, with the generic title ÒUntitled Sequence n.Ó 
Each new sequence is numbered incrementally until you 
rename it.

¥ If several bins are open but none is activated, the Select a Bin 
dialog box appears.

Select the bin in which to store the new sequence, or click the 
New Bin button to create and open a new bin, and click OK.

An untitled sequence appears in the bin, in the Record moni-
tor, and in the Timeline.
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2. To rename the new sequence, immediately type a new name while 
the name Þeld is active in the bin. 

n If you click anywhere in the interface after creating the new sequence, you 
deactivate the name Þeld. Click the sequence name again to rename the 
sequence.

Changing the Sequence Clip Info

You can also change the 
default start timecodes 
for all new sequences 
by using General Set-
tings. For more infor-
mation, see the Avid 
Media Composer Products 
Reference.

The following optional procedure allows you to rename the new 
sequence and set a customized start timecode by using the Clip Info 
command.

1. With your sequence loaded and the Record monitor active (click it 
to make it active), choose Get Clip Info from the File menu to open 
the Clip Info dialog box.

2. Drag a cursor across the sequence name in the Name Þeld, then 
type a new name.

3. Drag a cursor across the start timecode, then type a new timecode.

New sequence



376

4.  Click OK.

Setting Up Tracks for the New Sequence

When you create a new sequence by using the New Sequence com-
mand, and no material is loaded into the Source monitor, the Timeline 
displays only the TC (master timecode) track.

You can add any number of audio or video tracks to the sequence 
before making the Þrst edit, as follows:

¥ Choose New Video Track from the Clip menu to add a video track.

¥ Choose New Audio Track from the Clip menu to add an audio 
track.

The following illustration shows the Timeline after one video and two 
audio tracks have been added, with no material loaded in the Source 
monitor.
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User Preferences for Creating Tracks

For information on 
opening and changing 
settings, see ÒUsing the 
Settings DisplayÓ on 
page 61.

Your Avid Composer system provides two options in the Composer 
Settings dialog box that help automate the way tracks are created and 
enabled as you edit. You can adjust these settings in advance based on 
personal preference.

The default settings are:

¥ Auto-create New Tracks: Whenever you edit new source material 
from the Source monitor, the system automatically creates any 
new tracks in the sequence that match enabled tracks on the 
source side.

¥ Auto-enable Source Tracks: Whenever you load new source 
material into the Source monitor, the system automatically enables 
all existing source tracks.

Alternatively, you can do the following:

¥ Deselect the Auto-create New Tracks option to have the existing 
tracks in the sequence remain the same when you edit in new 
source material. This allows you to create new tracks selectively as 
you edit, which is often preferable at the more advanced stages of 
a project.

¥ Deselect the Auto-enable Source Tracks option to leave the tracks 
of newly loaded material in whatever state they were in when 
they were last loaded. This allows you to turn on the source tracks 
more selectively as you edit, which is often preferable at the more 
advanced stages of a project.

Adding Filler

You can add a small amount of black Þller at the start of your sequence 
before making the Þrst edit. A brief moment of black before the start of 
your sequence is sometimes useful during playback, or when record-
ing a digital cut. You can also add Þller at any time during editing to 
another part of the sequence.
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To add Þller:

1. Click on the clip name above the Source monitor and choose Load 
Filler from the monitor menu. The system loads a 2-minute clip of 
Þller into the Source monitor.

2. Mark the desired length of Þller, as needed.

3. Click the Splice-in or Overwrite button to edit the black into the 
sequence.

Copying Locators from Source Clips

You can copy all locators currently placed in source clips directly into 
the sequence as you edit. The locators and the locator text appear in all 
sequence segments that reference the source clips.

To automatically copy source locators as you edit:

1. Double-click Composer in the Settings scroll list of the Project win-
dow to open the Composer Settings dialog box.



379

2. Select the Copy Source Locators option.

Making the First Edit

Whether you establish a new sequence in advance, or do not prepare a 
sequence and want to begin editing right away, use the following pro-
cedure to begin editing:

1. Load the Þrst clip into the Source monitor. If you have not already 
marked IN and OUT points for the clip in advance or created a 
subclip, view and mark the clip as necessary.

Copy 
Source 
Locators 
option



380

2. Click buttons in the source track selector panel to select the tracks 
you want to include in the edit. Only the tracks that have been dig-
itized for the clip appear as source tracks in the Timeline. For more 
information on using the track selector panel, see ÒUsing the 
Track Selector PanelÓ on page 435.

For example, with a talking head you might select tracks V1 (pic-
ture) and A2 (sound), if the voice was recorded on that track. You 
would deselect track A1, which might have unwanted wild sound 
picked up from a second microphone, or it might have no sound at 
all.

Or, as another example, if you are Þrst laying down a music track, 
you would select track A1 or A2 depending upon where the music 
was digitized, and deselect V1.

3. Click the Splice-in button to add the edit to the sequence in the 
Record monitor.

The Record monitor displays the end of the last frame of the new 
edit. (You can scroll the position indicator in the Timeline or the 
position bar beneath the Record monitor to review the shot.) The 
edit also generates a graphical display of the cut in the Timeline.

Source Tracks
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Creating an Instant Rough Cut

For additional informa-
tion on editing directly 
from the bin into the 
Timeline, see ÒBin Edit-
ing into the TimelineÓ 
on page 425.

As an alternative to creating a new sequence by editing shots one at a 
time, you can quickly create a rough cut by selecting and loading mul-
tiple clips directly from the bin into the Record monitor by using the 
Shift or Option keys. You can load clips that have been sorted in a bin 
in Text mode. Or, you can create a storyboard in Frame or Script mode 
and then load these clips directly.

To create a rough cut from a bin:

1. To create a more accurate rough cut, screen and mark clips in the 
bin in advance, as described in ÒMarking IN and OUT PointsÓ on 
page 350.

Screen display of the 
first edit in a 
sequence

Splice-in button

Timeline generated 
by the edit

The end of the last 
frame of the first new 
edit

Source clip

Sequence
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2. In the bin, sort the clips in the order in which you want them to 
appear in the sequence:

¥ In Text mode, alphabetic or numeric sorting of clips might not 
provide you with the clip ordering that you want. You can cre-
ate a new bin column for numbering the clips in the order in 
which you want them to appear, then sort the column numeri-
cally.

¥ In Frame or Script mode, rearrange frames and prepare a sto-
ryboard as described in ÒStoryboard WorksheetÓ on 
page 268.

3. Select the source and record tracks for the edit.

4. Shift-select or lasso the clips. Choose Select All from the Edit menu 
if there are no other clips in the bin.

5. Press and hold the Option key and drag the highlighted clips to 
the Record monitor to splice the clips into place. Alternatively, 
press and hold the Shift key and drag the clips to overwrite them 
into an existing sequence.

The clips are spliced together to form a new sequence based on the 
order in which they are listed in the bin. If there is a sequence 
already loaded into the Record monitor, the new clips are spliced 
or overwritten in the sequence beginning at the location of the 
position indicator or an IN point marked in the sequence.

Undoing or Redoing Edits

You can undo or redo up to 32 previous actions listed in the Edit 
menu. You can quickly undo or redo a just completed command, or 
you can search through a submenu to undo or redo all commands 
leading back to a particular command.
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¥ To undo only the previous edit or function, choose Undo from the 
Edit menu.

¥ To redo only the previous edit or function, choose Redo from the 
Edit menu.

¥ To undo or redo everything back to a particular command, choose 
a command from the Undo/Redo list in the Edit menu. All of the 
previous commands, back to and including the command chosen 
from the submenu, are undone or redone as appropriate.

Editing Additional Shots into the Sequence

You can use two or 
sometimes one mark to 
complete an edit by 
using phantom marks. 
For more information, 
see ÒUsing Phantom 
MarksÓ on page 386.

The three primary edit functions for adding material to your sequence 
are the splice-in, overwrite, and replace commands. In most cases you 
perform three-point edits in which you set three marks Ñ two in the 
source material and one in the sequence, or the reverse. The fourth 
mark is determined automatically. The way you set marks depends 
upon the type of edit you perform, as described in this section.

Performing a Splice-In Edit

A splice-in edit inserts the material marked in the Source monitor into 
the sequence without replacing material already in the sequence. 

Prior Redo com-
mands appear in the 
upper portion of the 
Undo/Redo List sub-

Prior Undo commands 
appear in the lower 
portion of the submenu

Undo/Redo commands
for previous edit
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Existing material moves down beyond the spliced material, lengthen-
ing the overall duration of the sequence.

To perform a splice-in edit:

1. Load a clip into the Source monitor.

2. Mark an IN and OUT point.

3. Mark an IN point in the sequence as follows:

a. Move the position indicator in either the Timeline or the posi-
tion bar of the Record monitor to the point where you want to 
splice the shot into the sequence. 

b. Click the Mark IN button or press the Mark IN key on the key-
board.

n If you donÕt mark an IN, the system splices the new shot into the sequence at 
the current location of the position indicator.

4. Click the Splice-in button (yellow) to complete the edit.

Performing an Overwrite Edit

An overwrite edit replaces a section of the sequence with the material 
you select in the Source monitor. Unlike a splice-in edit, an overwrite 
edit replaces existing material and therefore does not lengthen the 
overall duration of the sequence.

To perform an overwrite edit:

1. In the Source monitor, mark an IN or OUT, but not both, to show 
the start or end of the shot you want to use.

2. In the Record monitor, mark both an IN and OUT to select the 
material in the sequence you want to overwrite. Or you can mark 
an OUT and move the position indicator in the Timeline or posi-
tion bar to the IN point.
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3. Click the Overwrite button (red) to complete the edit.

Performing a Replace Edit

You use the Replace button (blue) to replace a clip in the sequence 
(video, audio, or both) with new material from the Source monitor, 
while maintaining the original IN and OUT points of the previous 
edit. The Replace button must be mapped to a button under the 
Record monitor before you begin to edit.

To perform a replace edit:

1. Choose a sync frame in the source clip by moving the position 
indicator to display that frame in the Source monitor. 

The sync frame can be an IN point, an OUT point, or any frame in-
between that you want to sync to a frame in the existing shot in 
the sequence based on the location of the position indicator.

2. Choose the sync frame in the sequence for the edited shot that you 
want to replace by moving the position indicator in either the 
Record monitor position bar or in the Timeline to that frame.

3. Click the Replace button (blue).

The system calculates IN and OUT points for the source material 
by using the sync frames and the existing IN and OUT points in 
the sequence for the previously edited shot that you are replacing.

n If you are replacing a clip in an overwrite edit, and the position indicator falls 
within the overlap, you might end up replacing the wrong material unless 
you select the entire segment you want to replace. See ÒSelecting and Dese-
lecting SegmentsÓ on page 417.

For more information 
on sync point editing, 
see ÒUsing Sync Point 
EditingÓ on page 567.

Like replace editing, Sync Point Editing allows you to overwrite mate-
rial in the sequence based on alignment of the position indicators in 
the source material and in the Timeline. The difference is that Sync 
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Point edits end at the nearest marks in either the source or record 
material, while replace edits always Þll the IN to OUT of the clip in the 
sequence. 

Using Single Mark Editing

Single mark editing (also called mark and park editing) allows you to 
establish a single mark, then use the location of the position indicator 
to determine the second mark when making the edit. You can use this 
procedure in several ways to save steps:

¥ You can mark an IN point in the Source monitor and then perform 
a splice-in, overwrite, or replace edit without adding an OUT 
mark.

¥ You can mark an OUT point, then locate a frame for the IN mark, 
and perform the edit without marking the IN point.

¥ You can mark the IN or OUT, play, step (jog), or shuttle through 
the clip forward or backward, then press the Splice-in, Overwrite, 
or Replace button to perform the edit on-the-ßy without adding 
the second mark.

To enable single mark editing, open the Composer Settings dialog box 
from the Project window and select the Single Mark Editing option.

Using Phantom Marks

Phantom marks provide visual guidance when editing according to 
the three-mark rules described in ÒEditing Additional Shots into the 
SequenceÓ on page 383. When you enable phantom marks, the system 
displays gray IN or OUT mark icons in the position bars below both 
the Source monitor and the Record monitor. These phantom marks can 
indicate one, two, or sometimes three edit points calculated by the sys-
tem to complete an edit. The following are a few sample scenarios.
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Setting One Mark

In this example, you set only the IN mark on the source side. By 
default, the system uses the location of the position indicator as the IN 
mark for the sequence, and calculates both OUT points based on the 
length of the source clip.

You can see the system calculations instantly and can make the edit 
after setting just one mark, when appropriate.

Adding a Second Mark

If you decide that an OUT mark is required Ñ to shorten the source 
clip, for example Ñ then the system recalculates and displays new 
phantom marks.

Phantom marks can help you see the results of marks you set before 
you complete the edit, and is especially useful when doing sync-point 
editing or other complicated replace edits in which two or more marks 
are calculated automatically.

One IN mark Three phantom marks

Additional OUT mark New phantom marks
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Lifting, Extracting, and Copying Material

Extract/Splice-in and 
Lift/Overwrite are Seg-
ment mode functions 
you can also use to 
remove and reposition 
segments. For more 
information, see 
ÒUsing Segment 
ModeÓ on page 416.

Lifting, extracting, and copying allow you to remove or reposition mate-
rial quickly in your sequence. For example, you can move a clip from 
the end of your sequence to the beginning; or you can remove the 
material from the sequence altogether. Lifting, extracting, and copying 
place the removed material into the Clipboard. You can then paste the 
material elsewhere in the sequence, or in another sequence altogether. 
These procedures are described in this section.

Lifting Material

The Lift function removes selected material from a track in the 
sequence and leaves black Þller or silence to Þll the gap. You can later 
move or Þll this gap with other footage. When you lift material, the 
overall duration of the track (or sequence) remains the same.

To lift material:

1. Mark IN and OUT points at the start and end of the material in the 
sequence that you want to lift.

2. Select the tracks containing the material. The system will perform 
the function on selected tracks only.

3. Click the Lift button to complete the edit.

Extracting Material

The Extract function removes selected material from a track in the 
sequence and closes the gap left by its removal. As a result, when you 
extract material you shrink the duration of the track or sequence.

To extract material:
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1. Mark IN and OUT points at the start and end of the material in the 
sequence that you want to extract.

2. Select the tracks containing the material. The system will perform 
the function on selected tracks only.

3. Click the Extract button to complete the edit.

Copying Material

For more information 
on using the Clipboard, 
see ÒUsing the Clip-
boardÓ on page 389.

The Copy to Clipboard function makes a duplicate of selected material 
in the sequence and leaves the material intact. When you copy mate-
rial, the sequence remains unaffected. The material can then be 
inserted into the sequence elsewhere or into another sequence.

To copy material to the Clipboard:

1. Mark IN and OUT points at the start and end of the material in the 
sequence that you want to copy.

2. Select the tracks containing the material. The system will perform 
the function on selected tracks only.

3. Click the Copy to Clipboard button.

The system copies the selected material to the Clipboard, and 
leaves the sequence untouched.

Using the Clipboard

The Avid Composer systemÕs Clipboard is a cut, copy, and paste tool 
adapted to the special needs of the editing environment. You can place 
a marked section of the sequence into the Clipboard at any time by 
clicking the Lift, Extract, or Copy to Clipboard buttons.
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The Copy to Clipboard function is useful for moving or repeating 
material in a sequence without moving multiple segments in Segment 
mode, or rebuilding the section at another location. For example, you 
can:

¥ Copy a portion of a sequence for pasting into another sequence.

¥ Isolate and copy a portion of an audio track for looping music or 
repeating a sound effect.

¥ Copy graphic elements for repeating at other locations in a format 
cut.

Preserving Clipboard Contents

The Clipboard stores only one clip at a time; each time you copy, lift, or 
extract additional material, you delete and replace the previous con-
tents. 

To keep the Clipboard contents throughout a session, do one of the fol-
lowing:

¥ Choose Clipboard Contents from the Source Monitor menu.

The contents appear as a clip in the Source monitor, and the name 
ÒClipboard Contents.nÓ appears above the monitor and in the 
Monitor menu. The n is an incremental numbering of clips placed 
in the Clipboard during the session.

¥ Press the Option key when you copy, lift, or extract the material. 
The contents appear as a clip in the Source monitor, and the name 
ÒSequence name. SubÓ appears above the monitor and in the Moni-
tor menu.

Repeat these procedures each time you want to preserve copied, lifted, 
or extracted material during a session. All the clips remain available in 
the Monitor menu until you choose Clear Menu or close the project.
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n Material placed in the Clipboard does not appear as a clip in the bin, and is 
deleted when you close the project. To save a portion of a sequence for future 
use, mark the section and create a subclip.

Recovering Material from the Clipboard

The Clipboard allows you to restore lifted or extracted segments 
quickly. This is especially useful if youÕve performed one or more edits 
since removing the material. In contrast, if you restore the material by 
using the Undo function, the system also undoes all edits performed 
in the meantime. The Clipboard provides the beneÞt of restoring the 
material while maintaining subsequent edits.

To restore material from the Clipboard:

1. Load the Clipboard contents in one of two ways:

¥ Choose Clipboard Contents from the Source Monitor menu to 
place the contents into the Source monitor and the Monitor 
menu list of clips.

¥ Open the Clipboard as a pop-up monitor by choosing Clip-
board Monitor from the Tools menu.
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2. Click the Mark Clip button to mark the entire segment.

Optionally, view the sequence segment as a source Timeline by 
clicking the Toggle Source/Record button in the Timeline tool bar 
to mark and select speciÞc tracks.

3. Locate the IN point in the sequence from which the segment was 
removed. Place the position indicator here, or mark an IN.

4. Splice or overwrite the material back into the sequence.

Adding Comments to Sequence Clips

You can add comments to sequence clips to appear in the Timeline or 
in lists that you create, such as an EDL or a cut list. Comments can 
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include such things as instructions for color correction, or for adjusting 
an effect.

To add comments to the sequence:

1. Click one of the Segment Mode buttons (located below the Time-
line) and highlight the clip in the Timeline to which you want to 
add a comment.

2. Choose Add Comments from the Monitor menu. The Comments 
dialog box appears.

3. Type your comments in the text box and click OK.

n You can display the comments in the Timeline by using the Clip Text option 
in the Timeline Fast menu.

4. Click one of the Segment Mode buttons again to leave Segment 
mode.

Playing the New Sequence

After completing a rough cut, you can play the new sequence to see 
the results of your editing. You can view the sequence in the Record 
monitor or in the third, full-screen monitor.

n If you need to prepare a screening of the sequence away from the system, see 
Chapter 19.

To review your work thus far:

If you have several 
tracks of audio, you 
might need to mix them 
down and adjust levels 
before playback. For 
more information, see 
Chapter 16.

1. Make sure that the video track monitor icon is located on the 
uppermost video track in order to display all video tracks and 
effects during playback.

2. Make sure the audio track monitor icon on the uppermost audio 
track is enabled to ensure proper playback of all audio tracks.
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3. Go to the start of the sequence in the Record monitor by clicking 
the left side of the position bar to reposition the position indicator 
at the beginning, or press the Home key on the keyboard.

4. Use the position indicator, buttons, mouse, or keyboard to play, 
step, or shuttle through footage. View the sequence in the Record 
monitor or in the full-screen monitor. 

Starting a Playback Loop

You can play back your sequence in a continuous loop by augmenting 
the Play IN to OUT command with the Control key. You must set 
marks in the sequence to determine the range of the playback loop. 

n You can also use this technique to isolate and continuously play back a small 
portion of the sequence during a difÞcult edit.

To start a playback loop:

1. Place IN and OUT marks in the sequence.    To play back the entire 
sequence, place the IN mark at the beginning and the OUT mark 
at the end. 

2. Press the Control key and the Play IN to OUT key or button.

The playback loop begins and continues until you press the Stop 
key or click anywhere with the mouse.

n You can also press the Control key and the Play to OUT button. The location 
of the position indicator acts as the IN point for a continuous loop.

Playback Performance Tips 

As you continue to edit, you might Þnd the playback performance of 
the system diminishing as the sequence grows in length and layers. 
This can happen when you are using a great deal of RAM for playback 

control
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of large and complex sequences. The following are a few tips for 
improving playback performance:

¥ Check the number of media objects in use for your project in the 
Memory window, as described in ÒViewing MemoryÓ on page 84. 
If this number is large (more than 50,000 objects on a system with 
32 MB of RAM, for example), reduce the number of media objects 
by doing one of the following:

- Close bins that are not in use.

- Reduce the number of clips in the open bins.

- Unmount drives that are currently not in use by dragging 
them to the Trash. You can remount the drives at any time by 
choosing Mount All from the File menu.

¥ Restart the computer every few hours to refresh the system mem-
ory. Frequent opening and closing of Þles, tools, and applications 
can diminish the functional capacity of RAM.

¥ Split the sequence into two or more segments, if possible.

Using the Play Length Toggle Feature

Long sequences with many effects can be time consuming to work 
with in the Timeline. Working with a smaller sequence can save time. 
The Play Length toggle feature allows you to toggle between playing 
the entire sequence and playing a limited duration of the sequence.

When you use the Play Length feature, Þrst map the Play Length tog-
gle button from the Command Palette to the Record monitor com-
mand palette, then set the value for the Play Length toggle button. You 
can then use the toggle button to switch between playing the entire 
sequence and playing a limited duration centered around the current 
position.

Mapping the Play Length Toggle Button to the Record Monitor Palette

To map the Play Length toggle button to the Record monitor palette:
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1. From the Tools menu choose Command Palette.

2. Select the Play tab at the top of the Command Palette.

3. Click and drag the Play Length toggle button to the Record moni-
tor command palette.

Changing the Value for the Play Length Toggle Button from the Default

To change the value for the Play Length toggle button from the 
default:

1. From the Tools menu choose Console Window.

2. In the Console window text box, enter

playlength n

Where n is the duration (in minutes) you want mapped to the Play 
Length toggle button.

n The n variable must be a whole number set to 1 or higher.

3. Press return.

The Console window displays the value for Playlength. For exam-
ple, if you set playlength to 1, the console window will display 
playlength = 1 (half forward/half backward). 

Selecting the Play Length Toggle Button to Map to the Play Button

To select the Play Length toggle button to map to the Play button:

1. Press the Play Length toggle button. It toggles between play entire 
sequence and play length 1 minute. 

2. Set the toggle button to play length 1. 

With the Play Length toggle button activated, press the L key or 
the Play button. The sequence will play from the position indica-
tor forward 30 seconds (half forwards). If you press the J key or 
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Play Reverse button, the sequence will play from the position indi-
cator backward for 30 seconds (half backward).

3. To set the Play Length back to play entire sequence, press the Play 
Length toggle button again.

How to Proceed

If you have Þnished a rough cut and are ready to Þne-tune the 
sequence, you can return to Source/Record mode, or you can proceed 
with the following:

¥ To learn about the Timeline and Segment mode editing tech-
niques, see Chapter 14.

¥ To make frame-accurate adjustments to your edits by using Trim 
mode, see Chapter 15.

¥ To edit with audio or mix audio tracks in preparation for playback 
or output, see Chapter 16.

¥ To edit with synced tracks, see Chapter 17.

¥ To edit with multicamera material, see Chapter 18.

¥ To add effects to your sequence, see the Avid Media Composer and 
Film Composer Effects Guide.
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CHAPTER 14

Using the Timeline

The Avid Composer system represents each edit and effect in a graphi-
cal timeline structure to help you track and manipulate the elements of 
your sequence. The Timeline continuously updates as you work, dis-
playing an extensive array of icons and information that you can cus-
tomize in various ways.

In addition, the Timeline has its own set of editing tools that you can 
use to create and revise edits and transitions across multiple tracks. 
These features are described in the following sections:

¥ Customizing Timeline Views

¥ Restoring the Default Timeline View

¥ Navigating in the Timeline

¥ Using Segment Mode

¥ Using Advanced Timeline Techniques

¥ Working with Multiple Tracks

¥ Additional Ofßine Aids

¥ Printing the Timeline
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n Illustrations of the Composer window in this chapter show the full set of two 
button rows, two information rows, and Center Duration display, as selected 
in Composer Settings. For more information, see the Avid Media Composer 
Products Reference.

Customizing Timeline Views

There are also a number 
of on-the-ßy procedures 
for changing your view 
of the Timeline (such as 
the Zoom and Focus 
functions) that are not 
saved as part of a Time-
line view. 

You can customize your view of the Timeline to display a variety of 
information about your sequence as well as the clips and transitions it 
contains. You use the Timeline Fast menu to change the display. You 
can also save different custom views that you can call up instantly in 
various circumstances.

The following are a few examples:

¥ Effects editing: If you are editing complex visuals with multiple 
tracks and effects, you can display Effect contents, Effect and Dis-
solve icons, Clip Frames, and Clip Transition Durations within 
enlarged video tracks in the Timeline.

¥ Complex audio work: If you are doing advanced audio work with 
multiple tracks, or Þne-tuning difÞcult audio edits, you can hide 
video tracks and enlarge audio tracks while displaying waveform 
plots.
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¥ Film and Animation editing: If you are working on a Þlm or ani-
mation project, you can display the Þlm track, show every frame 
in the sequence, and/or display sync breaks where they occur.

¥ Editing for online: If you are editing ofßine with plans to generate 
an EDL and Þnish the sequence in an online videotape suite, you 
can track detailed clip and dupe-reel information by displaying 
clip text and enabling Dupe Detection.

¥ Basic trimming: If you are Þne-tuning and trimming simple edits 
at the early stages of a project, you can view the sequence in Heads 
and Tails view to see a display of the Þrst and last frame of every 
shot.
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Using the Timeline Fast Menu

To create a custom Timeline view, you choose various options from the 
Timeline Fast menu. The Timeline Fast Menu button appears in the 
bottom left corner of the Timeline tool bar.

To select an item from the Timeline Fast menu, click the Fast Menu 
button and scroll through the menu to select or deselect an option. 
Selected options have check marks (√) next to them. You must select 
some options from a submenu.

You can learn about the various Timeline view options as follows:

¥ For an overview of all Timeline Fast menu options, see the Avid 
Media Composer and Film Composer Quick Reference.

¥ For more information on Effect icons and displays, see the Avid 
Media Composer and Film Composer Effects Guide.

¥ For information on different view types, see ÒCustomizing Time-
line ViewsÓ on page 399.

¥ For information on Dupe Detection in the Timeline, see ÒDetect-
ing Duplicate FramesÓ on page 449.

¥ For information on displaying the Þlm track, see ÒEditing with 
the Film TrackÓ on page 429.

Timeline Fast menu

Show Track submenu
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¥ For more information on the display of sync breaks in the Time-
line, see Chapter 17.

¥ For more information on displaying energy and waveform plots in 
audio tracks, see Chapter 16.

¥ For more information on manipulating the height of tracks or 
moving tracks as part of a view, see ÒAdditional Procedures for 
Customizing the TimelineÓ on page 402.

Additional Procedures for Customizing the Timeline

In addition to the options provided in the Timeline Fast menu, you can 
customize a Timeline view by enlarging or reducing the size of tracks, 
or by moving tracks up or down in the Timeline hierarchy.

Enlarging and Reducing Tracks

You can enlarge or reduce the height of one or more tracks to improve 
visibility and display more information within the tracks. You can save 
these changes with a Timeline view.

To enlarge or reduce the height of tracks:

1. Select the tracks that you want to resize.

2. Do one of the following:

¥ Choose Enlarge or Reduce Track from the Edit menu.

¥ Press and hold the Option key and move the cursor to the bot-
tom edge of the track selector until it appears as a bar with a 
vertical up and down arrow. Drag the edge up or down to 
make the track narrower or wider. This method applies to 
only one track selection at a time.

You can use the Control key along with the Enlarge Track (kÐL) or 
Reduce Track (kÐK) shortcut key combinations to change the height 
of all tracks quickly in the Timeline regardless of track selection. You 
can use this enhancement to:
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¥ Reduce and view all the tracks in a multilayer sequence, and 
enlarge them when Þnished

¥ Enlarge all tracks to view waveform plots or other displays in 
multiple tracks

Do one of the following to enlarge or reduce all highlighted tracks at 
once:

¥ Press the Control, Command (k), and L keys to enlarge all tracks.

¥ Press the Control, Command (k), and K keys to reduce all tracks.

Moving a Track

You can move a track to reposition it vertically relative to the Timeline. 
Surrounding tracks are repositioned above or below the track. You can 
save these changes with a Timeline view. Moving tracks is especially 
useful when you are working with multiple-layer effects and discover 
that the tracks are built in the wrong hierarchy to apply the effect cor-
rectly.

To move a track, press and hold the Option key, click the track selector 
for the track that you want to move, and drag the track to its new
position.

n Do not move a track when patching to another track would be more appropri-
ate. Moving whole tracks can throw effects and track monitoring out of place.

Changing the Timeline Background Color

To change the background color of the Timeline, you also have to 
change the background color of the Source and Record monitors. To 
change the color:

1. Click in the Source or Record monitor to activate them.

2. Choose Set Composer Background from the Edit menu.
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3. Choose a shade of gray for the background from the pop-up 
palette.

Changing the Timeline Track Color

To change the color of the tracks in the Timeline:

1. Click in the Timeline to activate it.

2. Choose Track Color from the Timeline Fast menu.

3. Choose a color for the tracks from the pop-up 
palette.

Saving a Customized View

You can save a customized Timeline view. Timeline views appear in 
the Settings scroll list in the Project window. You can save, rename, 
and copy several views. 

The system saves the following Timeline information with each view: 
displayed tracks, track sizes, and track positions; clip names and 
frames; audio waveforms; and type of view (Time, Heads, or Heads 
and Tails).

Once you have created and saved several Timeline views, you can 
choose alternate views at any time from the Timeline View pop-up 
menu located near the middle of the Timeline tool bar at the bottom of 
the screen. The Timeline view is labeled Untitled until you name and 
save a customized Timeline view. 

To name a Timeline view or to change a viewÕs name:

1. Choose Save As from the Timeline View pop-up menu.
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A dialog box appears.

2. Type a name for the view and press Return.

The following is an alternative procedure:

1. Press and hold the k key, then click the name displayed in the
Timeline View pop-up menu and drag it to the Project window.

The system adds the Timeline view to the project.

2. Click the Settings button in the Project window to display the
Settings scroll list. The Timeline view appears in the scroll list.

3. Click the User Name column of the Timeline view, type a new 
name, and press Return.

Replacing a Timeline View

If your saved views become extensive and there are views you no 
longer use and would like to replace, use the following procedure:

1. Press and hold the Option key while you click the View button to 
display the list of saved view names, each appended with the 
Replace command, as shown:

Timeline View pop-
up menu
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2. Select a saved view name from the list. 

The current Timeline view is applied to the selected name, and that 
name is displayed in the Settings scroll list in the Project window. You 
can change the User Name in the Project window if you want.

Setting the Scroll Option for the Timeline

You can have the Timeline scroll over the position indicator while you 
play a sequence.

To set the scroll option:

1. Click Settings in the Project window to display a list of your cur-
rent settings.

2. Double-click Timeline to display a list of your current Timeline 
settings. For more information on Timeline settings, see the Avid 
Media Composer Products Reference.

3. Select the Scroll While Playing option.

To turn off scrolling 
while you play, dese-
lect it in the Timeline 
Settings window.

4. Click OK.

When you play a sequence in the Timeline, the sequence scrolls 
over the position indicator. When the Timeline has passed the 
playhead and the end of the Timeline is revealed, the Timeline 
stops moving and the blue position bar travels the remaining dis-
tance.



407

n For the Timeline to scroll, you might need to display more detail in the Time-
line to expand the sequence. Click the scale bar and drag it to the right to 
expand the Timeline.

All effect icons are hidden as you scroll.

Restoring the Default Timeline View

To restore the default view in the Timeline, choose Default Setup from 
the Timeline Fast menu.

Navigating in the Timeline

The Timeline window provides various controls for quickly moving 
through a sequence and adjusting your view of details displayed in 
the tracks while editing. You can use the position indicator, the Time-
line scroll bar/position bar, the scale bar, Zoom In and Zoom Back 
commands, or the Focus button. In addition, marked sections of the 
sequence can be highlighted for visual reference.

Figure 14-1 Timeline Window

Timeline Fast 
Menu button

Position 
indicator

Track Selector 
panel

Focus button Source/Record Toggle button Scale box Timeline scroll bar
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Using the Position Indicator

The position indicator in the Timeline marks your place in the 
sequence. It also determines how some of your commands are inter-
preted. For example, when you perform an edit, the system takes the 
location of the position indicator as the Mark IN in the absence of 
established marks.

When you move the position indicator in the Timeline, the smaller 
position indicator within the Record monitorÕs position bar also 
moves.

Using the Timeline Scroll Bar/Position Bar

By default the Timeline scroll bar appears along the bottom of the 
Timeline window, on the right side of the Timeline tool bar, as shown 
in Figure 14-1.

The Timeline scroll bar functions like any standard Macintosh scroll 
bar. You can drag the scroll box to reposition yourself within the Time-
line, or click the arrows to scroll left or right.

You can change the Timeline scroll bar to a position bar that acts like 
the position bar in the Record monitor, except that you can manipulate 
it without deactivating the Timeline window.

To use the Timeline position bar, select Show Position Bar in the Time-
line Settings window.

To access the Timeline Settings window:

1. From a Project window, click Settings.

The Settings scroll list appears.

2.  Scroll down to Þnd Timeline and double-click on it.

The Timeline Settings (Current) window opens.
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3. Click the appropriate options.

 An X appears in the box. To deselect an option, click it again.

For more information on the Timeline settings, see the Avid 
Media Composer Products Reference.

4. Click OK.

The scroll bar changes to a position bar.

An advantage of the position bar is that when you focus on just a por-
tion of the sequence, both the Timeline and Record monitor position 
bars show a highlighted region around the position indicator. This rep-
resents the range of material displayed in the window.
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Displaying Detail in the Timeline

The scale bar stretches and contracts the Timeline area centered 
around the blue position bar. This allows you either to zoom in to 
focus on a speciÞc area of your sequence, or to zoom out to display 
your whole sequence. This feature is especially useful when you have 
a lengthy sequence with many edits.

The scale bar replaces three buttons formerly in the Timeline tool bar: 
Show More Detail, Show Less Detail, and Show Entire Sequence.

Position indicators Highlighted region

Position indicator and highlighted
region

Scroll barDotted blue line Scale bar
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To zoom in on a section of the Timeline at the position indicator and 
then zoom back to your original display:

1. Click the scale box and drag it to the right.

The following happens:

¥ The Timeline expands horizontally.

¥ The Timeline track shows more detail.

¥ The position indicator splits into a solid blue line and a dotted 
blue line (or ÒshadowÓ), marking the beginning and end of the 
current frame. You can click either the line or the shadow to 
move exactly one frame forward or back.

2. Move the scale box back to the left.

The Timeline shrinks to its original size.

Zooming In and Out

The Zoom In/Back commands in the Timeline Fast menu stretch out 
the Timeline like an accordion to allow you to focus on detail, but with 
the following differences:

¥ The Zoom In command does not expand the Timeline incremen-
tally, but allows you to select a portion of the Timeline of any size 
to instantly expand to Þll the window.

¥ The Zoom Back command does not shrink the Timeline incremen-
tally, but instantly restores it to its former size.

¥ The Zoom In and Zoom Back commands are not dependent on the 
position bar. You can select any portion of the Timeline to expand 
and contract.

As Timeline expands, a 
shadow position indica-
tor appears.



412

To zoom in on a section of the Timeline and then zoom back to your 
original display:

1. Choose Zoom In from the Timeline Fast menu. The cursor arrow 
changes to a selection bar.

2. Position the cursor at either the start or end of the place you want 
to zoom in on, and drag to select the chosen section.

When you release the mouse button, the material inside the Zoom 
In box expands to Þll the Timeline window.

3. To return to the previous Timeline display, choose Zoom Back 
from the Timeline Fast menu.

Focusing the Timeline

The Focus button also allows you to zoom in on a section of the Time-
line. It is located in the Timeline tool bar next to the Fast Menu button.

The Focus button allows you to center the position indicator quickly 
and expand the Timeline. The Focus button always expands the Time-
line to a scale of 90 pixels per 1 second. The position indicator is cen-
tered in the window. When you click the Focus button a second time, it 
always returns the Timeline to its previous size.

Focus button
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To focus the Timeline:

1. Place the position indicator at frame or transition you want to 
expand.

2. Click the Focus button.

This centers and enlarges the region of the Timeline immediately 
surrounding the position indicator.

3. Click the Focus button again to return to the previous view.

Displaying Source Material in the Timeline

The Source/Record toggle button allows you to view multitrack 
source material quickly in the Timeline for selecting and marking spe-
ciÞc tracks.

By default the Timeline displays only the available tracks for source 
material.

When you click the button to display the source material, both the but-
ton and the position indicator turn green to indicate that you are view-
ing source material.

Source Tracks

Source/Record
toggle button
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This feature is particularly useful when you are editing with a 
sequence or subclip created from a sequence; you can also use it to 
look at the contents of any source clip in a Timeline display.

n Heads or Tails views are disabled when you are displaying material from the 
Source monitor.

Controlling Movement in the Timeline

While working in the Timeline window, you can use Control, Option, 
and Command keys to control the movement of both the position indi-
cator and any segments that you move in Segment mode.

The Timeline provides a small icon window called the motion mode 
indicator in the Timeline tool bar. 

This small window displays a speciÞc icon, depending on the key you 
press to augment your movement within the Timeline. The keys and 
movements are as follows:

¥ To snap to the head of transitions as you move through the Time-
line sequence, press and hold the Command (k) key as you drag 

 

Button and position indi-
cator turn green.

Motion mode indicator
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either the position indicator or any segments selected in Segment 
mode.

¥ To snap to the tail of transitions, press and hold the Command 
(k) and Option keys as you drag either the position indicator or 
any segments selected in Segment mode.

¥ To move frame-by-frame, hold the Option key and drag either the 
position indicator or any segments selected in Segment mode.

¥ The Control key affects the movement of segments only. To snap 
the selected segments to an edit point in the track above or below 
the current track, click a segment mode button, then press and 
hold the Control key and drag the segments.

IN to OUT Highlighting in the Timeline

When you mark a sequence with IN to OUT points, the system indi-
cates the selection by highlighting the marked region in the Timeline. 
Only selected tracks are highlighted.

This visual guide helps you monitor track and segment selection more 
carefully when mixing or applying effects across multiple tracks and 
segments.

To turn the highlighting feature on and off, select Show Marked 
Region from the Timeline Settings window.

Highlighted regionAll tracks selected
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Using Segment Mode

Segment mode provides editing controls for moving, deleting, mark-
ing, and editing entire segments in the Timeline. A segment is a por-
tion of the sequence that includes two or more transitions. There are 
two modes for editing segments or adding shots: Extract/Splice-in, 
indicated by a yellow arrow, and Lift/Overwrite, indicated by a red 
arrow.

Unlike traditional tape editing, Segment mode allows you to instantly 
reposition entire segments by using visual controls as though you 
were physically ÒdraggingÓ portions of your sequence around on a 
tape. You can move shots separately or together, on one track or across 
tracks.

Observe the following guidelines when editing in Segment mode:

¥ Transition effects on either side of a moved selection are deleted. 
Transition effects inside the selection are preserved.

¥ You can track the audio while moving segments by pressing the 
Caps Lock key to enable audio scrub. For more information, see 
ÒUsing Audio ScrubÓ on page 482.

¥ When you are Þnished, Segment mode continues to affect your 
editing in Source/Record mode or Trim mode unless you click the 
active Segment Mode button to deactivate it.

Segment Mode Workflow

The following is the basic workßow for editing segments in Segment 
mode:

¥ Select the segments by clicking with the Segment Mode pointer, or 
by lassoing segments with the mouse, as described in ÒSelecting 
and Deselecting SegmentsÓ on page 417.
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¥ Move, mark, or delete the segments in either Extract/Splice-in 
mode or Lift/Overwrite mode, as described in ÒPerforming Seg-
ment Mode EditsÓ on page 419.

¥ Use Segment mode, if desired, to edit directly from a bin as 
described in ÒBin Editing into the TimelineÓ on page 425.

Selecting and Deselecting Segments

There are two basic methods for selecting segments for moving or 
editing:

¥ Click a Segment Mode button, and select segments with the 
pointer.

¥ Lasso one or more segments on one or more tracks by using the 
mouse. 

Once you enter Segment mode by using either of these methods, you 
can continue to select or deselect additional segments. The selected 
segment or group of segments becomes highlighted, and remains in its 
original position during the move until you select its new position.

Observe the following guidelines when selecting tracks:

¥ You cannot simultaneously move segments that are separated 
along a track. You can, however, move segments separated on dif-
ferent tracks.

¥ You cannot overlap the source and destination tracks. For exam-
ple, you can move audio segments from A3 and A4 to A1 and A2, 
but you cannot move them from A3 and A4 to A2 and A3 (A3 
overlaps).

¥ With a group, you can click any selected segment to drag the 
entire group to a new position.

¥ You can select black Þller as a segment.
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Selecting with the Segment Mode Pointer

When you enter Segment mode, the cursor becomes an enlarged 
pointer that is yellow to indicate Extract/Splice-in mode, and red to 
indicate Lift/Overwrite mode. Outside of the Timeline, the cursor 
changes back to the standard arrow or I-beam, allowing you to per-
form other functions while in Segment mode.

To select segments with the pointer:

1. Click one of the Segment Mode buttons located in the Timeline 
tool bar next to the scale bar. The arrow changes to an enlarged 
pointer.

2. Click a segment in any track to select it. Shift-click additional seg-
ments to select a group.

Lassoing One or More Segments

You can use the mouse to lasso a single segment or a group of seg-
ments across one or more tracks.

To lasso segments, draw a lasso beginning in the area above the tracks 
in the Timeline. Drag left to right and down to select more than one 
transition.

Extract/Splice-in Segment mode is enabled by default when you draw 
a lasso. To switch to Lift/Overwrite mode, click the Overwrite button 
after drawing the lasso.

Observe the following guidelines when lassoing segments:

To select, drag a lasso from left to right and down.
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¥ Position the cursor above the tracks before dragging. If you click 
within the tracks, you simply relocate the position indicator to that 
position. To lasso segments in the middle of the Timeline between 
multiple tracks, hold the Control key while you click and drag.

¥ Lasso at least two transitions, or all transitions included in multi-
ple segments. If your lasso surrounds only one transition, you 
enter Trim mode. 

¥  Drag from left to right. If you drag from right to left, you enter 
Trim mode with slip rollers selected.

Deselecting Segments

To deselect one or more selected segments, do one of the following:

¥ To deselect an entire track, click the track selector. For example, if 
you lasso segments on V1, V2, and A1, you can click the V2 and 
A1 track selectors to leave only the segment on the middle 
track, V1, selected, as shown.

¥ Use the Shift key and the Segment Mode pointer to deselect spe-
ciÞc segments on any track, leaving the remaining tracks selected.

Performing Segment Mode Edits

Once youÕve selected one or more segments and entered Segment 
mode, you can reposition the segments by clicking and dragging with 
the Segment Mode pointer. You can also delete or mark the segments 
in one step.

Tracks V2, A1 deselected

Only the segment on V1 
remains highlighted.
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n You cannot overlap the source and destination tracks. For example, you can 
move audio segments from A3 and A4 to A1 and A2, but you cannot move 
them from A3 and A4 to A2 and A3 (A3 overlaps).

About Four-Frame Display

When you begin to drag the segments, the interface changes to the 
Segment mode four-frame display:

¥ The Source/Record monitors change to a four-frame monitor dis-
play. The two outer frames are updated while you drag the seg-
ment forward and/or backward in the Timeline, indicating the 
frames you pass as you drag the segment. The outer two frames in 
the four-frame display make it easy to view and analyze the 
frames between which you might want to drop the selected seg-
ment.

¥ A centered numeric offset counter appears directly below the 
frame monitors. The counter tracks the number of frames you 
move while you drag the selected segment from its starting point.

When you drag the segments, the original highlighted segment 
remains in place, while a ÒghostÓ segment enclosed in a dotted white 

The two inner 
frames represent 
the start and end 
frame of the seg-
ment.

The two outer 
frames indicate 
ending and begin-
ning frames of 
shots before and 
after the segment.

Four-Frame Display
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box moves along with the pointer until you release it at a new edit 
point.

When you release the segment into its new position, the actual lift 
(Overwrite) or extract (Splice-in) occurs. The preservation of the seg-
ment position in the Timeline until then allows you to maintain your 
perspective of the sequence while selecting the new edit point.

Suppressing Four-Frame Display

The four-frame display of incoming/outgoing frames can occasionally 
slow the movement of segments as you drag them through the 
sequence. You can improve the speed of segment editing by using the 
Shift key to suppress the four-frame display.

To suppress the four-frame display:

1. Click either the Extract/Splice-in button (yellow) or Lift/Over-
write button (red) to enter Segment mode.

2. Choose Show Segment Drag Quads from the Timeline settings.

3. Press the Shift key, then drag the segments you want to move.

As you begin to drag, notice that the monitors maintain their 
Source/Record conÞguration, rather than shifting to the four-
frame display.

Selected segment is dragged to new position.
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Extracting/Splicing Segments

Use Extract/Splice-in to move the selected segments in the Timeline 
without affecting any of the adjacent material. The total duration of 
the sequence is unaffected.

Like the standard Splice-in function, the Extract/Splice-in edit inserts 
the segment into the new position. However, as an additional func-
tion, it also ÒextractsÓ or removes the segment from its previous posi-
tion and closes the gap.

To perform an Extract/Splice-in:

1. Click the Extract/Splice-in button (yellow) in the Timeline tool 
bar.

2. Select the segments you want to move.

3. Click and drag the segment to its new position. Use the four-frame 
monitor display, the offset counter, and the segment image in the 
Timeline to carefully determine the new position.

4. Release the mouse button. The system extracts the selected seg-
ment from its old position, closes the gap left by its removal, then 
splices the material back into the sequence at the newly selected 
location.

5. Click the Segment Mode button again if you want to leave Seg-
ment mode, or continue to extract and splice-in segments.

n To cancel a segment edit in progress, drag the edit out of the Timeline window 
and release the mouse button. Alternatively, choose Undo from the Edit 
menu.

Lifting/Overwriting Segments

Use Lift/Overwrite to replace existing material at the new position, 
while leaving blank space in the previous position. The total duration 
of the sequence is unaffected.
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Like the standard Overwrite function, the Lift/Overwrite edit deletes 
and replaces underlying material at the new position, effectively creat-
ing new edits. It also ÒliftsÓ the segments from the previous position, 
leaving black or silence of the same duration.

To perform a Lift/Overwrite:

1. Click the Lift/Overwrite button (red) in the Timeline tool bar.

2. Select the segments you want to move.

3. Click and drag the segment to its new position. Use the four-frame 
monitor display, the offset counter, and the segment image in the 
Timeline to determine the new position carefully.

4. Release the mouse button. 

The system lifts the selected segment from its old position, leaving 
black, then overwrites the material onto the sequence at the newly 
selected location.

5. Click the Segment Mode button again if you want to leave Seg-
ment mode, or continue to lift and overwrite segments.

n To cancel a segment move, drag the edit out of the Timeline window and 
release the mouse button. Alternatively, choose Undo from the Edit menu.

Deleting Segments with Segment Mode

Segment mode allows you to delete whole segments in the Timeline 
quickly without having to mark IN and OUT points Þrst. In addition, 
you can select multiple segments in separate tracks anywhere along 
the Timeline to delete at once.

To delete segments quickly:

1. Click one of the Segment Mode buttons:

¥  Extract/Splice-in (yellow) deletes the segments and closes the 
remaining gaps. The total duration of the sequence is short-
ened, and any synchronized tracks lose sync.
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¥ Lift/Overwrite (red) deletes the segments but leaves blank 
space or silence in their place. The total duration of the 
sequence remains the same, and sync is maintained.

2. Select one or multiple segments.

3. Press the Delete key. The segments are deleted.

n If the segment has an effect, the effect is deleted Þrst.

Marking Clips and Sequences with Segment Mode

As an alternative procedure to marking sections of the Timeline in 
Source/Record mode for deleting, copying, subclipping, rendering, or 
creating an EDL or digital cut, you can use Segment mode to mark 
segments quickly, as follows:

1. Click one of the Segment Mode buttons. In this case, it does not 
matter which Segment Mode button you click.

2. Click one or more segments to highlight a section of the sequence.

3. Click the Mark Clip button.

The system marks an IN point at the start and an OUT point at the 
end of the selected segments. If you have more than one track 
selected, the IN and OUT points mark where the edit points across 
tracks line up.

IN point OUT point
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Using Advanced Timeline Techniques

There are several advanced techniques for displaying and editing in 
the Timeline that you can use in any combination, including:

¥ Editing directly from a bin

¥ Cutting, copying, and pasting

¥ Full-screen editing

¥ Editing with the Film track

¥ Editing in Heads and Tails view

Bin Editing into the Timeline

For information on edit-
ing multiple clips 
directly from the bin 
into the Record monitor, 
see ÒCreating an 
Instant Rough CutÓ on 
page 381.

You can use Segment mode to edit clips directly from a bin into the 
sequence in the Timeline. Bin editing allows you to bypass the process 
of loading clips into the Source monitor, setting marks, and clicking 
the Splice-in or Overwrite buttons.

To perform a direct edit from a bin into your Timeline:

1. For a more accurate edit, mark IN and OUT points for each clip or 
create subclips, as described in ÒMarking and Subcataloging 
FootageÓ on page 350. Otherwise, the entire clip is edited into the 
sequence.

2. Click one of the Segment Mode buttons:

¥ Lift/Overwrite (red arrow) acts as an overwrite edit, causing 
the clip to overwrite material of the same length in the 
sequence, while maintaining the same duration of the 
sequence.

¥ Extract/Splice-in (yellow arrow) acts as a splice edit, inserting 
the clip into the sequence, moving existing material down, 
and lengthening the total duration.
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3. Drag a clip from the bin into the Timeline. You only can edit one 
clip at a time.

The cursor changes to the selected Segment mode icon, and the 
interface changes to the four-frame monitor display. In this case, 
the numeric offset frame counter displays zero because there is no 
offset. As you drag, a white outline of the clip indicates the seg-
ment position. 

4. When you Þnd the right placement for the clip, release the mouse 
button. The Timeline reßects the new edit.

n Once the edit is completed, you remain in Segment mode until you click the 
active Segment Mode button again to deactivate it.

Cut, Copy, and Paste in the Timeline

You can use the traditional Macintosh shortcut keys for cutting, copy-
ing, and pasting segments selected in the Timeline.

To cut, or copy:

1. Select the segment by using one of the Segment mode pointers.

2. Press kÐC to copy, or kÐX to cut.

3. Place the position indicator at the new IN point, and press kÐV to 
paste the segment in.

n The action of the cut and paste action depends on the Segment mode selected.

Using Full-Screen Timeline

As an alternative to constantly scrolling through the Timeline window 
or resizing tracks to get a view of the material, you can resize the Time-
line window to full-screen display.
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To resize the Timeline window, click the Zoom box at the upper right 
corner of the window.

Notice that a Timeline with reduced tracks wraps around to show 
more of the sequence. As you reduce tracks in a full-screen Timeline, 
the sequence wraps around up to four times, allowing you to examine 
a long sequence in greater horizontal detail.

Zoom 
box
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You can also enlarge the tracks to view complex audio or video layers 
in greater vertical detail. To enlarge tracks, select them and press kÐL.



429

With the proper controls mapped to the keyboard and a full-screen 
monitor connected to your system, you can edit with a full-screen 
Timeline for long periods.

You can also continue to work in Source/Record mode by resizing the 
Timeline window so that the two windows overlap.

You can click in either window to activate it and bring it forward at 
any time. Or you can click in the title bar of the Timeline window and 
drag it to the Bin monitor to place each window in its own monitor.

To restore a resized Timeline to its default position, choose Home from 
the Windows menu.

Editing with the Film Track

You can use the Þlm track to examine each frame of the sequence in a 
linear display, much as you would when looking at a strand of Þlm on 
a ßatbed or workbench. Unlike your view of the footage in the moni-
tors, which display one frame at a time, the Þlm track within the Time-
line allows you to compare individual frames side by side within a 
range of frames.
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To display the Þlm track, choose Film from the Show Track submenu 
of the Timeline Fast menu.

A row of Þlm frames appears at the top of the Timeline.

To adjust your view of the Timeline quickly for frame-by-frame view-
ing and editing, choose Show Every Frame from the Timeline Fast 
menu.

The film track displays as many representative 
frames as possible within the window.
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n The Þlm track displays frames for the topmost video track only. You cannot 
display more than one Þlm track at a time.

To quickly view more frames as you scroll, click the zoom box in the 
upper right corner of the Timeline for a full-screen view. You can 
reduce the size of Timeline tracks to wrap the sequence around several 
times.

The position indicator splits to surround each 
frame. The solid blue bar indicates the head, and 
the shadow bar indicates the tail of each frame.
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As you continue to scroll, each strand of the Timeline wraparound is 
updated.

Editing in Heads and Tails View

While in the early stages of editing a project, you can easily rearrange 
shots in the sequence visually by using Heads view or Heads and Tails 
view. These display formats are useful for quickly rearranging simple 
straight-cut edits. 
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c If you rearrange a split edit (in which the audio extends beyond the 
video, or the reverse) the system cuts all tracks to the same edit 
point. To rearrange split edits, edits on multiple video tracks, or to 
move audio and videopicture separately, use Segment mode editing 
techniques described in ÒUsing Segment ModeÓ on page 416.

To edit in Heads view or Heads and Tails view:

1. Choose View Type from the Timeline Fast menu, then choose 
Heads, or Heads and Tails, from the submenu.

The Timeline changes to one of the following displays.

2. Click the track selector buttons to select the tracks to be edited.

3. Hold down the Option key, click the frames representing the shot 
you want to move, and drag the shot to its new position. The 
sequence is rearranged to match the changes you made.

Head frame for each clip

Head and tail frame for each clip

Heads view

 
Heads and
Tails view
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Working with Multiple Tracks

As your project progresses, you might need to add and edit with addi-
tional audio or video tracks. The Avid Composer system allows you to 
edit up to 24 tracks of video and 24 tracks of audio. In addition, you 
can step into tracks to create additional tracks for nested effects.

While working with multiple tracks, you can use the Track Selector 
panel to select, manipulate, delete, lock, patch, and monitor your 
tracks. You can use multiple tracks to layer audio effects and sound, 
or to add video titles and other effects, as described in this section.

n Multiple video tracks do not immediately play back at the same time until you 
apply an appropriate effect that composites the layers. Multiple audio layers, 
however, do play back immediately if correctly monitored.

About Effects Editing

Your primary use for multiple tracks of video is in the use of effects. 
Effects editing techniques in the Avid Composer system fall into the 
following basic categories:

¥ Motion effects, such as freeze-frame and slow- or fast-motion 
effects, involve applying frame-motion parameters to selected 
footage, usually on a single video track.

¥ Transition effects, such as dissolves and wipes, involve making the 
transition from one edited clip to another on the same video track. 

¥ Segment effects, such as picture-in-picture, keys, or color effects, are 
applied to whole segments. These often require multiple layers of 
video.

n For more information on all types of effects editing, see the Avid 
Media Composer and Film Composer Effects Guide. 
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About Nesting

Occasionally, effects editing involves a unique procedure known as 
nesting. This involves stepping into existing tracks to reveal added lay-
ers for combining multiple images and digital video effects. When the 
effect is applied, you can step out to view and render the effect as one 
segment on the track.

Media Composer allows you to nest up to 24 additional tracks within 
each track.

n For more information on nesting techniques, see the Avid Media Composer 
and Film Composer Effects Guide.

Using the Track Selector Panel

The Track Selector panel provides numerous controls for working 
effectively with multiple tracks. With this one resource you can select, 
delete, monitor, enlarge, reduce, sync lock, patch, and move any video 
or audio track.

The Track Selector panel also provides a quick display of track infor-
mation. You can see which tracks are available, active, patched, moni-
tored, or locked on the source and/or record side at any time. The 
following conÞguration shows just one example. The Track Selector 
panel can look very different depending on the nature of the source 
material or the work underway in the sequence.
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The source side of the panel displays only those tracks available for 
the clip currently loaded and displayed in the Source monitor. For 
instance, a clip that has audio digitized for track A1 only does not dis-
play an A2 track in the Track Selector panel.

The record side of the panel displays only those tracks currently in use 
for the sequence. However, if you edit source material with a track 
selected that does not yet exist on the record side (A3 or V2, in the pre-
vious example), by default the track appears on the record side after 
the edit takes place.

Selecting Tracks

You can select tracks on either the record side or the source side of the 
Track Selector panel as follows:

¥ You can edit selected tracks on the source side directly into the 
sequence, assuming you have selected parallel tracks on the 
record side.

¥ You cannot edit deselected tracks on the source side into the 
sequence, regardless of record track selections.

¥ You cannot edit deselected tracks on the record side, regardless of 
source track selections.

There are four methods for selecting tracks:

Source track monitors
Source tracks
Track lock indicators
Record tracks
Record track monitors

Timecode track
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¥ Click any deactivated track to select it. Click any activated track to 
deselect it.

¥ Drag a lasso around multiple tracks to select them at once.

¥ With the Timeline window active, choose Select All Tracks from 
the Edit menu to select all tracks on the record and source side.

¥ Click the Cycle/Picture Sound button to cycle among selection of 
the video tracks, the audio tracks, and all tracks.

For example, you might select the source and record tracks for V1, A1, 
and A2 to edit picture and audio from the source clip into the 
sequence. Select only V1 source and record tracks to edit the picture 
without sound. Or, select only A1 and A2 to edit the sound without the 
picture.

n There are also keyboard equivalents for selecting tracks. Check your keyboard 
or the Keyboard settings in the Settings scroll list in the Project window.

Monitoring Tracks

You determine the monitoring of tracks by clicking the monitor col-
umn of either the source- or record-side tracks to activate or deactivate 
the monitor icons. Video monitors and audio monitors behave differ-
ently in some circumstances, as described in this section.
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Monitoring Video

The video track monitor determines whether you see video during 
playback. You can turn it off at any time to monitor only audio during 
editing. When there are multiple video tracks, all tracks below the 
monitored track are active during playback.

When you edit with multiple tracks, you can activate the monitor on a 
lower track to monitor only the video on that track. This is especially 
useful when you have multiple layers of video effects, and need to see 
one track without the additional layers.

n If you reposition the video monitor, be sure to return it to the topmost track to 
view, render, or record all the tracks together. Unmonitored tracks are not 
included in playback.

Monitoring Audio

Your Avid Composer system allows you to monitor up to eight audio 
tracks at a time.

Video track monitor

Audio track monitor
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Starting at Release 7.0, you can monitor eight channels of audio on 
two-channel audio boards. Previously, you could only monitor four 
channels with a two-channel board.

 The following characteristics apply to audio track monitoring:

¥ The system pans odd-numbered tracks to the left speaker, and 
even-numbered tracks to the right by default.

¥ If your sequence includes more than eight audio tracks, you can 
select any eight tracks to monitor at any one time by clicking in the 
monitor column of the Track Selector panel to display speaker 
icons in the chosen tracks.

¥ To hear more than eight tracks at once, you must mix some of 
them down to a maximum of eight. For more information, see 
ÒMixing Down Audio TracksÓ on page 553.

¥  A speaker icon (either solid or hollow) indicates that the tracks are 
monitored for playback and output. However, only the track with 
the hollow icon is monitored for audio scrubbing.

¥ The topmost audio track displays the hollow scrub icon by default 
until you select another track for scrubbing. To activate audio 
scrub for a particular track, Option-click in the monitor column. 
For more information, see ÒUsing Audio ScrubÓ on page 482.

¥ When you choose Direct Out in the Audio Mix Tool, tracks 5 to 8 
play back on channels 1 to 4. You can also customize the output of 
the tracks, as described in ÒUsing the Audio Mix ToolÓ on 
page 490.

Monitoring a Solo Track

You can use the k key to quickly select an individual video or audio 
track for monitoring during editing.

¥ To select a track for solo monitoring, press the k key and click in 
the monitor column for the chosen track. The monitor icon is high-
lighted in green to indicate solo monitoring.
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¥ To deselect solo monitoring, press the k key and click again in the 
monitor column. The monitor icons return to normal functionality.

Solo monitoring provides several advantages:

¥ You can overcome slowed playback and cueing when working 
with a complex sequence by isolating tracks for monitoring.

¥ You can quickly isolate an individual audio track without having 
to click several times in the monitor column to deselect all other 
tracks.

¥ You can monitor the upper layers of a composited effect apart 
from the lower layers.

Video track 
selected for solo 
monitoring

Audio track 
selected for solo 
monitoring

The screen on the left shows a multitrack 
matte key effect with the upper track 
selected for normal monitoring.

The screen on the right shows the same 
effect with the upper track selected for solo 
monitoring.
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Patching Tracks

When working with multiple tracks, you occasionally encounter a cir-
cumstance where you must edit source audio or video onto a track 
other than the parallel track displayed in the Track Selector panel. To 
edit the source material onto another record track above or below it, 
you must patch the source track to the targeted record track.

You can perform only one patch per edit, but there is no limit on the 
number of times you can patch from the same source track. Audio can 
only patch to audio, and video to video.

¥ To perform a patch, drag from a source track (audio or video) to 
the targeted record track (a white arrow appears during the 
patch).

¥ To undo a patch, click in the Record monitor or Timeline. Choose 
the Restore Default Patch command from the Special menu, or 
manually repatch to the previous track.

The selected source track moves beside the record track to which it is 
patched as soon as you draw the arrow and release the mouse. The 
patched track remains highlighted in preparation for your edit. You 
can proceed to select any other tracks required for the edit.

After you make the edit, you can continue to work on the same track 
or patch to a different track as necessary.

An audio patch 
from a source 
track to a record 
track

New source 
track order 
identifies the 
patch

During Patch After Patch
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c When patching from one video track to another, the video track 
monitor icon moves to the track you patch to. Be sure to return the 
icon to the topmost track when necessary to play back and output all 
video tracks.

Locking and Sync Locking Tracks

The system provides two ways of locking tracks:

¥ You can lock selected tracks to prevent further editing from being 
performed on them. 

¥ You can sync lock selected tracks, so that when you trim one track, 
the other track follows.

The middle row of the Track Selector panel displays a slash mark icon 
for sync-locked tracks, and a padlock icon for locked tracks. The pro-
cedure for applying the locks is different in each case.

Locking Tracks

Locking tracks to prevent further editing is especially useful in circum-
stances like the following:

¥ For video editing, you can lock tracks when you have completed a 
set of complex, multilayer edits and want to avoid making acci-
dental changes while you work on other adjacent tracks.

¥ For audio editing, you can lock audio tracks that contain sync dia-
log that should be maintained while you edit on adjacent video 
tracks or audio tracks. 

¥ For projects involving multiple editors, you can lock tracks to pre-
vent unnecessary or accidental changes.

Slash icon

Padlock icon
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To lock tracks:

1. Select the tracks to be locked (Source and/or Record) by clicking 
to select each in turn. 

2. Choose Lock Tracks from the Clip menu. The padlock icon indi-
cates that the selected tracks are locked.

No further editing can occur on locked tracks until you choose 
Unlock Tracks from the Clip menu.

Sync Locking Tracks

For more information 
on using the sync-lock 
feature in Trim mode, 
see ÒUsing Sync LockÓ 
on page 562.

Sync locking affects trimming and splice-in edits. This feature is espe-
cially useful when you are working with multiple tracks and want to 
maintain sync between two or more tracks.

To sync lock the tracks, click in the center column between track selec-
tors to activate the slash mark icon for each synchronized track. When 
you need to resume editing on individual tracks, click again to remove 
the slash marks.

Adding a Track

To add a new track to a sequence, do one of the following:

¥ With a sequence loaded in the Record monitor, choose New Audio 
Track or New Video Track from the Clip menu. 

The new track appears in the Timeline.

¥ If you want to manage the numbering scheme of tracks rather than 
use the consecutive numbering default:

a. Hold down the Option key and choose New Audio Track or 
New Video Track from the Clip menu. A dialog box appears.
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b. If you want to switch from the type of new track you chose 
(for example, from a new video to a new audio track), choose 
the other option from the track type pop-up menu.

c. If you want to select a track number other than the default 
consecutive numbering offered by the dialog box, choose 
another number from the track number pop-up menu. You 
cannot choose the number of an existing track.

d. Click OK. The new track appears in the Timeline and in the 
Track Selector panel.

Deleting Tracks

You can remove one or more tracks from a sequence if you no longer 
need the tracks.

To delete one or more tracks from the sequence:

1. Enable the tracks, and press the Delete key. A dialog box appears.

2. Click OK. The tracks are deleted.

Track type pop-up menu

Track number pop-up menu
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When you delete a track, it is permanently removed. If you want to 
remove the track temporarily, hide the tracks as described in ÒCustom-
izing Timeline ViewsÓ on page 399.

Adding an Edit (Match Framing)

The add edit function places an artiÞcial edit point between frames of 
a clip. In other words, the edit appears in the Timeline as a transition 
between two clips, but when you play the clip, the footage appears 
unchanged because the frames are continuous.

This form of edit is also known as a match frame. In traditional analog 
editing, match framing is used to accomplish speciÞc tasks, such as 
creating a dissolve between two shots. In the Avid Composer system, 
however, add edits (or match frames) function differently. Use match 
frames primarily to divide and isolate portions of a clip or sequence in 
order to modify that portion without affecting the rest of the footage. 
Once you make the adjustment, playback of the clip is no longer seam-
less because the two portions of the clip are different.

You can add an edit to a single audio or video track, or you can place 
the add edit across several tracks at once.

To add a match-frame edit:

1. Place the position indicator at the chosen frame. 

2. Select the tracks where you want to add the edit.

1 2 3 4 6 75

Add edit placed between frames.

Footage continues to play back fluidly.
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3. Click the Add Edit button. The edit appears in the sequence, with 
an equal sign to indicate a match frame.

n By default, the match frame indicator appears white. If a change in level 
occurs the match frame indicator changes to red.

Removing Match-Frame Edits

You can also remove 
individual match 
frames by selecting 
them in Trim mode and 
pressing the Delete key. 
For more information 
on Trim mode, see 
Chapter 15.

If you make a mistake when adding an edit, or if you have Þnished 
performing edit functions with multiple add edits and want to remove 
them, you can remove all add edits in the entire sequence, or within a 
selected portion of the sequence.

To remove match-frame edits:

1. Select the entire sequence or a portion as follows:

¥ Select a portion of the sequence by marking an IN point and 
an OUT point surrounding the match-frame edits (add edits) 
you want to remove.

¥ Select the entire sequence by removing any IN and/or OUT 
points.

2. Select the tracks from which you want to remove the edits.

3. Choose Remove Match Frame Edits from the Clip menu.

The Avid Composer system removes the edits.

Equal sign indicates 
a match frame.
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c You cannot remove match-frame edits between segments in which 
audio pan or volume levels have been adjusted.

Alternatively, you can select the match-frame edit in Trim mode and 
press Delete.

Backtiming Edits

Backtiming an edit is effectively the reverse of the process you nor-
mally use for marking footage: instead of marking from the IN points 
forward, you mark according to the OUT points.

For example, you might have a track of audio (music or voice) that 
ends at a speciÞc point, and you want to synchronize a video clip to 
end on a particular shot. You can backtime the edit to match the end 
points of the tracks. 

Here are a few concepts to keep in mind:

¥ The Avid Composer system needs only three marks to perform a 
backtimed edit when four edits of unequal duration exist in the 
sequence. The IN and OUT points set on the record side always 
take precedence.

¥ If you do not mark an IN point in the sequence, the Avid Com-
poser system uses the position indicator as the IN point.

¥ If you do not mark an OUT point in the clip, the Avid Composer 
system uses the end of the clip as the OUT point.

¥ If you mark OUT points in both the Source monitor and in the 
Record monitor, the Avid Composer system uses the OUT point 
on the record side.

To backtime an edit:

1. Mark an OUT in the sequence where you want the edit to end. 
Also mark an IN where the edit is to start.

2. Select the appropriate tracks.
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3. Load the clip into the Source monitor.

4. Mark an OUT point in the Source monitor to synchronize to the 
OUT point in the sequence.

5. Click the Overwrite button. 

The source material is added to the sequence, with the synchro-
nized ending.

Creating One-Step Overlap Edits

For more information 
on creating overlap 
edits in Trim mode, see 
ÒCreating Overlap 
EditsÓ on page 466.

You can quickly create an overlap edit (also known as an L-cut or 
delay edit) at the end of a sequence by using the Option key while per-
forming an overwrite edit.

To perform a one-step overlap edit:

1. Move the position indicator to the edit point before the end of the 
sequence.

2. Select record tracks for overlapping either the video or the audio:

¥ To extend the video beyond the audio, select the audio record 
tracks.

¥ To extend the audio beyond the video, select the video record 
tracks.

V1

A1

A2

Position indicator

Before edit

V1 V1

A1 A1

A2A2

V1

A1

A2

After edit

New

New

New

Track Selectors 

Overlapping the video
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3. Press the Option key while you click the Overwrite (red) but-
ton.

The overlap edit is complete.

n You can also use the Audio Mark In button to create an overlap edit.

Additional Offline Aids

Your Avid Composer system provides two features speciÞcally 
designed to aid the ofßine editing process by helping you track and 
adjust edits to avoid extra work in the online suite. These features are 
Dupe Detection and Color Frame tracking.

Detecting Duplicate Frames

When editing ofßine with plans to generate an EDL, the Dupe Detec-
tion feature allows you to visually track duplicate frames of footage as 
you edit so that you can eliminate or manage the requirements of an 
online dupe reel.

When you activate Dupe Detection, each set of duplicate frames is 
tagged with a different color. (Up to 10 color sets can be distinguished 
during a single detection process.) Matching frames have matching 

V1

A1

A2

Position indicator

Before edit

V1 V1

A1 A1

A2A2

V1

A1

A2

After edit

New

New

New

Track Selectors

Overlapping the audio
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colors. If the duplicate frames are unnecessary, you can use any of the 
Trim mode options to remove the superßuous frames prior to generat-
ing an EDL. 

The colored bars that distinguish duplicate frames in the sequence are 
automatically drawn above the frames in the Timeline, as shown.

Red bars mark the Þrst set of duplicate frames; green bars mark the 
second set, and so on. You can use Dupe Detection while you are edit-
ing to locate duplicate frames and remove them as the sequence 
evolves. 

To activate Dupe Detection, choose Dupe Detection from the Timeline 
Fast menu.

Two duplicate frames marked above the clip by the auto-
matic Dupe Detection option
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Dupe Detection is instantaneous and retroactive; if duplicate 
frames already exist in your sequence, the colored bars appear 
immediately. As you edit, the system shows duplicate frames as 
they occur.

n The handle size used by Dupe Detection can be changed in the Timeline set-
tings.

Tracking Color Frame Shifts

If you are preparing for an online edit using 1-inch reel-to-reel sources, 
you can enable the Color Framing option to track and correct instances 
where an edit cuts between the four Þelds (two frames) required to lay 
down a complete NTSC color sync signal phase.

When Color Framing is enabled, green bars appear beneath the Over-
write and Splice-in buttons and blink whenever a color sync signal is 
interrupted by an edit. The blinking lights indicate that color framing 
is out of phase at the edit transition.
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Use the following procedure to enable Color Framing while editing:

1. Click the Settings button in the Project window, then double-click 
Composer Settings in the projectÕs settings list.

The Composer Window Settings dialog box appears.

2. Click the Color Framing pop-up menu and choose the appropriate 
option:

¥ For NTSC video, choose the 4-Þeld option.

¥ For PAL video, choose the 8-Þeld option.

The dialog box displays the setting you selected. 

3. Click OK to complete the setting selection.

To correct color frame interruption as you edit:

1. Note any edits that cause the green lights to blink below the edit 
buttons. You can adjust the edits now, or place locators to return to 
these edits and correct them at a future time. 

2. To adjust the edit, enter Trim mode.

In Trim mode, the Avid Composer system displays small green 
boxes on the top-adjacent frame corners. When the color sync sig-
nals are in phase, the boxes are aligned horizontally.

Start Frame color phase indicator

End Frame color phase indicator

Green color frame phase bars 
blink during an interruption

Color Framing 
option
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3.  Trim one frame at a time on one side of the transition or the other 
until the indicator boxes are aligned, and the indicator lights 
below the Splice-in and Overwrite buttons stop blinking. 

If you are careful about color framing while editing, you will not need 
to consider the subject again when assembling your master tape. If 
you ignore color framing during the edit session, you might have to 
make adjustments during online editing if your edits interrupted any 
color-frame Þelds in the sequence.

Printing the Timeline

To print the Timeline:

1. Choose Print Timeline from the File menu. The print dialog box 
appears.

n The name of the printer and details of the dialog box will vary depending 
upon facilities.

2. Select printing options, then click Print.

The system prints the current view of the Timeline. You can also 
use the Print Timeline command to print the Timeline in Heads 
view or in Heads and Tails view.

Incoming frame Outgoing frame

Color Framing Indicator Lights

Boxes are out of alignment when color 
sync signal is out of phase
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CHAPTER 15

Working in Trim Mode

Basic editing in Source/Record mode and in the Timeline initially pro-
duces a rough cut, which can be loosely deÞned as a series of straight-
cut edits with many rough edges and few effects. After creating a 
rough cut, you can enter Trim mode and Þne-tune the transitions 
between each shot or between whole segments. You can also trim edits 
as you build a sequence, rather than creating a rough cut Þrst. The fol-
lowing sections describe the Trim mode procedures:

¥ Customizing Trim Mode

¥ Using Basic Trim Procedures

¥ Creating Overlap Edits

¥ Extending an Edit

¥ Slipping or Sliding Shots

¥ Maintaining Sync While Trimming

¥ Using the Transition Corner Display

Customizing Trim Mode

Trim mode provides a unique set of controls within the Composer 
window for Þne-tuning edits with various trim procedures. These con-
trols appear in both the Source/Record window and in the Timeline.
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Big Trim mode is the systemÕs default conÞguration for trimming. 
Small Trim mode is an optional display mode. In either mode you can 
perform many of the same functions, such as removing or adding 
frames, or slipping or sliding shots.

In Big Trim mode, 
Source and Record 
monitors are replaced 
by displays of outgoing 
and incoming frames. 
Big Trim mode also 
shows transition play-
back loop parameters.

Outgoing
frames

Playback loop
parameters 

Play Loop button
Frame offset
counters

Trim buttons

Incoming
frames
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Small Trim mode 
leaves the Source moni-
tor display intact, but 
has smaller displays for 
incoming and outgoing 
frames, and does not 
provide access to transi-
tion playback loop
parameters.

Use the Trim Settings dialog box to conÞgure basic displays and
functions.

You can learn about Trim settings as follows:

¥ For an overview of all settings, see the Avid Media Composer Prod-
ucts Reference.

¥ For more information on transition playback loop parameters, see 
ÒTrimming During a Playback LoopÓ on page 466.

¥ For information on dual image playback during trims, see ÒDual-
Image Playback During TrimsÓ on page 464.

In addition, you can:

¥ Map trim-related buttons onto palettes in Trim mode, as described 
in ÒAbout Button MappingÓ on page 96.

¥ ConÞgure a Trim-mode-speciÞc Timeline view, as described in 
ÒUsing the Timeline Fast MenuÓ on page 401.

Outgoing
frames

Incoming
Frames

Frame offset
counters

Trim
 buttons

Play Loop
button
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Using Basic Trim Procedures

For illustrations of the 
various types of trim 
edits you can perform 
in Trim mode, see the 
Avid Media Composer 
and Film Composer 
Quick Reference.

You can enter Trim mode in several different ways, depending on the 
type of trim you expect to perform. Once in Trim mode you can:

¥ Select additional tracks 

¥ Toggle between Big and Small Trim mode

¥ Toggle between trim sides

¥ Perform and play back the trim

Entering Trim Mode

There are four alternative methods for entering Trim mode:

¥ Click the Trim Mode button. By default, the system enters Trim 
mode and selects the tracks nearest the position indicator for dual-
roller trimming. This method is useful for selecting straight-cut 
transitions on one track or across video and audio tracks.

When you deselect one or more tracks in the Track Selector panel, 
by default only the transitions in the highlighted tracks are 
selected for trimming. If the transitions are not straight cuts (over-
lap cuts or L-edits), the system highlights the topmost track near-
est the position indicator.

¥ Lasso the transitions in the Timeline. Draw the lasso by clicking 
at a point above the top track in the Timeline and dragging to sur-
round the transitions. This method is useful when you need to 

Default Trim mode selection
for a straight cut
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select multiple transitions staggered across parallel tracks (overlap 
cuts) for simultaneous trimming.

You can drag from right to left, or left to right, and you can lasso 
single transitions across several contiguous tracks. However, 
avoid lassoing more than one transition on a single track, because 
this activates Segment mode.

n To select transitions located below several track layers, you can draw a lasso 
within the Timeline by pressing the Control key while you drag.

¥ Click the Go to Previous Edit or Go to Next Edit buttons. By 
default, the system selects the nearest transition in either direction 
of the selected track for dual-roller trimming. 

If the transition is a straight cut, the system selects all edited 
tracks. If the transition is an overlap edit, with staggered transition 
points, the system selects the topmost track.

¥ Click the Play Loop button on a palette or the keyboard.

This is useful if you like to trim quickly as you edit, going back 
and forth between Trim mode and other edit modes. This method 
is described in ÒTrimming During a Playback LoopÓ on page 466.

n The Play Loop button does not appear in Source/Record mode by default. You 
must map it to the keyboard or a palette in advance. For information on but-
ton mapping, see ÒAbout Button MappingÓ on page 96. 

Lasso drawn across three tracks

Transitions are selected for dual-roller trim
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Exiting Trim Mode

You can exit Trim mode at any time in one of several ways:

¥ Click the Source/Record Mode or the Effect Mode button.

¥ Press the Escape key on the keyboard to enter Source/Record 
mode by default.

¥ Click a speciÞc location in the Timecode (TC1) track at the bottom 
of the Timeline to exit Trim mode.   The position indicator moves 
to that location.

Toggling Between Big and Small Trim Mode

When you click the Trim Mode button, by default the system enters 
Big Trim mode. If you click the Trim Mode button again, the interface 
toggles between Big and Small Trim mode.

If you prefer the larger monitors and controls of Big Trim mode, select 
this as the default in the Trim Settings in the Project window. When 
you need to use the Monitor menus to switch between sequences, or 
have occasion to edit source material into the sequence, you can click 
the Trim Mode button to enable Small Trim mode, which includes the 
Source monitor controls.

esc

Click in the TC track at a 
selected location.

The system exits to Source/Record 
mode, and relocates the position indi-
cator.
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Selecting Between Trim Sides

There are three ways to select sides of a transition to trim:

¥ In Big or Small Trim mode display, click the outgoing (A-side) or 
incoming (B-side) monitor to deÞne which side of the transition to 
trim. Notice that the pointer changes to a single-roller A-side, 
single-roller B-side, or double-roller icon depending on position.

¥ You can also use the Trim-side keys on the default keyboard (or 
map them onto one of the monitor palettes while in Trim mode) to 
select side A, side B, or both.

¥ You can use the Cycle Trim Sides button to cycle between selection 
of the A-side, B-side, or both.

The selected parts of the transition are highlighted, and the corre-
sponding rollers appear in the Timeline. Also, one or both of the 
frame counter indicators below the monitors are highlighted to 
reßect the active trim sides: A-side, B-side, or both. The number 
indicates how many frames have been added or subtracted from 
the transition. Click to choose a side. Shift-click to choose both.

Selecting Additional Transitions

While you are in Trim mode, you can select additional transitions for 
trimming in different contexts in one of the following ways:

A-side B-side A and B

A-side
A and B

B-side

A-side B-side

Highlight indicates
active side
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¥ To quickly select additional transitions on contiguous tracks for 
trimming on the same side, click the corresponding record-side 
track selectors in the Track Selector panel. For example, if you 
select a single transition in track V1 for single-roller A-side trim-
ming, and want to add A1 and A2 tracks at the same transition, 
click the corresponding track selectors.

Likewise, you can deselect tracks in the track panel to remove 
transitions on those tracks from the trim procedure.

¥ To select additional transitions for single-roller trimming in vary-
ing locations on different tracks, Shift-click the transitions in the 
Timeline. This method is useful when you are working with stag-
gered transitions across multiple tracks; it also allows you to select 
both A- and B-side transitions for simultaneous trimming in oppo-
site directions (asymmetrical trim). This is not possible with dual-
roller trims.

Notice as you move the cursor back and forth across a transition, 
the roller icon changes from an A-side roller (facing left) to a B-
side roller (facing right) to indicate the type of selection. 

You do not see the dual roller within the Timeline. To select both 
sides, you must Þrst select one side, then Shift-click to select the 
other.

¥ To quickly add multiple transitions to the currently selected transi-
tions, press the Shift key and lasso the additional transitions. Press 
Shift-Control while lassoing tracks that are below other tracks.

¥ You can select and trim two heads or tails simultaneously, in any 
combination, for each track in the sequence. All selected transi-
tions are trimmed the same number of frames. This allows you to 

Select tracks on 

to add transitions.
the record side

Two A-sides and one B-side
selected for asymmetrical
trimming

A-side B-side
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save time, and in some cases, maintain sync by performing a sin-
gle trim procedure across multiple tracks and transitions.

Performing a Basic Trim

With your transitions and trim sides selected, you can perform a basic 
trim by using one of the following alternative procedures:

¥ Use the Trim buttons to trim forward or backward by 1- or 10-
frame increments.

¥ Use the numeric keypad at the right side of the keyboard, as fol-
lows:

- To move the transition a speciÞc number of frames, type a 
plus sign (+) or minus sign (Ð) and the number of frames (from 
1 to 99) you want to move forward or backward. Then press 
Enter. If the number of frames is larger than 99, type an F after 
the number to indicate frame count. For example, to enter 200 
frames, type 200F and press Enter.

- To move the transition to an exact timecode, type a timecode 
number larger than 99, including frames. For example, type 
102 to enter 1 second and 2 frames (1:02). 

¥ Use controls in the Timeline by clicking a roller at the selected 
transition and dragging forward or backward in the sequence.

In this example, tail frames 
on both shots are trimmed 
simultaneously across an 
overlap edit.

1 frame 10 frames
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¥ For greater control:

- Press the Option key as you drag to move one frame at a time.

- Press the Command key to snap to other transition points.

As you trim, all selected transitions in the Timeline move in unison. 
The Frame counter displays the frame count backward or forward for 
one or both trim sides, and the monitors display the new incoming or 
outgoing frames.

Reviewing the Trim Edit

To review the most recent trim edit, or to play the currently selected 
transition while in Trim mode:

1. To see the Timeline in a closer view while you review the trim, 
click the Focus button. (Click the button again to return to your 
original view of the Timeline.)

n You can also choose an option in Trim Settings to focus the Timeline automat-
ically when you enter Trim mode. For more information, see ÒFocusing the 
TimelineÓ on page 412. 

2. To view the playback in Full-Screen mode, press the Full Screen 
(Single Quote) key on the keyboard.

3. Click the Play Loop button.

Click and drag a transition in the Timeline.
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The system enters a playback loop. This repeatedly begins at a 
preroll point before the transition and ends at a postroll point, 
pausing brießy before beginning playback again. 

4. You set and alter the length of the preroll, postroll, and intermis-
sion intervals by clicking in the appropriate timing Þeld and typ-
ing a new value.

5. Stop the playback loop by clicking the Play Loop button.

6. To leave Trim mode, click the timecode track in the Timeline, or 
click the Source/Record Mode button.

Dual-Image Playback During Trims

Dual-image playback allows you to preview A-side and B-side frames 
in real time while performing a trim. You can play through the transi-
tion by using the J-K-L keys or the Play and Trim buttons.

c Dual-image playback works with single-Þeld resolutions only.   
Only one side rolls when you attempt to use dual-image playback 
with material digitized at AVRs 12, 70, 75, and 77.

To use dual-image playback during trims:

1. Double-click Trim in the Settings scroll list in the Project window 
to open the Trim Settings dialog box.

2. Select the Dual Image Play option and click OK.

3. Enter Trim mode and select a transition for trimming.

4. Press a playback button or key combination.

Preroll timing Postroll timing

Intermission timing
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As the transition plays or loops, notice that both the A-side and B- 
side of the trim play back in the Trim monitors.

5. When you see or hear the point that you want to trim to, press the 
space bar to stop playback and update the transition in the 
sequence.

Trimming On-the-Fly

In both Big and Small Trim mode, you can use the J-K-L keys on the 
keyboard to play through outgoing or incoming material and mark 
trim points. This is similar to the procedure for marking footage on-
the-ßy, as described in ÒMarking and Subcataloging FootageÓ on 
page 350.

For convenience, this method isolates the trim controls to just three 
keys. However, when performing a dual-roller trim, you cannot view 
both sides at once; the monitors play only the A-side during the proce-
dure, updating the B-side once the trim is completed.

To trim on-the-ßy:

1. Select one or more transitions for single- or dual-roller trimming.

2. Use the J-K-L keys to step (jog), play, or shuttle through the foot-
age at varying speeds:

¥ Press and hold the K key while pressing J or L to step slowly 
backward or forward through the footage. When you Þnd the 
frame where you want to relocate the transition, release the K 
key to complete the trim.

¥ Press the J or L keys once to play at normal speed, or more 
than once to shuttle at higher speeds. When you see the frame 
where you want to relocate the transition, press the space bar 
or the K key to complete the trim. 

The monitors and the Timeline are updated to reßect the trim.
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Trimming During a Playback Loop

An alternative method for trimming is to view the transition continu-
ously in a playback loop, and use the keyboard to adjust the transition 
in 1- or 10-frame increments until you achieve the trim you want. You 
can perform this procedure in Big or Small Trim mode, using either 
single-roller or dual-roller trims.

1. Enter Trim mode and select transitions for trimming.

2. Click the Play Loop button to repeatedly play the selected transi-
tions.

n To make adjustments to the playback loop for preroll, postroll, or intermission 
intervals, see ÒReviewing the Trim EditÓ on page 463.

3. Press a keyboard equivalent to perform a Trim function. Also, if 
you are having difÞculty determining which side of the transition 
to trim (for example, during a difÞcult audio edit), use the Go to 
IN and Go to OUT keys to review just one side. 

The system performs the trim before the next playback loop, so 
you can view the trimmed transition during playback, then make 
further changes until you are satisÞed with the adjustment.

4. When you are Þnished, exit the playback loop by pressing the 
space bar or clicking the Play Loop button.

Creating Overlap Edits

You can use an overlap edit to smooth a transition by giving the 
viewer the subtle illusion that the audio, or video, is shared between 
two separate but adjacent shots.

To create an overlap edit:

1. Perform a straight-cut edit between two shots, including audio 
and video tracks: If the timing of the video edit is crucial, mark 

1 frame 10 frames
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edit points according to picture. If the timing of the audio transi-
tion is crucial, edit to audio.

2. Perform a dual-roller trim on either the video track or the audio 
tracks, but not both:

¥ If the video transition occurs at the right place, but you want 
the audio from one shot to linger into the other (or the 
reverse), trim the audio tracks accordingly.

¥ If the audio transition occurs at the right place, but you want 
the picture to transition either before or after the audio cut, 
trim the video track accordingly.

Extending an Edit

Use an extend edit to perform dual-sided (A- and B-side) trims on 
selected tracks from within Source/Record mode. Using an extend 
edit allows you to quickly create a split edit without entering Trim 
mode. It also allows you to establish the exact frame that you want to 
trim to by using the position indicator. (If you enter Trim mode, by 
default the position indicator moves to the nearest transition.)

You can extend edits backward or forward in the Timeline. In either 
case, like a dual-roller trim the extend edit function always maintains 
sync relationships.

To perform an extend edit:

1. Select the tracks you want to extend.

2. Find the point in the sequence to which you want to trim. If the 
trim point is before the edit, mark an IN. If it is after the edit, mark 
an OUT.
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3. Click the Extend button. You can import the Extend button from 
the Command Palette. For information on the Command Palette 
and button mapping, see ÒAbout Button MappingÓ on page 96.

The adjustment appears in the Timeline.

Slipping or Sliding Shots

Slip and slide procedures are two unique Trim mode techniques that 
allow you to make frame-accurate adjustments to a selected clip. 
These occur without affecting the overall duration of the sequence or 
the sync relationships between multiple tracks. Procedures for per-
forming them are described in this section.

Mark IN

Audio tracks are 
selected for extend-
ing back.
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Selecting Segments for Slip or Slide Trimming

There are three ways to select segments for either slip or slide trim-
ming:

¥ While in Source/Record mode, make a selection for slipping. Then 
enter Trim mode by dragging a lasso from right to left around a 
segment (two or more transitions). To select for slide trimming, 
press the Option key while you drag.

You can also select two or more contiguous segments within a 
track for slipping or sliding as a whole by dragging the lasso 
around four or more transitions.

c Be sure to draw the lasso from right to left; if you draw from left to 
right, you enter Segment mode.

¥ While in Trim mode, double-click a segment to select it for slip 
trimming. To select it for slide trimming, press the Option key 
while you click.

You can also select two or more segments on different tracks for 
simultaneous slip or slide trimming. To do so, press the Shift key 
as you repeat this procedure. However, you cannot use the Shift 
key to select additional segments on the same track.

¥ While in Trim mode, press the Shift key and select both the head 
and tail of a clip for slipping. Alternatively, select the outgoing tail 
frame of the preceding shot and the incoming head frame of the 
following shot in the sequence to prepare the clip for sliding.

Drag right to left around at least two 
transitions.

IN OUT
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You can also use this method to select two or more contiguous seg-
ments on the same track, and/or additional segments on other 
tracks for slipping or sliding as a group.

n You must select all multiple selections for either slipping or sliding. You can-
not perform both functions simultaneously.

You can slip and/or slide the video and audio for a shot together.   
Alternatively, slip and/or slide a single segment of video or audio 
independently from the rest of the shot. You can also slip shots in 
Source/Record mode by using the Slip Left and Slip Right buttons.

The Slip/Slide Display

Once you select the clips for slipping or sliding, the Trim mode inter-
face changes to a four-frame display. For more information on four-
frame display, see ÒAbout Four-Frame DisplayÓ on page 420.

Outgoing and 
Incoming 
video (or A- 
and B-side)

Tail and head 
frames of the 
selected clip
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The type of trim you perform (slip or slide) determines which frames 
are updated, as follows:

¥ In slip trimming, the two inner monitors for the head and tail 
frames of the clip change, because only the contents of the clip are 
adjusted. The frames that precede and follow the clip are not 
affected.

¥ In slide trimming, the two outer monitors for the outgoing (A-
side) and incoming (B-side) frames change, because the clip 
remains Þxed while the footage before and after it is trimmed.

Performing the Slip or Slide Trim

To slip or slide a shot:

1. After selecting the segments, as described in ÒSelecting Segments 
for Slip or Slide TrimmingÓ on page 469, do one of the following:

¥ Click any roller in the Timeline, drag the selected material to 
the left or right, and release.

¥ Use the numeric keypad to enter speciÞc frame-count or time-
code values, and press Enter.

¥ Use the trim keys or buttons to shift the selection by 1- or 10-
frame increments.

2. Monitor the progress of the trim by using the monitors, the frame 
counters, and the Timeline. 

When you reach the end of available material while slipping a 
shot, the trim stops. Similarly, when you reach the next transition 
while sliding a shot along a track, the trim stops. A bright white 
line at the transition indicates the limit. After completing the ini-
tial slide, you can perform another slide in the same direction.

3. When you are Þnished, exit slip or slide mode either by clicking 
another transition for trimming, or by clicking either the Source/
Record Mode or Effect Mode button to exit Trim mode.
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Slipping Shots in Source/Record Mode

You can use this alternative procedure to slip a shot in Source/Record 
mode by using the Slip Left and Slip Right buttons, as follows:

1. In Source/Record mode, select the tracks for the clips to be 
slipped.

2. Place the position indicator within the shot that you want to slip.

3. Slip the shot by doing one of the following:

¥ Click the Slip Left button to slip the shot one frame left 
(revealing later material from the source clip). 

¥ Click the Slip Right button to slip one frame right (revealing 
earlier material from the source clip).

¥ Hold the Option key while you click the Slip Left or Right but-
ton to trim 10 frames at a time.

n The Slip Left and Slip Right buttons do not appear on the interface or key-
board by default. You must map them from the Command Palette Trim tab to 
use this procedure.

Performing a Slide Trim

To perform a slide trim:

1. While in Big Trim mode, press the Option key and double-click a 
shot or a segment of video or audio to select the frames that pre-
cede and follow the shot or segment.

Or hold the Option key, then press the mouse button and drag a 
lasso around the material you want to slip. 

2. In the Timeline, press one of the selected heads or tails, then drag 
the shot to the left or right.

If you slide the shot to the right, the edit before the shot is 
extended to the new IN point for the shot. The edit after the shot is 
trimmed forward to the new OUT point for the shot.
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If you slide the shot to the left, the edit before the shot is trimmed 
back to the new IN point for the shot. The edit after the shot is 
extended back to the new OUT point for the shot.

Maintaining Sync While Trimming

For more information 
about sync relation-
ships, as well as addi-
tional procedures for 
managing sync, see 
Chapter 17.

Trim mode has two features that you can use to ensure that you do not 
break sync unintentionally between two or more video and/or audio 
tracks when performing single-roller trims.

¥ You can add black to the track while trimming.

¥ You can sync-lock tracks that maintain a synchronized relation-
ship.

Adding Black When Trimming

If you are trimming a 
video track and need to 
Þll the black, you can 
perform a replace edit 
to add another piece of 
footage. For more infor-
mation, see ÒPerform-
ing a Replace EditÓ on 
page 385.

Because single-roller (A-side or B-side) trims shorten or lengthen the 
duration of the track being trimmed, any relationships that exist with 
other tracks downstream of the trim will be thrown out of sync. You 
can use the Control key while trimming to add black on either the A- 
side or the B-side to maintain the overall duration of the track and the 
sync relationships.

To add black while trimming, press and hold the Control key while 
performing any of the A-side or B-side trim procedures. The system 
adds a black segment to Þll the duration of trimmed frames.
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n You can only add black while performing single-roller trims, because dual-
roller trims do not cause sync breaks.

Trimming with Sync-Locked Tracks

n Sync-locked tracks aid only single-roller trim functions in Trim mode because 
dual-roller trims do not cause sync breaks.

Trim with sync-locked tracks as follows:

1. Sync-lock the tracks as follows:

¥ Click in the center column next to the tracks you want to keep 
in sync. The sync-lock icon appears.

¥ Click in the narrow column to the left of the TC1 button to tog-
gle sync-lock on and off for all tracks.

2. Perform single-roller trims as necessary, with the following 
results:

Trimming without 
adding black

Adding black while 
trimming

(Control key + trim)

No black is added and sync 
breaks appear in the Timeline.

Black fills the trim duration, and 
sync is maintained.

Sync-lock icon
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¥ When you trim the A-side of a transition forward, all other 
segments locked in sync move forward with the trim. If the 
transitions are staggered, this might split one or more of the 
segments at the sync point established by the position indica-
tor, leaving Þll.

If you trim the B-side of the transition in the same direction, 
the additional sync-locked segments slide back in the 
sequence to maintain sync until they encounter another seg-
ment in the same track. At this point, you can trim no further 
and the system emits a warning sound.

¥ When you trim back the A-side of a transition, additional seg-
ments locked in sync move back as well. If the segments are 
staggered and one of the additional sync-locked segments 
encounters another segment on the same track, you can trim 
no further and the system emits a warning sound.

Before trimming forward, 

After trimming forward,
sync is maintained from 

three tracks are sync-locked.

position indicator forward.
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If you trim the B-side of the transition in the same direction, all 
other segments locked in sync move forward to stay in sync. If 
the transitions are staggered, this action might split one or 
more of the sync-locked segments at the sync point estab-
lished by the position indicator. Fill is added where the split 
occurs.

n Slip and slide trims are not protected for sync. Be sure to select all synced 
tracks for simultaneous slipping or sliding to avoid sync breaks.

Using the Transition Corner Display

The Transition Corner Display is a Trim Mode interface that shows six 
important frames you use as reference points when trimming a transi-
tion effect:

Trim is stopped here

Before the trim, 
three tracks are 
sync-locked.

After the trim, sync 
is maintained, but 
the trim stops at 
earlier segment.
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Use the Transition Corner Display to trim the transition effectÕs start 
frames, end frames, and duration. As you trim the transition effect, 
you will be able to see the corresponding frame adjustments in all six 
monitors simultaneously. 

Frames on which the 
transition effect starts

Frames on which the 
transition effect ends

The two frames between 
which a cut point defines 
the transition

Transition Corner 
Display button
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c The Transition Corner Display is only applicable to the trimming of 
transition effects (for example, dissolves, wipes, picture-in-picture, 
and so on). It is not designed for trimming key, image, or segment 
effects. 

To trim a transition by using the Transition Corner display:

1. Select a transition effect for trimming:

¥ Lasso the effect in the Timeline from right to left. 

¥ Enter Trim mode and click on the transition in the Timeline.

¥ Use the Go to Transition buttons to enter Trim mode and step 
through transitions until you highlight the desired transition. 

2. Click the Transition Corner Display button.

The button turns bright green, and the display is enabled.

3. Trim the transition effect by clicking the outgoing or incoming 
frame you want to trim, then use one of the following three trim 
methods:

¥ Position your mouse on the rollers and drag the transition 
backward or forward. (Hold the Option key to roll forward or 
backward slowly one frame at a time.)

¥ Click the appropriate trim button to trim backward 10 frames; 
trim backward 1 frame, trim forward 1 frame, or trim forward 
10 frames.

¥ Enter the number of frames you want to move forward on the 
numeric keypad, then press Enter. Or, type a minus sign (Ð) 
and enter the number of frames you want to move backward, 
then press Enter.

4. To review your edit, click the Play Loop button.
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CHAPTER 16

Working with Audio

You edit audio by using many of the same techniques and tools you 
use to edit video, including Source/Record mode, Segment mode, and 
Trim mode functions. Your Avid Composer system also provides sev-
eral unique features that facilitate audio editing, such as audio scrub, 
waveform displays, and tools for adjusting and mixing audio levels 
and pan between speakers. In addition, you can adjust the high, low, 
and midrange frequency ranges of segments by using the Audio 
Equalization (EQ) Tool. These procedures are described in the follow-
ing sections:

¥ About Audio Tools

¥ Accessing Audio Effect Tools

¥ Audio Editing Aids

¥ Using the Audio Mix Tool

¥ Using Audio Gain Automation

¥ Using the Audio EQ Tool

¥ Using Digidesign AudioSuite Plug-Ins

¥ Using Audio Punch-In

¥ Fine-Tuning Audio Transitions

¥ Mixing Down Audio Tracks
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About Audio Tools

The Avid Composer system provides a collection of tools for manag-
ing and Þne-tuning audio volume, pan, equalization, and transitions. 
The general purpose of each tool is as follows:

¥ Use the Audio Tool primarily for adjusting and calibrating global 
input and output levels when digitizing from analog sources or 
outputting to tape. For more information, see ÒPreparing for 
Audio Input and OutputÓ on page 157 and ÒPreparing for Out-
putÓ on page 601.

¥ Use the Audio Mix Tool primarily for adjusting pan and volume 
levels on clips or whole tracks within a sequence. For more infor-
mation, see ÒUsing the Audio Mix ToolÓ on page 490.

¥ Use the Audio Gain Automation feature in the Timeline for Þner 
control over volume key frames and ramps within a sequence. For 
more information, see ÒUsing Audio Gain AutomationÓ on 
page 500.

¥ Use the Audio EQ Tool for adjusting the sound characteristics of 
audio clips in the sequence based on three-band control over high, 
low, and midrange frequencies. For more information, see ÒUsing 
the Audio EQ ToolÓ on page 518.

¥ Use the Digidesign AudioSuite plug-ins to access third-party 
audio plug-ins. For more information, see ÒUsing Digidesign 
AudioSuite Plug-InsÓ on page 534.

¥ Use the Audio Punch In Tool to record up to two channels of audio 
directly into the Timeline for voice-over narration. For more infor-
mation, see ÒUsing Audio Punch-InÓ on page 543.

Accessing Audio Effect Tools

You can now access the following tools from the same window:

¥ Audio Mix (for adjusting pan and volume)
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¥ Audio EQ

¥ Audio Gain Automation

¥ Digidesign AudioSuite Plug-Ins

To access one of the audio effect tools:

1. Choose one of the tools from the Tools menu.

2. To switch to another tool, choose the name from the Tool Name 
menu.

To keep more than one tool open at the same time, choose the tool 
from the Tools menu or hold the Option key while choosing a new 
tool from the Tool Name menu. To prevent confusion, the Avid 
Composer system allows only one copy of a given audio effect tool 
to be open at any given time.

The following section describes two features that help you locate tran-
sitions and monitor audio samples while editing or adjusting sound 
with the tools.

Audio Editing Aids

The Avid Composer system provides audio scrub features and wave-
form plots speciÞcally designed for frame-accurate cueing, marking, 

Tool Name menu
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and editing of audio. You can use these features any time during edit-
ing or while making adjustments with the audio tools.

Using Audio Scrub

The term audio scrub originates in the Þlm industry. It describes the 
process of ÒscrubbingÓ a magnetic audiotape across the playback 
heads to monitor a portion of sound. This process helps isolate por-
tions of audio to accurately mark edit points, or to analyze transitions 
for careful trimming.

Smooth Scrub Versus Digital Scrub

You have two options for scrubbing audio in either the sequence or the 
source material:

¥ Smooth audio scrub mimics the variable pitch playback of tradi-
tional analog tape.

¥ Digital audio scrub takes advantage of the digital environment by 
sampling incoming and/or outgoing frames at normal pitch and 
playback rate.

Each type of scrub has its advantages: 

¥ Smooth scrub makes it easier to examine sound at varying speeds.

¥ Digital scrub allows you to focus quickly on individual bits of 
incoming or outgoing audio for frame-accurate edits and adjust-
ments.

Try both and see which works best in different situations.

Selecting Tracks for Scrubbing

By default, the system selects the topmost audio track unless you 
make a selection. Always check the position of the hollow speaker icon 
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and select the correct track, if necessary, to avoid marking or trimming 
the wrong track.

To select a track for scrubbing, hold down the Option key and click the 
speaker icon in the track panel beside the Timeline. 

The speaker icon becomes hollow to indicate that it is selected for 
scrubbing.

Using Smooth Audio Scrub

You perform the smooth audio scrub procedure by using either the J-
K-L keys or the mouse, as described in this section.

Using the J-K-L Keys to Perform Smooth Scrub

You can use three-button play with the J-K-L keys to perform smooth 
audio scrubbing of selected tracks of audio at variable speeds. You 
cannot activate digital audio scrub with three-button play. You can 
monitor while stepping (jogging) 1 frame at a time, 10 frames at a time, 
or while shuttling at Þxed rates up to 8 times normal speed.

To monitor audio with three-button play:

1. Select the correct track and adjust playback volume as necessary. 

2. Play the audio, using the three-button variable speed playback 
procedures described in ÒJ-K-L Keys (Three-Button Play)Ó on 
page 346.

Hollow speaker indicates a track 
selected for scrubbing.
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Using the Mouse to Perform Smooth Scrub

You can use the mouse to perform smooth audio scrubbing of selected 
tracks. (You cannot activate digital scrub by using the mouse.) Like the 
J-K-L keys, you can step and shuttle with the mouse. Unlike 
three-button play, however, playback rates with the mouse are not at 
Þxed increments. They can vary all the way from 1 to 300 fps (NTSC), 
depending on manipulation of the mouse.

To monitor audio with the mouse:

1. Select the correct track and adjust playback volume as necessary.

2. Activate the mouse for stepping or shuttling by pressing the 
Mouse Jog button or the Mouse Shuttle button. Mouse Jog allows 
you to move the position indicator with the mouse. Mouse Shuttle 
allows you to control the speed of the position indicator by drag-
ging the mouse at different speeds.

To deactivate shuttle, press the space bar or the Escape key.

3. Play the footage with the mouse, as described in ÒUsing the 
MouseÓ on page 348.

n When you use the MUI, smooth audio shuttling is invoked by default.

Using Digital Audio Scrub

Digital audio scrub enables you to sample selected frames of incoming 
or outgoing audio as you move through the footage, without a change 
in pitch or speed. The following are unique characteristics of digital 
scrub:

¥ The frames of audio you hear are always at your point of destina-
tion. For example, if you step forward 10 frames, you hear a 
selected number of audio frames from a point behind the position 
indicator (outgoing frames) to a point in front of the position indi-
cator (incoming frames) as it reaches the new destination point. 
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¥ The audio is always sampled in a forward playback direction; 
whether you step back or forward through the material, you hear 
the same audio sampling at each destination frame.

Adjusting Digital Scrub Parameters

The default parameters for the number of frames you hear as you 
scrub are zero frames of outgoing audio (behind the position indica-
tor), and one frame of incoming audio (ahead of the position indica-
tor). For the common purpose of isolating frames for marking or 
trimming, the default parameters are sufÞcient.

You can increase these settings to include more frames of audio on 
either side Ñ for example, when you want to sample whole words or 
parts of words as you scrub to Þnd edit points within a phrase. Or you 
can reverse the settings to sample frames behind the position indicator 
(outgoing frames) as you scrub. In general, you should avoid increas-
ing the number of sampled frames on both sides at once because this 
can make it difÞcult to isolate an edit point or trim point based on the 
location of the position indicator.

To adjust the parameters for digital scrub:

1. Open the Audio Settings dialog box, using one of the following 
procedures:

¥ Double-click Audio in the Settings scroll list of the Project win-
dow.

Digital Scrub Example

Selected
track

Outgoing frames Incoming frames
(behind position indicator) (ahead of position indicator)

This entire section is sampled.

Step 10 frames
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For more information 
on displaying digital 
scrub parameters, see 
the Avid Media Composer 
Products Reference.

¥ If you have digital scrub parameters displayed in the second 
row of information above the Composer window monitors, 
you can Option-click the digital scrub parameters or open 
Audio Settings in the Project window.

The Audio Settings dialog box appears.

2. Click in an entry Þeld and type a new number of outgoing or 
incoming frames on the source side, the record side, or both.

3. Press Return. The new parameters are now in effect.

Performing the Digital Scrub Procedure

To locate an audio edit point in either source-side or record-side audio 
by using digital scrub: 

Source-side digital 
scrub parameters

Record-side digital 
scrub parameters
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1. Select an audio track for scrubbing, and adjust the output volume, 
if necessary.

2. Press the Caps Lock key to activate digital audio scrub.

3. Move through the material in one of the following two ways to 
hear the scrub:

¥ Drag the position indicator.

¥ Click the step buttons to step through in Þxed increments: 
1 frame backward, 1 frame forward, 10 frames backward, 
10 frames forward.

When youÕve found the right frame, mark the location, trim the transi-
tion, or perform any other function you choose.

If you are sampling incoming frames (with the default scrub parame-
ters, for example), you see the position indicator is located at the head 
of the last sampled audio point. If you are sampling outgoing frames, 
you see the position indicator is located at the tail of the last sampled 
audio point.

Using Waveform Plots

You can use waveform plots to help you visually locate points in an 
audio track for editing or trimming. There are two types of waveform 
plots, Energy or Sample, that you choose from the Timeline Fast menu. 



488

Displaying Audio Waveforms

To display audio waveforms:

1. If you are searching for a point in a known section of the tracks, 
zoom in and/or show more detail in the sequence to isolate a sec-
tion of the audio. With less audio to display, the system draws the 
waveform plot faster.

2. Choose Audio Data from the Timeline Fast menu. A submenu 
appears containing two waveform plot options.

Choice of plot type is a matter of visual preference:

¥ The Energy Plot option displays only the peaks of the audio 
amplitude in the waveform from the baseline. It is a graphical 
representation of the mathematical Energy Function for audio 
waveforms.

¥ The Sample Plot option displays the entire amplitude of the 
audio waveform. This is the same as the sample voltage val-
ues you would see on an analog oscilloscope waveform.

After you make a choice, the waveform appears in the selected 
tracks.

3. To maximize the visibility of your waveform display, use the fol-
lowing optional procedures:

Waveform 
energy plot

Waveform 
sample plot
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¥ Continue to expand or shrink your view of the Timeline (by 
using the scale bar), effectively spreading out the waveform 
plots to show detailed variations in the audio levels.

¥ Enlarge or reduce the height of selected audio tracks, and sub-
sequently the waveform displays, by pressing kÐL to enlarge 
or kÐK to reduce.

¥ You can also increase or reduce the size of the Sample plot 
image itself (this does not work with Energy plots), without 
enlarging its track, by pressing kÐOptionÐL to enlarge, or kÐ
OptionÐK to reduce.

Audio waveform plots 
can slow your naviga-
tion through the Time-
line. You might want to 
use these selectively. To 
facilitate this, you can 
create a custom Time-
line view, as described 
in ÒCustomizing Time-
line ViewsÓ on 
page 399.

4. Move through the audio shown in the waveform by using any of 
the playback methods. You hear sound as you track the audio 
visually. When you have the position indicator parked at the 
desired point in the waveform, you can mark, trim, or perform 
any other function.

Once youÕve created a customized waveform view, you can simply 
select it from the Timeline View pop-up menu when needed, and 
return to another view when done.

Muting the Audio

The Mute button, which is located in the Command Palette, allows 
you to quickly turn all sound tracks on and off during editing. This is 
especially convenient when Þne-tuning complex audio and video 
edits, making it possible to shift quickly between the two. You can set 
your audio levels and speaker volumes and mute them whenever nec-
essary without changing the settings.

Click the Mute button to mute all audio tracks. Click it again to turn 
them on.
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Using the Audio Mix Tool

For additional informa-
tion on audio levels for 
digital cut output, see 
ÒPreparing for OutputÓ 
on page 601.

The default volume for master clips is set to zero (that is, with no 
attenuation) when you Þrst digitize the media. Pan is based upon the 
tracks recorded in the Þeld, and is subsequently digitized into the sys-
tem. 

n The pan option in the Audio Settings dialog box determines how the system 
plays back the default pan. For more information, see the Avid 
Media Composer Products Reference.

The Audio Mix Tool allows you to:

¥ Adjust pan and volume for an individual clip, a whole track, sev-
eral tracks at once, or a whole sequence. 

¥ Adjust the volume and/or pan for one track at a time.

¥ Adjust volume and/or pan for multiple tracks simultaneously by 
ganging them together.

The system uses these adjustments for all playback, including output 
to a digital cut.

n You can also adjust volume levels in the Timeline by using Audio Gain Auto-
mation. For information, see ÒUsing Audio Gain AutomationÓ on 
page 500.

Open the Audio Mix Tool by choosing Audio Mix from the Tools 
menu.
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Resizing the Audio Mix Tool

You can simplify the Audio Mix Tool display by clicking the Display/
Hide Sliders button to toggle between hiding and displaying the vol-
ume sliders.

Audio Effect Mode 
Selector pop-up 
menu Fast menu Play Loop button

Display/
Hide Sliders 
Button
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With the window collapsed, you can continue to adjust levels by 
selecting a track and typing values by using the numeric keypad on 
the keyboard, or by typing a value into the volume level display.

Adjusting One Audio Track at a Time

To adjust one audio track at a time in the Audio Mix Tool:

1. Load a clip or sequence, and activate the appropriate monitor:

¥ To adjust a track in a source clip, make sure the Source moni-
tor is active. 

¥ To adjust a track in a sequence, make sure the Record monitor 
is active.

2. Select the track or portion of a track to be adjusted:

¥ To adjust the track in a single edited shot in a sequence, place 
the position indicator in the shot.

¥ To adjust an isolated section of audio on a track, mark IN and 
OUT points. Adjusting a clip with mark IN and mark OUT 
adjusts the entire clip.

¥ To adjust levels from an IN point through the end of the track, 
mark an IN point only. One mark also adjusts the entire track 
from the beginning of the clip that includes the mark.

¥ To adjust levels globally throughout the track, make no marks.

Volume Level display
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3. Choose Audio Mix from the Tools menu to open the Audio Mix 
Tool.

If you have Þve audio 
tracks or more, and 
need to adjust all of 
them, consider mixing 
down to four tracks, as 
described in ÒMixing 
Down Audio TracksÓ 
on page 553.

The Audio Mix Tool contains four to eight panels (depending 
upon your system model), one for each audio track you can moni-
tor and adjust. The Audio Mix window can only display tracks 
that exist in the sequence, or tracks that were digitized with the 
source clip.

4. Choose the type of audio output from the Output Options pop-up 
menu:

¥ Choose Stereo Mix to make adjustments for output to left and 
right speakers.

¥ Choose Mono to make adjustments with all levels panned to 
center between speakers.

Gang buttons

Track selection 
pop-up menu

Output Options pop-up
menu

Audio Effect
Mode Selector
pop-up menu
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¥ Choose Direct Out when performing a digital cut for output of 
up to eight source tracks to a maximum of four output chan-
nels. For more information, see ÒAdjusting Output on Four-
Channel or Eight-Channel Audio Board SystemsÓ on 
page 610.

5. Select the audio track to be adjusted by choosing the track from 
the Track Selection pop-up menu in a panel.

6. Choose the type of mix you want when applying stereo mix out-
put from the Mix Tracks pop-up menu:

¥ Mix To 1 & 2 sends the stereo mix to output channel one and 
the left speaker, and output channel two and the right speaker.

¥ Mix To 3 & 4 send the stereo mix to output channel three and 
the left speaker, and output channel four and the right 
speaker.

7. With the Audio Mix window active, use any playback method 
(such as the J-K-L keys on the keyboard) to play, shuttle, or step 
through the audio to check for necessary volume or pan adjust-
ments.

The keyboard can control either the Source or Record monitor, 
depending on which monitor was active when you opened the 
Audio Mix Tool. Switch your selection by clicking the appropriate 
monitor.

8. Decide whether to raise or lower the volume, or pan left or right. 
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To change a value in the panel, use any of the following methods:

¥ Click a number along the vertical edge of the Audio Level 
slider.

¥ Click the slider and type a value.

¥ Values are cumulative until you press Return. For example, if 
you want to enter the value 12, simply type it. However, if you 
enter 1 and then want to change the value to 2, press Return 
before typing the 2.

¥ Click the slider and then drag it.

¥ Click the Volume level display box and type a value.

¥ Set a value of zero decibels by clicking the slider and entering 
0, or by clicking 0 along the vertical edge of the volume slider.

¥ Adjust pan by clicking the Pan Value display to reveal the 
pop-up slider, then drag the slider to a new position.

If the sequence is playing, notice that play stops when you make 
an adjustment (the Audio Mix window does not provide real-time 
audio control).

9. Apply the adjustments to a chosen region of the track by using the 
Audio Mix Fast menu located at the upper right of the tool.

Audio Level slider

Click gang buttons to select a track or 
to gang multiple tracks.

Pan Value display

Volume level display

Pop-up slider for pan
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Options in the Fast menu are dimmed until you select a track by 
clicking the gang button. The options vary depending upon the 
types of marks you set within the clip or sequence, as follows:

n The Clip Gain values set by the Audio Mix Tool is the value for the entire seg-
ment that was set; for example, you cannot set a subsection of a segment with-
out affecting the entire segment.

¥ With IN and OUT marks: Commands apply adjustments to 
selected tracks between the marks.

¥ With an IN mark (no OUT mark): Commands apply adjust-
ments to full clips from the IN point to the end of selected 
tracks.

¥ With no marks: Commands apply globally (across entire 
tracks).

Fast menu

Mix Tracks pop-up menu
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To apply the adjustments, do one of the following:

¥ The Set commands (Set Pan, Set Level) apply the same pan or 
volume levels currently set in the Audio Mix Tool to all seg-
ments in the marked region of the tracks.

¥ The Adjust Pan/Vols command opens a dialog box for adding 
incremental adjustments to all current settings across seg-
ments in the marked region of selected tracks.

For example, when you enter Ð1 into the Gain Adjustment 
Þeld, the various audio level settings across all segments of 
the marked region of selected tracks will be lowered by 
exactly one decibel when you click OK.

¥ The Remove Pan/Vols command deletes all audio mix adjust-
ments that have been applied to segments in the marked 
region of selected tracks. Each audio clip is restored to its pre-
vious pan and volume settings.

10. Play through the audio again, using the J-K-L keys. Repeat steps 8 
through 10 until you are satisÞed with the pan and volume levels.

The system uses the new settings whenever you play back or 
record the sequence.
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Ganging and Adjusting Multiple Tracks

You can gang multiple tracks in the Audio Mix Tool in order to main-
tain the same relative settings between tracks when you make adjust-
ments. This is useful in a variety of circumstances. For example, you 
can gang tracks to raise the overall volume of a portion of a sequence 
while maintaining variations in level adjustment among tracks.

To gang and adjust multiple tracks:

1. Click the Gang button in the Þrst track panel.

2. Click the Gang button of any additional panels. Click the button a 
second time to deselect it. 

3. Adjust either volume or pan for one of the tracks by using any of 
the techniques described in the previous section, and the other 
tracks will maintain the same relative levels.

When you gang two or more panels, you gang both the volume and 
pan sliders. 

To set all ganged sliders to the same value:

¥ For volume, click the number along the vertical edge of the vol-
ume slider or enter a value into one of the Volume Level displays.

¥ For pan, click the pan value display box and enter a value.

Ignoring Existing Volume and Pan Settings

You can have the system ignore the volume settings established with 
the Audio Mix Tool when playing back or recording a sequence. You 
can also deactivate the pan settings by choosing Mono or Direct Out 
from the Output Options pop-up menu.

To turn off current volume adjustments, click the Ignore Volume check 
box located next to the Output Options pop-up menu at the top of the 
Audio Mix Tool.
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The volume controls disappear. Deselect the option to restore the cur-
rent settings.

To turn off pan adjustments, choose one of the following from the Out-
put Options menu:

¥ Direct Out plays back the tracks with their default pan settings.

¥ Mono pans all tracks to center during output.

When you choose one of these options, the pan controls disappear in 
the Audio Mix Tool. Choose Stereo Mix to restore the current settings.

Adjusting Volume While Playing an Audio Effect

You can use the Play Loop button to create or change the volume on an 
Audio Mix effect while you play the clip.

To adjust volume while playing an effect:

1. Choose an existing Audio Mix effect or identify an area of the clip 
with IN and OUT marks.

2. Click the Play Loop button. The Avid Composer system repeat-
edly loops through the audio effect.

3. Adjust the volume as necessary.

4. Click the Play Loop button to stop. The Avid Composer system 
automatically saves your changes as part of an Audio Mix effect.

Play Loop button
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Limitations

If there is not an existing Audio Mix effect on the clip before you start, 
you will not hear any changes until you click the Play Loop button to 
stop and replay the effect.

As you adjust the volume values on an existing Audio Mix effect, you 
might not hear the results immediately. It takes a few moments for the 
Avid Composer system to apply the changes to the clip. The response 
time for this feature is considerably longer than for adding EQ effects 
while using Play Loop. You might need to click Play Loop to complete 
the edit and then play the effect to hear the result. 

To improve the response time, you can do the following:

¥ Monitor as few audio tracks as possible. 

¥ Deselect the video track if practical.

¥ Use IN and OUT marks to choose a narrow interval to adjust.

n For additional ways to change the volume while playing an audio effect, see 
ÒRecording Audio Gain InformationÓ on page 507.

Using Audio Gain Automation

Audio Gain Automation (also known as audio volume rubber-band-
ing) allows you to change the volume of a segment by adding and 
manipulating gain key frames in the Timeline. The following illustra-
tion shows an expanded audio track containing gain key frame infor-
mation.
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The Avid Composer system uses a linear ramp to change the volume 
from one gain key frame to the next. The above illustration shows four 
ramps.

System Clip Gain

When you add a key frame, the Avid Composer system adds the point 
at the level currently set for that track in the Audio Mix Tool.

Gain values in decibels Graphic representation of key frames and gain 
ramps in the Timeline
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Values set by the volume sliders in the Audio Mix window are referred 
to as system clip gain values. Audio gain key frames are not additive 
to the system clip gain values. When you move a gain key frame up or 
down, it cancels the system clip gain for that point in the sequence. 
Use of Automation Gain disables gain sliders in the Audio Mix Tool. 
For more information, see ÒUsing Audio Gain Automation and the 
Audio Mix WindowÓ on page 516.

If you move the volume slider for a clip in the Audio Mix window, all 
the key frames for that clip move relative to the new value. 

Real-Time Response of Audio Gain Automation

In real time, the Avid Composer system reads the gain value every 
2000 audio samples and linearly ramps between readings. For exam-
ple, at 44.1 kHz (44,1000 samples per second), the Avid Composer sys-
tem checks the gain value every 0.0416 second. This works well when 
you use gradual ramps.

Current
volume 
settings
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Using Audio Gain Automation

To use Audio Gain Automation:

1. Select an audio track for adjusting volume.

2. Choose Volume from the Audio Data submenu of the Timeline 
Fast menu.

n You can enable both Volume and Energy Plot or Sample Plot in the Audio 
Data submenu of the Timeline Fast menu to display audio gain meters and 
key frame information superimposed over waveform plots in the Timeline.

A straight line appears in the selected audio track. The line shows 
the current gain level for that track in the Audio Mix Tool.

3. (Option) Expand the audio track by pressing kÐL, or pressing the 
Option key and dragging in the Track Selector panel.

The following illustration shows the expanded audio track. 
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4. Click the Add Key Frame button in the FX section of the Com-
mand Palette to add key frames along the Timeline. The Avid 
Composer system adds a key frame to each enabled track.

n You adjust gain in the Automation Gain window by dragging key frames in 
the Timeline or by placing the position indicator on a key frame and adjusting 
the slider.

By default the Add Key 
Frame button is 
mapped to the double 
quote key (Ò). You can 
map the button to 
another key or to exist-
ing button locations in 
the Source/Record 
monitor.

After you add one key frame to a segment, you can adjust the gain for 
the entire clip.When you move the point up or down, the correspond-
ing volume slider in the Automation Gain window moves also.

Deleting Audio Gain Key Frames

To delete key frames, do one of the following:

¥ To delete a single key frame, move the cursor over the point. 
When the cursor turns into the pointing hand, press the Delete 
key. If there are identical key frames in other active tracks, the sys-
tem deletes them also. (Do not press the mouse button.)

¥ To delete groups of key frames, mark an IN to OUT or mark the 
entire segment, then delete any key in the marked area.

Initially gain is set to the clip gain setting in the Audio Mix Tool
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Moving Audio Gain Key Frames on the Timeline

To move key frames, do one of the following:

¥ Click a key frame and drag it up or down to increase or decrease 
the gain at that point. If there is a point at the same position on 
another enabled track, it moves also.

n To snap to the decibel lines, hold the Command key (k) while you drag the 
point.

¥ Move a key frame horizontally to move the start or end of a ramp. 
Option-click the point and drag it. You cannot move one key 
frame on top of another.

¥ Move several key frames on a track at the same time by placing IN 
and OUT marks to select the area you want. When you move one 
key frame within the marked area, all key frames within the 
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marked area move in relation to each other. This works for all 
enabled audio tracks.

This is similar to ganging sliders on an audio mixing board or in the 
Audio Mix Tool.

This example shows how to move key frames within IN to OUT marks 
on two tracks.

Notice that the key frames outside the IN to OUT marks do not move.
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Recording Audio Gain Information

You can instruct the Avid Composer system to record your actions 
while playing the clip as you move sliders to adjust the volume. The 
system creates the corresponding key frames and saves them as part of 
a pan volume audio effect. After you Þnish the recording, you can 
move, add, and delete key frames to achieve the results you want. 

The following illustration shows the Automation Gain window.

You can record audio gain information by using the Automation Gain 
window directly. You can also use an optional external fader box. For 

Record button

Cancel button

Recording status light Hardware Toggle button

Track Solo
button

External fader box 
position indicators

Automation Gain
Fast menu

Gang button
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information on connecting a fader to your Avid Composer system, see 
ÒConnecting a Fader to Your Avid Composer SystemÓ on page 514.

Some portions of the Automation Gain window are identical to the 
Audio Mix and Audio Punch In Tools. For example, the following 
record features are identical to the Audio Punch In Tool:

¥ The Record button starts and stops the recording. 

¥ The Cancel button stops a recording without saving the recorded 
data.

¥ The Recording status light is black when there is no activity, green 
during a preroll, red during recording, and blue during a postroll.

¥ The PreRoll text box allows you to provide a visual cue before the 
recording begins. The Avid Composer system backs up the blue 
position indicator for the prescribed number of seconds. During 
the preroll, the Recording status light is green.

¥ The PostRoll text box gives the same kind of visual cue at the end 
of the recording. During the postroll, the Recording status light is 
blue.

The remainder of the features described in this section are speciÞc to 
the Automation Gain window.

The Hardware Toggle button switches control between the external 
fader sliders and the sliders on the Automation Gain window.

Button Color To Enter the Mode Description

Gray (default) Click the button. The sliders in the Automation Gain 
window control volume when the 
position indicator is placed on a key 
frame. The system ignores the exter-
nal fader.
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When the HW button is blue, the external fader controls the volume 
sliders in the tool window. When you move the external fader sliders, 
the software sliders move also. This has the following beneÞts:

¥ You can view the decibel values as you move the slider for each 
track. (The FaderMaster does not have numbers along its sliders.)

¥ It is a good test of whether the fader is working correctly. 

The Track Solo button (speaker icon) lets you mute and solo individual 
audio tracks during audio gain automation recording.

Pink Click the button. The fader sliders control volume. 
The sliders in the Automation Gain 
window do not allow user input.

Blue Option-click the 
button.

The Automation Gain window 
slider positions reßect the hard-
ware. This is for display purposes 
only. You cannot control volume in 
this mode.

Button Color To Enter the Mode Description

Button Color Description

Gray The audio track is muted.

Yellow The track is soloed. You can solo more than one track at a 
time.

Green (default) The audio track is on.
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Click or press the number keys 1 to 8 to toggle between solo and on. 
The number keys (at the top of the keyboard) let you quickly select a 
track.

To toggle between on and mute, use Option-click or Option-number 
key.

When you turn off solo, the button returns to its previous state (mute 
or on). To change the previous state of a button, Option-click the but-
ton. 

c While the Automation Gain window is active, the Avid Composer 
system overrides any other mappings of the number keys 1 to 8 at 
the top of the keyboard. Number keys on the right side of the key-
board are not affected.

The position indicator lights provide information about the current 
location of the sliders on the external fader.

The position indicator lights are useful because it is important to posi-
tion the fader sliders close to the track volume before you start record-

Position 
indicator 
lights

Colors Description

Both lights blue The fader slider matches the current Timeline vol-
ume. 

Only top light blue The slider is higher than the Timeline volume.

Only bottom light blue The slider is lower than the Timeline volume.

Both lights gray Either there is no fader attached to the system or the 
Avid Composer system does not recognize the fader. 
If the system does not recognize the fader, check the 
connection and restart the system as described in 
ÒConnecting a Fader to Your Avid Composer Sys-
temÓ on page 514.
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ing. Otherwise you might create an unwanted jump in the volume 
when you move the sliders during a recording. 

Note that the Avid Composer system does not record values from a 
fader slider until you move the slider. Then it reads the current posi-
tion of the slider and adjusts the volume accordingly.

Also note that in many cases it is not possible to exactly match the 
Timeline value.

Automation Gain Fast Menu

To make the Automation Gain Fast menu active for a given track, click 
the Gang button for that track.

The following illustration shows the Fast menu when an In/Out area 
is marked. When no area is marked, the words In/Out are replaced by 
the words Global. This allows you to perform the operation on the 
entire clip rather than just the marked region.

The Automation Gain Fast menu is similar to the Audio Mix Fast 
menu with the addition of the following items:

¥ Filter Automation Gain In/Out removes approximately 50 percent of 
the key frames in the marked region. If you hold down the Option 
key while selecting the menu item, the system removes all key 
frames in the selected area, except for the minimum and maxi-
mum peaks.The Avid Composer system tries to save major ges-
tures while removing redundant points and points on a linear 
ramp. This is useful for deleting extra key frames after a recording. 
See the examples later in this section for more information.

Gang
button



512

When there are no In/Out marks on the track, the menu item is 
Filter Automation Gain Global. This option allows you to remove 
key frames from the entire track.

¥ Remove Automation Gain In/Out removes all of the audio key 
frames within the marked region.

When there are no In/Out marks on the track, the menu item is 
Filter Automation Gain Global. This option allows you to remove 
all of the audio key frames on the track.

Using the Automation Gain Window Sliders

To record audio gain information by using the Automation Gain win-
dow sliders:

1. Select an audio track for adjusting volume by clicking the gang 
button.

2. Choose Volume from the Audio Data submenu of the Timeline 
Fast menu.

3. (Option) Expand the audio track by pressing kÐL, or by pressing 
the Option key and dragging the top or bottom of the Track Selec-
tor panel.

4. Move the blue position indicator to the section of audio that you 
want to adjust and mark IN and OUT points.

5. Click the Record button to start recording your actions.

6. Listen to the audio and adjust the volume sliders on the Automa-
tion Gain window as necessary.
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The Avid Composer system adds volume key frames to the audio 
in the Timeline. Because it records every movement of the sliders, 
there are usually more key frames than you need.

7. To decrease the number of key frames:

a. Click the Gang button for the track to enable the Fast menu.

b. Choose Filter Automation Gain Control In/Out from the 
Automation Gain Fast menu.

8. Repeat step 7 until you have decreased the number of key frames 
to an acceptable level.

You should remove as many excess key frames as possible while 
still maintaining the desired volume changes. 

You can move, add, and delete key frames individually or as groups to 
further adjust the volume. For details on how to adjust the key frames, 
see ÒUsing Audio Gain AutomationÓ on page 500.

Using a Keyboard Shortcut

Click the Gang button on a track to turn it green. Then you can use the 
Fast Forward and Rewind buttons to jump to the next or previous 
audio key frame. You can map these keys to your keyboard to speed 
your editing of audio key frames.

Using the Fader to Record Audio Gain Information

To record audio gain information, using the fader box:

1. Attach the fader box to your system (see ÒConnecting a Fader to 
Your Avid Composer SystemÓ on page 514).

2. Move the blue position indicator to the section of audio that you 
want to adjust and mark IN and OUT points.

3. Note the color of the position indicator lights for the track you 
want to adjust. Move the fader box slider until both lights are blue. 

Position 
indicator 
lights
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If you canÕt adjust it to the exact position where both are blue, get 
it as close as you can.

4. Set PreRoll and PostRoll values if necessary.

5. Click the Record button to start recording your actions.

6. Listen to the audio and adjust the volume sliders on the fader box 
as necessary.

7. Play the clip to test your results.

8. To decrease the number of key frames, choose Filter Automation 
Gain Control In/Out from the Automation Gain Fast menu.

9. Repeat step 8 until you have decreased the number of key frames 
to an acceptable level.

You should remove as many excess key frames as possible while 
still maintaining the desired volume changes. 

Connecting a Fader to Your Avid Composer System

Your Avid Composer system supports the JL Cooper FaderMaster Pro-
fessional fader. You connect the fader to your printer port or modem 
port by using a standard Macintosh serial cable. The FaderMaster 
sends and receives MIDI data, so you need to attach a MIDI translator 
to convert the MIDI signals to a format that can travel over a serial 
line. 

To initialize the fader:

1. Attach the cables as described in the Avid Media Composer Products 
Connecting Audio and Video Equipment manual.

2. Turn on the fader.

3. In the Composer application, choose Serial Ports from the Tools 
menu. The Serial Ports Tool appears.

4. Choose Printer Port from the Audio Faders menu and close the 
tool. 
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If your printer port is already in use, attach the cable to the 
modem port and choose Modem port.

To test the fader:

1. Choose Automation Gain from the Tools menu. The Automation 
Gain window opens.

2. Option-click the HW button in the Automation Gain window. The 
box turns blue.

3. Check the color of the position indicator lights. If the external 
fader is not connected, the lights are off (gray). If the fader is con-
nected, at least one of the lights is on (blue).

4. Move the sliders on the fader. The corresponding slider should 
move in the Automation Gain window.

n The external fader position lights will be off (gray) if the box is not connected.

n The fader is optional. It is not required to perform Audio Gain Automation 
recording.

Ganging Sliders on the FaderMaster Fader

You can use software features available on the FaderMaster Profes-
sional to gang sliders. When the sliders for two tracks are ganged, the 
fader sends identical volume messages for both tracks when you move 
one slider. This can be useful when you have stereo tracks. 

Note that the ganged sliders do not move together physically. For 
information on ganging the sliders, see the FaderMaster userÕs man-
ual. For example, if you have two stereo tracks and want to gang fad-
ers 1 and 2 to respond to movement on fader 1:

1. On the FaderMaster, press the PROG button to light the Fader 
LED.

Position 
indicator 
lights
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2. Hold down the Group button and move fader 2 until "1" is dis-
played.

3. Press the PROG button to turn off the Fader LED.

Now when you move slider 1, the Avid Composer system will receive 
identical volume information for slider 2.

To turn off the group feature, repeat steps 1 to 3 but assign fader 2 to 0.

Using Audio Gain Automation and the Audio Mix Window

This section describes the interactions between the Audio Mix window 
and the Automation Gain window. 

When you add the Þrst audio key frame to a track, the Avid Composer 
system adds the point at the level currently set for that track in the 
Audio Mix Tool.

Values set by the volume sliders in the Audio Mix window are referred 
to as system clip gain values. Audio gain key frames are not additive 
to the system clip gain values. When you move a key frame point up 
or down, it cancels the system clip gain for that point in the sequence.

You can add key frames to some tracks and use the Audio Mix win-
dow to control the volume on other tracks. The Avid Composer system 
provides visual clues to let you keep track of which type of audio 
effect is on a given track.

The following illustration shows the Audio Mix window and the 
Automation Gain window with audio data on two tracks. In this 
example there is audio gain automation information on track A1 and a 
system clip gain setting on track A2.
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When you have audio gain automation on a track, the slider for the 
track does not appear in the Audio Mix window. The system displays 
the word Auto in the track volume text box to indicate that audio gain 
automation is associated with the track. 

Likewise, when you use the Audio Mix window to change volume for 
a track, the slider for the track disappears from the Automation Gain 
window. The word Clip appears in the track volume text box.

To add audio gain automation to a track that contains system clip gain 
information, you simply need to add an audio key frame. To use the 

Track A1 has
audio gain
automation.

Track A2 has
system clip gain 
settings from the 
Audio Mix window.
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Audio Mix sliders on a track containing audio gain automation, you 
must Þrst remove all of the audio key frames from the track. Choose 
Remove Automation Gain Global from the Automation Gain Fast 
menu. You need to remove any IN and OUT points on the track before 
the menu item changes from In/Out to Global.

Using the Audio EQ Tool

The Audio Equalization (EQ) Tool supports real-time, segment-based 
frequency equalization on individual clips. This allows you to adjust 
the high, low, and midrange frequency ranges of an audio clip. You 
can also save a variety of audio EQ effects and apply them in different 
circumstances, as described in this section.

You can access the Audio EQ Tool in one of two ways:

¥ Choose Audio EQ from the Tools menu.

¥ Choose EQ from the Audio Mix pop-up menu.
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The Audio EQ Tool appears.

Audio EQ Tool Features

The Audio EQ Tool provides three bands of control:

¥ The Þrst band, the low shelf, has four turnover points (50 Hz, 80 Hz, 
120 Hz, and 240 Hz). A turnover point is the point at which the 
curve starts to return to 0.

A shelf affects all frequency values within the range of the shelf. 
The low shelf affects all frequency values from 20 Hz to the low 
shelf turnover point.

Track Selection 
pop-up menu

Fast menu

3-band controls

EQ Range Slider

Play loop button

Effect icon

Low shelf

Parametric
midrange

High shelf



520

¥ The second band is the parametric midrange. This band has two 
bandwidth values, 1/4 octave and 2 octaves. These control the 
width of the curve.

¥ The third band, the high shelf, has four turnover points (6 kHz, 
8 kHz, 12 kHz, and 15 kHz). The high shelf affects all frequencies 
from the high shelf turnover point to 20 kHz.

The horizontal center line of the graph is 0. As you move the curve 
below the zero line, the corresponding frequencies are deemphasized. 
Above the zero line the corresponding frequencies are emphasized. 
The parametric midrange allows a smooth transition from deempha-
sized frequencies to emphasized frequencies.

The IN button allows you to turn off the EQ effect. The button is yel-
low when the effect is on (inline) and gray when the EQ effect is off.

You apply Audio EQ like effects:

¥ Audio EQ can only be applied to entire segments. You cannot iso-
late portions of a segment for an Audio EQ effect by using IN and 
OUT marks. You must use add edits (match frames) to mark off a 
smaller segment.

¥ You can use IN and OUT marks to select a range of complete seg-
ments for applying an Audio EQ effect. Segments that fall within 
the marks, either in part or in whole, will have the effect applied to 
them.

The following illustration shows the Audio EQ Tool with the fre-
quency response curve displayed and identiÞes the related areas of the 
window. The graph displays from 20 Hz to 20 kHz.
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The Audio EQ Tool allows you to emphasize or deemphasize audio 
frequencies. The height of the curve shows the amount of emphasis or 
deemphasis (also called boost or cut) that is being applied. The range 
is from +15 dB to Ð20 dB.

Applying Audio EQ Effects

To adjust audio EQ for a track:

1. Load the sequence containing the audio track.

2. (Option) Isolate a portion of an audio segment by placing add 
edits.

3. (Option) Mark off a range of audio segments by adding IN and 
OUT marks in the track.

4. Open the Audio EQ Tool.

Turnover point where low 
shelf curve starts moving 
back toward 0

The current value of the EQ 
parameters

Turnover point where high 
shelf curve starts moving 
back toward 0

Bandwidth around the 
center point of the para-
metric curve – 1/4 octave 
(narrow) or 2 octave 
(wider)

Low shelf

Center point of the paramet-
ric midrange curve

High shelf

Parametric midrange 

0 line
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5. Select the audio track to be adjusted from the Track Selection pop-
up menu in the Audio EQ Tool.

Notice that the Track Selector panel in the Timeline window is 
updated to reßect your selection.

6. Click the Play Loop button to play the currently selected audio 
clip within the current In/Out range. To stop playing the loop, 
click the button again or click anywhere in the Timeline.

7. Use any of the following methods to change a value in the Audio 
EQ Tool:

¥ Click a number along the vertical edge of the volume slider.

¥ Click the slider and type a value.

Values are cumulative until you press Return. For example, if 
you want to enter the value 12, simply type it. However, if you 
enter 1 and then want to change the value to 2, press Return 
before typing the 2.

¥ Click and drag the slider.

¥ Click the EQ Parameter display and type in a value.

¥ Set a value of 0 dB by clicking the slider and entering 0, or by 
clicking 0 along the vertical edge of the volume slider.

8. Apply the adjustments to a chosen region of the track by using the 
Audio EQ Fast menu located at the upper right of the tool.

Track selection 
pop-up menu

EQ Fast menu button
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The Fast menu on the Audio EQ Tool allows you to remove or 
apply an EQ effect to clips included within the current IN to OUT 
range. For a description of a number of predeÞned audio tem-
plates, see ÒUsing Audio EQ TemplatesÓ on page 528.

For example, the following illustration shows a segment with one 
EQ applied to the Audio Clip 2 in track A2. If you choose Set EQ 
In/Out, the current EQ effect is also applied to Audio Clip 1 and 
Audio Clip 3 on track A2.

If there is no EQ setting on the currently selected clip, choosing Set 
EQ In/Out deletes the EQ settings on all clips within the IN to 
OUT range. For example, because there is no EQ setting on Audio 
Clip 3 in the following example, Set EQ In/Out deletes the EQ 
effect from Audio Clip 1 and Audio Clip 2.

Before Set EQ In/Out

After Set EQ In/Out – EQ effect is added to Audio Clip 1 and Audio Clip 3.
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Set EQ In/Out applies only to the audio track currently selected 
by the Audio EQ Tool. You can change your selected region by 
eliminating or adding marks in the Timeline, or by selecting a dif-
ferent track.

9. Play through the audio again, using the Play Loop button. 

10. Repeat steps 8 through 10 until you are satisÞed with the EQ 
adjustments.

Saving Audio EQ Effects

The Avid Composer system treats an EQ setting as an effect. You can 
save EQ settings in a bin just as you save any other effect template. 
This makes it easy to save EQ settings and apply them whenever you 
need them. The following illustration shows EQ Effect icons in a bin 
and in the Timeline.

Before Set EQ In/Out

After Set EQ In/Out – EQ effect is deleted from Audio Clip 1 and Audio Clip 2.
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Use the Effect icon to save EQ settings in a bin or to copy the settings 
to another audio clip. Either drag the icon into a bin or drag the icon to 
another audio clip in the Timeline. For more information on using 
effect templates, see the Avid Media Composer and Film Composer Effects 
Guide.

Removing Audio EQ Effects

To remove an effect:

1. Place the position indicator on the effect.

2. From Source/Record mode, click the Remove Effect button.

From Trim or Effects mode, press Delete.

EQ effect in the Timeline

EQ effect templates in a bin
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Audio EQ Examples

The following examples show two different ways to use the Audio EQ 
Tool to remove excess bass from an audio track. These examples use 
the sound track from the Rain Forest sequence. The bass in the sound 
track is very pronounced, and we use the Audio EQ Tool to deempha-
size it. The main challenge with this particular sound track is that 
there are voices on the same track as the music. The human voice cov-
ers a wide range of frequencies and the challenge is to preserve the 
bass frequencies of the voices while deemphasizing the bass drum 
sound.

Keep in mind that the goal of the adjustments is the Þnal sound. In 
general, you should use small adjustments to preserve as much of the 
original sound track as possible. DonÕt be overly concerned about spe-
ciÞc parameter values.

Low Shelf Example

This example adjusts the low shelf to deemphasize the bass. By drop-
ping the low shelf down Ð20 dB, we are able to deemphasize it. How-
ever, there are voices on this track and simply dropping the low shelf 
also removes some bass from the voices. So we did the following to 
compensate for this:

1. Use the 2 octave midrange setting to create a wide midrange.

2. Move the midpoint of the parametric curve over to 90 Hz.

3. Boost the midrange of the parametric curve to +7.7 dB.
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Small Octave Range Example

This example isolates the particular frequency that we want to deem-
phasize. In this example we donÕt use the low shelf, but instead use the 
parametric midrange to isolate the frequency.

1. Use the 1/4 octave inßuence range.

2. Set the midrange EQ parameter to Ð15 dB.

3. Use the slider to move the midpoint of the parametric curve until 
it isolates the bass frequency. In this case the bass frequency we 
want to deemphasize is approximately 80 Hz.
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This technique allows you to locate a speciÞc frequency and either 
emphasize or deemphasize it: 

¥ Use the 1/4 octave inßuence range and a large negative deci-
bel value. 

¥ Keep both the high and low shelf set to zero.

¥ Use the slider to move the center point of the parametric curve 
along the frequency range while you play the audio track.

Once you locate the desired frequency, you can adjust it as needed.

Using Audio EQ Templates

Your Avid Composer system provides a set of predeÞned audio EQ 
templates. These templates address a number of common audio prob-
lems such as removing tape hiss or boosting the low frequency on a 
music track. The templates are accessible from the Fast menu on the 
Audio EQ Tool. You can also add your own custom EQ templates to 
the Fast menu list.

Use this slider to move 
the center point of the 
parametric curve and 
locate a specific 
frequency.



529

The Fast menu on the Audio EQ Tool provides access to a number of 
predeÞned EQ templates as shown in the following illustration.

The EQ templates are designed to Þx problems that are often encoun-
tered with audio clips. For example, Tape Hiss Filter rolls off frequen-
cies above 4 kHz. NTSC Hum Buster cuts the bass on frequencies that 
often cause hum on NTSC systems.

Applying an EQ Template

To apply an EQ template from the Audio EQ Tool Fast menu:

1. Place the blue position indicator on the audio clip in the Timeline.

2. Choose the template from the Audio EQ Tool Fast menu.

The Avid Composer system places the EQ effect on the audio clip.

The following illustration shows the contents of the EQ window when 
you select the Female Voice with Presence template in the Timeline. As 
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explained in the window, you cannot change the parameters of a pre-
deÞned EQ template.

To see the parameter values of one of the EQ templates, view the Con-
sole window after you apply the effect. To open the Console window, 
choose Console from the Tools menu.

Creating Your Own Templates

If you create an EQ effect that you want to use again in another 
sequence or on another track, simply drag the Effect icon to a bin.The 
system creates an effect in the bin called EQ Effect. Rename the tem-
plate by clicking the text and typing a new name.
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You can add your own EQ templates to the EQ Fast menu. You do this 
by storing your EQ template in the same bin as the predeÞned tem-
plates.

The Avid Composer system stores the predeÞned EQ templates in a 
special bin named Site_EQs_Bin. This bin resides in a new Site_Effects 
folder in the Supporting Files directory. The following illustration 
shows the binÕs location.

n The IN button in the EQ window allows you to turn off the particular EQ 
effect. The button is yellow when the effect is on (inline) and gray when the 
EQ effect is off. The Ignore EQ check box turns off all EQ effects for the 
sequence.

Effect icon
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To add an EQ template to Site_EQs_Bin:

1. Choose Open Bin from the File menu.

A dialog box appears.

2. Open the bin named Site_EQs_Bin as follows:

a. Open the Media Composer folder.

b. Open the Supporting Files folder.

c. Open the Site_Effects folder.

d. Double-click the Site_EQs_Bin Þle.

3. Drag one of your own templates to Site_EQs_Bin.

4. If you have not already done so, name the template by clicking the 
text and typing a name.

EQ templates bin

In this example, the Supporting 
Files folder resides in the 
Media Composer folder.
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5. Close the bin. 

n The Avid Composer system does not save the effect to the bin until you close 
the bin.

6. Select the Audio EQ Tool Fast menu and look for your new tem-
plate.

For more information on using the Audio EQ Tool, see ÒUsing the 
Audio EQ ToolÓ on page 518.

Adjusting EQ While Playing an Audio Effect

You can use the Play Loop button to create or change an EQ effect 
while a clip is playing.

To adjust EQ while playing an effect:

1. Choose an existing EQ effect or identify an area of the clip with IN 
and OUT marks.

2. Click the Play Loop button. The Avid Composer system repeat-
edly loops through the audio effect.

3. Adjust the EQ as necessary.

4. Click the Play Loop button to stop. The Avid Composer system 
automatically saves your changes as part of an EQ effect.

Play Loop button
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Limitations

If there is not an existing EQ effect on the clip before you start, you will 
not hear any changes until you click the Play Loop button to stop and 
replay the effect.

As you are adjusting the EQ values on an existing EQ effect, you might 
not hear the results immediately. It takes a few seconds for the changes 
to be applied to the clip. To improve the response time, you can do the 
following:

¥ Monitor as few audio tracks as possible. 

¥ Deselect the video track if practical.

¥ Use IN and OUT marks to choose a narrow interval to adjust.

Using Digidesign AudioSuite Plug-Ins

Your Avid Composer system supports AudioSuite, Digidesign's new 
host-based, Þle-based Plug-In speciÞcation. Users now have access to 
audio processing plug-ins developed by Digidesign and by 
Digidesign's third-party developers, including Waves, Arboretum, 
DUY, S.A., Steinberg, and others. For example, plug-ins are available 
to perform pitch processing, artifact removal, reversing of audio, and 
many other processes. For more information on using the AudioSuite 
plug-ins, see Appendix A.

For information on Digidesign and third-party plug-ins, see the 
AudioSuite Plug-In Catalog available from Digidesign. Contact
Digidesign at 800-333-2137.

For a list of plug-ins that are not supported by the Avid Composer sys-
tem, see ÒPlug-In LimitationsÓ on page 540.
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Installing AudioSuite Plug-Ins

The Avid Composer system installation software automatically creates 
a folder in your System Folder named DAE Folder (DAE stands for 
Digidesign Audio Engine). The DAE application manages the Audio-
Suite Plug-Ins.

The DAE Folder contains the following Þles and folders:

¥ The DAE application program.

¥ A Plug-In Settings folder. The plug-in vendor might install set-
tings in this folder.

¥ A Plug-Ins folder containing the following:

- A set of basic plug-ins from Digidesign.

- A Þle named Avid Application PlugIn. The Avid Composer 
system requires this Þle; do not delete it.

The following basic plug-ins are installed automatically:

¥ InvertÑInverts the polarity (phase of the audio Þle).

¥ DuplicateÑThis plug-in does not work on Avid Composer system 
audio Þles.

¥ NormalizeÑFinds the peak value in the source audio Þle and 
scales the entire Þle proportionally to that maximum value.

DAE application icon

The Avid Composer 
system requires this 
file.



536

¥ GainÑSame as normalize, but allows positive or negative gain 
adjustment.

¥ ReverseÑÒFlips the tape over,Ó making audio signals run back-
ward.

¥ DC Offset RemovalÑRemoves an audio artifact that is common in 
digital audio Þles. A DC offset is caused by poorly calibrated
A/Ds (analog-to-digital converters), and can produce clicks and 
pops on clip edit transitions if not removed.

When you purchase additional plug-ins, the third-party vendor will 
provide instructions on how to load the plug-ins. Some might require 
you to drag the plug-in to the Plug-Ins folder. Others might perform 
the task automatically for you by using an installation program.

Starting and Quitting the DAE Application

When you open the Digidesign AudioSuite window (see ÒUsing the 
AudioSuite Plug-InsÓ on page 537), the Avid Composer system auto-
matically launches the DAE application. The application continues 
running even after you close the window. To quit the DAE application 
while the window is open, kÐclick the status display in the Audio-
Suite window.

Drive Selection 
menu

Plug-In 
Selection menu

Status display
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n The DAE application uses between 9 and 16 MB of memory, depending on 
how many plug-ins are loaded. If you plan to use other applications while the 
Avid Composer system is running, you might Þnd it useful to quit the DAE 
application to free up memory for the other application.

Setting Playback Buffer Size

While the DAE application is running, you can choose Set Playback 
Buffer Size from the DAE applicationÕs File menu. However, this com-
mand has no effect on the Avid Composer system performance. For an 
example of how to use this command, see ÒAddressing Memory Allo-
cation ProblemsÓ on page 540.

Using the AudioSuite Plug-Ins

The following illustration shows the AudioSuite window.

To apply an AudioSuite plug-in:

1. Open the AudioSuite window and do one of the following:

Drive Selection menu

Plug-In Selection menu

Status display

Fast menu
Render effect 
button

Effect icon.

Play Loop button

Audio Effect Mode Selector 
pop-up menu

Track Selection menu Plug-In button



538

¥ Choose AudioSuite from the Tools menu.

¥ If an audio tool is already open, choose AudioSuite from the 
Tool Selection menu.

2. Select the track to modify in the AudioSuite window. You can only 
work on one track at a time.

3. Choose a plug-in from the Plug-In Selection menu.

The Avid Composer system automatically applies the plug-in 
effect to the track in the Timeline.

4. Click the Plug-In button to open the dialog box associated with the 
plug-in.

5. Make any necessary adjustments and click the Play Loop button to 
preview the effect. For more information, see ÒUsing a Plug-In 
Dialog Box.Ó

6. To save the effect, click OK. To close the dialog box without saving 
the effect, click Cancel.

Using a Plug-In Dialog Box

The contents of the plug-in dialog boxes vary, but the top six buttons 
will always be visible. If a particular button is not available, it is 
dimmed. The following illustration shows the Digidesign Gain plug-in 
as an example.

¥ OK saves the effect and closes the dialog box.

These six 
buttons appear 
on all AudioSuite 
dialog boxes.
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¥ Cancel closes the dialog box and does not save the effect.

¥ Render renders the effect and creates a new audio media Þle. 

¥ Preview plays back a portion or all of the currently selected audio 
clip with processing.

Some plug-ins can preview in real time and some cannot. If the 
plug-in cannot preview in real time, the Avid Composer system 
plays back the processed audio in 2-second intervals. The Avid 
Composer system processes 2 seconds of audio, plays it, processes 
the next 2 seconds, plays it, and so on.

¥ Bypass plays the selected audio without processing. This is useful 
for comparing the audio with and without processing applied.

¥ Optional performs an analysis pass on the audio data.

Some plug-ins require an analysis pass on the audio data before they 
can process the information. If so, they perform the Þrst pass automat-
ically. Other plug-ins do not require a Þrst pass but can achieve more 
accurate results if you allow them to perform a Þrst pass. If the plug-in 
supports the optional pass, this button will be available. Otherwise it 
will be dimmed.

Rendering Plug-In Effects

Some plug-ins can process a Þle in real time and some cannot, due to 
the complexity of the effect. Even if a plug-in can run in real time, you 
must render it before you can add it to the following:

¥ An audio mixdown

¥ An EQ effect

If you do not render the effect manually, the Avid Composer system 
automatically renders the effect before it creates an audio mixdown or 
audio dissolve containing the effect.
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For more information, see ÒTroubleshooting AudioSuite Plug-InsÓ 
on page 540.

Plug-In Limitations

There are a few important exceptions to the list of compatible plug-ins. 
The following types of plug-ins do not work with the Avid Composer 
system:

¥ Third-party plug-ins that process audio in stereo pairs, such as ste-
reo sound Þeld expanders. These plug-ins only receive input on 
the Þrst channel.

¥ Plug-ins that perform analysis passes, using playlist information 
to cache analysis data.

¥ Plug-in options that perform time compression/expansion. For 
example, some Pitch Shift plug-ins have an option for changing 
the length of the audio Þle. You can use the plug-in as long as you 
donÕt choose that option.

Also note that you can only work on one track at a time. This means 
that you should use the mono AudioSuite Plug-Ins where applicable.

Troubleshooting AudioSuite Plug-Ins

This section describes problems you might encounter when using the 
AudioSuite Plug-Ins.

Addressing Memory Allocation Problems

The DAE application requires between 9 and 16 MB of RAM, depend-
ing on how many plug-ins are loaded. When the application launches, 
it attempts to allocate enough memory for all the plug-ins in the Plug-
Ins folder in the DAE Folder. If you have a lot of plug-ins (for example, 
more than 10), the application might not be able to allocate enough 
memory for all of them.
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If you receive memory allocation errors or if the screen does not 
redraw correctly when you use the AudioSuite Plug-Ins for the Þrst 
time, you should do the following:

1. Quit the Avid Composer application.

2. Locate the DAE Folder in your System Folder and click the DAE 
application icon within the DAE Folder.

3. Press kÐI to display the Get Info dialog box.

4. Change the Preferred Size value to a large number, such as 30000 
(30 MB), to change the memory allocation.

5. Close the Get Info dialog box.

6. Start up the DAE application by double-clicking the DAE applica-
tion icon.

The DAE application automatically checks the available plug-ins 
and allocates enough memory to run all of the plug-ins.

7. Choose Set Playback Buffer Size and set the buffer size to 0.

n The Set Playback Buffer Size setting has no effect on Avid Composer perfor-
mance.

8. Quit the DAE application.

9. Use the Get Info dialog box again and change the Preferred mem-
ory size back to the Suggested Size.

10. Restart the Avid Composer system.

If you still receive memory errors when you use the AudioSuite Plug-
Ins, you might have too many plug-ins in the Plug-Ins folder in the 
DAE Folder. Move some plug-ins out of the folder and try running the 
AudioSuite Plug-Ins again. For example, you could create a Plug-Ins 
Disabled folder for storing plug-ins that are not in use.
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Starting and Stopping the DAE Application

By default, the DAE application is always running while the Audio-
Suite window is open. You can stop the DAE application to free up 
memory for other applications.

To stop the DAE application while the AudioSuite window is open, 
kÐclick the status display in the AudioSuite window.

To restart the DAE application, Option-click the status display.

Canceling a Render Operation

You can press kÐperiod to cancel a render operation. However, be 
careful not to press kÐperiod multiple times. If you press the com-
mand after the render operation has been stopped (from a previous 
kÐperiod), the Avid Composer system closes the window after it can-
cels the render operation.

Addressing Error Messages When Rendering a Plug-in Effect

If the DAE application is not running when you start to render a plug-
in effect, the system displays an error message stating that the DAE 
connection does not exist. The dialog box gives you the following 
choices:

¥ Cancel stops the rendering process. This allows you to launch the 
DAE application and then start rendering again.

¥ Bypass continues rendering but doesnÕt render the plug-in effect.

In most cases, you should click Cancel and restart the DAE applica-
tion. Either open the AudioSuite Plug-In window or, if the window is 
already open, Option-click the status display in the AudioSuite win-
dow.

If the plug-in is not installed when you go to render a plug-in effect, 
the system displays an error message and tells you which plug-in is 
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not installed. At that time you can cancel or bypass as previously 
described.

Using Digidesign Pro Tools

If you plan to use Digidesign Pro Tools on the same system with the 
Digidesign AudioSuite Plug-Ins, install Pro Tools Version 4.1.1 or 
greater. This version has the matching version of the DAE application.

Using Audio Punch-In

Audio punch-in allows you to record up to two channels of audio 
directly into the Timeline for voice-over narration. This saves the extra 
steps of recording the narration to tape Þrst, digitizing, and then edit-
ing the audio clip into the sequence.

You access the Audio Punch In Tool from the Tools menu.

The following illustration identiÞes the various elements of the tool:
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Features of the Audio Punch In Tool are as follows:

¥ The Record button starts and stops the recording. 

¥ The Cancel button stops a recording without saving the recorded 
data.

¥ The Recording status light is black when there is no activity, green 
during a preroll, red during recording, and blue during a postroll.

¥ The Display Audio Tool button displays the Audio Tool so that 
you can monitor and adjust the audio levels during recording.

¥ The PreRoll text box allows you to provide a visual cue before the 
recording begins. The Avid Composer system backs up the blue 
position indicator for the prescribed number of seconds. 

¥ The PostRoll text box gives the same kind of visual cue at the end 
of the recording.

¥ The Handles text box instructs the Avid Composer system to 
record audio at the beginning and end of the clip. This allows you 
to perform trim edits on the audio.

Timeline Track selection menus
Input channel
selection buttons 
and menus

Bin selection menu

Drive selection menu

Record button
Cancel button

Display Audio Tool
button

Recording status light

Preroll and Postroll boxes

Handles box
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¥ The input channels identify the channels on the audio hardware 
that are used for recording. Click the button to select the channel. 
The button turns pink when it is selected. Option-click the button 
to display a menu and select another channel. 

¥ The Track selection menus allow to specify where the Composer 
system places the audio in the Timeline. Either choose New Track 
or choose an existing track. When you choose an existing track, the 
Avid Composer system overwrites the audio on that track 
between the IN and OUT points.

Using the Audio Punch In Tool

This section provides an overview of how to set up and use your Avid 
Composer system for creating voice-overs in the Timeline.

Connecting the Hardware

Before you can use Audio Punch In, you need to connect a microphone 
or other input device to your system. The following are typical exam-
ples:

¥ Connect a microphone to a mixer and connect the mixer to the 
Audio board or to the Audio Interface on your Avid Composer 
system.

¥ Connect a microphone to a microphone preamp and connect the 
preamp to the Audio board or to the Audio Interface on your Avid 
Composer system.

For information on connecting the hardware, see the Avid 
Media Composer Products Connecting Audio and Video Equipment manual.
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Creating the Voice-Over

You can replace part (or all) of an existing track or you can instruct the 
Avid Composer system to create a new track for the voice-over. The 
following procedure shows how to use the tool when you want to 
mark IN and OUT points and plan to create a new track for the voice-
over. 

1. Mark the IN and OUT points in the Timeline as shown in the fol-
lowing illustration.

2. Choose Audio Punch In from the Tools menu. 

The Audio Punch In Tool appears.
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3. Choose the channels that correspond to your hardware setup and 
set other values in the dialog box as appropriate.

4. To start recording, click the Record button.

If you started with both IN and OUT points in the Timeline, the 
Avid Composer system automatically stops recording when it 
reaches the OUT point (or after it adds the appropriate audio han-
dle after the OUT point). If you only added an IN point, click the 
record button a second time to stop the recording.

The following illustrations show the results after adding a voice-over. 
The system automatically names the voice-over. You can change the 
name as you would any clip (for example, change the name in the bin).

Record button Cancel button

Recording status light
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Voice-Over Media Files

The Avid Composer system automatically names the voice-over and 
stores it as an audio clip as shown in the following illustration.

Voice-over adding a new track

Voice-over replacing a portion of a track
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Fine-Tuning Audio Transitions

When making audio level and pan adjustments, the Avid Composer 
system looks at either an individual clip in the Source monitor, a seg-
ment in the sequence, or entire tracks. To change level or pan settings 
in an area not deÞned by a discrete clip or group of clips, use the Add 
Edit function to deÞne your own custom area.

1. Find the start of the area where you would like to change the pan 
or level, leaving your position indicator on that frame as a marker.

2. Turn on the appropriate track in the track panel.

3. Click the Add Edit button.

This places an edit where the position indicator is parked.

4. Find the end of the area where you want to change the pan or 
level, leaving your position indicator on that frame as a marker.

5. Turn on the appropriate track.

6. Click the Add Edit button.

7. Use the process described in ÒUsing the Audio Mix ToolÓ on 
page 490 to change the level or pan within this new segment.

Fading and Dipping Audio

In traditional analog editing, you manually change volume levels to 
smooth audio transitions between elements in an edited sequence by: 

¥ Fading audio up or down

¥ Dipping to a lower level

¥ Crossfading between audio elements on two separate channels

With the Avid Composer system, these effects are more accurately 
termed audio dissolves because they occur instantly when you apply the 
same dissolve effect that you use for video tracks.
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You can use the procedures described in ÒUsing Audio Gain Automa-
tionÓ on page 500 to achieve these effects. If your model does not 
include Audio Gain Automation (releases prior to Release 6.1), you 
must use the procedures described in this section.

This section describes three basic procedures for achieving fades, dips, 
and crossfades with the Avid Composer system. For complete informa-
tion on applying and adjusting effects, see the Avid Media Composer and 
Film Composer Effects Guide.

Fading Audio

To fade or crossfade audio, you can use the procedures described in 
ÒUsing Audio Gain AutomationÓ on page 500. If your model does 
not include Audio Gain Automation (releases prior to Release 6.1), you 
must use the procedure described in this section.

Fading and crossfading audio are easy effects to achieve. The proce-
dure that differs most from analog editing is crossfading. In the analog 
world, unless you are using a mixer, you must lay down audio on two 
separate channels and fade one down, then fade up the second on an 
overlapping section. With the Avid Composer system, you simply 
apply the aural equivalent of a visual dissolve.

To apply a fade or crossfade:

1. Place the position indicator on a transition.

2. Click the Add Dissolve button (it appears by default on the second 
row of buttons below the Record monitor).

The add dissolve dialog box appears.
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3. Do not choose another effect from the Add pop-up menu at the 
top; only dissolves work with audio tracks.

4. Select a duration for the dissolve, measured in frames (30 frames 
equals 1 second of NTSC footage; 25 frames for PAL).

5. Choose the location for the dissolve from the Position pop-up 
menu.

¥ Ending at Cut fades the audio to 0 from the A-side segment by 
the cut point.

¥ Centered on Cut, or Custom Start creates a crossfade. Custom 
Start allows you to begin the dissolve off-center Ñ that is, 
closer to the transition and ending later into the B-side, or the 
reverse.
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¥ Starting at Cut fades the audio up from the B-side starting at 
the cut point.

6. If you chose Custom Start, enter the number of frames before the 
transition to begin the effect in the ÒStarts x frames before cutÓ 
entry box. Otherwise, leave the default value in the entry box.

7. (Option) Choose a media drive other than the default Effect 
Source Disk from the Target Disk pop-up menu.

8. Click Add to place the effect at the transition point without ren-
dering. Click Add and Render to do both at once. 

n In most cases you can choose the second option, Add and Render, to allow 
immediate real-time playback of the audio effect (rendering of audio dissolves 
is usually instantaneous).

The effect is completed.

Dipping Audio

To dip audio from a higher level to a lower oneÑfor example, when 
bringing music down and under a voice-over trackÑyou can use the 
procedures described in ÒUsing Audio Gain AutomationÓ on 
page 500. If your model does not include Audio Gain Automation 
(releases prior to Release 6.1), use the procedure described in this sec-
tion.

To apply a dip in audio:

1. Play back the section of the sequence where the dip will take place 
to determine the start point for the dip, and apply an add edit to 
the audio track. 

2. Do the same for the end point where the audio will dip back up.

3. Place the position indicator over the new segment of audio, and 
open the Audio Mix Tool.

4. Adjust the track to the desired volume level as described in the 
section ÒUsing the Audio Mix ToolÓ on page 490.
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5. Apply a Quick Dissolve to both Add Edit points, using the tech-
niques described in the previous section. Be sure to choose ÒCen-
tered on CutÓ or ÒCustom StartÓ from the Position pop-up menu.

After rendering, the audio dips smoothly from the higher levels of the 
adjacent segments of the track to the lower level applied to the middle 
segment.

Mixing Down Audio Tracks

When you work with multiple audio tracks while editing your mate-
rial, you might need to mix the Þnal audio down to two tracks.

After you edit a number of tracks of audio, mix them down to one or 
two tracks of audio by following these steps:

1. Load a sequence into the Record monitor.

2. Click the track selectors to select the audio tracks you want to mix 
down.

3. Mark an IN and an OUT at the start and end of the material you 
want to mix down.

If you do not mark the section of audio you want to mix down, the 
system mixes down all of the selected audio tracks.

4. Choose Audio Mixdown from the Special menu. The top of the 
box displays the source audio tracks and the start and end time-
codes for the section of audio youÕve selected to mix down.
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5. Click Mono and select the target track to which you want to mix 
down the audio.

If you want stereo, click Stereo and select two target tracks for the 
mixed-down audio. The system mixes down all the odd audio 
tracks to the left track and all the even audio tracks to the right.

6. Choose a target disk.

The target disk is the media disk where the system stores the 
media Þles for the mixed-down audio.

7. Click OK.

The audio is mixed down and ready for two-channel playback.

Selected section of audioDestination track



555

CHAPTER 17

Syncing Methods

Your Avid Composer system provides special tools that help you 
establish and maintain sync relationships between various clips. This 
includes managing sync between unrelated clips or clips with the 
same timecode, ganging footage, match-framing footage, and using 
Sync Point Editing. These topics are discussed in the following sec-
tions:

¥ Autosyncing Clips

¥ Managing Sync Breaks

¥ Managing Sync with Multiple Tracks

¥ Using Sync Point Editing

¥ Ganging Footage in Monitors

¥ Using Match Frame

Autosyncing Clips

For more information 
on tracking sync breaks, 
see ÒDisplaying Sync 
BreaksÓ on page 559.

When you digitize footage that includes both audio and video, the sys-
tem automatically establishes sync when it creates clips in the bin. 
Autosyncing applies to audio and video clips that have been digitized 
separately, usually from two separate sources. Autosyncing creates a 
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new subclip that displays sync breaks in the Timeline as though the 
audio and video were digitized simultaneously.

Autosyncing is often used for Þlm projects in which picture and sound 
are captured separately. These clips are often synced based on com-
mon Þlm timecode, sound timecode, or auxiliary timecode. You can 
also autosync any audio and video clips based on an artiÞcial IN point 
or OUT point relationship you establish with marks.

Use the following guidelines when autosyncing:

¥ You can autosync audio clips with video clips only. To link two or 
more video clips or audio clips, use the Grouping option described 
in ÒGrouping and MultigroupingÓ on page 582.

¥ You can create only one autosynced subclip at a time. You cannot 
autosync numerous pairs of audio and video clips simultaneously.

¥ If the audio and video clips do not have matching source or auxil-
iary timecode, you must establish common sync frames. To do 
this, mark IN points (or OUT points) on both clips before auto-
syncing.

¥ If you are autosyncing clips of different lengths, the longer clip is 
truncated to the length of the shorter clip.

¥ If you autosync according to common timecodes that are stag-
gered (one clip starts later than the other), the later starting time-
code becomes the start of the new subclip. The clip with the earlier 
starting timecode is trimmed accordingly.

To create an autosynced subclip:

1. Highlight the two clips in the bin. Choose AutoSync from the Bin 
menu. 

The AutoSync dialog box appears.

Sync break displayed
in the Timeline



557

2. Select an option, based on the following:

¥ Film TC/Sound TC if you are syncing clips with matching Þlm 
and sound timecode recorded in the Þeld; this option is 
dimmed if you are not working on a Þlm project.

¥ Inpoints if you are syncing according to IN points set in both 
clips.

¥ Outpoints if you are syncing according to OUT points set in 
both clips.

¥ Source Timecode if the two clips have matching timecode.

¥ Auxiliary TC1-TC5 if the two clips have matching timecode in 
the same auxiliary timecode column. Choose an Auxiliary TC, 
1 through 5, from the pop-up menu.

3. Click OK. The subclip is created and named by default after the 
video clip with the sufÞx .sync.n, where n is the incremental num-
ber of subclips created with the same name.
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You can change the name according to preference. You can load an 
autosynced subclip into the Source monitor and immediately edit it 
into a sequence.

Managing Sync Breaks

Sync breaks occur when a frame-accurate relationship between two 
clips or between the audio and video tracks within a single clip is off-
set during editing. Often this happens unintentionally when you per-
form one of the following actions:

¥ Selecting only one track in a synced relationship (for example, 
audio only or video only) and performing edit functions that 
lengthen the duration, such as Splice-in, Extract/Splice-in, or add-
ing frames in Trim mode.

¥ Selecting only one synced track and performing edit functions that 
shorten the duration, such as Extract, Extract/Splice-in, or remov-
ing frames in Trim mode.

Your Avid Composer system provides several features for avoiding, 
tracking, and removing sync breaks, as described in this section.

Editing to Avoid Sync Breaks

One way to avoid breaking sync is to maintain the duration of the 
track when adding or removing material, as follows:

¥ When adding material to a track, use the Replace or Overwrite 
functions instead of Splice-in, whenever possible.

¥ When removing material from a track, use Lift instead of Extract 
(the Lift function leaves Þller of the same duration when removing 
footage).

¥ When performing Segment mode edits, use the Lift/Overwrite 
function instead of Extract/Splice-in whenever possible (Lift/
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Overwrite leaves Þller behind and overwrites material at the new 
destination, maintaining sync in both cases).

¥ In Trim mode, you can sync lock tracks to avoid breaking sync, or 
use the Control-key function for adding black during trims, as 
described in ÒMaintaining Sync While TrimmingÓ on page 473. 
You can also perform dual-roller trims (that maintain duration) 
instead of single-roller trims.

There are many cases in which you cannot avoid splicing or extracting 
material, or performing single-roller trims that break sync. The follow-
ing sections describe features for tracking and Þxing sync breaks in 
those circumstances.

Displaying Sync Breaks

By default the Timeline displays sync breaks whenever they occur 
during editing. These appear at break points as white numbers indi-
cating negative or positive offset values relative to zero. The Sync 
Breaks option also displays match-frame edits by displaying an equal 
sign (=) on the edits.

You encounter sync breaks and match frames in different circum-
stances:

¥ You can encounter sync breaks in one or several video tracks, 
audio tracks, or both. Sync-break offset numbers appear by default 
only in the affected tracks.

Sync BreaksMatch frames
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For more information 
on match frames, see 
ÒAdding an Edit 
(Match Framing)Ó on 
page 445.

¥ You encounter match-frame cuts whenever you perform an add 
edit or whenever you move a segment up against footage from the 
same clip, and the timecode is continuous across the edit.

You can also customize the Timeline view to display sync breaks and 
match-frame edits in video tracks only, audio tracks only, or none.

To customize the sync break display, choose Sync Breaks from the 
Timeline Fast menu, and choose an option from the submenu.

n This feature applies only to master clips in which audio and video tracks were 
digitized simultaneously, to autosynced subclips, or to any other subclip with 
video and audio tracks.

Fixing Sync Breaks

In general, sync breaks are displayed only when the out-of-sync tracks 
overlap. In other words, if an overlapping portion of one of the tracks 
is deleted, replaced, moved, or trimmed, then the sync break disap-
pears. You Þx sync breaks in one of several ways, based upon the type 
of break and the needs of your sequence.
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Fixing Sync in Trim Mode

For more information 
on trimming, see
 Chapter 15.

In Trim mode, restore the frames to sync by performing one or more 
single-roller trims on the out-of-sync tracks. Trim the exact number of 
sync-break frames displayed in the Timeline to reverse the break. Keep 
in mind the following considerations:

¥ Sync lock any additional tracks that are synced to the track you are 
trimming. Otherwise, you might restore sync in one track and 
break it in the others.

¥ Do not perform a dual-roller trim Ñ this does not remove the sync 
break.

¥ Do not perform the trim on the OUT point (A-side transition) of 
the out-of-sync segment. This does not remove the sync break. 
Always perform the trim on the IN point (B-side transition) of the 
segment.

Fixing Sync in Source/Record Mode

For more information 
on editing in Source/
Record mode, see 
Chapter 13.

In Source/Record mode, restore sync by either adding new material or 
extracting material from the out-of-sync track. Add or extract the exact 
number of offset frames displayed in the Timeline, with the following 
considerations:

¥ Do not use the Overwrite or Lift functions. These do not remove 
the sync break. You can, however, overwrite or lift the out-of-sync 
material entirely to eliminate the break.

¥ You can splice in or extract selected frames of Þller when neces-
sary.

¥ You can use the add edit function to isolate just a portion of a clip 
or Þller segment in the sequence for extracting or replacing.
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Fixing Sync in Segment Mode

For more information 
on editing in Segment 
mode, see ÒUsing Seg-
ment ModeÓ on 
page 416.

In Segment mode, you can restore sync in some circumstances by 
selecting and moving the entire out-of-sync segment. You can move 
the segment forward or backward in the opposite direction of the 
break to reverse it, but with the following considerations:

¥ Use Lift/Overwrite (the red arrow) to leave Þller behind and 
maintain any other sync relationships that might be affected by 
the move.

¥ Use Lift/Overwrite to delete the entire segment and leave Þll to 
eliminate the break.

¥ Use the add edit function to isolate a portion of the clip for moving 
or deleting.

¥ Move the out-of-sync track, if possible, beyond the overlapping 
range with the synced material to eliminate the sync break.

Managing Sync with Multiple Tracks

The Sync Breaks display in the Timeline makes it easy to manage sync 
between video and one or two audio tracks. There are a number of 
additional techniques you can use to manage sync when working with 
four or more tracks. These include the sync lock feature, tail leaders, 
and add edits.

Using Sync Lock

For more information 
on sync locking tracks 
in Trim mode, see 
ÒMaintaining Sync 
While TrimmingÓ on 
page 473.

The sync lock feature allows you to maintain sync among several tracks 
while adding or removing frames in Trim mode. For example, if you 
insert an edit into one track that is sync locked to a second track, the 
system automatically inserts Þller in the second track to maintain sync 
between the two.
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You activate sync locking by clicking the indicator box in the Track 
Selector panel to display the Sync Lock icon. You can also toggle all 
locks on or off by clicking in the TC indicator box.

There are several unique aspects to sync locking:

¥ Sync locking is a Trim mode feature only. Edits performed in 
Source/Record, Segment, or Effect mode will override sync-
locked tracks.

¥ Sync locking applies to single-roller trims only, because dual-roller 
trims do not break sync.

¥ You can sync lock any number of tracks in any combination. In 
other words, the tracks do not require matching timecode or com-
mon sources, and can include multiple video tracks as well as 
audio tracks.

¥ Sync locking affects entire tracks. This means that parallel seg-
ments in other sync-locked tracks are affected when you trim any-
where in the sequence.

Syncing with Tail Leader

You can add tail leader to the audio or video material in your Avid 
Composer system to provide a useful visual reference in the Timeline 
for tracking and Þxing sync breaks across any number of tracks.

Film editors traditionally use standard head and tail leaders for this 
purpose. You can create your own leader according to any speciÞca-
tion, as described in ÒCreating LeaderÓ on page 266.

Sync lock indicator

Tail leaders lined up for multiple

video (vid) and audio (aud) tracks
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With tail leader added to synchronized tracks, you can go to the end of 
the sequence after making a complicated edit and see whether the 
leaders are lined up. If they are out of line, this indicates a sync break 
that you can measure and eliminate as follows:

1. Place the position indicator in the black segment that follows the 
out-of-sync leader.

2. Select the track, then click the Mark Clip button. You can measure 
the break by checking the IN to OUT duration of the marked seg-
ment.

3. To restore sync, Þnd the point at which the sync was lost. Add or 
remove frames using the appropriate edit function, as described in 
ÒFixing Sync BreaksÓ on page 560.

As a quick Þx, you can enter Extract/Splice-in Segment mode by click-
ing the yellow arrow button. Drag the black segment at the end of the 
out-of-sync tail leader to the location where the sync was lost. This 
segment of black, created when the track went out of sync, is the exact 
length of the sync break.

Mark Clip allows you to 
measure the break.

Move the black
segment, using

Extract/Splice-in.
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Syncing with Locators

For more information 
on using locators, see 
ÒUsing LocatorsÓ on 
page 355.

Like tail leaders, you can add locators to material in the Timeline to 
track and adjust breaks in sync between any number of tracks. You can 
place locators anywhere in the sequence and you can add speciÞc 
notes.

To mark sync points with locators:

1. Place the position indicator at the point in the sequence where you 
want to maintain sync between two or more tracks.

2. Select the Þrst track and click the Add Locator button.

The system adds a red locator to the track in the Timeline and in 
the Record monitor.

3. To add a note that will appear in the Record monitor whenever 
you park on the locator frame Ñ such as Music sync or Sound Effect 
sync Ñ double-click the locator in the Timeline, type the text into 
the Locator text box, and click OK.

4. Repeat the procedure for subsequent synchronized tracks. Make 
sure you keep the position indicator in the same location in order 
to line up the locators in sync.

You can use the Find 
procedure to go to a 
locator quickly with 
text. For more informa-
tion, see ÒFinding 
Frames, Clips, and 
BinsÓ on page 360.

5. After completing an edit that you think might have affected the 
sync, return to the segment that contains the locators and click the 
Focus button. If the locators are not lined up, the sync is broken.

To adjust the sync break:

Locators in sync
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1. Measure the sync break by Þrst placing the position indicator on 
the leftmost locator and clicking the Mark IN button. Then place it 
on the other locators and click the Mark OUT button.

2. Check the IN to OUT duration of the marked section.

3. To restore sync, Þnd the point at which the sync was lost. Add or 
remove frames by using the appropriate edit function, as 
described in ÒFixing Sync BreaksÓ on page 560.

Using Add Edit When Trimming

When trimming with several audio tracks in sync, you can use the 
Add Edit button to create an edit in the silent or black areas of the 
synced tracks. These occur in line with the track you are trimming, 
and they trim all the tracks at once to maintain sync.

To use the Add Edit button while trimming:

1. Place the position indicator on the edit that you want to trim.

2. Select only the additional tracks that are in sync, and click the Add 
Edit button. 

The system adds a transition at the location of your position indi-
cator in the Timeline.

3. Select the transition and trim (be sure to select all the synced 
tracks).

As you trim, frames are added or removed from the additional 
tracks as well.

Add Edits in black
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4. When you are Þnished trimming, remove the add edits from the 
sync tracks by choosing Remove Match Frame Edits from the Clip 
menu.

Using Sync Point Editing

Sync Point Editing (SPE) allows you to overwrite material onto your 
sequence in such a way that a particular point in the source material is 
in sync with a particular point in the sequence. For example, you can 
sync an action in the source video with an audio event, such as a musi-
cal beat in the Record monitor, then edit it so that the action occurs on 
the beat.

Like a replace edit, Sync Point Editing uses the relative location of the 
position indicator in both the source and record material as the sync 
point. However, Sync Point Editing determines the duration of the 
new edit according to marks that you set, as opposed to a replace edit, 
which uses the head-to-tail frame duration already established in the 
Timeline. You can apply these marks across multiple tracks when 
marking a sequence. This allows you to add overlap cuts.

SPE requires two pieces of information:

¥ The sync points: These are the points where the synchronized 
relationship between the source and record material is established.

¥ The duration of the relationship: This is determined by the posi-
tions of the head and tail frames (and sometimes by the position 
indicator). Both marks can be in one monitor, or one mark can be 
in one monitor and the other mark in the other monitor. The dura-
tion of the material being edited into the sequence must be sufÞ-
cient for the size of the edit.

To perform a sync-point edit:

1. Load a clip or sequence into the Source monitor. 

2. Load a sequence into the Record monitor.
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3.  Mark the material in one of the following ways:

¥ Mark the IN and OUT points in either the Source or Record 
monitor, leaving the opposite monitor clear of marks. 

¥ Mark an IN or OUT point in the Source monitor, or an IN or 
OUT point in the Record monitor. For example, if you marked 
an IN point in the Source monitor, mark the OUT point in the 
Record monitor.

4. Move the source position indicator to the sync frame in the clip. 
This establishes the source sync point.

5. Move the record position indicator in the Source/Record window 
to the sync frame in the sequence.

6. Select Sync Point Editing in the Composer Settings dialog box, or 
choose Sync Point Editing from the Special menu.

Notice the orange box on the Overwrite button that signals that 
Sync Point Editing is active.

7. Select the source and record tracks for this edit. Click the Over-
write button.

The sync point edit is completed.

To turn off Sync Point Editing, deselect the option from the Composer 
Settings dialog box or from the Special menu.

Ganging Footage in Monitors

The Gang function does not combine tracks into a synced relationship, 
but rather locks monitors in sync so that you can move through foot-
age in two or more monitors simultaneously. This is convenient for 
viewing and marking the sequence and source material simulta-
neously, based on syncing of the position indicators in each monitor.

You can gang the Source monitor and/or any number of pop-up mon-
itors with the Record monitor. For instance, before editing them into a 

Orange mark 
indicates Sync 
Point Editing.
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sequence, you can gang a music track in a pop-up monitor, source 
footage in the Source monitor, and a sequence in the Record monitor. 
Then you can view the footage, adjust the sync points, and mark them 
before completing the edit.

To gang monitors:

1. Load a sequence into the Record monitor.

2. Load one or more clips into the Source monitor and/or pop-up 
monitors.

3. Click the Gang button for each monitor that you want to synchro-
nize (the Record monitor is always ganged). The button turns 
green when enabled.

n The Gang button appears by default in the second row of buttons below the 
Source monitor, and in the second row of information above the Source/
Record monitors.

4. View the footage in any of the monitors by using standard play-
back methods. 

Notice as you move through footage in one monitor, the footage in 
all other monitors freezes. The footage is updated when the play 
stops. Simultaneous full-motion playback is not possible, although 
sync is maintained at all times.

Using Match Frame

The Match Frame feature allows you call up and display matching 
footage in the Source monitor from the Record monitor. Reverse Match 
Frame lets you load a source clip and locate its sync frame in the 
sequence.
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Like the Gang function, match framing does not create a permanent 
sync relationship between clips, but instead provides you with a con-
venient way of locating, marking, and editing matching material.

Track selection determines the match frame. If you select a video track, 
the system matches a frame from the video. If you enable several 
tracks, the system matches the frame from the highest selected track 
level, in descending order: V1, A1, A2, and so on.

The Match Frame button appears by default in the second row of but-
tons below the Source monitor. To match frame from footage in the 
Record monitor, you must map the button to the Record monitor pal-
ette.

Performing a Match Frame

To use Match Frame:

1. Load a sequence into the Record monitor.

2. Select a track for the footage you want to match, and place the 
position indicator on a selected frame.

3. Click the Match Frame button.

The system loads the source clip into the Source monitor, parks on 
the match frame, and marks a new IN point to prepare for making 
an edit.

n Any previous IN or OUT marks are removed when you use match frame. To 
override this, Option-click the Match Frame button.

Performing a Reverse Match Frame

To perform a reverse Match Frame:



571

1. Place the position indicator on the desired frame in the source 
footage.

2. Make sure the appropriate tracks are selected in the Timeline.

3. Press the Control key and click the Match Frame button under the 
Source monitor.

The system cues the sequence to the matching frame on the record 
side. If the shot exists in more than one place, the sequence cues to the 
Þrst location of the match frame, and continues through the sequence 
to subsequent locations each time you click the Match Frame button.

Using the Match Frame to Find Sources

The Match Frame function also provides the ability to trace objects 
quickly through their hierarchy of links. For example, you can match 
frame a cut in the sequence to its original subclip, then from the sub-
clip to the original master clip, and Þnally locate the bin in which the 
master clip is saved. 

n For more information on Þnding clips and frames with Match Frame, see 
ÒUsing Match FrameÓ on page 363.
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CHAPTER 18

Multicamera Editing

The Avid Composer multicamera editing tools allow you to incorpo-
rate multiple camera angles easily into the nonlinear editing process. 
Systems equipped with the Multicamera Play option can also play 
back, in real time, up to four camera angles in a Source monitor quad 
split, along with playback of the sequence in the Record monitor. Tech-
niques for using these features are described in the following sections:

¥ Developing a Postproduction Model

¥ Grouping and Multigrouping

¥ MultiCamera Edit Modes

¥ MultiCamera Editing Techniques

¥ Workßow Options

Developing a Postproduction Model

As the name indicates, multicamera production multiplies the amount 
and complexity of source material you manage in a project. As a result, 
comprehensive postproduction planning is essential to avoid the haz-
ards of mismatched shots, takes, and entire reels during digitizing and 
grouping.
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This section presents a postproduction model that can help you orga-
nize your material. While the routines of a typical situation comedy 
are used to illustrate these organizing principles, you can easily adapt 
this model to suit the particular needs of other productions, such as 
sports, documentary, and music videos.

The guidelines of organizing for a large multicamera project are as fol-
lows:

¥ Choose a tape-numbering scheme and be consistent.

¥ Record the multicamera shoot logically according to ofßine and 
online editing needs.

¥ Manage the production path of both sound and picture for quality 
and efÞciency.

Tape Classification Schemes

Because multicamera production involves both sequential and syn-
chronous recording on numerous reels, a comprehensive classiÞcation 
scheme for reels, takes, and clips can help avoid confusion.

Many situation comedies that record on videotape classify their mas-
ter record reels with two digits indicating both the sequential and syn-
chronous identity of the tape, as follows:

¥ The Þrst digit indicates the order in which the reel was recorded.

¥ The second digit indicates the source that feeds the reel.

For example, if there is a line feed or directorÕs cut (a switched version 
of the show), this source is designated with a 0 (zero), so that reel 10 is 
the Þrst reel of the line feed. Reel 11 is the Þrst reel recorded on iso (iso-
lation) camera one, and so forth. 

Each set of reels, then, forms a decimal group, called a tape load. Each 
load is traditionally referred to by its preÞx. In this example, reels 10 to 
14 are called the tens, reels 20 to 24 the twenties, and so on.
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Production Paths

In addition to a numbering scheme, you can organize the ßow of 
recorded material throughout postproduction to make efÞcient use of 
resources and maintain the quality of video and audio.

For videotaped production, often two sets of reels are recorded during 
production: a set of online masters, and a set of ofßine work tapes. The 
online masters remain untouched until editing of the Þnal show mas-
ter begins. Clips from the ofßine work tapes are digitized, then used 
for editing and generating an EDL in Media Composer.

Facilities and tape formats might vary. The basic model can apply to 
any multicamera production in which a broadcast-quality program is 
the goal.

3/4 inch

Beta-
cam

EDL

Online masters

Offline work tapes Digitize Offline Edit

Online Edit Finished program

Simultaneous
multicamera
recording

D2
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Managing Audio

The Media Composer MultiCamera features allow you to patch chan-
nels of audio from any source clip to any track during editing. You can 
strategically designate speciÞc channels of audio to record on speciÞc 
reels or tracks in preparation for editing and generating an effective 
EDL.

In this example, the goal is to create a Þnished master with production 
dialog on channel 1, music and sound effects on channel 2, audience 
left on channel 3, and audience right on channel 4. To achieve this, you 
record channels to ofßine work tapes with only two channels as fol-
lows:

¥ Line Feed: dialog on channel 1, mono audience on channel 2

¥ Camera 1: dialog on channel 1, music and effects on channel 2

¥ Cameras 2 and 3: dialog on channel 1, mono audience on 2

¥ Camera 4: audience left on channel 1, audience right on 2

If the online master tapes are capable of recording four channels of 
audio, these usually duplicate the conÞguration of channels on the 
Þnal master.
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This is just one example. Choose the right path for your production.

Digitizing Workflow

The organization of the digitize bins helps to avoid slowing the system 
with large bins. It also keeps editing resources free of clutter. The basic 
procedure for using the digitize bins is as follows:

1. When you are ready to digitize, create one bin for each tape. This 
keeps bins to a manageable size, and when you autodigitize the 
system automatically names each clip (take) after the name of the 
bin (tape), and numbers them sequentially.

2. Gather the clips for each tape load into one bin. This helps avoid 
accidentally grouping clips with the same timecode from different 
days. Sort the clips by name so they group in the right order.

3. After creating groups or multigroups, move all the new clips into 
a separate bin. This helps simplify the contents of the bin for edit-
ing.

Video &
Audio

Video 
only

Video &
Audio

Dialog &
Audience

Ch 1: Dialog

Ch 2: Music & FX

Ch 3: Audience L

Ch 4: Audience R

channels in Media Composer
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Cam 1

Cam 2

Cam 3

Cam 4
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14 
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only
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Audience
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Effects

Audience L
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only D2
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Using the numbering scheme and production plan described in the 
example, the path of video for the Þrst tape load digitized in Media 
Composer might be as follows:

Digitizing Methods

For more information 
on logging and digitiz-
ing procedures, see 
Chapter 6 and 
Chapter 7.

There are three approaches to digitizing multicamera material:

¥ Log in advance and digitize selected takes: This method allows 
you to shorten the time required for digitizing and to lessen the 
amount of digitized material by logging timecodes noted on 
selected takes during the shoot and subsequent screenings.

¥ Log and digitize all takes in advance: This is similar to the previ-
ous method, except that you save less storage space by digitizing 
portions of all takes.

¥ Autodigitize entire reels: This method allows you to bypass the 
logging procedure, but requires the most storage space.

Line

Cam 1

Cam 2

Cam 3

Cam 4

2. Gather each tape load
into one bin, sort by name, 

3. Gather all multigroups 
into one bin for easy access.

1. Digitize each reel separately.

11 

12 

13 

10

14 

then multigroup.
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However you choose to digitize, you should have accurate notes on 
the number and content of takes on each reel in order to identify the 
content of each clip when necessary. 

Logging Tips

For additional logging 
tips, see ÒLogging 
TipsÓ on page 109.

The following tips apply to methods that involve logging in advance 
for digitizing multicamera material:

¥ Narrow the IN and OUT points to avoid false starts on one or 
more reels in a tape load.

¥ Save time by logging just one ISO reel in each tape load, exporting 
in the .ALE format, modifying reel and clip names in a text editor, 
then reimporting into bins for each of the other reels.

¥ When logging in advance, name each clip with the source tape 
name (same as the master tape to be used in online) and a cut 
number, for quick identiÞcation when clips get moved or copied.

Autodigitizing Tips

The following tips apply to autodigitizing entire reels:

For more on Digitize 
Settings and Deck Set-
tings, see the Avid Media 
Composer Products Refer-
ence.

¥ Select the ÒDigitize across timecode breaksÓ option in the Digitize 
Settings dialog box prior to digitizing.

¥ Select the ÒLog errors to the console and continue digitizingÓ 
option in the Digitize Settings dialog box.

¥ Under Deck Settings, turn off the Fast Cue option and set the pre-
roll to approximately 4 seconds.

¥ When loading a tape and assigning a name to a source reel, give 
the reel the same name as the online master tape (same as the 
work tape).

¥ Name each bin after the source reel number. By default, all clips 
are named after the reel and numbered incrementally beginning 
with the sufÞx .01.
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¥ To start digitizing, cue the source reel past any false starts, play the 
tape, and wait 4 seconds before clicking the Record button in the 
Digitize Tool.

Storage Tips

The following tips can help you make the best use of storage drives:

¥ To save storage space, digitize only the audio channels required 
for ofßine editing.

¥ For the most efÞcient playback of multicamera material, distribute 
the reels in each tape load between drives.

¥ To avoid switching drives while digitizing the same reel, target 
one volume per reel whenever possible.

With a large multicamera production, you can plan the use of drives in 
advance, based on the number of drives available, the chosen AVR, 
and the length of each reel. 

Consider the following example:

¥ You have a four-camera production yielding two tape loads 
(approximately 50 minutes per tape).

¥ You want to autodigitize at AVR 3m.

¥ You need to digitize 2-channel audio at 44.1 kHz from cameras 
one and four.

¥ For storage, you have four 4-GB drives.

With this set of circumstances, you might distribute the media as 
shown in the following illustration. Storage requirements are based on 
information provided in the Avid Media Composer Products Reference.
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Checking the Bins

Before gathering the digitized clips into bins for grouping, you should 
open the bins in each tape load and compare the clips for inconsisten-
cies. You can take steps to conform the bins now and avoid problems 
during grouping and editing, as described in the following sections.

Replacing Missing Clips

If one bin has fewer clips than the others in the tape load, the ISO reel 
might have been stopped during a particular take. If you group the 
take with the missing camera, the shots shift in the Quad Split to Þll 
the missing angle, which can disorient the editor. Correct this problem 
by creating a dummy clip.

To create a dummy clip:

1. Log a new source clip into the bin.

2. Match the timecode from one of the clips from another camera, 
and use any name.

002 

003 

004 

005 

001

Work tapes Tracks digitized Storage required Targeted drive

3.5 GB

2 GB

2 GB

3.5 GB

2 GBX 2

X 2

X 2

X 2

X 2
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When the clips are grouped and loaded during editing, this dummy 
clip displays the message ÒMedia Ofßine,Ó and maintains the distribu-
tion of camera angles in the Quad Split.

Deleting Extra Clips

For speciÞc procedures 
for deleting clips, see 
ÒDeleting Clips and 
SequencesÓ on 
page 235.

If a particular bin has more clips than the others in the load, one or 
more false starts might have been recorded during digitizing. If you 
create a multigroup, the extra clips form unusable sections with only 
one or two camera angles. 

To eliminate the clips:

1. Compare timecodes among bins until you isolate the unique clips.

2. Load the clips into the Source monitor, and/or compare timecodes 
with a line script if available.

3. If the clips are useless, delete them and their media until you have 
the same takes in each bin. 

Checking Audio and Image Quality

Check the Audio column to make sure the audio was recorded on the 
correct channels, from the correct source reels, at the correct kHz. You 
cannot play back audio compressed at different rates within the same 
group or multigroup.

You can also spot-check the picture quality by loading two or more 
clips from each bin into the Source monitor and viewing the clips. If 
you Þnd a problem, you can redigitize before the edit session begins.

Additional Offline Editing Aids

If you are editing your multicamera material with the intention of gen-
erating an EDL and preparing a master tape in an online tape editing 
suite, Media Composer provides features speciÞcally designed to aid 
the ofßine editing process, including:
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For more information 
on these features, see 
Chapter 14.

¥ Color Frame tracking, for avoiding color frame shifts in online 
editing with 1-inch videotape

¥ Dupe Detection, for avoiding duplicate frames in online editing

Grouping and Multigrouping

The grouping and multigrouping procedures both gather selected 
clips into a single unique clip. Both allow you to use special Multi-
Camera editing features, such as Quad Split and cutting on-the-ßy in 
MultiCamera mode. The difference between the two can be summa-
rized as follows:

¥ Grouping creates a separate group clip out of a single set of master 
clips, from the IN point to the OUT point of the longest clip. Multi-
grouping takes the Group function one step further, literally 
stringing numerous sequential groups into a rough sequence. For 
this reason, multigroups are also known as sequence clips.

¥ The Group function allows you to sync clips based on common 
source timecode, auxiliary timecode, or marks placed in the foot-
age. Because of the need for complete accuracy in sorting and 
grouping the clips, multigrouping is performed on the basis of 
common source timecode only.

¥ The MultiGroup function is designed primarily for situation com-
edies and similar productions that record multiple takes sequen-
tially on the same source tapes. Multigrouping does not provide 
any beneÞt when you edit with clips that do not share common 
timecode or were not recorded sequentially, and might even cause 
the wrong clips to be grouped together.

Creating Group Clips

In addition to the multicamera context, grouped clips can be useful in 
other circumstances. Unlike multigrouping, which requires clips with 
matching source timecode, you can group clips that were shot at dif-
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ferent times, on different days, and on completely different source 
tapes. This means that you can:

¥ Use group clips to create montage sequences quickly with fast-
cutting between unrelated shots

¥ Use group clips to sync and edit an audio track (music for 
instance) with two or more video tracks (especially useful in 
music-video editing)

¥ Use group clips for multicamera editing when you want to isolate 
each take as a group, and edit selectively, rather than build a larger 
sequence clip

¥ Use carefully synchronized marks to group selected portions of 
multicamera clips

The last two options are generally for use in smaller multicamera 
projects. Sorting, marking, selecting, and grouping individual takes of 
a larger project can be very time consuming.

To create a group clip:

1. If you are using a sync point, load the clips and mark an IN at the 
sync point at the start of each clip, or mark an OUT at the sync 
point at the end of each clip.

n For multicamera video or Þlm shoots, you typically use a slate for marking IN 
and OUT points. But you can use any visual or aural event that is recorded 
by all cameras simultaneously.

2. In the bin, select all the clips you want to group.

3. Choose Group Clips from the Bin menu. The Group Clips dialog 
box appears.
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4. Select an option, based on the following:

¥ Film TC/Sound TC: If you are syncing clips with matching Þlm 
and sound timecode recorded in the Þeld. This option is 
dimmed if you are not working on a Þlm project.

¥ Inpoints: If you are syncing according to IN points set in each 
clip.

¥ Outpoints: If you are syncing according to OUT points set in 
each clip.

¥ Source Timecode: Select if the clips have matching timecode.

¥ Auxiliary TC1-TC5: If the clips have matching timecode in the 
same auxiliary timecode column.

5. Click OK. A group clip appears in the bin, with the name of the 
Þrst clip in the group, followed by the extension Ògrp.n.Ó 

The n is an incremental numbering of group clips with the same 
name in the same bin. You might want to rename this to some-
thing easier to read, such as name.Group.



585

Creating Multigroup Clips

Multigrouping is strictly for use in large multicamera productions, 
such as situation comedies, in which all synchronous camera shots are 
recorded with the same timecode. The MultiGroup function is a single 
Bin menu command that eliminates the time-consuming steps of col-
lecting, sorting, grouping, and assembling large volumes of multicam-
era clips.

To multigroup your material:

1. Sort the clips by name in the bin. 

2. Choose Select All from the Edit menu to select the master clips.

3. Choose MultiGroup from the Bin menu.

The system creates several group clips for each take in the bin, 
then creates a multigroup from the groups. The multigroup has 
the same icon as the groups, but the icon is preceded by a plus 
sign.

MultiCamera Edit Modes

The three edit modes you use during multicamera editing are Full-
Monitor display, Quad Split, and MultiCamera mode. You can edit 
with either group clips or multigroup clips in all three modes.
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Full-Monitor Display

When you Þrst load a grouped or multigrouped clip, the Source moni-
tor displays a single frame from one clip in the group in Source/
Record mode. This is called Full-Monitor display when working with 
group clips, because you can view each angle in full-monitor size as 
you edit. Also, in Full-Monitor display, the full-screen monitor also 
remains full screen.

The basic features of Full-Monitor display are as follows:
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¥ Provides source-oriented control of multicamera material. In other 
words, you can switch camera angles, cue, and mark material 
without affecting the sequence.

¥ Provides all the same Source monitor controls that are available 
when editing other clips in Source/Record mode.

¥ Provides all the same multicamera editing tools that are available 
in Quad Split and MultiCamera mode. These are described in 
ÒMultiCamera Editing TechniquesÓ on page 591. The only dis-
tinction is that in Full-Monitor display you can view each angle 
full-size as you edit.

Quad Split

After loading a group clip into the Source monitor, you enter Quad 
Split by clicking the Quad Split button located in the Command Pal-
ette on the MCam command tab. The Source monitor splits into four 
quadrants. A Group Menu icon appears in the second row of informa-
tion above the Source and Record monitors. The third monitor dis-
plays the Quad Split when the Source monitor is active, and full-
screen when the Record monitor is active.
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The basic features of Quad Split are as follows:

¥ Provides source-oriented control of multicamera material, like Full-
Monitor display. In other words, you can switch camera angles, 
playback, cue, and mark material without affecting the sequence.

¥ Provides the same Source monitor controls that are available when 
editing other clips in Source/Record mode.

Quad Split display Sequence or linecutGroup Menu icon
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¥ Provides all the special multicamera editing features that are avail-
able in Full-Monitor and MultiCamera mode, as described in 
ÒMultiCamera Editing TechniquesÓ on page 591.

¥ Provides a list of all group clip video and audio tracks in the 
Group menu for custom selection and patching.

¥ Allows you to toggle the Quad Split button to switch the Source 
monitor between Full-Monitor and Quad Split viewing and edit-
ing (editing functions are the same in both).

¥ Displays whichever monitor is active in the third monitor (you can 
toggle between Quad Split and full-screen as needed).

MultiCamera Mode

After loading a group clip into the Source monitor and editing it to cre-
ate a new sequence, you choose MultiCamera Mode from the Special 
menu to activate the features. MultiCamera mode takes the Quad Split 
one step further: it gangs all shots in the group clip displayed in the 
Source monitor to the sequence footage displayed in the Record moni-
tor. All shots are synchronized and continuously updated during play-
back and editing.
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The basic features of MultiCamera mode are as follows:

¥ Provides sequence-oriented control of multicamera material, in con-
trast to Full-Monitor and Quad Split. In other words, whenever 
you play back, cue, switch camera angles, or mark material, your 
changes take place in the sequence.

¥ Provides only Record monitor controls.

Source monitor controls are 
disabled

The Gang icon turns 
green.   

Group Menu icon
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¥ Provides special MultiCamera editing features that are available in 
Full-Monitor display and Quad Split, as described in ÒMultiCam-
era Editing TechniquesÓ on page 591.

¥ Provides the ability to cut between shots on-the-ßy during full-
motion playback, as you would during live switching of a show.

¥ Provides a list of all video and audio tracks in the group in the 
Quad Split menu, for custom selection and patching.

¥ Lets you deselect MultiCamera Mode in the Special menu at any 
time to switch between source-oriented and sequence-oriented 
multicamera editing.

¥ Lets you deselect MultiCamera Mode when you need to play back 
full-screen.

MultiCamera Editing Techniques

When you load a group or multigroup clip into the Source monitor 
and begin editing, the Timeline provides a unique display of the clip 
name to indicate the presence of a group. 

The system uses the name of the clip within the group to identify the 
shot in each cut, but adds a G in parentheses to indicate the group.

Using various keys and functions, you can switch and edit the dis-
played group shot at any point in the sequence, as described in this 
section. These features apply to both group and multigroup clips.

(G) indicates a group clip.
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Switching Shots with the Arrow Keys

You can switch the display of camera angles by using the Up Arrow 
and Down Arrow keys. The angle selection switches in either the 
Source monitor (source material) or in the Record monitor (sequence 
material), whichever is active.

When the Record monitor is active, you can place the position indica-
tor within any segment and use the arrow keys to switch the group 
shot selected for that segment.

n Whenever you switch camera angles, you also switch the frame representing 
the group in the bin. You can use this method to change the representative 
frame for bin display and storyboarding.

Cutting On-the-Fly with Hot Keys

You can switch the display of up to eight camera angles by using hot 
keys on the keyboard. The default hot keys are F9 to F12 for cameras 1 
to 4. You can map an additional four cameras from the Command Pal-
ette to the keyboard for the full eight.
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If you press a hot key when the footage is stopped, the system 
switches the camera angle and also creates an edit in the sequence. You 
can use this method to walk through one long group or multigroup 
sequence and edit camera angles as you go.

n To switch without creating a cut, hold the Option key when you press a hot 
key.

You can also cut on-the-ßy during playback by using the hot keys. Sys-
tems equipped with the Media Composer Release 6.0 or later can cut 
on-the-ßy with live playback of all four quadrants, creating a virtual 
live-switching environment with the added ability to stop, trim, or 
adjust edits at any time

Using the MultiCamera Linecut Option

The Linecut option in the Composer Settings dialog box allows you to 
edit and playback a linecut (single stream playback of the edited 
sequence) while in MultiCamera mode. Primarily for systems that 

F10

F11 F12

F9

Key equivalents for quadrants:
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include the Avid MultiCamera Play option, this preference allows you 
to switch between singular and quad-split playback without exiting 
MultiCamera mode. The Linecut option is not selected by default.

To select the Linecut option:

1. Double-click Composer in the Settings scroll list of the Project win-
dow. The Composer Settings dialog box appears.

2. Select Play MultiCamera Linecut.

Using the Add Edit Button

You can use the Add Edit button like a hot key to add edits while step-
ping through a sequence, or on-the-ßy during playback. The only dif-
ference is that you are not switching camera angles until after you set 
the edit points. 

This method is especially useful when editing to music because it 
allows you to concentrate on the beats and ignore camera angles until 
the edits are placed.

To use this method, you must Þrst map the Add Edit button onto the 
keyboard. Consider mapping the Add Edit button to a function key 
next to the default hot keys. For more information on mapping keys, 
see ÒAbout Button MappingÓ on page 96.

To add edits on-the-ßy:

1. Load the group or multigroup into the Source monitor and splice 
it into a sequence.

2. Play the sequence. Each time you want to make an edit, press the 
Add Edit key. When you stop the sequence, the edits appear in the 
Timeline.

Play the sequence repeatedly to add more edits, or remove edits in 
Trim mode by lassoing them in the Timeline and pressing the 
Delete key.
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3. After adding the edits, place the position indicator within each 
segment and use the arrow keys to switch camera angles. 

Using the Group Menu

The Group menu allows you to select video or audio channels from 
any of the clips in the group and patch to the tracks available in the 
sequence. This means that you can potentially have eight camera 
angles and eight or more audio tracks synchronized and available for 
patching at any time.

n The Second Row of Info option must be selected in Composer Settings to dis-
play the Group Menu icon above the Source monitor.

In addition, you can choose the Audio-Follow-Video option from the 
Group menu to instruct the system to switch both audio and video for 
each camera angle together when you cut on-the-ßy or single-camera 
style. 

Click the Group Menu icon 
to display the pop-up menu.
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Audio-Follow-Video overrides the track selection beside the Timeline 
and switches audio in track A1 only. Audio-Follow-Video edits appear 
in the Timeline as match frames (that is, the transition contains an 
equal sign).

Using the Group Angle Menus

You can use the Group menus to group up to eight clips at a time, and 
select additional shots to display in any of the Source monitor quad-
rants.

To select an additional shot from the group to display in one of the 
quadrants:

1. Press the Control key to activate the display of shot names in the 
Source monitor quad split.

2. Click the name of the quadrant where you want to display the 
new shot. The Group menu of shots in the group appears. 

Select additional 
angles from the 
Group menu 
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3. Choose the shot you want to display from the menu. The new shot 
appears in the quadrant.

Using Match Frame in Multicamera Editing

You can use the Match Frame button to call up the matching shot 
within the group when matching from the sequence. Or you can call 
up the original clip when match framing from the source group. For 
more information on using the Match Frame feature, see ÒUsing 
Match FrameÓ on page 569.

Workflow Options

The Media Composer MultiCamera editing features make possible 
three basic workßow models for cutting multiple-angle shows: selec-
tive camera cutting, cutting on-the-ßy, and combination cutting. Each 
workßow option has its own advantages. When and how to use them 
is a matter of preference.

Selective Camera Cutting

Selective camera cutting involves marking and editing source material 
into the sequence, much as you build a sequence by using nongrouped 
clips in a normal session. You can play, cue, and mark clips on the 
source side, then splice, overwrite, and trim shots in the sequence.

You can perform selective camera cutting in two ways: 

¥ Lay down an entire group as a master sequence, then add edits, 
switch camera angles, and trim within the sequence or cut in new 
shots.
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¥ Edit one clip at a time, without laying down a master sequence 
Þrst, effectively building a sequence as you would with
single-camera material. 

The advantage of selective camera cutting with grouped clips is that 
all the clips are synchronized, for simpliÞed selection of camera 
angles. Selective camera cutting generally requires use of a detailed 
line script, or detailed notes, that enable you to select shots and assem-
ble the sequence one clip at a time.

To perform selective camera cutting:

1. Load the group or multigroup into the Source monitor.

2. Using timecode notes and the numeric keypad, type in the time-
code for the Þrst take to begin the sequence, and press Enter to cue 
the clip in the Source monitor to the take.

3. Mark IN and OUT points for the entire scene.

4. Select a camera angle for the Þrst shot, then splice the entire scene 
into a sequence. 

5. Use the arrow keys and/or the Add Edit button to select edit 
points and switch to different angles throughout the master scene 
in the sequence.

6. To replace a portion of the take with a better part from another 
take, use the timecode notes again to cue up the take, set marks, 
and perform a replace edit.

7. When you are Þnished with a scene, repeat the procedure for each 
additional scene in the sequence.

Cutting On-the-Fly

When cutting on-the-ßy, you use MultiCamera mode in conjunction 
with the hot keys (function keys F9 to F15) to switch between Quad 
Split camera angles ganged to the record sequence. The capability of 
full-motion quad-split playback with the Avid video board set allows 
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you to virtually re-create the live event atmosphere, as though you 
were switching the shots live on location.

While you are cutting on-the-ßy, the Source monitor controls are dis-
abled. You cannot mark IN and OUT points as you do during selective 
camera cutting. Generally, you are editing from the quads according to 
the action in the Record monitor.

To cut on-the-ßy:

1. Load the group or multigroup into the Source monitor.

2. Using timecode notes and the numeric keypad, type in the time-
code for the Þrst take to begin the sequence and press Enter to cue 
the clip in the Source monitor to the take.

3. Mark IN and OUT points for the entire scene.

4. Select a camera angle for the Þrst shot, then splice the entire scene 
into a sequence.

5. Choose MultiCamera Mode from the Special menu to enter Multi-
Camera mode.

6. Play the sequence from the beginning. Watch the shots in the 
Quad Split and the sequence footage in the Record monitor; then 
use the hot keys to switch to different angles on-the-ßy.

7. Press the space bar to stop the sequence and update the Timeline 
to include all the edits you made while cutting. Repeat the proce-
dure until you have the edits you want.

8. When you are Þnished with the scene, repeat the procedure for 
each additional scene in the sequence.

After cutting in various angles, you can adjust transitions and/or edit 
out the superßuous material from the sequence in Trim mode.
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Combination Cutting

Combination cutting involves the use of both selective camera cutting 
and cutting on-the-ßy interchangeably. Most productions use both 
methods at one time or another. Others use them in combination 
throughout postproduction. The following are two examples:

¥ If you are editing a situation comedy or similar production that 
requires a speciÞc show length for the Þnished master, you can 
begin using selective camera cutting to edit the show for time. 
This often involves emphasizing the audio on the Þrst editing pass 
(also known as a radio edit), and then cutting on-the-ßy in subse-
quent passes to get the timing of shot transitions and cutaways.

¥ If you are editing a live-on-tape event, such as a concert or comedy 
club performance, you can begin by cutting on-the-ßy to capture 
transitions spontaneously. However, you have the added beneÞt 
of stopping and returning to a transition if you make a mistake, 
and trimming or adjusting edits in a nonlinear fashion.

The difference in alternative editing styles is a matter of preference. 
Choose the approach that works best for your production.
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CHAPTER 19

Output Options

The Avid Composer system provides tools for generating output for 
individual tracks or entire sequences to various videotape or audio-
tape formats. In addition, you can generate an edit decision list (EDL) 
to be used by editors in a videotape suite for preparing a master tape. 
You can also use VTR emulation for direct playback of sequences by 
using an edit controller in an analog editing suite. These options are 
described in the following sections:

¥ Preparing for Output

¥ Recording a Digital Cut

¥ Using EDL Manager

¥ VTR Play Emulation

Preparing for Output

Preparing for video output involves the following procedures:

¥ Render all non-real-time effects, as described in the Avid 
Media Composer and Film Composer Effects Guide.

¥ Calibrate and adjust video output levels, as described in ÒCali-
brating for Video OutputÓ on page 602.
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¥ Calibrate and adjust audio output levels, as described in ÒPrepar-
ing for Audio OutputÓ on page 608.

For more information 
on mixing down audio 
tracks, see ÒMixing 
Down Audio TracksÓ 
on page 553.

¥ Decide whether you want to generate stereo or mono audio.

¥ Mix down multiple audio tracks if necessary. Systems equipped 
with a two-channel audio board can generate a maximum of two 
channels. Systems equipped with the Digidesign audio interface 
can generate a maximum of four channels. 

¥ Prepare the record tapes.

¥ (Optional) Record reference bars and tone to tape.

Calibrating for Video Output

Read the information in the following sections based on the following:

¥ Calibrating for video output (optional): All users can follow the 
steps for calibrating video output, as described in ÒBasic Output 
CalibrationÓ on page 602.

¥ Calibrating/syncing output signals in a production facility: 
Advanced users and house engineers should follow the steps for 
adjusting and conforming output signals to house standards, as 
described in ÒAdvanced Output CalibrationÓ on page 604.

Basic Output Calibration

You can calibrate by using digital bars and tone that you create and 
edit into the sequence, as described in this section.

n If you or your site engineers calibrate the system as a general maintenance 
procedure, or if you do not have an external Waveform monitor, leave the 
Video Output Tool set to the preset values.

To calibrate for video output:

1. Choose Video Output Tool from the Tools menu. The tool opens.
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n The Video Output Tool for systems equipped with the serial digital video I/O 
board for recording to a D1 or digital Betacam VTR displays a single slider 
control for H-Phase adjustment only. All other levels remain in digital form 
and cannot be adjusted from within Media Composer.

2. Cue the sequence to bars and tone, and click or press Play (basic 
calibration requires digital bars and tone). Color bars are dis-
played on the third, full-screen monitor, and signal appears on the 
Waveform and Vectorscope monitors.
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3. Adjust luminance values based on the video format and the type 
of bars in the sequence.

4. To save this setting, choose Save As from the Settings pop-up 
menu, type a name, and click OK.

Advanced Output Calibration

Advanced users and site engineers can Þne-tune output calibrations 
by using test patterns, genlock options, and signal timing controls, as 
described in this section.

Displaying Advanced Calibration Controls

To display the advanced calibration controls in the Video Output Tool, 
click the arrow button at the lower left corner of the window.

The additional options appear and the arrow button points down. To 
return to the normal display, click the arrow again.

Test Patterns Genlock pop-up menu

Composite output 
settings

Component output 
settings

pop-up menu
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Using Test Patterns

The expanded Video Output Tool provides a pop-up menu of test pat-
terns you can use to calibrate the system output. To display a test pat-
tern, click the pop-up menu and choose a pattern.

You can add test patterns to the list by doing the following:

1. Close the Media Composer application.

2. Find or create a PICT Þle for a chosen pattern.

n You can create your own test pattern Þles by digitizing the pattern from vid-
eotape, and exporting it as a PICT Þle. You can improve the accuracy of the 
image by correcting colors and removing errors in a third-party application 
such as Adobe Photoshopª.

3. Place the Þle into the Test Patterns folder in the Supporting Files 
folder, which is located in the Media Composer folder on the Avid 
drive.

4. Start the Media Composer application. The new pattern appears 
in the Test Patterns pop-up menu on the Video Output Tool.

Calibrating Site Output Settings

If you have connected a Waveform monitor between the output of the 
Avid system and your video destination, you can use the Video Out-
put Tool to adjust the video output levels and timing to reference 
video.

n If you do not have external Vectorscope and Waveform monitors, leave the 
calibration settings at their preset values.
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To calibrate the output signal:

1. Choose Video Output Tool from the Tools menu. The tool opens.

2. Click the arrow button at the lower left corner, if the left side (Out-
put: Composite) display shows only two sliders.

Additional options appear and the arrow button points down.

3. Choose the appropriate genlocking method from the Genlock 
menu:

¥ Choose External to use a genlock source connected to the Avid 
video boardÕs genlock input. Make sure a genlock source is 
attached.

¥ If there is no external source, choose Internal to create an inter-
nal reference signal.

4. Choose ColorBars from the Test Patterns pop-up menu.

Standard full-Þeld, 75% color bars appear on the third, full-screen 
monitor, and on the Vectorscope and Waveform monitors.

5. Set luminance values based on the settings in Table 19-1.

Test Patterns Genlock pop-up menu

Composite output 
settings

Component output 
settings

pop-up menu
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6. Adjust chrominance levels as follows:

¥ For composite video, for NTSC users, set hue by adjusting the 
SC Phase slider until the six color vectors fall within the target 
boxes on the vectorscope. 

n If you do not have separate Vectorscope and Waveform monitors, you can use 
the full-screen monitorÕs Òblue onlyÓ feature, if available, to adjust SC phase 
(hue) for composite output. To determine if you have this feature, see the doc-
umentation supplied with your monitor.

¥ Set subcarrier to horizontal phase timing by adjusting the 
SC/H slider according to house standards.

n SC/H phase becomes important only when video signals from two or more 
sources are combined or sequentially switched. If this is not the case, leave the 
SC/H slider at the preset value.

Table 19-1 Luminance Settings 

Parameter SMPTE bars Full-Þeld bars at 
75% signal level

Full-Þeld bars at 
100% level

NTSC/EIAJ

Black level (setup) Adjust Line Selector 
slider to 183

Adjust Line Selector 
slider to 150

Any line Any line

Adjust Black slider 
to 
7.5 IRE (NTSC)

Adjust Black slider 
to
7.5 IRE (NTSC), 
0.3 volts (PAL)

Adjust Black slider 
to
7.5 IRE (NTSC), 
0.3 volts (PAL)

Adjust Black 
slider to 
0.0 IRE

White level (gain) Adjust Line Selector 
slider to 203

Adjust Line Selector 
slider to 150

Adjust Line Selector 
slider to 150

Adjust Line Selec-
tor slider to 203

Adjust Gain/Y 
Gain slider to 
100 IRE (NTSC)

Adjust Gain/Y 
Gain slider to 
77 IRE (NTSC), 
.825 volts (PAL)

Adjust Gain/Y 
Gain slider to 
100 IRE (NTSC), 
1.0 volts (PAL)

Adjust Gain/Y 
Gain slider to 
92.5 IRE
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¥ Set the horizontal phase by adjusting the H Phase slider 
according to house standards.

¥ For component video, use a three-channel Waveform monitor 
to calibrate R-Y gain. For NTSC users using 75% color bars, 
the R-Y value should have a peak-to-peak deviation of 
700 millivolts. PAL users should have a peak-to-peak devia-
tion of 525 millivolts.

¥ Calibrate B-Y gain by adjusting the slider. For NTSC users 
using 75% color bars, the B-Y value should have a peak-to-
peak deviation of 700 millivolts. PAL users should have a 
peak-to-peak deviation of 525 millivolts.

Save this setting by choosing Save As from the Settings pop-up menu, 
typing a name, and clicking OK.

Preparing for Audio Output

The Audio Tool allows you to generate and customize calibration tone, 
and adjust global output levels. For information on additional audio 
mix procedures such as adjusting volume and pan, mixing down 
selected tracks, or ignoring mix levels, see Chapter 16.

Setting the Calibration Tone

The Audio Tool provides an internal calibration tone that you can cus-
tomize and play as a reference signal on a digital cut. You can use the 
recorded reference signal for calibrating the digital cut audio at 
another site. 

The default tone playback is Ð14 dB (digital scale) with a 1000-Hz sig-
nal. In some cases you might need to customize the signal. For exam-
ple, a common reference signal convention for audio work involves 
recording 30-second segments of 1-kHz, 10-kHz, and 100-Hz tone back 
to back.
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To change the parameters for the calibration tone:

1. Choose Set Calibration Tone from the Peak Hold pop-up menu. 

A dialog box appears.

2. Enter new values for the tone level and frequency, and click OK.

To play back the tone, choose Play Calibration Tone from the Peak 
Hold pop-up menu. To check the adjusted tone level in the meters, 
make sure the In/Out toggle buttons are toggled to O for Output.

Calibrating Global Output Levels

You can use the meters and a master attenuator (output slider control) 
in the Audio Tool to make global level adjustments for output from the 
system. These adjustments affect levels for all output tracks to both the 
speakers and to record devices. The procedures differ slightly for sys-
tems equipped with a four-channel audio board and systems 
equipped with a two-channel audio board.
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c Normally you should leave this setting at the factory preset of 0 dB. 
Adjust the level only when necessary to raise or lower the overall 
volume based on the headroom parameters of the record format, or 
consistently overmodulated or undermodulated source material.

Adjusting Output on Four-Channel or Eight-Channel Audio Board 
Systems

To adjust global output from a four-channel or eight-channel audio 
board system:

1. Choose Audio Tool from the Tools menu.

2. Click the output level button (the speaker icon) to display the mas-
ter attenuator (slider).

3. Click the Output Options button to open the options panel.

4. Choose a type of output from the Output Type pop-up menu.

Peak Hold pop-up
Output Type pop-up menuMaster attenuatorOutput Options button

Output Options panel

In/Out toggle buttons

Track number displays

Channel assignments Mix Tracks
pop-up menu

Output Level button

Reset Peak button
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¥ Choose Stereo Mix to mix the currently monitored audio 
tracks into a stereo pair.

¥ Choose Mono to pan all the currently monitored tracks to cen-
ter.

¥ Choose Direct Out to map tracks directly to up to eight-chan-
nels of output (depending on your hardware conÞguration).

5. (Option) Depending on your type of output, you can make addi-
tional adjustments:

¥ By default, Stereo Mix directs the mixed tracks to output chan-
nels 1 and 2. Alternatively, you can choose Mix To 3 & 4 from 
the Mix Tracks pop-up menu.

¥ By default, Direct Out maps all audio tracks in numerical 
sequence to existing output channels. You can remap a track to 
any channel by clicking the channel assignment display and 
choosing another channel.

¥ You can select Ignore Volume or Ignore EQ to disable the cus-
tomized pan, volume, or equalization effects you applied with 
the audio tools.

6. Click the In/Out toggle buttons above the meters to display O for 
Output.

7. Play back one of the following sources of reference audio:

¥ Choose Play Calibration Tone from the Peak Hold pop-up 
menu.

¥ Play back a representative sequence or clip containing audio.

8. Watch the levels in the meters, and adjust the master attenuator to 
the level that you want.

n To adjust levels for individual tracks, you must use the Audio Mix Tool.

9. Close the tool.
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Adjusting Output on Two-Channel Audio Board Systems

Systems equipped with two-channel audio boards (Avid Xpressª, 
Media Composer Ofßine, Media Composer 900, 
Media Composer 1000) can use the Pro Level option to take advantage 
of the professional audio output features of the board. 

By default, the ÒproÓ output levels option is not selected, and the vol-
ume scales for output sliders in the Audio Tool reßect levels for con-
sumer-grade VCRs and recording devices.

To adjust the levels for recording to professional record decks:

1. Choose Audio Tool from the Tools menu.

2. Click the Output Level button (the speaker icon) to display the 
master attenuator (slider) and the Pro L. check box.

3. (Option) Select the Pro L. check box to enable professional output 
levels.

4. Click the Output Options button to open the options panel.

Master attenuator

Output Level 
button

Output Options button
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5. Choose a type of output from the Output Type pop-up menu:

¥ Choose Stereo Mix to mix the currently monitored audio 
tracks into a stereo pair.

¥ Choose Mono to pan all the currently monitored tracks to cen-
ter.

¥ Choose Direct Out to map tracks directly to up to eight chan-
nels of output (depending on your hardware conÞguration).

6. (Option) Depending on your type of Output, you can make addi-
tional adjustments:

¥ By default, Stereo Mix directs the mixed tracks to output chan-
nels 1 and 2. Alternatively, you can choose Mix To 3 & 4 from 
the Mix Tracks pop-up menu.

¥ By default, Direct Out maps to all audio tracks in numerical 
sequence to existing output channels. You can remap a track to 
any channel by clicking the channel assignment display and 
choosing another channel.

¥ You can select Ignore Volume or Ignore EQ to disable the cus-
tomized pan, volume, or equalization effects you applied with 
the audio tools.

7. Click the In/Out toggle buttons above the meters to display O for 
Output.

8. Play back one of the following sources of reference audio:

¥ Choose Play Calibration Tone from the Peak Hold pop-up 
menu.

¥ Play back a representative sequence for clip containing audio.

9. Watch the levels in the meters and adjust the master attenuator to 
the level that you want.

10. Close the tool.
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Preparing Record Tapes

There are two basic methods of recording to tape: frame-accurate 
recording by using the Digital Cut Tool, and manual recording by 
using controls on the record deck. Each of these methods requires dif-
ferent treatment of the record tapes.

Frame-Accurate Recording

Frame-accurate recording involves using the Digital Cut Tool to record 
your sequence onto a prestriped tape (a tape with prerecorded control 
track and timecode), or a partially striped tape.

Before you can record a frame-accurate digital cut, you must prepare 
the record tapes in advance by using one of the following options:

¥ If you intend to perform assemble edit recording, you must record 
black with timecode onto the tape including the necessary preroll 
prior to the IN point plus at least 10 seconds.

¥ If you intend to perform insert edit recording, you must stripe the 
record tapes (record black and timecode for the entire duration of 
the tape) in advance.

Manual Recording

Manual recording (sometimes referred to as crash recording) involves 
bypassing deck control in Media Composer and using manual opera-
tion of the record deck. Because the timing of playback is based on 
manual procedures, the recording is not frame-accurate. However, you 
do not need to record timecode onto the tape in advance. You can also 
record onto non-Avid-controlled decks, such as consumer grade VHS 
or Hi8.

To record manually:

1. Set the serial control switch on the record deck to Local.

2. Use the controls on the deck to start the videotape recording.
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3. Play the sequence in Media Composer. 

Recording Bars and Tone

You can also record a portion of bars and tone onto the tape before 
recording a digital cut. There are two methods of recording bars and 
tone to tape:

¥ If your recording must be frame-accurate, then consider adding a 
segment of digital bars and tone to the front of your sequence, or 
prepare it as a separate sequence that you can record by using the 
Digital Cut Tool. For more information, see ÒPreparing Digital 
Bars and ToneÓ on page 264.

¥ If your recording does not need to be frame-accurate, you can 
manually record direct output of bars and tone from Media Com-
poser.

To manually record bars and tone:

1. Open the Video Output Tool and the Audio Tool by choosing them 
from the Tools menu.

2. Choose a color bars pattern from the Test Patterns pop-up menu in 
the Video Output Tool.

3. Choose Play Calibration Tone from the Peak Hold pop-up menu in 
the Audio Tool.

4. Place the record deck on Local for manual recording.

5. Record the bars and tone as either an insert or assemble edit 
according to the operation of your record deck and chosen 
method.

Enabling Assemble-Edit Recording

Insert editing is the default setting for the Digital Cut Tool. You can 
also use assemble-edit settings in Media Composer, along with the 



616

assemble-editing capabilities of your record deck, to quickly record 
frame-accurate digital cuts without striping entire tapes in advance.

c To avoid accidentally breaking timecode on prestriped tapes during 
Digital Cut recording, enable assemble editing only when in use, 
and disable it during normal insert edit recording.

 To enable assemble editing:

1. Double-click Deck Preferences in the Settings scroll list of the 
Project window to open the Deck Preferences dialog box.

2. Select the option ÒAllow assemble edit for digital cut.Ó

Once assemble editing is enabled, you select additional options in the 
Digital Cut Tool when you are ready to record, as described in the sec-
tion, ÒRecording a Digital Cut to TapeÓ on page 621.

These switches are often 
located below the 
machineÕs playback 
control buttons. For 
more information, see 
your record deviceÕs 
manual.

In addition, make sure the record deck has the following settings:

¥ The free run/rec (record) run switch should be set to record run.

¥ The Ext (external)/Int (internal) sync switch should be set to inter-
nal.

¥ The switch for internal timecode should be set to Regen (regener-
ate) or Slave Lock, not Preset.

Assemble-editing 
option
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¥ After you record 15 to 30 seconds of timecode onto the record tape 
for jam syncing, return the Local/Remote switch to Remote for 
deck control from within Media Composer.

Recording a Digital Cut

The Digital Cut Tool provides frame-accurate control when recording 
a sequence to tape. You can also use the Digital Cut Tool to preview 
the sequence with a computer-generated countdown. 

The Digital Cut Tool includes its own Deck Controller for cueing a 
record deck and marking points during recording of digital cuts. It 
also includes track selection buttons for the record deck.

Record track buttons

Deck controls
Logging 
controls for 
marking IN 
and OUT 
points.
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The Deck Controller and track selection buttons provide the following 
advantages:

¥ Deck control within the tool allows you to cue the tape from 
within the tool and log your own IN and OUT points for frame-
accurate recording during a digital cut. This capability applies 
when you choose Mark In Time from the ÒatÓ pop-up menu. 

n For more information on logging procedures, see Chapter 5.

¥ The record track buttons allow you to specify which tracks on the 
record tape you want to record to from the selected source tracks.

Previewing a Digital Cut

You can manually 
record a digital cut 
including countdown, 
but the recording will 
not be frame-accurate. 
For information, see 
ÒPreparing Record 
TapesÓ on page 614.

You can preview a digital cut before recording it to tape to make sure 
your preparations and output settings are correct, or for screening pur-
poses.

To preview a digital cut:

1. Choose Digital Cut from the Output menu.

The Digital Cut Tool appears.

2. Deselect the Record to Tape option.

The With Countdown option is enabled.

3. Select the With Countdown option to preview the digital cut using 
a countdown. The default is a computer-generated countdown 
containing the Avid logo.
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When you select With Countdown, the Custom Screen option is 
enabled.

Select Custom Screen to count down using a customized count-
down screen that you create, as described in ÒCreating a Custom 
Countdown DisplayÓ on page 620.

4. Select the audio and video tracks you want represented in the dig-
ital cut preview. The display of tracks in the Digital Cut window 
varies according to the tracks existing in the sequence.

Only those tracks beside and beneath the speaker icon and the 
monitor icon are included in the digital cut.

5. Click Play.

The system plays the digital cut in the Record monitor and the 
full-screen monitor.

6. To stop the playback at any time, press the space bar.
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Creating a Custom Countdown Display

The Custom Screen option allows you to change the font (type style), 
size, and color of the countdown numbers. You can also import your 
own PICT graphic Þle as a background.

To create a custom countdown:

1. Select both the With Countdown and the Custom Screen options. 
The Custom Screen box appears in the Digital Cut Tool.

2. Click the Custom Screen box. The Digital Cut Countdown Screen 
dialog box appears.

3.  (Option) Choose another font, font size, or font color from the 
pop-up menus.

n The menus display all currently available fonts, as determined by the contents 
of the Fonts folder in the Macintosh System folder. For information on adding 
fonts to your system, see your Macintosh documentation.

Custom 
Screen 
box

Font

Font Size

Font Color
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4. Click the Import button if you want to import an available PICT 
Þle to use as a custom background. The Directory dialog box 
appears.

5. Locate a PICT Þle to serve as the new background image and 
select it.

6. Click OK. The custom countdown screen is ready for previews.

n The best resolution for imported PICT Þles is 720 x 486 for NTSC and 
720 x 576 for PAL. The resolution cannot be changed after import.

Recording a Digital Cut to Tape

If you have a Media 
Reader connected to 
your system, you can 
create burn-in timecode 
on the digital cut. For 
more information, see 
the Avid Media Reader 
Setup and UserÕs Guide.

The Digital Cut Tool provides several options for managing the 
recording of your sequence. For example, you can:

¥ Record by using either assemble or insert edits 

¥ Record a selected portion of the sequence or selected tracks

¥ Record according to different timecode parameters

To record a digital cut:

1. Load a sequence into the Record monitor. (You cannot access digi-
tal cut options without a sequence loaded.)
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2. Choose Digital Cut from the Output menu.

The Digital Cut Tool appears.

3. (Option) Select the Record to Tape option and choose either Insert 
Edit or Assemble Edit from the pop-up menu. This menu only 
appears if you enabled assemble editing in the Deck Preferences 
dialog box.

4. Select or deselect the Entire Sequence option based upon the fol-
lowing:

¥ Select the Entire Sequence option if you want the system to 
ignore any IN or OUT marks and play the entire sequence 
from start to Þnish.

¥ Deselect this option if you have established IN and/or OUT 
marks for recording a portion of the sequence.

5. Choose an option from the Record to Tape pop-up menu as fol-
lows:

Menu appears only with 
assemble editing enabled.
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¥ Choose Sequence Time to start the recording at a timecode 
existing on tape that matches the start timecode of the 
sequence.   If you intend to record several sequences to tape 
one after another, this option requires resetting the start time-
code on each sequence to match appropriate IN points on the 
tape.

You can change the start 
timecode to match the 
record tape. For more 
information, see 
ÒChanging the 
Sequence Clip InfoÓ on 
page 375.

¥ Choose Record Deck Time to ignore the timecode of the 
sequence, and start the recording wherever the record deck is 
currently cued.

¥ Choose Mark In Time to ignore the sequence timecode. Estab-
lish a speciÞc IN point on the record tape by cueing and mark-
ing with the deck controls.

6. Select the audio and video tracks you want represented in the dig-
ital cut preview. The display of tracks in the Digital Cut window 
varies according to the tracks existing in the sequence.

Only those tracks beside and beneath the speaker icon and the 
monitor icon are included in the digital cut.

7. Select the audio and video tracks you want represented in the dig-
ital cut. Only those tracks beside and beneath the speaker icon and 
the monitor icon are included in the digital cut.

The display of tracks in the Digital Cut window varies according 
to the tracks existing in the sequence.

8. Click Play.

The system cues the record deck, then plays and records the digi-
tal cut. The playback appears in the Record monitor and the full-
screen monitor.

9. To stop the recording at any time, press the space bar.

Timecode entry field
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n After assemble-edit recording, a freeze frame is usually added after the OUT 
point for one or more seconds, depending upon the record deck model. This 
provides several frames of overlap for the next IN point, before control track 
and timecode break up.

Using EDL Manager

An EDL (edit decision list) is a detailed list of the edits contained in a 
sequence, including all the timecode and supported effects informa-
tion required to re-create the sequence in an online videotape suite. 
The EDL is organized into a series of chronological instructions called 
events, which are interpreted by an edit controller that automates the 
assembly of the videotape master.

Your system includes the EDL Manager, an application with powerful 
features and sorting capabilities to help you prepare an EDL.

To launch EDL Manager, choose EDL from the Output menu.

For more information on speciÞc features and capabilities of EDL 
Manager, see the Avid EDL Manager UserÕs Guide.

VTR Play Emulation

VTR play emulation allows you to control a sequence loaded in the 
Record monitor from an edit controller for playback in the edit room 
along with other sources.

n To use VTR play emulation, you must connect a supported controller (any 
controller that uses Sony¨ serial control protocol) to the Macintosh¨ by 
using a 9-pin to serial cable.

With a controller properly connected, enable VTR play emulation as 
follows:
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1. Choose Serial Ports from the Tools menu to open the Serial Ports 
Tool.

2. Select the appropriate port (printer or modem) from the VTR 
Emulation pop-up menu.

3. Close the Serial Ports Tool. The system saves the setting as a Site 
setting, effective for all projects.

4. Choose VTR Emulation from the Special menu when you are 
ready to use the system for playback.

A check mark appears next to the command to indicate that the 
system is ready. A yellow outline appears around the Play button 
in the Record monitor to indicate that VTR emulation is active.

n This command behaves like a Local/Remote switch on a playback device, with 
VTR play emulation disabled (in Local mode) by default when you launch the 
system.

Once active, VTR play emulation allows you to control the sequence 
with an edit controller as follows:

¥ You can shuttle, step (jog), play, cue, and mark points based on 
master sequence timecode for editing onto another master. Mark 
points will appear in the Timeline only if the controller sends that 
information to the Avid Composer system.

¥ Your control of the Avid Composer system is for play only. For 
example, you cannot arm tracks or send record commands to the 
Avid Composer system itself.
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¥ Smooth audio scrub is enabled by default, emulating analog audio 
scrub on a VTR.
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CHAPTER 20

Exporting and Exchanging 
Material

At the advanced stages of a production, you might need to export or 
exchange material with another system, another application, or 
another platform. Your Avid Composer system provides tools for 
exporting clips and sequences in various formats, or for transferring 
projects and media between systems, as described in the following sec-
tions:

¥ Using Global Export Settings

¥ Exporting Files

¥ Exchanging Files with Other Systems

Using Global Export Settings

You can establish a set of global export parameters in the Export Set-
tings dialog box prior to beginning the export process. These parame-
ters remain the default settings for all exported Þles, unless you 
change them during export. This is especially useful when you batch 
export a number of Þles directly from a bin in one procedure.
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To adjust the options in the Export Settings dialog box, double-click 
Export in the Settings scroll list of the Project window.

Exporting Files

You can export material directly from a Media Composer product to 
any one of more than 25 supported Þle types. You can export an indi-
vidual frame, a selected region of footage, or an entire clip or 
sequence.

n For information on a speciÞc Þle format, see the Avid Media Composer Prod-
ucts Reference. 

There are several reasons why you might want to export video, audio, 
or both from the Avid Composer system: 

¥ You can export audio Þles for audio sweetening in compatible 
applications.

¥ You can export picture Þles for touching up or creating special 
effects in third-party applications.

¥ You can export Þles compatible with CD-ROM for use in multi-
media projects.

¥ You can use the export process to convert audio media Þles 
between the two supported formats: AIFC and Sound Designer II 
(SD2).

n If you plan to transfer the exported Þles to another Avid Composer system or 
third-party application, see ÒExchanging Files with Other SystemsÓ on 
page 639 for recommended steps and advice.

The following sections describe general procedures for preparing to 
export a sequence and for exporting frames, clips, and sequences.
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Preparing to Export a Sequence

If you are exporting part or all of a sequenceÑto QuickTime, 
ERIMovie, Sequenced PICT, or OMFI Þle types, for exampleÑyou can 
speed the export process by preparing the sequence in advance, as fol-
lows:

¥ Make sure all media for the sequence is online. For more informa-
tion, see ÒSelecting Ofßine Items in a BinÓ on page 239.

¥ If you want to archive the source sequence before making any 
alterations, duplicate the sequence, place the duplicate in another 
bin, and prepare the duplicate for export. The original sequence 
will be unaffected.

For more information 
on rendering, see the 
Avid Media Composer 
and Film Composer 
Effects Guide.

¥ Consider rendering all effects in advance. Although any unren-
dered effects are rendered on export (except for an OMF export), 
rendering effects in advance saves you time during the export pro-
cess.

¥ If your sequence contains numerous video tracks, consider mixing 
down the tracks in advance for faster export, unless you need to 
preserve the multiple track information. For more information, see 
ÒUsing Video MixdownÓ on page 629.

¥ If your sequence contains numerous audio tracks with various 
audio effects and level adjustments, consider mixing down the 
tracks for faster export, unless you need to preserve the informa-
tion. For more information, see ÒMixing Down Audio TracksÓ on 
page 553.

Using Video Mixdown 

Video mixdown allows you to combine several tracks into a single 
new master clip. This is convenient for building multilayered effects, 
for consolidating media, and for export and exchange.
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c When you mix down video tracks, you cannot separate them again to 
work on the tracks individually. Use this function only during the 
last stages of editing when you no longer need to make changes, or 
to make a copy for previewing.

To perform a video mixdown:

1. Choose Compression from the Tools menu.

The Compression Tool opens.

2. Choose an AVR for the mixdown from the AVR pop-up menu in 
the Compression Tool.

3. Make sure the video track monitor is in the topmost track that you 
want to mix down. 

Video mixdown works from the monitored track down, regardless 
of track selection.

4. Mark an IN and OUT point around the area to mix down.

5. Choose Video Mixdown from the Special menu.

The Video Mixdown dialog box appears.



631

6. Choose a Target Disk for storing the new master clip and click OK.

A progress indicator appears, indicating the progress of the video mix-
down. When the mixdown is completed, a new clip appears in the bin 
along with the sequence, and a new media Þle is created on the target 
disk.

Exporting Frames, Clips, or Sequences

To export frames, clips, or sequences:

1. Select the material you want to export in one of the following 
ways:

¥ To export speciÞc tracks in a clip or sequence, enable those 
tracks in the Track Selector panel, and disable all others.

c When you select speciÞc tracks for export, you must select the option 
Use Enabled Tracks in the Export Settings dialog box. If no tracks 
are enabled and you want to export all the tracks in the clip or 
sequence, you must deselect Use Enabled Tracks.

¥ To export a single frame, mark an IN point to export the 
marked frame from a bin or a monitor, or put the position 
indicator on the frame you want to export from a clip in the 
monitor.
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¥ To export part of a clip or sequence, mark IN and OUT points 
to export the marked range from a bin or a monitor. If you 
mark an IN point and no OUT point, the system exports from 
the IN mark to the end of the clip or sequence.

c When you place IN or OUT marks to determine a frame or range for 
export, you must select Use Marks in the Export Settings dialog box. 

¥ To export the entire clip or sequence, deselect the options Use 
Enabled Tracks and Use Marks in the Export Settings dialog 
box, and make sure the topmost track is monitored.

n When you export to an OMF Þle, you do not need to select both the sequence 
and its source clips. Select only the sequence to export all the necessary infor-
mation, including reference clips.

2. Choose Export from the File menu.

The Export File Type dialog box appears.
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3. Select the appropriate Þle type and options based on the descrip-
tions in Table 20-1.

Table 20-1 Export File Type Dialog Box Options 

Option Suboption Description

Avid Log Exchange Exports the selected bin as a shot log Þle that complies with 
Avid Log Exchange (ALE) speciÞcations. For more informa-
tion, see ÒConverting Logs with Avid Log ExchangeÓ on 
page 114.

Tab Delimited Exports the selected bin as a shot log Þle in the form of a tab- 
delimited ASCII text Þle.
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OMFI Composition StandardÑAIFC Choose this option to export a standard OMFI composition for 
transfer to a third-party workstation that supports OMFI. The 
export is Composition only, unless you select the With Media 
option.

AudioVision Choose this option speciÞcally for export to AudioVision. 
Appropriate options for OMFI 1.0 and With Media are auto-
matically chosen for this type of export. If you choose Video 
and Audio from the second pop-up menu, the video media is 
embedded in the OMFI Composition Þle. Audio media is 
external to the OMF Þle. If necessary, the system translates 
AIFC audio into the SD2 format.

SD2 Choose this option for export to Pro Tools or another product 
that supports the SD2 (Sound Designer II) audio format. The 
With Media option is automatically selected. Audio media is 
external to the OMF Þle. If necessary, the system translates 
AIFC into the SD2 format.

TIFF Video Choose this option to export video tracks to a third-party, 
OMFI-compatible application that does not support video 
media for Release 7.0 of the Media Composer products. If the 
third-party application is compatible with Release 7.0 video 
media, choose StandardÑAIFC instead.

OMFI Composition

(second pop-up 
menu)

Video and Audio Choose this option if you are using both video and audio 
tracks of a clip or sequence in an OMFI-compatible editing or 
graphics enhancement system.

Video Only Choose this option if you do not need audio tracks; for exam-
ple, when adding video or Þlm effects in an OMFI-compatible 
application.

Audio Only Choose this option if you do not need video tracks and are 
using or enhancing audio in an OMFI-compatible application 
such as a digital audio workstation. You must choose this 
option if you are transferring to Pro Tools.

Table 20-1 Export File Type Dialog Box Options (Continued)

Option Suboption Description
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OMFI Composition

(third pop-up 
menu)

OMFI 1.0 Choose this option if the application to which you are export-
ing does not support OMF Version 2.0.

OMFI 2.0 Choose this option if the application to which you are export-
ing supports OMF Version 2.0. If you are not sure, choose 1.0.

With Media Choose this option when you want to transfer the audio media 
Þles along with the OMF Composition for use in a third-party 
application that supports the type of media Þles used in the 
exported OMFI composition.

Audio media is external to the OMF Þle.

QuickTime Video and Audio Choose this option if, for example, you are using an entire clip 
or sequence in a multimedia project.

Video Only Choose this option if, for example, you are adding effects in a 
third-party application or using only the video in a 
multimedia project.

Audio Only Select this option if, for example, you are using or enhancing 
audio in a third-party application or using only the audio in a 
multimedia project.

Sound SD2 Exports audio tracks in the Sound Designer II format that 
is compatible with Pro Tools and other third-party 
applications. 

You can use this option to convert AIFC audio media to 
Sound Designer II media on export.

AIFF Exports audio tracks in the industry-standard Audio Inter-
change File Format (AIFF) that is compatible with many third-
party sound editing and multimedia applications. 

You can use this option to convert Sound Designer II audio 
media to AIFF media on export.

Table 20-1 Export File Type Dialog Box Options (Continued)

Option Suboption Description
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After you select export Þle type options, additional current 
options for the clip or sequence are listed in the lower-third region 
of the dialog box. The following screen shows an example of a 
sequence selected for export as a QuickTime Þle.

4. If the additional options listed need correction, click the Options 
button.

An appropriate subset of export options appears based on the 
selected Þle type. The following screen shows an example of 
options for a graphics Þle export.

Graphic Exports a single frame as a graphic Þle or series of frames as 
sequenced graphic Þles. Choose a Þle type from the pop-up 
menu.

Options button Opens the Export Settings dialog box for reÞning export 
options. For information on all options, see the Avid 
Media Composer Products Reference.

Table 20-1 Export File Type Dialog Box Options (Continued)

Option Suboption Description

Lower-third region 
of the Export File 
Type dialog box
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5. Adjust the additional export settings, and click OK to return to the 
Export File Type dialog box.

n For a complete description of all options in the Export Settings dialog box, see 
the Avid Media Composer Products Reference.

6. When all options are listed correctly, click OK.

A destination dialog box appears with a default Þle name in the 
Export As text box, based on the Þle type.
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7. (Option) Change the Þle name.

n If you are transferring the Þles for use in a third-party application, keep the 
default extension to avoid conßicts. Also, avoid names that include spaces or 
special characters.

8. Select the destination folder for the Þle and click Save.

For most Þle types, the Þle is exported and appears at the chosen 
destination.

n For OMFI export, if the sequence contains effects that are not supported by 
OMFI 2.0, a dialog box appears. You can choose to cancel or continue export-
ing a composition that will not include the unsupported effects.

With the following Þle types, an additional dialog box appears 
before the Þles are exported:

¥ BMP

¥ Cineon

¥ ERIMovie

¥ JPEG

¥ Photoshop

¥ PNG
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¥ SGI

¥ Targa

¥ TIFF

¥ Wavefront

¥ YUV

9. If you are exporting one of the Þle types shown in the previous 
list, see the Avid Media Composer Products Reference to select addi-
tional export parameters.

10. Click OK to complete the export.

c Macintosh systems prior to Release 8.1 allow a maximum Þle size of 
approximately 2 GB. If you exceed this limit, the Þle is unusable and 
the system displays an error message.

c If a power failure or mishap occurs during the export process, the 
entire Þle is unusable. You need to repeat the export process. The 
only exception is a PICT sequence, where all frames up to the point 
of failure are usable.

Exchanging Files with Other Systems

This section provides speciÞc steps and recommendations for 
exchanging Þles and media in the following circumstances:

¥ Audio sweetening in AudioVision: To export a sequence with 
audio tracks for audio sweetening in the AudioVision application, 
see ÒTransferring OMF Files from Media Composer Products to 
AudioVisionÓ on page 643.

¥ Audio sweetening in Pro Tools: To export a sequence with audio 
tracks for audio sweetening in the Pro Tools application, see 
ÒTransferring OMF Files to Pro ToolsÓ on page 649.

¥ Audio sweetening in other compatible applications: To transfer 
Þles to other OMF-compatible third-party digital audio applica-
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tions, see ÒTransferring OMF Files to Pro ToolsÓ on page 649. 
Also see the digital audio workstationÕs documentation.

¥ Visual effects in OMFI-compatible applications: To export video 
tracks for touching up or creating special effects in OMFI-compati-
ble effects applications, see ÒExporting Frames, Clips, or 
SequencesÓ on page 631. Also see the effects workstationÕs docu-
mentation.

¥ Visual effects in QuickTime applications: To export video tracks 
for touching up or creating special effects in QuickTime-compati-
ble applications, see ÒUsing the Media Composer QuickTime 
CodecÓ on page 655.

¥ Exchange of audio media Þles between systems: To transfer 
audio media Þles directly from the OMFI MediaFiles folder for use 
in any third-party application that supports the AIFF or Sound 
Designer II formats, see ÒExchanging Audio Media Files 
Between SystemsÓ on page 663.

¥ Transfer of projects to other Media Composer products: To trans-
fer whole projects between Media Composer products (for exam-
ple, if your facility uses different system models at different stages 
of postproduction), see ÒTransferring a Project to Another 
Media Composer ProductÓ on page 664.

n To learn more about OMF Interchange, see ÒAbout OMF InterchangeÓ on 
page 640.

About OMF Interchange

OMF Interchange is a platform-independent Þle format that stores 
both the digital media (video, audio, graphics, animation) and the
recipe describing how the media ingredients are edited together to 
form a Þnal sequence. This editing information, called a composition, 
is the OMF representation of the sequence created in the Avid Com-
poser system. The OMF Interchange format is the result of cooperative 
efforts of many industry and standards partners and Avid Technology, 
Inc.
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Any other program that supports OMF can read OMF Þles, even if the 
program resides on a different computer platform. As a result, with 
OMF you can transfer among different applications on different plat-
forms, without worrying about cross-platform translations. This can 
be very effective for importing animation or audio Þles created on pro-
prietary platforms.

c To avoid errors and incompatibilities when importing and exporting 
OMF Þles, observe the recommendations described in the Avid 
Media Composer Products Reference.

See the Avid Media Composer Products Reference for an appendix that 
lists applications that currently support OMF Interchange. For the lat-
est information, see the Avid OMFI web site:

http://www.omÞ.org 

Choosing an OMF Transfer Method

OMF Interchange, as implemented in the Avid Composer system, pro-
vides two basic methods for exporting Þles:

¥ Method 1: OMF compositions only without media Þles

The Avid Composer system can export an OMF Þle that contains 
only the editing information about a selected master clip or 
sequence. You then need to transfer both the OMF Þle and the 
media Þles, or redigitize the media on the other system. After you 
have transferred the media once, you can transfer revised compo-
sition-only Þles (unless you consolidated the media, in which case, 
you must transport the media Þles as well. For more information, 
see ÒConsolidating MediaÓ on page 276.

¥ Method 2: OMF compositions with media Þles

The Avid Composer system exports an OMF Þle that contains all 
the editing information for the selected master clip or sequence 
along with references to the audio media Þles for that master clip 
or sequence. In the case of AudioVision or SD2 export, audio 
media is converted if necessary to the SD2 format.



642

n If you are not sure what audio Þle format the third-party application sup-
ports, export by using the more universal Standard ÑAIFC option for use in 
other OMF-compatible applications that might not be able to read the 
Sound Designer II Þle format. The OMF Tool can also be used to convert the 
Þles back to the Sound Designer II format. You can download the OMF Tool 
from the Avid OMFI web site:

http://www.omÞ.org

Preparing Sequences for OMF Export

If you are exporting part or all of a sequence to an OMF Þle, you can 
speed the export process by preparing the sequence in advance:

¥ Make sure all media for the sequence is online. For more informa-
tion, see ÒSelecting Ofßine Items in a BinÓ on page 239.

¥ Duplicate the sequence and place the copy in a new bin. (This pre-
serves the links from your original sequence to the original media 
disk or disks.)

¥ If your sequence contains numerous video tracks, consider mixing 
down the tracks in advance for faster export, unless you need to 
preserve the multiple track information. For more information, see 
ÒUsing Video MixdownÓ on page 629.

¥ Check and adjust all pan and audio levels in advance. All current 
pan and level settings in the sequence are carried through to the 
exported media. For more information on performing an audio 
mixdown, see ÒMixing Down Audio TracksÓ on page 553.

¥ Consider rendering all effects in advance to shorten the time 
required for export. For more information, see the Avid 
Media Composer and Film Composer Effects Guide.

¥ Consider consolidating the sequence to create smaller source clips, 
thereby saving time and disk space. For more information, see 
ÒConsolidating MediaÓ on page 276. For information on appro-
priate storage devices for consolidating, see ÒRecommended Stor-
age DevicesÓ on page 666.
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¥ OMF Þles with very complex sequences can fail during import 
into some applications, due to memory limitations. Try one of the 
following solutions:

- Break the sequence into smaller sequences and export the new 
sequences. 

- Allocate more memory to the application.

- Add more physical memory.

¥ To export multiple clips in a single OMF Þle, create a sequence 
from them. For example, you can select all the clips and Option-
drag them into the Record monitor to create an instant sequence, 
then export it.

Transferring OMF Files from Media Composer Products to 
AudioVision

After editing in Media Composer, you can export and transfer your 
sequence and media to AudioVision for audio sweetening, using OMF 
Interchange.

Compatibility Issues for AudioVision Transfer

Observe the following compatibility issues between AudioVision and 
the Media Composer products when transferring Þles:

¥ Video media is not directly compatible between Release 7.0 of the 
Media Composer products and AudioVision. You cannot move 
video media Þles directly to the AudioVision system. However, 
you can use the AudioVision option in the Export procedure to 
transfer video. The Avid Composer system converts the video 
media to the TIFF video format, which is reconverted to 
AudioVision compatible media when you import the Þles into 
AudioVision.

¥ AudioVision Release 4.0 and Releases 6.0, 6.1, and 6.5 of the 
Media Composer products are compatible in terms of both video 
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media and audio media. You can include both video and audio 
tracks in the export, and you can transfer media Þles directly 
between systems.

¥ Video media in Release 3.6 or earlier of AudioVision is not com-
patible with Release 6.0 or later of the Media Composer products.

¥ Video media in Release 3.6 or earlier of AudioVision is compatible 
with Release 5.51 or earlier of the Media Composer products. If 
you want to include video tracks in the transfer, see the documen-
tation that came with the earlier release.

¥ In cases where video media is not compatible, you can add video 
to the transfer as follows:

- Record a digital cut to tape of the video track only. You donÕt 
have to record the audio tracks to the videotape unless you 
need a scratch track reference. 

- Be sure to match the timecode on the tape to the sequence 
timecode. You can do this by striping the videotape with 
appropriate timecode before the transfer. The digital cut will 
place the video onto the tape at the proper timecode location.

Before You Begin

To avoid problems, follow these guidelines when exporting from 
Media Composer:

¥ Prepare the sequence as described in ÒPreparing Sequences for 
OMF ExportÓ on page 642.

¥ The audio sampling rate of the sequence must be 44.1 kHz or 
48 kHz. All audio clips in the sequence must be the same rate.

¥ Do not modify the start or end timecodes of master clips, and do 
not convert the frame rates. 

¥ Make sure that the sequence contains video digitized at a single 
AVR level. AudioVision does not display video for sequences that 
contain mixed AVR levels.
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¥ Occasionally, AudioVision stops importing and an ÒOut-of-mem-
oryÓ error message appears. This occurs because the OMF Inter-
change composition is too large. To correct the problem, export 
from Media Composer in smaller sections as follows: 

- Divide the sequence into smaller segments by duplicating the 
sequence (perhaps several times) and deleting different por-
tions of each copy. 

- Export and import each segment individually. 

- After the segments are imported, you can edit them together 
easily and accurately.

The size of the OMF Interchange composition is determined not 
by the length of the sequence but by its complexity. For example, a 
short sequence with many edits and tracks might be larger when 
exported as an OMF Interchange composition than a long 
sequence with only a few edits and only a few tracks of audio and 
video.

Transferring a Video Sequence to AudioVision

To transfer a video sequence to AudioVision:

1. Select the material you want to export in one of the following 
ways:

¥ To export speciÞc tracks in a clip or sequence, enable those 
tracks in the Track Selector panel, and disable all others.

c When you select speciÞc tracks for export, you must select the option 
Use Enabled Tracks in the Export Settings dialog box. If no tracks 
are enabled and you want to export all tracks in the clip or sequence, 
you must deselect Use Enabled Tracks.

¥ To export a single frame, mark an IN point to export the 
marked frame from a bin or a monitor, or put the position 
indicator on the frame you want to export from a clip in the 
monitor.
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¥ To export part of a clip or sequence, mark IN and OUT points 
to export the marked range from a bin or a monitor. If you 
mark an IN point and no OUT point, the system exports from 
the IN mark to the end of the clip or sequence.

c When you place IN or OUT marks to determine a frame or range for 
export, you must select Use Marks in the Export Settings dialog box.

¥ To export the entire clip or sequence, deselect the options Use 
Enabled Tracks and Use Marks in the Export Settings dialog box, 
and make sure the topmost track is monitored.

n When you export to an OMF Þle, you do not need to select both the sequence 
and its source clips. Select only the sequence to export all the necessary infor-
mation, including reference clips.

2. Choose Export from the File menu.

The Export File Type dialog box appears.



647

3. Select OMFI Composition, and choose AudioVision from the Þrst 
pop-up menu.

The system automatically chooses the correct options for OMFI 
Version 1.0 With Media.

4. Choose an appropriate option from the second pop-up menu:

¥ If you want to include the video tracks with the audio, choose 
Video and Audio.

¥ If you do not want to include the video tracks, choose Audio 
Only.

5. Depending upon how you marked the source material for export, 
click the Options button and adjust the export settings for 
Use Marks and Use Enabled Tracks if necessary.
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¥ Use Marks: Instructs the system to use IN and OUT marks 
currently set in the selected media to determine the starting 
and ending frames for the export. Deselect this option to 
export the entire clip or sequence.

¥ Use Enabled Tracks: Instructs the system to export only the 
currently enabled tracks for a selected sequence during the 
export. Deselect this option if you want to export all tracks in 
the sequence.

6. Click OK to close Export Settings and return to the Export File 
Type dialog box.

7. When all the options are listed correctly, click OK.

A directory dialog box appears with a default Þle name in the 
Export As text box.

8. (Option) Change the Þle name if you want (keep the default exten-
sion), select the destination folder for the Þle, and click Save.

The sequence is exported.

c Macintosh systems prior to Release 8.1 allow a maximum Þle size of 
approximately 2 GB. If you exceed this limit, the Þle is unusable and 
the system displays an error message.

9. Close the application and shut down your system.
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10. Remove the drive or diskette containing the OMFI composition 
and the drive containing the media Þles, and transport them to the 
AudioVision system.

n For more information on the correct procedures for connecting and discon-
necting drives, see the appropriate hardware guide.

11. With the AudioVision system turned off, insert or connect the 
drives and boot the system.

12. Start the AudioVision application and import the composition. For 
more information, see the Avid AudioVision UserÕs Guide.

13. (Option) If you made a digital cut of the video track for the trans-
fer, digitize the tape in AudioVision.

Transferring OMF Files to Pro Tools

You can use OMF Interchange to transfer audio tracks from 
Media Composer products to Pro Tools for audio sweetening. Proce-
dures and special considerations are described in the following sec-
tions:

¥ To decide whether to consolidate the source sequence prior to 
export, see ÒChoosing Whether to Consolidate Your Media 
FilesÓ on page 649.

¥ To prepare the sequence for more effective export, see ÒPreparing 
Sequences for OMF ExportÓ on page 642.

¥ To perform the transfer, see ÒTransferring a Project to Pro ToolsÓ 
on page 651.

Choosing Whether to Consolidate Your Media Files

Before you export the sequence, you need to decide whether or not to 
consolidate your media Þles based on the following scenarios.
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Pro Tools and the Avid Composer System on the Same Computer

If you are running Pro Tools and the Avid Composer system on the 
same computer, you do not need to consolidate your Þles. You can 
simply:

1. Shut down and reconnect the hard drive (with the audio Þles) 
from the Avid SCSI bus to the Macintosh SCSI bus. 

2. Start up and open the Pro Tools session. Pro Tools looks for the 
associated audio Þles in the Avid Composer system OMFI 
MediaFiles folder. 

n Pro Tools will be able to play back audio Þles only from drives connected to the 
Macintosh computerÕs SCSI bus.

The advantage of this method is that you do not need to consolidate, 
convert, or copy media Þles, thereby saving time and effort. The disad-
vantage of this method is that you must move the hard drive from one 
bus to another.

Pro Tools and the Avid Composer System on Different Computers

If you are running Pro Tools and the Avid Composer system on differ-
ent computers, you have two options for handling the media that is 
referenced in the sequence that you are converting. 

¥ Consolidate the media Þles: Consolidating saves time and disk 
space by copying only the required media to a designated hard 
drive. In the process, the system creates smaller media Þles based 
on portions of clips used in the sequence.

n For more information on consolidating media Þles, see ÒConsolidating 
MediaÓ on page 276.

¥ Copy or transport the media Þles manually from one system to 
another: Copying media Þles to another drive or transporting the 
drives themselves to another system lets you avoid managing 
duplicate media Þles in different locations. If you simply move the 
Þles, however, either the OMF Tool or Pro Tools might display a 
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Where Is dialog box to locate the media (by Þle name) after it has 
been copied. You are responsible for knowing the names of the 
speciÞc media Þles.

n For more information on transporting media Þles between systems, see 
ÒMethods for Transferring Media FilesÓ on page 666.

Transferring a Project to Pro Tools

To transfer a project to Pro Tools:

1. Select the material you want to export in one of the following 
ways:

¥ To export speciÞc tracks in a clip or sequence, enable those 
tracks in the Track Selector panel, and disable all others.

n Pro Tools does not support playback of video transferred from 
Media Composer products. 

c When you select speciÞc tracks for export, you must select the option 
Use Enabled Tracks in the Export Settings dialog box. If no tracks 
are enabled and you want to export all tracks in the clip or sequence, 
you must deselect Use Enabled Tracks.

¥ To export a single frame, mark an IN point to export the 
marked frame from a bin or a monitor, or put the position 
indicator on the frame you want to export from a clip in the 
monitor.

¥ To export part of a clip or sequence, mark IN and OUT points 
to export the marked range from a bin or a monitor. If you 
mark an IN point but not an OUT point, the system exports 
from the IN mark to the end of the clip or sequence.

c When you place IN or OUT marks to determine a frame or range for 
export, you must select Use Marks in the Export Settings dialog box.
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¥ To export the entire clip or sequence, deselect the options Use 
Enabled Tracks and Use Marks in the Export Settings dialog box, 
and make sure the topmost track is monitored.

n When you export to an OMF Þle, you do not need to select both the sequence 
and its source clips. Select only the sequence to export all the necessary infor-
mation, including reference clips.

2. Choose Export from the File menu to open the Export File Type 
dialog box.

3. Select OMFI Composition and choose SD2 from the Þrst pop-up 
menu.
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The system automatically chooses the With Media option.

4. Choose Audio Only from the second pop-up menu.

n Pro Tools does not support video media exported from the Avid Composer sys-
tem.

5. Choose an option from the OMFI Version pop-up menu:

¥ If you are transferring to a newer Pro Tools system, choose 
OMFI 2.0.

¥ If you are transferring to an older Pro Tools system that does 
not support OMFI 2.0, choose OMFI 1.0.

¥ If you are not sure which version your system supports, 
choose OMFI 1.0.

6. Depending upon how you marked the source material for export, 
click the Options button and adjust the export settings for 
Use Marks and Use Enabled Tracks if necessary:

¥ Use Marks: Instructs the system to use IN and OUT marks 
currently set in the selected media to determine starting and 
ending frames for the export. To export the entire clip or 
sequence, deselect this option.

¥ Use Enabled Tracks: Instructs the system to export only the 
currently enabled tracks for a selected sequence during the 
export. To export all tracks in the sequence, deselect this 
option.

7. Click OK to close the Export Settings dialog box and return to the 
Export File Type dialog box.

8. When all the options are listed correctly, click OK.

A directory dialog box opens with a default Þle name in the 
Export As text box.
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9. (Option) Change the Þle name if you want (keep the default exten-
sion), select the destination folder for the Þle, and click Save.

The Þle is exported and appears at the chosen destination.

c Macintosh systems prior to Release 8.1 allow a maximum Þle size of 
approximately 2 GB. If you exceed this limit, the Þle is unusable and 
the system displays an error message.

10. Copy the OMF Þle from the Avid Composer system to the 
Pro Tools system and transfer the media Þles. For more informa-
tion, see ÒMethods for Transferring Media FilesÓ on page 666.

11. Use the OMF Tool to convert the exported OMFI Þle to a Pro Tools 
Session.

n For more information on acquiring and using the OMF tool, visit the OMF 
Web site at:
http//www.omfi.org

12. Open and save the Pro Tools Session in Pro Tools. For more infor-
mation, see the Pro Tools documentation.
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Using the Media Composer QuickTime Codec

You can speed the process of importing and exporting QuickTime Þles 
by using the Media Composer QuickTime codec when you intend to 
treat the Þles in a third-party application before reimporting them into 
Avid Composer products. The following sections describe the codec 
and procedures for using it:

¥ To learn more about how the codec works, see ÒAbout the Media 
Composer QuickTime CodecÓ on page 655.

¥ To prepare a third-party application for working with Avid Com-
poser QuickTime Þles, see ÒInstalling the Codec in QuickTime 
ApplicationsÓ on page 656.

¥ To review speciÞcations for QuickTime export, see the Avid 
Media Composer Products Reference.

¥ To prepare a sequence for QuickTime export, see ÒPreparing to 
Export a SequenceÓ on page 629.

¥ To perform the export, see ÒExporting with the Media Composer 
QuickTime CodecÓ on page 657.

¥ To perform an export from a third-party application, see ÒExport-
ing from a Third-Party QuickTime ApplicationÓ on page 662.

About the Media Composer QuickTime Codec

This software-based codec creates encapsulated media Þles for quick 
export of high-resolution Þles that are readable within QuickTime 
applications also equipped with the codec.

n Using the QuickTime codec usually involves maintaining the ITU-R -601 
(CCIR  601) standard video dimensions of the media (720 x 486 nonsquare 
pixels for NTSC, 720 x 576 for PAL) as well as large media Þle sizes. This 
codec might not be appropriate for some uses. For example, if the destination 
of your QuickTime export is a multimedia title, you should use another 
appropriate codec such as Cinepak.
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The codec allows you to maintain AVRs up to AVR 77. It also speeds 
the QuickTime import and export processes to a rate of approximately 
four times real time or better (depending on resolution). The codec 
provides a vast improvement over the standard QuickTime conver-
sion, which can take as long as 300 times real time or more with full-
size, high-resolution clips.

n Avid Composer QuickTime Þles can be quite large, depending on the AVR, 
and require adequate storage and transfer capacities.

Installing the Codec in QuickTime Applications

After you install Avid Composer Release 7.0 on your system, the new 
codec is automatically installed in the Extensions folder inside the Sys-
tem Folder. You can copy this extension and install it at other worksta-
tions where you are using QuickTime-compatible applications. Once 
the Media Composer codec is installed on the workstation, you can 
export Þles either from the Avid Composer system or from the third-
party application for reimport into the Avid Composer system.

You can install the codec on either a Power Macintosh¨ or non-Power 
Macintosh system. To install the Media Composer codec on the system 
where the third-party application resides:

1. Drag the copy of the extension labeled Avid Codec onto the 
System Folder and release the mouse button. 

A dialog box asks if you would like to install the Þle in the Exten-
sions folder. 

2. Click OK.

3. Restart your system.

The codec is installed.

n If you are having trouble opening or playing the export in a third-party appli-
cation, increase the memory allocated to the program.
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Exporting with the Media Composer QuickTime Codec

To export with the Media Composer QuickTime codec:

1. Select the material you want to export in one of the following 
ways:

¥ To export speciÞc tracks in a clip or sequence, enable those 
tracks in the Track Selector panel and disable all others.

c When you select speciÞc tracks for export, you must select the option 
Use Enabled Tracks in the Export Settings dialog box. If no tracks 
are enabled and you want to export all tracks in the clip or sequence, 
you must deselect Use Enabled Tracks.

¥ To export a single frame, mark an IN point to export the 
marked frame from a bin or a monitor, or put the position 
indicator on the frame you want to export from a clip in the 
monitor.

¥ To export part of a clip or sequence, mark IN and OUT points 
to export the marked range from a bin or a monitor. If you 
mark an IN point and no OUT point, the system exports from 
the IN mark to the end of the clip or sequence.

c When you place IN or OUT marks to determine a frame or range for 
export, you must select Use Marks in the Export Settings dialog box.

¥ To export the entire clip or sequence, deselect the options Use 
Enabled Tracks and Use Marks in the Export Settings dialog box, 
and make sure the topmost track is monitored.

n When you export to an OMF Þle, you do not need to select both the sequence 
and its source clips. Select only the sequence to export all the necessary infor-
mation, including reference clips.

2. Choose Export from the File menu.

The Export File Type dialog box appears.
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3. Select one of the following options:

¥ QuickTime Video and Audio: Select this option if, for exam-
ple, you are using an entire clip or sequence in a multimedia 
project.

¥ QuickTime Video Only: Select this option if, for example, you 
are adding effects in a third-party application.

¥ QuickTime Audio Only: Select this option if, for example, 
you are using or enhancing audio in a third-party application.

After you select export options, note that additional current 
options for the clip or sequence are listed in the lower-third region 
of the dialog box. The following is an example of a sequence 
selected for export as a QuickTime Þle.
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4. If the additional options listed need correction, click the Options 
button in the Export File Type dialog box and select options in 
Export Settings dialog box based on the descriptions in Table 20-2.

Lower-third region 
of the Export File 
Type dialog box

Table 20-2 Export Settings Options for QuickTime Codec

Option Suboption Description

Use Marks Instructs the system to use IN and OUT marks currently set in the 
selected media to determine starting and ending frames for the 
export. To export the entire clip or sequence, deselect this option.

Use Enabled Tracks Instructs the system to export only the currently enabled tracks for a 
selected sequence during the export. To export all tracks in the 
sequence, deselect this option.

Use Both Fields Select this option if you are exporting any of the two-Þeld resolu-
tions (AVR 70B to AVR 77, or AVR 12). This option exports both 
video Þelds for higher resolution.

Destination Size 720 x 486 
(NTSC)
720 x 576 (PAL)

Full-screen, non-square-pixel dimensions according to ITU-R-601 
(CCIR 601) video standards.Use these dimensions, for example, 
when treating video footage in a third-party application before 
reimporting into the Avid Composer system.

Audio Output Mono Pans all tracks to center on export.

Stereo Exports all even-numbered tracks to track 1 and all odd-numbered 
tracks to track 2.
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5. Click the Compression Settings button in the Export Settings dia-
log box and select options in the Compression Settings dialog box 
based on descriptions given in Table 20-3.

Audio Sample 
Rate

Native Rate The native rate of the chosen audio media (44.1 kHz or 48 kHz).

22.254 kHz 
(Std Macs)

Half the sample rate of 44.1-kHz media for playback on standard 
Macintosh models.

22.050 kHz 
(AV Macs)

Half the sample rate of 44.1-kHz media for playback on AV (Audio/
Video enabled) Macintosh models.

11.127 kHz One-quarter the sample rate of 44.1-kHz media for playback on 
standard Macintosh models.

11.025 kHz One-quarter the sample rate of 44.1-kHz media for playback on AV 
Macintosh models.

Audio Sample 
Size

8 bits Exports an 8-bit audio sample size for use in third-party systems 
that do not support 16-bit; also used to minimize the data through-
put requirements (for example, to improve playback in multimedia 
projects).

16 bits Exports a 16-bit audio sample size (currently the industry standard 
bit rate for digital audio).

Create Movie Preview Creates a QuickTime poster (a still-frame preview image) for your 
movie (slows the export process).

Cross-Platform Movie Creates a single-fork, cross-platform compatible movie that can be 
opened on both the Macintosh and the PC for use in cross-platform 
multimedia development.

Compression Settings This button appears when Use Source Compression is not selected. 
Click this button to open the Compression Settings dialog box. For 
more information, see the Avid Media Composer Products Reference.

Table 20-2 Export Settings Options for QuickTime Codec

Option Suboption Description
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6. Click OK to close the Compression Settings dialog box and return 
to the Export Settings dialog box.

7. Click OK to close the Export Settings dialog box and return to the 
Export File Type dialog box.

8. When all options are listed correctly in the Export File Type dialog 
box, click OK.

A directory dialog box opens with a default Þle name in the 
Export As text box based on the Þle type.

Table 20-3 Compression Settings Options for the QuickTime 
Codec

Option Suboption Description

Compressor Media Com-
poser

Creates encapsulated media Þles for quick export of high-resolution 
Þles that are readable within QuickTime applications also equipped 
with the codec.

Exporting with the Media Composer codec does not cause any loss 
in quality because the codec maintains the identical media data. 
However, the quality cannot be better than the original resolution of 
the digitized media.

Quality

n

If you selected the Media Composer codec, when you click the qual-
ity slider and drag it, a dialog box appears. This dialog box allows 
you to select another AVR.

If you change the AVR, when you click OK to close the Compression 
Settings dialog box, another dialog box allows you to decide 
whether to accept the new AVR or maintain the original AVR.

Because the Media Composer codec uses the AVR of your original source 
Þles, selecting another AVR requires conversion of the media and slows 
down the export process considerably. Maintain the AVR of the source 
media whenever possible.

Motion Choose 29.97 to maintain NTSC video frame-rate standards.
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9. (Option) Change the Þle name if desired.

n If you are transferring the Þles for use in a third-party application, keep the 
default extension to avoid conßicts. Also, avoid names that include spaces or 
special characters.

10. Select the destination folder for the Þle and click Save.

The Þle is exported and appears at the chosen destination.

c Macintosh systems prior to Release 8.1 allow a maximum Þle size of 
approximately 2 GB. If you exceed this limit, the Þle is unusable and 
the system displays an error message.

n If a power failure or mishap occurs during the export process, the entire Þle is 
unusable. You need to repeat the export process.

Exporting from a Third-Party QuickTime Application

Exporting from a third-party QuickTime application by using the 
Media Composer QuickTime codec and the default Avid Composer 
system frame size allows you to speed the process of importing back 
into the Avid Composer system to approximately three to four times 
real time (video only).
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To export Avid Composer Þles from a QuickTime-compatible applica-
tion for import (or reimport) into the Avid Composer system:

1. Make sure the Avid codec is installed in the System FolderÕs 
Extensions folder.

2. Conduct the export procedure according to the manual included 
with the particular software.

3. When you get to the step where the standard QuickTime Create a 
Movie dialog box appears, select the option Use Source Compres-
sion.

n If you select another frame size, the Avid Composer system will not import 
the Þle quickly using the Media Composer codec.

4. Complete the export according to the procedures used by the par-
ticular software.

Exchanging Audio Media Files Between Systems

You can transfer audio media Þles directly from the OMFI MediaFiles 
folder for use in any third-party application that supports the AIFF, 
AIFC, or SD2 formats:

¥ To identify the appropriate media Þles in the OMFI MediaFiles 
folder, use the Media Tool. For more information, see ÒFinding a 
Related Media FileÓ on page 281.

¥ To convert some or all of the media Þles on a mixed project to 
either the SD2 or AIFF format for direct transfer to a third-party 
application, choose the desired format when exporting the master 
clips from the bin. For more information on exporting audio Þles, 
see ÒExporting Frames, Clips, or SequencesÓ on page 631.

¥ To copy the selected Þles quickly onto a target drive, use the Con-
solidate feature. For more information, see ÒConsolidating 
MediaÓ on page 276.
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¥ To transfer the Þles, transport them on a removable or Þxed drive. 
For more information, see ÒMethods for Transferring Media 
FilesÓ on page 666.

c You cannot transfer audio media Þles that have been altered in a 
third-party application directly into the OMFI MediaFiles folder on 
an Avid Composer system.

Transferring a Project to Another Media Composer Product

This section describes basic steps for transporting Þles with a remov-
able storage device.

Compatibility Requirements for Transfer

When you transfer a project to another Avid Composer system, make 
sure that:

¥ The memory allocation of the Avid Composer system is similar in 
both systems.

¥ The AVRs are compatible between systems.

¥ The release of the Avid Composer system on each system is com-
patible. See the Avid Media Composer and Film Composer Release 
Notes for a complete description of compatibility issues between 
releases.

Transferring the Project

There are two basic methods for transferring projects between Avid 
Composer systems:

¥ Back up the project Þles to a 3.5-inch diskette, and transport the 
media Þles on a removable storage device.

¥ Send sequences, clips, or entire projects over a high-speed net-
work using AvidNet.
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n For more information on using AvidNet, see the AvidNet Peer-to-Peer Setup 
and UserÕs Guide. If you would like to purchase AvidNet, contact your Avid 
sales representative.

To transfer a work in progress and associated media to another Avid 
Composer system:

1. (Option) Consolidate the media for the project onto an appropriate 
drive for transfer to the other system. 

¥ For more information on consolidating, see ÒConsolidating 
MediaÓ on page 276.

¥ For more information on removable storage devices, see ÒRec-
ommended Storage DevicesÓ on page 666.

c Do not rename the folders named OMFI MediaFiles located on the 
media drive. The target Avid Composer system uses the folder 
names to locate the media Þles.

2. Copy the project folder and any settings Þles you want to maintain 
at the new location onto a 3.5-inch diskette. For more information, 
see ÒBacking Up Your WorkÓ on page 42.

3. Close the Avid Composer application and shut down your system.

4. Remove the drives containing the media, and take these and the 
3.5-inch diskette to the new location.

5. With the system turned off at the new location, insert or connect 
the drives and boot the system.

6. In the Finder, copy the Project folder and any settings to the Avid 
drive. For more information, see ÒMoving Projects and User Pro-
Þles from Another SystemÓ on page 28.

7. Start the Avid Composer application, open the project, and resume 
work.

n The Avid Composer system will reconstruct the MediaFiles database the Þrst 
time you launch the application to incorporate the new media into the sys-
temÕs internal directory.
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Methods for Transferring Media Files

The fastest methods for transferring media Þles between systems 
involve either transporting removable storage devices or sending your 
material over a high-speed network using AvidNet. These methods 
and others are described in the following sections.

Recommended Storage Devices

The following is a list of storage devices, and related restrictions, to 
consider for the transfer of media Þles:

¥ Removable hard drive: Both the Avid Composer system and the 
target system must have compatible RMAG XL or MediaDock 
chassis. Both systems should be running the same version (latest) 
of the AVIDdrive Utility.

¥ Fixed hard drive: Both the Avid Composer system and the target 
system must have compatible device drivers. Both systems should 
be running the same version (latest) of the AVIDdrive Utility.

¥ Avid DLT (digital linear tape) drive: Both the Avid Composer 
system and the target system must have compatible versions of 
AVID/MEZZO archive software.

n If you are transferring media from striped drives, make sure the other system 
supports striped drives. Check the Extensions folder for the AVIDstripeª 
extension.

Using AvidNet

If your facility is equipped with AvidNet, you can simplify and speed 
the exchange of media between workstations by sending your mate-
rial over a network by using the AvidNet Transfer Tool and the Inbox 
located in the Tools menu.

n For more information on AvidNet, see the AvidNet Peer-to-Peer Setup and 
UserÕs Guide. If you would like to purchase AvidNet, contact your Avid sales 
representative.
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Other Network Transfer Methods

Other methods of Þle transfer include:

¥ AppleShare¨: You can transfer Þles between Macintosh systems 
by using Macintosh Þle sharing or an AppleShare server. See your 
Macintosh documentation for more information.

From UNIX¨ systems to Macintosh systems, you can use pro-
grams such as Xinet¨ K-AShareª to mount UNIX volumes on a 
Macintosh desktop.

¥ Internet File Transfer Protocol (FTP): You can transfer Þles 
between networked systems by using TCP/IP and FTP, including 
transfer from UNIX, PC, or other platforms. For transferring from 
Silicon Graphics systems to Avid Composer systems by using 
Fetch, see the Avid Technical Note, ÒUsing Fetch to Transfer OMF 
Files,Ó available through Avid Customer Support.

¥ To transfer audio media Þles back into a Avid Composer product, 
use the import procedures. For more information, see
Chapter 8.

c You cannot transfer audio media Þles that have been altered in a 
third-party application directly into the OMF MediaFiles folder on 
an Avid Composer system.
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APPENDIX A

Using AudioSuite Plug-Ins

This appendix describes how to use the AudioSuite Plug-Ins. Access 
the Plug-Ins by choosing AudioSuite from the Tools menu. The follow-
ing illustration shows the AudioSuite Plug-In Window.

For details on installing and accessing the Plug-Ins, see Chapter 16.

Drive 
Selection 
pop-up 
menu

Plug-In 
Selection 
pop-up 
menu

Status display
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AudioSuite Plug-Ins

The following basic plug-ins are installed automatically as part of the 
Avid Composer system software installation:

¥ Invert - Inverts the polarity (phase of the audio Þle).

¥ Duplicate - This plug-in does not work on Avid Composer system 
audio Þles.

¥ Normalize - Finds the peak value in the source audio Þle and 
scales the entire Þle proportionally to that maximum value.

¥ Gain - Same as normalize, but allows positive or negative gain 
adjustment.

¥ Reverse - Rewrites the selected audio in reverse.

¥ DC Offset Removal - Removes an audio artifact that is common in 
digital audio Þles. A DC offset is caused by poorly calibrated
A/Ds (analog to digital converters), and can produce clicks and 
pops on clip edit transitions if not removed.

¥ Pitch Shift - Change pitch with or without changing length.

The following sections give a brief overview of each plug-in, and 
where appropriate, describe how to use the plug-in.

Invert

The Invert Plug-In reverses the polarity of the selected audio. All posi-
tive sample amplitude values are made negative, and all negative 
amplitudes are made positive. This process is useful for permanently 
altering the phase (polarity) relationship of tracks. Inverting can be 
useful when mixing because it alters frequency response between 
source tracks recorded with multiple microphones, and also allows 
you to correct for audio that was recorded out of phase. 
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Normalize

In cases where a sound Þle has been recorded with too little ampli-
tude, or where volume is inconsistent throughout the duration of a 
sound Þle (as in a poorly recorded narration), the Normalize function 
ensures that the inherent dynamics of the performance remain 
unchanged while the overall volume level of the passage is raised. 

In addition to the standard AudioSuite parameters (described earlier 
in this chapter), the Max Peak At controls lets you specify how close to 
maximum level (the clipping threshold) the peak level of your selec-
tion/Þle will be boosted. You can enter this in three ways:

¥ By entering a numeric decibel value below the clipping threshold

¥ By entering a percentage of the threshold

¥ By adjusting the on-screen slider

Editing any of these controls automatically calculates the equivalent 
value in the others. 

To conÞgure the Normalize parameters:

1. Enter the amount of boost you want applied during the Normalize 
process.

2. To set a speciÞc decibel amount below maximum, double-click 
and enter that value in the Max Peak at: (dB) Þeld.

3. To set the amount of normalization as a percentage of maximum, 
enter the desired percentage in the Max Peak at: (%) Þeld. To man-
ually set the amount, click and adjust the Max Peak slider (hold 
down the Command key to Þne-adjust). 
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Gain 

Gain allows you to boost or lower amplitudes in a Þle or selection by a 
speciÞed amount. The Change Gain command is ideal for smoothing 
out undesirable peaks and other dynamic inconsistencies.

To conÞgure the Gain parameters, do the following:

¥ Enter the new level as a decibel amount (dB) or percentage (%) by 
double-clicking on the respective Þeld and entering a new value. 

¥ Use the slider to adjust the Gain manually (hold down the Com-
mand key while dragging the slider to Þne-adjust). 

Reverse

Reversed sounds are useful effects in many music and Þlm/video 
projects. The Reverse Plug-In lets you perform this type of processing 
very easily. 

DC Offset

The DC Offset Plug-In removes DC offset from your audio Þles. The 
term ÒDC OffsetÓ describes a very speciÞc type of audio artifact which 
infrequently appears in digital audio signals.

DC Offset Plug-Ins can be identiÞed in a waveform overview because 
they appear to have a near-vertical fade in with a constant or Òsteady-
stateÓ offset from zero, when the Þle is actually ÒsilentÓ (it contains no 
audible audio). The DC Offset Plug-In can help remove (or at least 
reduce) the DC Offset from your source audio Þles. 
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Pitch Shift

The AudioSuite Pitch Shift Plug-In allows you to adjust the pitch of 
any source audio Þle with or without a change in its duration. This is a 
very powerful function which essentially allows sounds to be trans-
posed a full octave up or down in pitch with or without altering play-
back speed.
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Edit the Pitch Shift parameters by double-clicking and typing into any 
the Destination Þelds (tempo, bar:beats:ticks, or time sig), or by click-
ing and dragging the coarse, Þne or ratio sliders. All Pitch Shift Plug-In 
controls are linked so that changing one changes the others.

Gain

The gain controls set the input level, in tenths of a dB. This should be 
set so that the Plug-In can adequately handle amplitude peaks in the 
selection. Dragging the slider to the right increases gain, dragging to 
the left decreases gain. 

Coarse and fine

Adjust the pitch by dragging either of the two faders, or by typing val-
ues in the boxes below them. The Coarse slider transposes in semi-
tones (half steps); the Fine slider transposes in cents (hundredths of a 
semitone).

Time Correction

This box must be checked for Avid Composer systems.

c You cannot use plug-in options that perform time compression/
expansion because the output would have a different sample
duration than the original Þle.

Ratio

The Ratio slider lets you set the amount of transposition (pitch 
change). Moving the slider to the right raises the pitch of the processed 
Þle, while moving the slider to the left decreases its pitch. Hold down 
the Command key while dragging the slider to Þne-adjust. 

Crossfade

This slider allows you to manually adjust the crossfade length in milli-
seconds to optimize performance of the Pitch Shift Plug-In according 
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to the type of audio material you are processing. The Pitch Shift Plug-
In achieves pitch transposition by processing very small portions of 
the selected audio material and very quickly crossfading between 
these alterations in the waveform of the audio material. 

Crossfade length essentially affects the amount of ÒsmoothingÓ per-
formed on audio material to prevent audio artifacts such as clicks 
when the audio is looped to generate the desired pitch shift. In gen-
eral, small narrow-range pitch changes require longer crossfades while 
larger transpositions require smaller crossfades. The disadvantage to 
long crossfade times is that they smooth the signal, including any tran-
sients. While this can be desirable for audio material such as vocals, it 
is not appropriate for material with sharp transients such as drums or 
percussion. 

The default setting for this parameter is Auto (full left), in which cross-
fade times are set automatically, according to the settings of the coarse 
and Þne controls. This setting should be sufÞcient for most applica-
tions. However, by using this slider, you can manually adjust and opti-
mize crossfade times if necessary. For audio material with sharper 
attack transients, use smaller crossfade times. For audio material with 
softer attack transients, use longer crossfade times. 

Min Pitch

The Min Pitch slider lets you select the minimum, or lowest, pitch that 
will be used in the Plug-InÕs calculations during the Time Compres-
sion/Expansion process. The slider has a range of 40 Hz to 400 Hz. By 
being able to control the minimum pitch, you can focus the Time Com-
pression/Expansion process for maximum efÞciency Ñ it all depends 
on the audioÕs spectral shape. This slider should be set lower when 
processing bass guitar or other instruments with a similarly low range. 

Set the min pitch higher when processing other instruments such as 
snare drums, violins, and other higher range instruments/sounds. 
After reading the following sections, begin experimenting with combi-
nations of the other Þne-tune controls in relation to the min pitch 
slider.
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Accuracy

Use the accuracy slider to prioritize the processing resources allocated 
to audio quality (sound) or timing (rhythm). Moving the slider toward 
sound generally results in better sonic quality and fewer audio arti-
facts. Moving the slider toward rhythm puts the emphasis on keeping 
the tempo consistent. When working with loops, listen carefully until 
you Þnd the setting which keeps timing solid within the region. Start 
and end times will be precise, but the perception of beats may be 
ÒshufßedÓ if the accuracy sliderÕs rhythm setting is too low. 

Reference Pitch

Generates a sine wave tone that you can adjust to match a selected 
portion of audio material, then use as an audible reference when pitch-
shifting other audio material in your session. 

To use the reference pitch feature:

1. Select the audio material you wish to use as a pitch reference. 
Click the preview button to begin playback of the selected audio. 

2. Click the Reference Pitch button to activate the reference sine 
wave tone.

3. Adjust the note and detune settings to match the reference tone to 
the pitch of the audio playback. Adjust the level setting to change 
the relative volume of the reference tone. It may also be helpful to 
toggle the reference pitch on and off to compare pitch.

4. Select the audio material to be pitch shifted. 

5. Adjust the coarse and Þne Pitch Shift controls to match the pitch of 
the audio playback to the reference pitch.
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Numerics
16 x 9 display option 329
16 x 9 format 133
3/4-inch U-matic videotape See Videotape
4 x 4 audio interface See Digidesign audio 

interface

A
A2 timecode option 335
Absolute timecode 335
Add Channel button (Deck Configuration 

dialog box) 136
Add Comments command (Monitor menus) 

393
Add Deck button (Deck Configuration dialog 

box) 138
Add dissolve dialog box 550
Add Edit function

for maintaining sync 566
for multicamera editing 594

Add edit function
using 445

Add Page button (script window) 302
Add Scene button (script window) 302
Add Scene or Page dialog box 302

Adding
bin columns 247
color indicators (script window) 316
comments

during digitizing 190
during editing 393

edits 445
filler

during a trim 473
to a sequence 377

locators
during digitizing 190
while editing 355

new tracks 443
off-screen indicators (script window) 315
page and scene numbers in the script 

window 302
script marks 317
takes in the script window 312

Adjusting
digital scrub parameters 484
input levels with the Audio Tool 169
margins in the script window 296
output on four- or eight-channel systems 

610
output on two-channel audio board systems 

612
pan in the Audio Mix Tool 490

Index

A B C D E F G H I J K L M N O P Q R S T U V W X Z 
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reference level in the Audio Tool 166
take lines in the script window 314
volume in the Audio Mix Tool 490
volume in the Timeline 500

AES/EBU (Audio Engineering Society/
European Broadcast Union) digital format, 
defined

ALE (Avid Log Exchange), converting shot log 
files with 114

Alias, launching an application from 32
Align Selected to Grid command (Bin menu) 

260
Annotate feature 190
AppleShare, for file transfer 667
Arrow keys, stepping with 347
ASCII text files

importing to a script window 294
A-side (outgoing frames), in trims 460
Assemble edit recording 614

enabling in Deck Settings 616
Attic folder

defined 59
retrieving files from 60

Audio
See also Audio Gain Automation, Audio Mix 

Tool, Audio Tool
checking for multicamera 581
crossfading 550
dipping 552
dissolves 549
eight-channel input 157
EQ templates 528
fading 550
input levels See Audio Tool
leader

creating 266
using to maintain sync 563

levels
fine-tuning with add edit 549

mixdown 553
multicamera, managing 575, 575

number of tracks supported 434
output

calibrating 608 to 613
preparing for 608

pan
adjusting in Audio Mix Tool 490
centering 225
defaults, setting 224

sample rates
in the Audio Setup display 162

scrub 482 to 487
setup, in the Audio Tool 160
tracks

mixing down 553
monitoring 437

volume
adjusting in Audio Mix Tool 490
adjusting in the Timeline 500
adjusting while playing 499

waveform plots, displaying 487
Audio 4 x 4 interface See Digidesign audio 

interface
Audio Data command (Timeline Fast menu) 

487
Audio effect tools, accessing 480
Audio Engineering Society/European 

Broadcast Union (AES/EBU) See  AES/
EBU

Audio EQ (Equalization)
adjusting while playing 533
templates 530

Audio EQ command (Tools menu) 518
Audio EQ Tool

examples of uses 527
Fast menu options 522
features of 519
opening 518
saving effects 524
See also  EQ effect

Audio File Format pop-up menu 134
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Audio file types
importing 215

Audio Gain Automation
deleting key frames in 504
enabling and adding key frames in 503
real time response for 502

Audio Mix command (Tools menu) 490
Audio Mix Tool

adjusting volume and pan
on a single track 492
on multiple tracks 497

and Automation Gain 516
Fast menu options 495

Audio Mixdown
media files, deleting 275
procedure 553

Audio Mixdown command (Special menu) 553
Audio Mixdown dialog box 554
Audio Settings dialog box 224, 486
Audio Setup display See Audio Tool
Audio solo feature 439
Audio timecode, using in Composer 222
Audio tone media, creating 172
Audio Tool

adjusting input levels with 169
Calibrate mode 170
digital scale, defined 165
features, described 164
Peak Hold option, choosing 167
reference level, adjusting 166
resizing 165
Setup options 160
volume meters, defined 165
VU (volume unit) scale, defined 165

Audio Tool command (Tools menu) 163
Audio volume rubber-banding See Audio Gain 

Automation
AudioSuite Plug-Ins

applying 534
limitations 540
rendering 539

troubleshooting 540
AudioVision

transferring OMF files to
compatibility issues 643
guidelines for 644

Autodigitizing 196, 577
Automation Gain

and the Audio Mix window 516
connecting a fader 514
Fast menu 511
keyboard shortcuts 513

Auto-save function, described 59
AutoSync command (Bin menu) 556
Autosync dialog box, options in 556
Autosyncing 555
Auxiliary timecode 335
Avid Calculator Tool, using 100
Avid Composer system

application
launching 32
location of 32

quitting 44
settings 61
turning off the equipment 45

Avid controller, specifying 105
Avid drive, described 25
Avid Log Exchange See  ALE
Avid logs See Shot Log files
Avid Media Reader, defined 188
Avid Users folder

deleting folders from 27
described 26
moving work between systems 28

AvidDroid, specifying a port for 105
AvidNet 666, 666

B
Background color, changing

in bins 258
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in the Source/Record window 328
Background color, changing in the Timeline 401
Backing up

media files 42, 280
Backtiming edits 447
Backups

Attic folder 60
Bandwidths in Audio EQ Tool 520
Bars and tone

for calibrating video output 602
preparing for digitizing 264
recording to tape 615

Batch Digitize command (Clip menu) 202, 209
Batch Digitize dialog box 202
Batch digitizing

See also Autodigitizing, Digitizing, 
Redigitizing

preparing for 200
procedure 202
sequences, procedure 206

Betacam See Videotape
Big Trim mode

defined 455
toggling with Small Trim mode 459

Bin editing in Segment mode 425
Bin Fast menu 230
Bin names, deleting from the Project window 58
Bin settings, defined 64
Bin views

customizing 243
types of 243

Bins
auto-save function, described 59
background color, changing 258
Bin View pop-up menu 243
changing the display font in 231
checking for multicamera 580
closing 58
columns in

adding 247
deleting 246

duplicating 246
moving 244
showing and hiding 245
tidying up 244

creating 54
deleting 58
deleting names 58
display modes for 228 to 230
displaying in Project window 48
editing from in Segment mode 425
Fast menu 230
finding 364
finding from the script window 322
Info Display 76
information in Console 103
locking items in 238
logging directly into 120 to 126
managing 52
opening 57
opening from a different project 49
organizing a project with 221 to 263
preparing for digitizing 187
printing 262
rearranging clips in 259, 262
renaming 56
retrieve 60
saving

using system backup 42
using the Save Bin command 59

selecting
media relatives in 240
offline items in 239
sources in 240
unreferenced clips in 241

setting clip display in 226
targeting for digitizing 149
transferring

with MediaLog for Macintosh 113
Bins display (Project window) 48
Black level, adjusting

for input 180
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for output 606
Black segment See  Filler
Blue bar See  Position indicator
Blue only feature (as substitute for Waveform 

and Vectorscope) 607
B-side (incoming frames), in trims 460
Buttons

See also User-selectable buttons
Add Channel 136
Add Deck 138
Add Scene and Add Page (script window) 

302
Color (script window) 316
Find Bin 364
Find Frame 365
Focus 412
for controlling playback 344
Grid 96
In/Out (Audio Tool) 164
Input (Audio Tool) 171
mapping user-selectable 96
Mark IN 352
Mark OUT 352
New Project (Project Selection dialog box) 38
New User (Project Selection dialog box) 36
Off-screen (script window) 315
Output Options (Audio Tool) 164
Play (script window) 314
Preset (Video tools) 176
Reset Peak (Audio Tool) 164
Source/Record toggle 413

B-Y gain adjustment 608

C
Calculator command (Tools menu) 100
Calculator Tool, using 100
Calibrate command (Peak Hold pop-up menu) 

170
Calibrating

audio output 609
global levels 608
of digital cut 608

video input 177
table of luminance settings 181
with vectorscope 181
with waveform monitor 179

video output 602
advanced procedures 604

Calibration tone
creating media for 172
setting 609

Camera setups, in the lined script 289
Camera, Digital News Gathering (DNG) 210
Capture mode

entering 142
Center Pan command (Clip menu) 225
Change Scene or Page dialog box 303
Changing

background color
in bins 258
in the Source/Record window 328
in the Timeline 401, 404

bin font 231
font in the script window 297
frame size 259
page and scene numbers in the script 

window 303
representative frame in takes 313
the frame identifying a clip 260

Channel Settings dialog box 136
Check Decks command (Deck Selection pop-up 

menu) 145
Choosing a user 36
Chrominance

adjusting for output 607
Clear command (Edit menu) 235, 246, 274
Clear Monitor command (Monitor menus) 341
Clearing clips from monitors 341
Clearing IN and OUT points 352
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Clip information
modifications table 129

Clip Information window
displaying 232
displaying from a monitor 332
opening from a bin 232
opening from a script window 295

Clip names, finding in a monitor 362
Clipboard

copying to 389
preserving contents of 389
recovering material from 389

Clipboard Contents command (Monitor menu) 
390

Clips
See also Master clips, Subclips, Group clips, 

Multigroup clips
autosyncing 555
clearing from monitors 341
clearing marks from 352
copying 235
deleting 235
deleting extra multicamera 581
deleting unreferenced 275
duplicating 234
Editcam, copying 211
Editcam, importing 210
exporting 628
group, creating 583
linking to script 306
loaded, switching between 340
loading into monitors 339, 339
locking 238
marking

entire segments 352
with IN and OUT points 351

modifying information in 126
moving 234
multigroup, creating 585
playing

using buttons 344

rearranging
in Frame mode bin display 259
in Script mode bin display 262

relocating 363
replacing 580
searching for text in 362
selecting 233
sifting 236
tracking the duration of 331

Closing a project 42
Closing bins 58
Closing the Project window 48
Color

frame shifts 451
Color bars

See also Bars and tone
in Dupe Detection 449
types of 179

Color button (script window) 316
Color indicators (script integration)

adding to takes 316
described 291

Color submenu (Script menu) 316
Columns  See Bins
Combination cutting in multicamera editing 

600
Command Palette

using 93, 93
Command palettes

See also Command Palette
mapping 99

Commands See Menu commands
Comments

adding during digitizing 190
adding to sequence clips 393

Compatibility between AudioVision and Media 
Composer 643

Compatibility requirements for transfer 664
Component output settings 606
Composer Projects folder

deleting folders from 27
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described 26
moving work between systems 28

Composer tools 89 to 105
Composer window, customizing 327
Composite output settings 606
Compression command (Tools menu) 143
Configuring decks 135
Console

bin information in 103
checking peak levels with 173
displaying system information in 102

Console command (Tools menu) 102, 173
Console Tool, using 102, 103
Consolidate command (Clip menu) 277
Consolidate dialog box 277
Consolidating

for transfer to Pro Tools 649
Consolidating media files

defined 276
group clips 278
master clips 276
procedure 277
sequences 276
subclips 276

Control track breaks, digitizing across 202
Control track, using for preroll 156
Controller, specifying 105
Converting

media files 29
projects 29
shot log files with Avid Log Exchange 114

Copying
clips and sequences 235
Editcam master clips 211
in the Timeline 426
locators from source clips 378
text from the Clip Information window 233
text in the script window 300
to Clipboard 389

Countdown
customizing 617

in a digital cut 617
Crash recording (Manual recording) 614
Creating

See also Editing, Deleting
a folder in a project 50
an instant rough cut 381
Avid log files 117
bins 54
group clips 583
leader 266
multigroup clips 585
overlap edits 466

in one step 448
subclips 353
subclips during digitizing 189
tone media 172

Creating a project 38
Crossfading audio 550
Custom bin view, defined 243
Custom countdown display 619
Custom Sift command (Bin menu) 237
Custom sift dialog box 237
Custom Time option (Digital Cut Tool) 623
Customizing

bin views 243
the Composer window 327
the manual user interface (MUI) 369
the Timeline 399
Trim mode 454

Cut, copy, paste in the Timeline 426
Cutaways, marking with locators 355
Cutting See Editing, specific edit modes
Cutting text in the script window 300
Cycle Picture/Sound button 437

D
D1 VTR

calibrating input from 176
digitizing from 174
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recording to 603
DAE (Digidesign Audio Engine) 535
DAT See Digital audiotape
Deck Configuration settings

adjusting 135
deleting elements in 140

Deck Controller
in Digital Cut Tool 617

Deck Controller Tool, using 91
Deck Preferences 141
Deck Selection pop-up menu 145
Deck Settings

for configuring decks 138
Deck settings

for assemble-edit recording 616
Decks, configuring 135
Decompose feature 207
Defaults for settings, restoring 70
Defining settings 63
Delay edit (Overlap edit) 448
Delete Clips dialog box 236
Delete dialog box (script integration) 304, 312
Delete Media Files dialog box 274
Delete Take command (Script menu) 311
Deleting

See also Creating, Editing
add edits (match frames) 446
bin columns 246
bins 58
clips and sequences 235
deck configurations 140
media files

in bins 235
with Media Tool 273

page and scene numbers in the script 
window 304

script marks 321
segments, in Segment mode 423
settings 70
slates in the script window 311
takes in the script window 312

text in the script window 301
tracks 444
unreferenced clips 275

Desktop, Composer elements on 25
Dialog boxes

add dissolve 550
Add Scene or Page 302
Audio Mixdown 554
Audio Settings 224, 486
Autosync 556
Batch Digitize 202
Change scene or page 303
Consolidate 277
custom sift 237
Delete (script integration) 304, 312
Delete Clips 236
Delete Media Files 274
Display Bin Selector 226
Display Media Selector 272
Find 362
Font 297
Group clips 583
Headings 245
Margin 297
Modify 127
Project selection 35
Read Audio Timecode 222
Relink 283
Selct Files to Import 118
Select a Bin 54, 374
Select Files to Import 217
View Name (bin) 249
view name (Timeline) 405

Dialog, in the lined script 289
Digidesign audio interface
Digidesign AudioSuite Plug-Ins
Digidesign hardware

See also Audio
Video Slave Driver

pulldown switch settings 133



685

Digital audio scrub
adjusting parameters for 484
compared to smooth audio scrub 482
using 484

Digital audiotape (DAT), digitizing from 133
Digital bars and tone, preparing 264
Digital Betacam VTR

calibrating input from 176
digitizing from 174
recording to 603

Digital Cut command (Output menu) 621
Digital Cut Tool

Deck Controller in 617
Digital cuts

previewing 617
Record to Tape options 623
recording 621

Digital scale (Audio Tool), defined 165
Digitize across timecode breaks option 135
Digitize command (Tools menu) 121
Digitize Tool

logging with 121
resizing 201
resolution, choosing 148
setting up 144
subclip status in 189

Digitize Video to Multiple Files option 134
Digitizing

See also Autodigitizing, Batch digitizing, 
Redigitizing

across control track breaks 202
across timecode breaks 196, 201
adding comments (annotating) during 190
adding locators during 190
and logging at the same time 191 to 196
bars and tone 264
defined 186
from a mark IN to a mark OUT 191
from a non-Avid-controlled deck 197
methods for 577
multicamera material 577

on-the-fly 193, 194
preparing for

Audio Tool setup 163 to 173
Compression tool setup 143
deck selection 145
Digidesign hardware settings 133
Digitize Tool setup 144
hardware considerations 132
resolution selection 148
settings selection 134
source track selection 147
tape selection 145
targeting bins 149
targeting drives 150
video input 174 to 184
video levels, adjusting by eye 184

setting only Mark IN 193, 193
sources for 134
to multiple media files 152
to the Timeline 199
using timecode-of-day 198
with Avid Media Reader 188
workflow, multicamera 576

Dipping audio 552
Diskette, saving work on 42
Display Bin Selector dialog box 226
Display Media Selector dialog box 272
Displaying

clip information in the Timeline 404
Safe Title overlays 96
sync breaks 559
take numbers in slates 313

Displays 334
Dissolves

audio 549
DLT for backup 42
Drive Filtering Based on Resolution option 134
Drive, saving work on 43
Drives for transferring media 666
Dual-image play during trims 464
Dual-rolling trim 464
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Dupe detection 449
Duplicate command (Edit menu) 69, 234, 246
Duplicating

bin columns 246
clips and sequences 234
settings 69

Duration, tracking 331

E
Edit controller, with VTR play emulation 624
Edit decision list

See  EDL
Editcam clips

acquiring 210
compatibility 210

Editcam file format
importing 215

Editcam files 210
Editcam master clips

copying 211
Editing

See also Edits, Creating, Deleting, specific 
edit modes

adding new tracks during 443
deleting tracks during 444
effects 434
in Heads (and Tails) view 432
multicamera material 572 to 600
new sequence 373
Sync Point Editing 567
to avoid sync breaks 558
with film track 429
with the script window 322

Edits
See also Editing, Creating, Deleting, specific 

edit modes
adding (match-framing) 445
backtiming 447
combination cutting (multicamera) 600

copying to clipboard 389
extending 467
Extract 388
Extract/Splice-in (Segment mode) 422
instant rough cut procedure 381
Lift 388
Lift/Overwrite (Segment mode) 422
on-the-fly cutting (multicamera) 598
overlap 448
Overwrite 384
Replace 385
selective cutting (multicamera) 597
Splice-in 383
undoing or redoing 382

EDL (edit decision list)
creating 624
described 624
transfer, assigning port for 105

Effects
Audio EQ, removing 525
nesting, defined 435
types of 434

Eight-channel audio input 157
Eject command (File menu) 34
End key 347
Energy Plot in Timeline 488
Enlarge Frame command (Edit menu) 259, 308
Enlarging and reducing frames in the bin 259
Enlarging tracks in the Timeline 402
Entering

Source/Record mode 373
Trim mode 457

EQ effect
adjusting while playing 533
applying 520
removing 525
templates for 528

Errors, viewing log of in the Console 102
Events in an EDL, defined 624
Exchanging material 627 to 666
Exiting Trim mode 459
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Exporting
shot log files 130

Exporting files
OMF to Pro Tools 651
preparing for 629
preparing for OMF export 642
procedure for 631
reasons for 628
with Media Composer QuickTime codec

described 655
from third-party application 662
guidelines for 655
installing 656
procedure for 657
settings for 659

Extend button 467
Extending an edit 467
External drive See Media drive
Extract edits 388
Extract/Splice-in button 422

F
Fader, connecting to a system 514
Fading audio 550
Fast Forward button 344
Fast menus

Bin 230
Locators window 358
Media Tool 271

Fetch
using to transfer OMF files 667

FieldPak
Editcam media 210

File managment 270
File Transfer Protocol (FTP) 667
File Type pop-up menu (Select Files to Import 

dialog box) 217
Files

exporting

OMF to Pro Tools 651
procedure for 631
reasons for 628
with Media Composer QuickTime codec

from third-party application 662
guidelines for 655
procedure for 657
settings for 659

importing
guidelines for 213
limiting size 213
mixed resolutions 214
procedure for 216

Fill Sorted command (Bin menu) 260
Fill Window command (Bin menu) 260
Filler

adding during a trim 473
adding to a sequence 377

Film
options, choosing 39
preferences, setting 39

Film bin view, defined 243
Film Composer folder 25
Film projects

nesting in folders 39
Film track, editing with 429
Find Bin button 364

in the script window 322
Find command (Edit menu) 305, 362
Find dialog box 362
Find Frame button 365
Find procedures 362
Find Script button 321
Finding

bins
from a monitor 364
from the script window 322
related media files 281

clip names, with Find command 362
script from marked takes 321
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text in the script window 305
Finding frames

with the Find command 362
with the Find Frame button 365
with timecode offset 360

Focusing the Timeline 412
Folders

creating 39
deleting 27
managing 52

Font dialog box 297
Font in bins, changing 231
Fonts in the script window, changing 297
Footage

clearing marks from 352
loading into monitors 339, 339, 342
marking and subcataloging 350 to 357
relocating 360
viewing and playing 326 to 350

Format elements, preparing 264 to 268
Four- to eight-channel audio board system

adjusting output on 610
adjusting trim level settings 170

Four-frame display
described 420
suppressing 421

Frame by frame movement in the Timeline 414
Frame mode (bin display)

defined 228
in Media Tool 271
using 257 to 260

Frame Mode button 257
Frame offset 361
Frame size, changing 259
Frame-accurate recording 614
Frames

displaying matching footage for 569
exporting 628
finding

with the Match Frame button 569
with the Match Frame function 363

with timecode offset 360
identifying a clip, changing 260
rearranging

in Frame mode 259
in Script mode 262

tidying up 260
Frequencies (audio), adjusting 518
FTP 667
Full-monitor multicamera display 586
Full-Screen mode

loading footage 342
Full-screen monitor

loading footage into 338
Full-screen Timeline 426

G
Ganging

footage in monitors 568
multiple tracks in the Audio Mix Tool 498

Gathering format elements 264 to 268
General settings, defined 64
Genlock options (Video Output Tool) 606
Go To Capture Mode command (Bin menu) 142
Going to scene or page numbers 305
Goto Page command (Script menu) 305
Goto Scene (Script menu) 305
Graphics file types

importing 215
Grid 96

aligning frames 260
Grid button 96
Group clips

consolidating 278
creating 583

Group Clips command (Bin menu) 583
Group Clips dialog box, options 583
Grouping procedures 583
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H
Hard recording See  Manual recording
Hardware command (Tools menu) 103
Hardware Tool

displaying 85
using 103

Headings command (Bin menu) 245
Headings dialog box 245
Heads (and Tails) View, in the Timeline 432
Hiding

bin columns 245
slate frames 309

High shelf in Audio EQ Tool 520
Home command (Windows menu) 429
Home key 347

I
Ignoring volume and pan settings 498
Import command 118
Import dialog box 217
Importing

a script 294
Editcam clips 210
shot log files 118
statistics files 81
test patterns 265

Importing files
before you begin 213
guidelines 213
in mixed resolution projects 214
procedure for 216

IN and OUT marks 351
In/Out buttons (Audio Tool), defined 164
Indicating off-screen dialog 315
Infinite Hold option (Audio Tool) 168
Info display in Project window 76
Info Display window

displaying Hardware 85

displaying Memory 84
displaying Profile 76
displaying Usage 77

Information Display menu
 331

Input button (Audio Tool) 171
Input Source pop-up menu (Audio Setup 

display) 162
Insert-edit recording 614
Interface settings, defined 64

J
J-K-L keys (Three-Button Play) 346
Jogging See  Stepping

K
K-AShare 667
Keyboard

using to control playback 346

L
Launching the application 32
Leader

creating 266
for managing sync breaks 563

L-edit (Overlap edit) 448
Left Arrow key 347
Left Margin command (Script menu) 296
Lift/Overwrite button 422
Lifting material 388
Line Selector slider (waveform monitor) 180
Linecut option, for multicam editing 593
Lined script, described 288
Linking clips to script 306
Load Filler command (Monitor menus) 377
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Loading
filler 377
footage 339, 339
takes from the script window 314, 320

Locators
adding during digitizing 190
adding while editing 356
copying from source clips 378
finding frames with 362
for managing sync breaks 565
using 355

Lock Bin Selection command (Clip menu) 238
Lock Tracks command (Clip menu) 443
Locking

bin items 238
tracks 442

Logging
and digitizing at the same time 191 to 196
bypassing by autodigitizing 196
directly into a bin

with a non-Avid-controlled deck 124
with an Avid-controlled deck 121

guidelines for 109
multicamera material 577
preroll 110, 110
procedures for 109 to 126, 577

Logging errors to the console 102
Logs See Shot Log files
Longitudinal timecode See LTC
Low shelf in Audio EQ Tool 519
LTC (longitudinal timecode)

decoding with Media Reader 188
reading the User Bits in 223

Luminance settings
adjusting for video output 604
table of 606

M
Macintosh computer

turning off 45
Making subclips 353
Managing

bins 52
folders 52
media files 270 to 286

Manual recording 614
Manual User Interface See  MUI
Mapping

menu commands 98
user-selectable buttons 96

Margin dialog box 297
Mark and park editing 386
Marking

clips 352
entire segment 352
IN and OUT points 351, 352
segments in Segment mode 424
with locators 355

Marks
clearing 352
IN and OUT points 351
phantom 386

Master clips
consolidating 276
copying 235
deleting 235
duplicating 234
locating from subclip 364
locking 238
moving 234
redigitizing 205, 206
relinking 282
selecting 233
sifting 236

Master shot, in the lined script 289
Match Frame function

for multicamera editing 597
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using 363, 569
Matchback

options 39
Match-framing (Adding edits) 445
Matching a frame 363
Media Composer folder 31
Media Conversion Tool 29
Media drive

ejecting 33
mounting 33
targeting 149

Media File Manager, converting from 29
Media files

backing up 280
consolidating

defined 276
procedure 277

converting 29
deleting

in bins 235
in the Media Tool 273
unreferenced 275

Editcam 210
finding related 281
managing 270 to 286
manipulating with Media Tool 270
multiple, digitizing to 152
relinking 282
transferring 666
unlinking 286

Media Inbox 666
Media Reader

assigning port for 105
defined 188

Media relatives
selecting in the bin 240

Media Tool
basic features of 271
opening 272

Media Tool command (Tools menu) 272
Media Tool Fast menu 271

MediaLog for Macintosh, transferring bins with 
113

MediaLog for PC
operating system requirements 114
transferring bins with 114

MediaShare icons, ejecting and mounting 33
Memory See RAM
Menu commands

Add Comments (Monitor menus) 393
Align Selected to Grid (Bin menu) 260
Audio Data (Timeline Fast menu) 487
Audio EQ (Tools menu) 518
Audio Mix (Tools menu) 490
Audio Mixdown (Special menu) 553
Audio Tool (Tools menu) 163
Autosync (Bin menu) 556
Batch Digitize (Clip menu) 202, 209
Calculator (Tools menu) 100
Calibrate (Peak Hold pop-up menu) 170
Center Pan (Clip menu) 225
Check Decks (Deck Selection pop-up menu) 

145
Clear (Edit menu) 235, 246, 274
Clear Monitor (Monitor menus) 341
Clipboard Contents (Monitor menu) 390
Color (Script menu) 316
Compression (Tools menu) 143
Console (Tools menu) 102, 173
Consolidate (Clip menu) 277
Custom Sift (Bin menu) 237
Delete Take (Script menu) 311
Digital Cut (Output menu) 621
Digitize Tool (Tools menu) 121
Duplicate (Edit menu) 69, 234, 246
Eject (File menu) 34
Enlarge Frame (Edit menu) 259, 308
Fill Sorted (Bin menu) 260
Fill Window (Bin menu) 260
Find (Edit menu) 305, 362
Go To Capture mode (Bin menu) 142
Goto Page (Script menu) 305
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Goto Scene (Script menu) 305
Group Clips (Bin menu) 583
Hardware (Tools menu) 103
Headings (Bin menu) 245
Home (Windows menu) 429
Import (File menu) 118
Left Margin (Script menu) 296
Load Filler (Monitor menus) 377
Lock Bin Selection (Clip menu) 238
Lock Tracks (Clip menu) 443
mapping 98, 98
Media Tool (Tools menu) 272
Modify (Clip menu) 127
Mount All (File menu) 34
New Audio Track (Clip menu) 376, 443
New Bin (File menu) 54
New Deck Controller (Tools menu) 91
New Script (File menu) 294
New Video or Picture Track (Clip menu) 376
New Video Track (Clip menu) 443
Open Bin (File menu) 54
Page Setup (File menu) 263
Play Calibration Tone (Peak Hold pop-up 

menu) 609
Print (File menu) 263
Print Timeline (File menu) 453
Read Audio Timecode (Special menu) 222
Redo (Edit menu) 383
Reduce Frame (Edit menu) 259, 308
Relink (Clip menu) 283
Remove Pan/Vols (Audio Mix Fast menu) 

497
Restore Default Patch (Special menu) 441
Reverse Selection (Bin menu) 275
Select All Tracks (Edit menu) 437
Select Media Relatives (Bin menu) 240
Select Offline Items (Bin menu) 239
Select Sources (Bin menu) 241
Select Unreferenced Clips (Bin menu) 241
Serial Ports (Tools menu) 105, 625
Set Bin Display (Bin menu) 226

Set Calibration Tone (Peak Hold pop-up 
menu) 609

Set Color (Edit menu) 258
Set Font (Edit menu) 231, 297
Set Level (Audio Mix Tool) 497
Set Pan (Audio Mix Fast menu) 497
Set Reference Level (Peak Hold pop-up 

menu) 166
Show All Takes (Script menu) 309
Show Every Frame (Timeline Fast menu) 

430
Show Frames (Script menu) 309
Show Track (Timeline Fast menu) 430
Sync Breaks (Timeline Fast menu) 560
Tidy Up Columns (Bin menu) 245, 260
Undo (Edit menu) 383
Unlock Bin Selection (Clip menu) 239
Unlock Tracks (Clip menu) 443
Video Input Tool (Tools menu) 174
Video Output Tool (Tools menu) 174, 602
View Type (Timeline Fast menu) 432
VTR Emulation (Special menu) 625
Zoom Back (Timeline Fast menu) 411
Zoom In (Timeline Fast menu) 411

Meters See Volume meters
Methods for transferring media between 

systems 664
MFM to MSM conversion 29
MII video See Videotape
Mixed resolutions 214
Mixing down audio 553
Modify command (Clip menu) 127
Modify dialog box 127
Modifying

clip information 126
settings 67

Monitor icons 437
Monitor menus, using 340
Monitoring audio/video tracks 437
Monitors

clearing clips from 341
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displaying the Clip Information window 
332

ganging footage in 568
loading footage into 339, 339
loading multiple clips and sequences into 

339
viewing in 336

Mono option (audio) 554
Motion effects, defined 434
Motion mode indicator in the Timeline 414
Mount All command (File menu) 34
Mounting disk drives 33
Mouse Jog button 349
Mouse shuttle button 349
Mouse, stepping and shuttling with 349
Movement in Timeline, controlling 414
Moving

bin columns 244
Clip Information window 233
clips and sequences 234
frames in the bin 259
projects between systems 28
script marks 320
slates in the script window 310
tracks in the Timeline 403
user profiles between systems 28

Moving settings
between settings files 71
between systems 74

Moving through clips 344
MSM format 29
MSM to AudioVision conversion 29
MUI (Manual User Interface)

customizing 369
default editing buttons 368
using 366

MUI controller, specifying 107
Multicamera editing

combination cutting in 600
cutting on-the-fly in 598
developing a production model for 572

digitizing workflow for 576
grouping 583
managing audio in 575, 575
modes of 585
production paths 574
Quad menus 596
Quad Split menu 595
Quad Split mode 587
selective cutting in 597
switching angles 592
tape classification 573
techniques 591
workflow options 597

Multicamera linecut option 593
Multicamera mode, described 589
Multigroup clips, creating 585
Multilevel sorting of columns 257
Multiple media files, digitizing to 152
Multiple tracks, working with 434 to 449

N
Nested effects, defined 435
Nesting

effects 435
film projects 39
projects in folders 39

New Audio Track command (Clip menu) 376, 
443

New Bin command (File menu) 54
New Deck Controller command (Tools menu) 

91
New Script command (File menu) 294
New sequence, setting up 373
New User button (Project Selection dialog box) 

36
New Video Track command (Clip menu) 376, 

443
NTSC (National Television Systems 

Committee) video
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B-Y Gain, adjusting 608
edit format 39
luminance values 606
PICT resolution 621
R-Y Gain, adjusting 608
waveform values 181

NTSC Has Setup option 134

O
Offline editing

detecting color-frame shifts during 451
detecting duplicate frames during 449

Offline items, selecting in the bin 239
Off-screen button (script window) 315
Off-screen dialog

in the lined script 289
indicating in the script window 315

Off-screen indicators (script integration)
adding to takes 315
described 291

OMF Interchange files
described 640
exporting to AudioVision

compatibility issues 643
guidelines for 644

exporting to Pro Tools
guidelines for 649
procedure for 651

importing 215
methods for exporting 641
preparing to export 642
web site 641

One/Two Disk Mode button 150
One-step overlap cuts 448
Open Bin command (File menu) 54
Opening a project 35, 41
Opening bins 57
Opening the Project window 48
Operator pop-up menu (Custom Sift dialog 

box) 237
Orphans See Offline items
Output

See also Digital cuts, EDL, Playback
calibrating for video 602
options 601
preparing for 601

Output Options button (Audio Tool), defined 
164

Overlap edits 448, 466, 467
Overwrite edits 384

P
Padlock icon in Track Selector panel 442
Page and scene numbers (script window)

adding 302
changing 303
deleting 304
searching for 305

Page Setup command (File menu) 263
PAL (Phase Alternating Line) video

B-Y Gain, adjusting 608
edit format 39
luminance values 606
PICT resolution 621
R-Y Gain, adjusting 608
waveform values 181

Pan adjustment
ignoring 498
See also  Audio Mix Tool

Parametric midrange in Audio EQ Tool 520
Pasting in the Timeline 426
Patching tracks 441
Pause button 344
Peak Hold option (Audio Tool) 167
Peak Hold pop-up menu (Audio Tool), defined 

164
Phantom marks, using 386
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PICT files
importing for custom countdown 621
importing for test pattern 605
of bars, importing 265

Picture tracks, monitoring 437
Play button 344
Play button (script window) 314
Play Calibration Tone command (Peak Hold 

pop-up menu) 609
Playback

improving 394
loop, starting 394
loop, trim during 466
with audio scrub 482

Playback, controlling
with buttons 344
with position bars and indicator 343
with the keyboard 346
with the mouse 349

Playing
takes from the script window 314

Pop-up monitor
loading into 339
viewing in 337

Position bar 343, 408
Position indicator

in the Timeline 408
using 343

Postroll in trim mode playback loop 464
Precompute media files

deleting 275
Preparing

sequences for export 629
sequences for OMF export 642
shot log files

with MediaLog 112
with text editors 117

to digitize 132 to 184
Preroll

in Trim mode playback loop 464
logging 110

using control track for 156
Preset buttons 176
Previewing digital cuts 617
Print command (File menu) 263
Print Timeline command (File menu) 453
Printing

bins 262
statistics 78
the Timeline 453

Pro Tools
transferring OMF files to

guidelines for 649
procedure for 651

Production paths for multicamera editing 574
Profile 76
Project Selection dialog box 35
Project settings, defined 62
Project window

bins display 48
closing 48
Info display, using 76
opening 48
Settings display, using 62

Projects
closing 42
converting 29
creating new 38
deleting 27
moving between systems 28
nesting in folders 39
opening 35, 41
relinking media files for 285
saving 42
selecting 38, 40
transferring 639, 664 to 666

Projects folder
See Composer Projects folder

Pull list
generating 39

Pulldown switch (Video Slave Driver) 133
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Q
Quad menus 596
Quad Split display 587
Quad Split menu 595
QuickTime file format

and Media Composer codec 655
QuickTime file type

importing 215
Quitting the Avid Composer application 44

R
RAM

displaying
requirements for 83

Read Audio Timecode command (Special 
menu) 222

Read Audio Timecode dialog box 222
Real time response, for Audio Gain Automation 

502
Rearranging clips

in Frame mode bin display 259
in Script mode bin display 262

Record Deck Time option (Digital Cut Tool) 623
Record monitor, viewing in 336
Recording

digital cuts 621
to the Timeline 199
types of 614

Redigitizing
See also Digitizing, Batch digitizing
master clips and subclips 206
sequences

procedure 206
using decompose 207

Redo command (Edit menu) 383
Reduce Frame command (Edit menu) 259, 308
Reducing and enlarging

frames in the bin 259

Reducing tracks in the Timeline 402
Relink command (Clip menu) 283
Relink dialog box 283
Relinking

See also Unlinking
consolidated clips 284
media files and clips 282
moved projects 285
to selected clips 284

Remove Pan/Vols command (Audio Mix Fast 
menu) 497

Removing
add edits (match frames) 446
color indicators (script window) 316
off-screen indicators (script window) 315
text from the script window 301

Renaming bins 56
Renaming settings 69
Replace edits 385
Replacing Timeline and bin views 405
Reset Peak button (Audio Tool), defined 164
Resizing

slates in the script window 308
the Audio Tool 165

Resizing the Digitize Tool 201
Resolution pop-up menu (Digitize Tool) 148
Resolutions, mixed 214
Restore Default Patch command (Special menu) 

441
Restoring

default settings 70
files from backup 43

Retrieve files 60
Reveal File command (File menu) 281
Reverse Match Frame 570
Reverse Selection command (Bin menu) 275
Review Transition button 458
Reviewing

trim edits 463
Rewind button 344
Right Arrow key 347
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Rollers See  Trim mode
Rough cut, creating in one step 381
Rubber-banding See Audio Gain Automation
R-Y gain adjustment 608

S
S/PDIF (Sony Phillips Digital Interface Format), 

defined 163
Sample Plot in the Timeline 488
Save As command (Timeline View pop-up 

menu) 404
Save Bin command (File menu) 59
Saving

bins 42, 59
custom bin views 248
projects 42
Timeline views 404

SC phase (hue), adjusting 607
Scanning for tapes 122
Scene and page numbers (script window)

adding 302
changing 303
deleting 304
searching for 305

Script box, in Script mode 262
Script integration

See also Scripts, Script window, Slates, Script 
marks, Takes, Off-screen indicators, 
Color indicators

described 290
elements of 291
for video projects 292
importing a script for 294
lining conventions in 288
workflow 291, 322

Script Mark button 318
Script marks

adding 317
adding during automatic screening 318

deleting 321
described 291, 316
moving 320
using for playback 320
using to find script 321

Script mode (bin display)
defined 229
in Media Tool 271
using 261

Script Mode button 261
Script window

adding color indicators to 316
adding page and scene numbers in 302
adding takes in 312
adjusting margins in 296
adjusting take lines in 314
changing font in 297
changing scene or page numbers in 303
cutting, copying, and pasting text in 300
deleting slates in 311
deleting takes in 312
displaying Clip Information from 295
displaying take numbers in 313
editing with 322
finding bins from 322
hiding slate frames in 309
indicating off-screen dialog in 315
linking clips to 306
loading takes from 314
moving slates in 310
navigating in 296
opening, closing, saving 295
playing takes from 314
removing text in 301
resizing slates in 308
screening and marking in 318
searching through 302 to 306
selecting slates in 308
selecting text in 298
splicing a range of script from 324
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Scripts
importing into script windows 294
linking clips to 306

Scroll bar/position bar in the Timeline 408
Scrubbing (audio) 482 to 486
Searching

for page and scene numbers in the script 
window 305

in the script window 302 to 306
Segment effects, defined 434
Segment mode 416 to 426

deleting segments in 423
editing from a bin in 425
extracting/splicing in 422
four-frame display

described 420
suppressing 421

lifting/overwriting in 422
marking segments in 424
workflow 416

Segments
cutting, copying, and pasting 426
deleting 423
marking 352, 424
selecting 417

Select a Bin dialog box 54, 374
Select All Tracks command (Edit menu) 437
Select Files to Import dialog box 118, 217
Select Media Relatives command (Bin menu) 

240
Select Offline Items command (Bin menu) 239
Select Sources command (Bin menu) 241
Select Tape dialog box 122
Select Unreferenced Clips command (Bin menu) 

241
Selecting

clips and sequences 233
media relatives in the bin 240
offline items in the bin 239
projects 38
segments in the Timeline 417

slates in the script window 308
sources in the bin 240
text in the script window 298
tracks

for audio scrub 483
for digitizing 147
in the Timeline 436

transitions for trimming 457
trim sides 460
unreferenced clips in the bin 241

Sequence Time option (Digital Cut Tool) 623
Sequences

adding comments 392
adding tracks to 376
consolidating 276
copying 235
deleting 235
duplicating 234
exporting 628
finding original bin for 364
making the first edit in 379
marking INs and OUTs in 351
moving 234
output options for 601
playback loop in 394
playback performance tips 394
playing 393
redigitizing

procedure 206, 208
saving two versions for 206
using Decompose 207

selecting 233
setting up 373
sifting 236

Serial digital
input 174
input, calibrating 176
output 603

Serial Ports command (Tools menu) 105, 625
Serial Ports Tool, specifying a controller in 105
Set Bin Display command (Bin menu) 226
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Set Calibration Tone command (Peak Hold pop-
up menu) 609

Set Color command (Edit menu) 258
Set Font command (Edit menu) 231, 297
Set Level commands (Audio Mix Fast menu) 

497
Set Pan commands (Audio Mix Fast menu) 497
Set Reference Level command (Peak Hold pop-

up menu) 166
Setting

audio pan defaults 224
the bin display 226

Settings
basic 63
bin 64
default, restoring 70
defining 63
deleting 70
displaying 62 to 74
duplicating 69
general 64
global export 627
global import 215
interface 64
location of 32
modifying 67
moving between settings files 71
moving between systems 74
multiple, working with 68
overview of 62
renaming 69
site

defined 62
using 75

Shot log files
Avid Log file specifications 117
converting with Avid Log Exchange 114
exporting 130
importing 118
preparing

text editors for 117

with MediaLog 112
Shot logs See Shot log files
Show All Takes command (Script menu) 309
Show Every Frame command (Timeline Fast 

menu) 430
Show Frames command (Script menu) 309
Show Track submenu (Timeline Fast menu) 430
Showing bin columns 245
Shutting down the system 44
Shuttling

with J-K-L keys 346
with the mouse 349
with the MUI 366

Sifting clips and sequences 236
Single mark editing 386
Single Mark Editing option (Composer settings) 

386
Single track monitoring 439
Single-field step 348
Site settings

defined 62
using 75

Slash icon in Track Selector panel 442
Slates (script integration)

creating 307
deleting 311
described 291
hiding frames in 309
moving 310
resizing 308
selecting 308
showing one take in 309

Slipping and sliding shots
in Source/Record mode 472
in Trim mode 468

Small Trim mode 455
toggling with Big Trim mode 459

Smooth audio scrub
compared to digital scrub 482
performing 483
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SMPTE
bars 606

SMPTE timecode, formats for entering 360
Snapping to transitions in Timeline 414
Solo track monitoring 439
Sony/Phillips Digital Interface Format (S/

PDIF), defined 163
Sorting

clips 257
columns, multilevel 257

Source clips
finding with Match Frame 571

Source frames, finding 365
Source material

displaying in Timeline 413
loading into monitors 339

Source monitor, viewing in 336
Source/Record mode

customizing window settings 327
entering 373
first edits in 372 to 393
slipping shots in 472

Source/Record toggle button (Timeline) 413
Source/Record window

changing background color 328
customizing settings 328

Sources, selecting in the bin 240
SPE

 See  Sync Point Editing
Splice-in edit 383
Splicing a range of script 324
Split edit (Overlap edit) 467
Spreadsheet, for reporting statistics 82
Statistics

displaying usage 77
file structure and layout 79
imported into a spreadsheet 82
printing 78
sample file 79
viewing 77

Statistics bin view, defined 243

Statistics folder 78
Steenbeck controller

assigning port for 105
specifying 106

Stepping
by single-field 348
with buttons 345
with J-K-L keys 346
with mouse 349

Storage
devices for transferring media 666
guidelines for multicamera 579

Storyboard
worksheet 268

Storyboard editing
from the script window 324

Striping record tapes 614
Subclip button 354
Subclip status (Digitize Tool) 189
Subclipping on-the-fly 189
Subclips

consolidating 276
copying 235
creating 353
creating during digitizing 189
deleting 235
duplicating 234
handle 353
locating master clip from 364
moving 234
redigitizing 205, 206
selecting 233
sifting 236

Supporting Files folder, defined 32
Switching multicamera shots 592
Sync

See also Genlock options
autosyncing 555
ganging footage in monitors 568
maintaining

with Add Edit 566
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with leader 563
with locators 565
with sync lock 562

maintaining during trim 473
pop-up menu (Audio Setup display) 162
sync-locked tracks, trimming with 474
using Match Frame 569

Sync breaks
displaying 559
fixing 561

Sync Breaks command (Timeline Fast menu) 
560

Sync Point Editing (SPE) 567
Sync-locked tracks 562
Sync-locking tracks in the Timeline 443
System information displayed 102

T
Takes (script integration)

adding 312
adjusting lines in 314
applying color indicators to 316
applying off-screen indicators to 315
changing representative frame for 313
deleting 312
described 291
displaying numbers for 313
loading 314
loading from script marks 320
playing 314
removing color indicators from 316
removing off-screen indicators from 315
showing one per slate 309

Tape deck See Videotape deck
Tape drive, backing up on 42
Tape name, finding 122
Tapes See Videotape, Audiotape
Target bin, choosing 149
Target Drive pop-up menu 150

Test patterns
See Also Bars and tone
importing 265
importing new 605
video 605

Text editors for Avid logs 117
Text in the script window

changing font of 297
cutting, copying and pasting 300
linking clips to 306
removing 301
searching through 302 to 306
selecting 298

Text mode (bin display)
defined 228
in Media Tool 271
using 242 to 257

Text Mode button 242
Text search

in the script window 305
Text, adding in Script mode 262
Three-button play (J-K-L keys) 346
Three-point editing, with phantom marks 386
Tidy Up Columns command (Bin menu) 245, 

260
Tidying up

columns in a bin 244
frames in a bin 260

Timecode
breaks in, digitizing across 196, 201
display options 334
displayed 331
finding frames with 360
setting muliple displays 335
SMPTE standard, formats for entering 360
timecode-of-day, digitizing with 198

Timecode option
displaying tracking information 335

Timecode window 334
Timeline

See also Segment mode
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adding new tracks 443
changing background color in 403
controlling movement in 414
creating a view 404
customizing 401
deleting tracks in 444
digitizing to 199
displaying detail in 409, 410
dupe detection in 449
editing with film track 429
Fast menu 401
finding clip text in 362
first edit displayed in 380
focusing 412
full-screen view 426
Heads (and Tails) view 432
IN to OUT highlighting in 415
locking tracks in 442
monitoring tracks in 437
motion mode indicator 414
nesting 435
patching tracks 441
position indicator 408
printing 453
recording to 199
removing add edits in 446
resizing 427
saving 404
scale bar 410
scroll bar/position bar 408
segment mode editing in 414
setting the scroll option 408
source material, displaying 413
Track Selector panel 435 to 443
using 398
view

customizing 399
examples of 399
replacing 405
restoring default 407

viewing in 338

working with multiple tracks in 434 to 449
zooming in and out of 411

Timeline Settings window
accessing 408

Timeline View pop-up menu 404
Time-remaining display (Digitize Tool) 151
Tips

logging 109
playback performance 394, 394
storage 579

Tone
creating media for 172
recording to tape 615

Tools
Audio 163
Audio EQ 518
Audio Mix 490
Calculator 100
Compression 143
Console 103
Deck Controller 91
Digitize 144
Hardware 103
Serial Ports 105
Video Input 174
Video Output 602

Tools menu, using 89
Track Selector panel

user preferences for 377
using 435 to 443

Tracking color frame shifts 451
Tracking information, displaying 329 to 332
Tracks

adding 376, 443
audio, mixing down 553
deleting

in Segment mode 444
with Media Tool 273

enlarging and reducing 402
ganging in the Audio Mix Tool 498
locking 442
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managing sync in 562
monitoring 437
moving in the Timeline 403
number supported 434
patching 441
preferences for creating and enabling 377
selecting 436

for digitizing 147
selecting for audio scrub 483
sync-locked, trimming with 474
sync-locking 443

Transferring a video sequence to AudioVision 
645

Transferring bins
with MediaLog for Macintosh 113
with MediaLog for PC 114

Transferring files 639, 666 to 666
OMF to AudioVision

compatibility issues 643
guidelines for 644

OMF to Pro Tools
guidelines for 649
procedure for 651

Transferring media
between systems

compatibility requirements 664
methods for 664
procedure for 665
storage devices for 666

with AvidNet 666
Transition Effects, defined 434
Transitions

audio, fine-tuning 549
selecting for trimming 457
selecting several for trimming 460

Trim
adding filler during 473
during a playback loop 466
edits, reviewing 463
maintaining sync during 473
on-the-fly 465

sides, selecting 460
slip and slide

procedures 468
with sync-locked tracks 474

Trim mode
basic procedures in 457 to 464
Big Trim mode

toggling with Small Trim mode 459
customizing 456
defined 454
entering 457
exiting 459
Play Transition Loop parameters in 464
selecting

several transitions in 460
single transitions in 457
trim sides in 460

Small Trim mode
toggling with Big Trim mode 459

using Transition Corner Display 476
Trim pots, adjusting 170
Trimming See Trim mode, Trim
Trimming two heads or tails 461
Turning off the system 45
Turnover points in Audio EQ Tool 519
Two-channel audio board systems

adjusting audio input levels 171
adjusting output on 612
set input level in 169

Two-channel board systems
slot number, in Audio Setup display 162

U
U-matic 3/4-inch videotape See Videotape
Unattended batch digitizing

See also Batch digitizing, Digitizing, 
Redigitizing

setting up for 201
Undo command (Edit menu) 383
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Undoing and redoing edits 382
UNIX systems, and file transfer 667
Unlinking media files 286
Unlock Bin Selection command (Clip menu) 

239
Unlock Tracks command (Clip menu) 443
Unreferenced clips

deleting 275
selecting in the bin 241

Usage
displaying 77

User
identifying 36
selecting another 66
selecting existing 37
setting up 36

User Bits in LTC, reading 223
User profile

adding 28
creating new 26, 36
deleting 27
moving between systems 28

User settings
defined 62
opening a project with 41
selecting a user from 66

User-selectable buttons
See also  Buttons
See also Buttons
Add Dissolve 550
Add Edit 445, 549
Add Locator 356
Clear IN 352
Clear Marks 352
Clear OUT 352
Copy to Clipboard 389
Cycle/Picture Sound 437
Cycling Trim Sides 460
Extend 467
Extract 388
Extract/Splice-in (Segment mode) 422

Fast Forward 344
Find Bin 364
Find Frame 365
Find Script 321
Go to Next Edit 458
Go to Previous Edit 458
jog 345
Lift 388
Lift/Overwrite (Segment mode) 422
Make Subclip 353
mapping 96, 97
Mark Clip 352
Mark IN 351
Mark OUT 351
Match Frame 363
Mouse Jog 349
Mouse Shuttle 349
Mute 489
Pause 344
Play 344
Play Loop 463
Replace 385
Review Transition 458
Rewind button 344
Script Mark 318
Slip Left, Right 472
Splice 380
Stop 344
Trim A-side 460
Trim B-side 460
Trim mode 457

Utilities folder 25

V
Vantage text editor 118
Variable-speed play See  Playback
Vectorscope

monitor, substitute for 605, 607
using 181



705

Vertical interval timecode See VITC
VHS tape, digitizing from 614
Video

advanced, calibrating 604
input

calibration 177
preparing for 174 to 184

leader
creating 266
using to maintain sync 563

levels, adjusting by eye 184
number of tracks supported 434
output, calibrating 602, 608
test patterns 605
tracks, monitoring 437

Video Input pop-up menu (Video Input tool) 
178

Video Input Tool
Line Selector slider 180
saving settings 182
vectorscope 181
waveform monitor 179

Video Input Tool command (Tools menu) 174
Video mixdown 629
Video Output Tool

less options display 602
more options display 604

Video Output Tool command (Tools menu) 602
Video Slave Driver See Digidesign hardware
Video solo feature 439
Videotape

classification schemes for multicamera 
editing 573

digitizing bars and tone from 265
naming guidelines 111
preparing for output 614
recording digital cut to 621
recording to 614
striping requirements 614
supported formats 175

Videotape deck

Avid-controlled, logging with 121
non-Avid-controlled, logging with 124

View
Heads and Tails, in the Timeline 432

View Name dialog box (bin) 249
View name dialog box (Timeline) 405
View Type command (Timeline Fast menu) 432
View, Timeline

customizing 399
replacing 405
saving 404

Viewing in monitors 336
VITC (vertical interval timecode)

decoding with Media Reader 188
Volume

adjusting while playing an effect 499
Volume adjustments

ignoring 498
in Audio Mix Tool 492

Volume meters
in the Audio Tool, defined 165
in the Timeline 503

VTR Emulation command (Special menu) 625
VTR Emulation pop-up menu 625
VTR play emulation 624
VTR See Videotape deck
VU (volume unit) scale (Audio Tool), defined 

165

W
Waveform monitor

calibrating input with 179
calibrating output with 605

Waveform plots (audio) 487
Wide screen (16 x 9) display option 329
Wide-screen format (16 x 9) 133
Window zoom box 338
With outpoint set option 135
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X
Xinet K-AShare 667

Z
Zoom Back command (Timeline Fast menu) 411
Zoom box 338
Zoom In command (Timeline Fast menu) 411
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